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1 Notices

1.1 Proprietary notice
The product information and design disclosed herein were originated by and are the property of Bosch
Security Systems, LLC. Bosch reserves all patent, proprietary design, manufacturing, reproduction, use
and sales rights thereto, and to any article disclosed therein, except to the extent rights are expressly
granted to others.

1.2 Copyright notice
Copyright 2024 by Bosch Security Systems, LLC. All rights reserved. Reproduction, in whole or in part,
without prior written permission from Bosch is prohibited.
*All other trademarks are property of their respective owners.
**MOTOROLA, MOTOTRBO, and the Stylized M logo are registered in the U.S. Patent and Trademark
Office.

1.3 Warranty notice (limited)
For warranty and service information, see http://www.telex.com/warranty.

1.4 Factory service center
Factory Service Center
Bosch Security Systems, LLC
Radio Dispatch Products
140 Caliber Ridge Drive
Greer, SC 29651

1.5 Contact information
Sales
E-mail: TelexDispatch@ keenfinity-group.com
Phone: (800) 289-0096

Customer service repair
E-mail: repairservice.nam@keenfinity-group.com
Phone: (800) 553-5992

Technical support
E-mail: TelexDispatchtechsupport@ keenfinity-group.com
Knowledge database: http://knowledge.keenfinity-group.com/
Web: www.telex.com

http://www.telex.com/warranty
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1.6 Claims
No liability will be accepted for damages directly or indirectly arising from the use of our materials or
from any other causes. Our liability shall be expressly limited to replacement or repair of defective
materials.

Mototrbo claim
Motorola Solutions, Inc and its subsidiaries make no express or implied representation or warranty
with respect to: (i) any of the Products references herein; (ii) the information provided herein (including
without limitation the key findings and test results regarding the Products and the functionality or
interoperability thereof) (“Information”) or any solution, combination or system that may be created
with the use thereof. The information is offered “as is” with all faults and does not constitute
professional, technical, legal or other advice to the user.

1.7 Warning

i
Notice!
This is a class A product. In a domestic environment this product may cause radio interference, in
which case the user may be required to take adequate measures.

!

Warning!
Do not open the unit. No user serviceable parts are contained within. Bosch cannot be responsible for
damage. If the unit is opened, the warranty can be voided.

1.8 OpenSSL project
– This product includes software developed by the OpenSSL Project for use in the OpenSSL

Toolkit (https://www.openssl.org/).
– This product includes cryptographic software written by Eric Young (eay@cryptsoft.com).
– This product includes cryptographic software written by Tim Hudson (tjh@cryptsoft.com).



14 en | Overview C-Soft 8.500

2025-08 | 16 | F.01U.218.561 Technical Manual Bosch Security Systems, LLC

2 Overview
The Telex C-Soft Console Software is a Microsoft Windows application (refer to Copyright notice,
page 12) that enables a PC with a network connection to monitor and control 2-way radios connected
to the network. Utilized in conjunction with an infrastructure of Telex VoIP (Voice Over Internet
Protocol) products, the C-Soft application offers a powerful and convenient method for controlling a
radio network using standard computer equipment.
The software console can support up to 300 lines and is fully compatible with popular touch screen
monitors. In addition, standard desk microphones, headsets, and foot-switches are supported through
the use of the ADHB-4 headset adapter panel.

i
Notice!
Application Notes containing instructions for specific product installation are available for download
at www.telex.com.

Computer system requirements

Operating system Microsoft Windows 10 and higher (supports both
32-bit and 64-bit)

Sound system Full-duplex Microsoft Windows compatible
sound system

Network connection 10Mbps or 100Mbps, full-duplex TCP/IP
connection. Static IP address preferred to DHCP

Processor speed Intel Core i3 2.80GHz processor

Random access memory Minimum of 8GB recommended

New Features in Version 8.5
– Supports up to 300 lines of configuration in Per-Line Setup.
– Supports ability to auto-mute line traffic when line controls are in popup button.
– Added ability to use $LINEX$ text macro to buttons, displays line name from Per-Line Setup

page.
– Supports connection to CSSI/CMS gateway connection.
– Supports sending console alias when using NEXEDGE Direct IP.
– Telex License Application Tools v1.8 has updated links for KEENFINITY Licensing page.

Refer to
– Appendix L - Console Sign In, page 607
– Appendix M - Console Configuration Tool, page 611

http://www.telex.com


C-Soft 8.500 License and optional features | en 15

Bosch Security Systems, LLC Technical Manual 2025-08 | 16 | F.01U.218.561

3 License and optional features
Description Model number

C-Soft 2-line SOFTWARE v8 C-Soft8 2L

C-Soft 6-line SOFTWARE v8 C-Soft8 6L

C-Soft 12-line SOFTWARE v8 C-Soft8 12L

C-Soft 24-line SOFTWARE v8 C-Soft8 24L

C-Soft 50-line SOFTWARE v8 C-Soft8 50L

C-Soft 100-line SOFTWARE v8 C-Soft8 100L

C-Soft 150-line SOFTWARE v8 C-Soft8 150L

C-Soft 200-line SOFTWARE v8 C-Soft8 200L

Upgrade Previous C-Soft to C-Soft v8 C-Soft8 Upgrade

***Each C-Soft license includes 2 lines of SIP and 1 line of Per Line Playback

SIP Enhanced 6-line SIP 6L

SIP Enhanced 12-line SIP 12L

Line Call Playback 2-line Playback 2L

Line Call Playback 6-line Playback 6L

Line Call Playback 12-line Playback 12L

Line Call Playback 24-line Playback 24L

Line Call Playback 50-line Playback 50L

Line Call Playback 100-line Playback 100L

NEXEDGE Direct IP 2-line NEXEDGE IP 2L

NEXEDGE Direct IP 6-line NEXEDGE IP 6L

NEXEDGE Direct IP 12-line NEXEDGE IP 12L

NEXEDGE Direct IP 24-line NEXEDGE IP 24L

DFSI Direct IP 2-line P25 DFSI 2L

DFSI Direct IP 6-line P25 DFSI 6L

DFSI Direct IP 12-line P25 DFSI 12L

DFSI Direct IP 24-line P25 DFSI 24L

AES Encryption Option, per seat Encryption Seat
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Direct IP Interface, DMR AIS, 2-line DMR AIS IP 2L

Direct IP Interface, DMR AIS, 6-line DMR AIS IP 6L

Direct IP Interface, DMR AIS, 12-line DMR AIS IP 12L

Direct IP Interface, DMR AIS, 24-line DMR AIS IP 24L

Application Programming Interface SDK API SDK

Application Programming Interface, per seat API Seat

P25 CSSI Direct IP 2-line License P25 CSSI 2L

P25 CSSI Direct IP 6-line License P25 CSSI 6L

P25 CSSI Direct IP 12-line License P25 CSSI 12L

P25 CSSI Direct IP 24-line License P25 CSSI 24L
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4 C-Soft Application Software
C-Soft Designer program
The C-Soft Designer program provides the ability to create custom dispatch screen designs. Console
operators with differing requirements can be given different screen designs. Once the screen layout is
created, the C-Soft Designer program generates a file read by the C-Soft Runtime program.

i
Notice!
A software-based license key is not required to operate C-Soft Designer.

C-Soft Runtime program
The C-Soft Runtime program does the actual network communications with the other radio elements
available on the network. This single screen design file makes it easy for the designer to send updates
to users wherever they may be located.
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5 Installation and setup
This chapter includes information on the installation of and the initial system setup requirements for
the C-Soft program.

Sections include:
– Install the C-Soft Runtime Software
– Install the C-Soft Designer Software
– Install the ADHB-4 Driver
– Install the Telex License Server
– Configure the initial Volume Control settings

5.1 Install the C-Soft Runtime software
Important: The C-Soft Installation package is downloadable from www.telex.com. Contact the
technical support team to get access.

To install the C-Soft software, do the following:
1. Download the C-Soft installation package and copy it to your computer.
2. Navigate to and double-click the C-Soft Setup_vXXXX.exe file. 

The C-Soft Runtime Setup wizard appears.

3. Click Next. 
The License Agreement window appears.

http://www.telex.com
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4. To agree with the agreement, select the “I accept the agreement” radio button.
5. Click the Next button. 

The Information window appears.

6. Follow the instructions in the window and click Next. 
The Select Destination Location window appears.
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7. Click Next to accept the default folder location for C-Soft (recommended). 
The Select Additional Tasks window appears. 
OR 
Click Browse to select a different folder location for C-Soft. 
The Browse window appears.

8. From the Additional shortcuts list, select check boxes for the shortcuts you want to create.
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9. Click Next.
The C-Soft Settings window appears.

10. Click Next to accept the default C-Soft Directory settings (recommended).
The C-Soft Settings TSM Setup window appears.
OR
Click the Browse button to navigate to the folder as desired for each Directory setting.
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11. Enter the TSM Username desired.
12. Select the Reset Password check box to reset the password that logs into the device with

TSM.
13. Enter the TSM Ping TTL to set the TTL (Time to Live) value, which is TSM device detection

feature.
14. Click Next.

The C-Soft Settings Position Name window appears.

15. Enter the Position Name; the position name is used for TSM naming.
16. Click Next.

The C-Soft Settings Summary window appears.
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17. Select the Confirm Position settings to continue check box. Or click Back to modify.
18. Click Next. 

The Ready to Install window appears. 
NOTE: The destination location and start menu folder paths appear in this window.

19. Click Install. 
C-Soft installs. The C-Soft Runtime Setup Wizard finish window appears.
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20. Click Finish, when complete.

5.2 Install the C-Soft Designer software
Important: The C-Soft Installation package is downloadable from www.telex.com. Contact the
technical support team to get access.
To install the C-Soft Designer software, do the following:

i
Notice!
The C-Soft Designer installer launches during the C-Soft Runtime installer. It has already downloaded
to your machine.

1. Navigate to and double-click the C-SoftDesigner_Setup_vXXXX.exe file. 
The C-Soft Designer Setup wizard appears.

http://www.telex.com
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2. Click Next. 
The License Agreement window appears.

3. To agree with the agreement, select the “I accept the agreement” radio button.
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4. Click the Next button. 
The Upgrade Design window appears.

5. (Optional) Select the Upgrade default design check box to have C-Soft Designer automatically
upgrade the current design to a version compatible with the C-Soft Designer version being
installed.

i

Notice!
If selected, a backup of the default design is saved prior to upgrade. It exists in the same folder, but a
version suffix is added to the file's name. For example, if the designs name is MyDesign.veg,
MyDesign.veg is the first backed up to MyDesign_X.XXX.veg. and then MyDesign.veg is upgraded to
the new C-Soft version.

1. Click Next.
The Information window appears.
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2. Follow the instructions in the window and click Next. 
The Select Destination Location window appears.

Figure 5.1:
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1. Click Next to accept the default folder (recommended). 
The Select Additional Tasks window appears. 
OR 
Click Browse to select a different folder location for the program’s files. 
The Browse window appears

2. From the Additional icons list, select check boxes for shortcuts you want to create.
3. Click Next.

The Ready to Install window appears.
NOTE: The destination location and start menu folder paths appear in this window.
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4. Click Install. 
C-Soft Designer installs.

5. Click Finish, when complete.
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5.3 ADHB-4 driver installation
The ADHB-4 Device Installer wizard appears automatically at the end of the C-Soft installation
process. The wizard can be skipped if the position has the latest drivers and you are only doing an
upgrade.

To install the ADHB-4 driver, do the following:
1. From the Welcome to the ADHB-4 Installer wizard, click the Next button. 

The Windows Security message appears.
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2. Click Next. 
The Windows Security window appears.

3. Click Install. 
The Congratulations! You are finished Installing the ADHB-4 window appears.

4. Click Finish. 
The ADHB-4 driver installation is complete.
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Note:
– When the installation is finished, the C-Soft executable files are located at: C:\Program

Files\Telex Communications\C-Soft.
– The cposi.txt, keyset.dat, and DefaultVeg.txt files are located at: C:\Programdata\Telex

Communications\design_folder.

5.4 Telex License Server setup
The Telex License Server Installer wizard appears automatically at the end of the ADHB-4 installation
process. The wizard can be skipped if the position has the latest drivers and you are only doing an
upgrade.

For more information about the Telex License process, refer to “Appendix I - Telex License Activation
tool, page 584”.

To install the Telex License Server, do the following:
1. From the Welcome to the Telex License Server Setup Wizard, click the Next button. 

The License Agreement window appears.

2. To accept the agreement, select the “I accept the agreement” radio button. 
The Select Destination window appears.
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3. Follow the instructions in the window and click Next. 
The Select Destination Location window appears.
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4. Click the Next button to accept the default folder location for C-Soft (recommended). 
The Select Start Menu Folder window appears. 
OR 
Click the Browse button to select a different folder location for C-Soft. 
The Browse window appears.
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1. Click the Next button to accept the default folder (recommended). 
The Select Additional Tasks window appears. 
OR 
Click the Browse button to select a different folder location for the program’s shortcut files. 
The Browse window appears.

2. From the Additional icons list, select check boxes for the shortcuts you want to create.
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3. Click the Next button. 
The Ready to Install window appears.

4. Click the Install button. 
The Microsoft Visual C++ 2012 window appears.

5. Select the I agree to the license terms and conditions check box.
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6. Click the Install button. 
Once installed, the Setup Successful window appears.

7. Click the Close button. 
The Completing the Telex License Server Setup Wizard appears.

8. Click the Finish button.

5.5 Initial volume control settings - Non-ADHB-4 Operation
There are two sets of volume control settings on the computer crucial to the operation of the C-Soft
programs. The first set controls playback volumes, and the second set controls recording volumes.
Before using the C-Soft applications, these settings need to be checked and adjusted, if necessary.
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These steps are only necessary when not using the ADHB-4.

5.5.1 Playback volumes
To set the playback volume, do the following:

1. Click the speaker icon  in the system tray. 
The Mixer window appears.

2. Click Mixer. 
The Volume Mixer window appears.
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3. Set the Device Volume to the maximum level. 
The C-Soft Console volume slider moves to maximum.

4. Click the Device Speaker’s icon. 
The Speaker Properties window appears.

5. Click Levels. 
The Levels page appears.

6. If a universal no symbol does not appear on the Microphone’s speaker icon, click the microphone
icon. 
The universal no symbol appears on the icon. 
OR 
If the universal no symbol appears on the microphone icon, go to the next step.

7. Click OK.
The window closes.

5.5.2 Recording volumes
To set the recording volumes, do the following:

1. Right-click the speaker icon  in the system tray.
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2. From the shortcut menu, select Recording Devices. 
The Recording page appears.

3. Click Microphone. 
The Configure Button is Enabled.

4. Click the Configure Button. 
The Configure Speech Recognition screen appears.
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5. Click Set up microphone. 
The Microphone Setup Wizard appears.

6. Select the type of microphone you want to configure.
7. Click Next. 

The Set up your microphone window appears.
8. Follow the instructions in the window.
9. Click Next. 

The Adjust Volume window appears.
10. Follow the instructions in the window.
11. Click OK. 

The Sound window closes.
12. Close the Volume Mixer window.

5.6 Position settings
These position settings are stored in the devices ProgramData and are used on any design file ran on
the device. These settings are configurable when running the C-Soft Installer (7.700 or greater). They
can also be configured using TSM for both C-Soft Desktop installations and IP-3XXX devices.
Audio Recording Directory: Location of recorded audio
Images Directory: Global location for images
Sounds Directory: Global location for sounds
GPS Directory: Global location for GPS kml files
TSM Username: Username for accessing device from TSM
TSM Password: Password for accessing device from TSM
TSM Ping TTL: TTL for TSM network connection
Position Name: Name of the dispatch position
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6 Communications system design
Designing a C-Soft console requires an understanding of the radio network and how the various
radios and other communication equipment are connected.

Before you begin to design the C-Soft console, create a road map of the radio, console, and any other
communication equipment locations.

This road map must include the following:
– Multicast Addresses for each channel of TX (Transmit) and RX (Receive) communication.
– Port numbers for each channel of TX and RX communication.
– Base IP Addresses assigned to each console or radio on the network and the number of

frequencies each radio operates on.
– The number of channels each radio may operate on.

6.1 Communication control

6.1.1 Tone remote control
Telex Radio Dispatch sells a full line of tone control consoles and radio adaptors. This technology
requires an analog connection between console and radio. Each console needing to control an
individual radio is wired in parallel to allow multiple operator positions to monitor and control the same
radio. For a large system with multiple console positions and multiple radio channels, an entire rack
might be devoted to bridging audio to all interested parties. In addition, due to loading of multiple
consoles on a particular circuit, additional bridging hardware might be required, increasing wiring and
tuning of the system for acceptable performance. The Ethernet-based IP network solves many of
these issues and provides for a number of other services not previously possible.

6.1.2 VoIP radio control
VoIP is referred to generically throughout this document to mean RoIP (Radio Over Internet Protocol).
RoIP terminology is a subset of VoIP and referred to as VoIP generically throughout this document.
VoIP is a method of breaking analog audio up into packets to be transferred over a computer data
network. Because Ethernet delivers information packets, audio is generally broken into 10-40ms
chunks of audio, compressed, and placed on the Ethernet. The nodes of the network are then free to
utilize or ignore any combination of packets. If a particular audio stream is of interest, the stream of
audio packets are captured, decompressed, converted back to analog, and played on available
speakers.

Given the popularity of the Ethernet-based networks, many companies and agencies already have an
existing network or LAN (Local Area Network). Beyond that, a large number of companies exist to
provide WAN (Wide Area Network) connections between sites with significant distances between
them. The WAN connections can be used to connect offices across the street from one another,
around the world, or anywhere in between. Possibly the best thing about these connections is they
may already exist. In many cases, WAN links are less expensive than a comparable leased analog line
and they can carry more conversations simultaneously.
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The most compelling reason to consider basing the next radio control system upgrade on VoIP
technology is the simplification in wiring requirements. Instead of needing to bring a pair or more of
wires, per channel, to each console, only a single connection to the Ethernet is required. Since Ethernet
can easily handle dozens of simultaneous connections, it becomes the only pipeline required for all
communications.

6.2 PC & Network Security Considerations

No system can be 100% protected against security threats. However, there are measures both
manufacturers and users can do to help reduce the likelihood of a malicious attack resulting in either
the loss of data or system takeover. We evaluate and improve our products continuously to protect
against such attacks. This is only one safeguard used to reduce the likelihood of such an event. There
are many more considerations needed to implement measures to strengthen your network security.

We strongly recommend the following considerations:
– Deploy Dispatch products and software on isolated networks that do not connect to other

networks, when possible.
– Apply the latest Windows updates and install up-to-date IT security software.
– User rights should be properly administered using group policies to prevent unauthorized use of

USB connected devices.
– If the Dispatch network must connect to other networks, install and properly maintain firewalls

and intrusion detection systems.
– If Dispatch devices or computers use the Internet to connect, a VPN or tunnel connection should

be utilized. Examples of such products are those made by DCB (Data Communications for
Business), Cisco, and others.

i

Notice!
Bosch recommends utilizing the services of IT professionals knowledgeable about network design
and security when designing, installing, and configuring dispatch networks and deploying PCs. By
default, the Telex Dispatch products using the Windows operating system has Windows Update
enabled along with Windows Defender (firewall and anti-virus). Disabling these features is not
recommended unless it is part of an internal IT security program that uses customized security
policies along with appropriate anti-virus and firewall software.

6.3 Network requirements

6.3.1 IP operation overview
The network options today have essentially converged on Ethernet. A local electronics store may sell
many of the components for both a wired or wireless network solution. For more advanced network
applications, an in-house or external network hardware source may be required. These sources of
information can also help with the design of the network, as well as provide sources for advanced
networking equipment, such as routers and hubs from Cisco and other network vendors. This section
is an overview of the protocols operating on the top of the Ethernet network.
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6.3.2 Ethernet as physical layer
Ethernet is a network and has a low level method for transferring data from one location to another.
Source and destinations are based on the MAC (Media Access Control) which is embedded in the
Ethernet interface. The MAC Address is unique for all devices in the world and cannot be changed.
The IEEE (Institute of Electrical and Electronics Engineers) controls the allocation of the MAC
Addresses. The definition for Ethernet includes requirements for inter-operation at speeds of 10 and
100 Mbps. Higher speeds are available, but generally have not filtered down into end-user equipment.

6.3.3 Bandwidth
Each VoIP channel requires 50kBit of bandwidth while active. Full-duplex conversation requires
100kBit of bandwidth.

Some radio systems transmit go-ahead beeps when it is clear to talk. In order for the console operator
to hear the beeps, the system must support full-duplex communication. Full-duplex bandwidth may
only be required for the first few seconds of a conversation, due to the brief nature of the go-ahead
beeps at the beginning of the transmission.

When using Telex’s IP-223 with a PIB (Phone Interface Box) or TDI (Telephone Dispatch Interface)
adapter, C-6200, or a NI-223 for a telephone connection, a full 100kBit is required since it is a full-
time, full-duplex conversation.

Additional vocoders available: Telex 32K (50 kbits/sec simplex), G.726 16K (34 kbits/sec simplex),
G.726 32K (50 kbits/sec simplex), G.711 (82 kbits/sec simplex).

6.3.4 Multicast
In general, Telex Dispatch Systems require Multicast to function. The network must be able to create a
static Multicast Address, accessible at all times.

Once an IGMP (Internet Group Management Protocol) join message is sent out, networks typically
enable Multicast and then prune branches after a period of time. Due to intermittent usage patterns of
2-way radios, such a system can appear to work flawlessly for a period of time and then no longer
work.

When using Cisco technology, IP PIM dense mode is recommended. Generally speaking, sparse-
dense-mode can also be implemented effectively. We recommend explicitly joining the Multicast
group with an IP IGMP static-join X.X.X.X command. For more information on Cisco and IGMP, visit
www.cisco.com.

If running Sparse mode, by design Telex equipment only sends a IGMP join message when powered
up or queried by routers. The routers need to be configured with a PIM Interval Timer to keep the
Multicast group active. (See example below.)

6.3.5 IP PIM query-interval
To configure the frequency of PIM (Protocol Independent Multicast) router query messages, use the ip
pim query-interval command in interface configuration mode.

http://www.cisco.com
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To return the default interval, use the no form of this command:

ip pim query-interval seconds

no ip pim query-interval [seconds]

6.3.6 Internet group management protocol
IGMP can be used to control where Multicast is allowed to propagate. This should be limited to
subnets utilizing the C-Soft program as the dispatch console and only when used on an intermittent
basis (when the C-Soft program is used for a period of time and then shut down). When a console on
the subnet is expected to be continually operational, Multicast must be active for the subnet at all
times.

6.3.7 Network performance
Networks should perform well under any loading conditions. The default audio delay is 120ms, plus
any delay added by the network. While delay alone does not cause issues, variable delay (also known
as jitter) does. Jitter, in a network, cannot exceed the maximum packet buffer of any individual product
buffer. Refer to the individual product manuals for these specifications. For example, the IP-223 or
IP-224 can handle approximately 600ms of network jitter.

i
Notice!
Losing more than 5% of the total packets transmitted compromises audio quality and system
performance. Optimally, packet loss should be less than 1%.

6.3.8 TCP/IP and UDP/IP
TCP/IP (Transmission Control Protocol/Internet Protocol) is the best-known protocol for use in
computer communications. It is the basis for communications on the Internet and World Wide Web. It
is a guaranteed method of transferring data between two computers. Being guaranteed means for
every packet of information transferred from one computer to another an acknowledgement packet is
returned. Additional handshaking is utilized from the outset of the data communications to ensure
both ends of the connection. Because of this guaranteed communications and its implementation
utilizing handshaking (no other method is available), TCP/IP adds a great deal of overhead to data
communications is not desirable for audio traffic over a network. This is where UDP/IP finds its
acceptance.

UDP/IP (Universal Datagram Protocol/Internet Protocol) has existed as long as TCP/IP as an unreliable
method of data communications. The term unreliable should not be thought of as a problem for audio
communications over a network connection. UDP allows for a computer to send a packet of data to
another computer without the handshaking sequence required within TCP/IP. Because of this, the
computer sending the packet has no confirmation the packet arrived at its destination. While the loss
of packets can be a problem, it generally is accounted for when the UDP application is developed. In
the case of VoIP, the loss of a packet, which only contains 10-40ms of audio, is not a problem, as the
human ear generally ignores the small chunk of lost audio. The largest single factor in the loss of UDP/
IP packets is network design and loading. UDP applications use algorithms which makes the loss of
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information the largest single factor in UDP/IP network design and loading. As long as a network is
well designed with capacity for all of its chartered requirements, packet loss can be a non-issue.
Because of its lower overhead and its ability to Multicast, UDP/IP is the protocol of choice for VoIP
development.

6.3.9 Multicast UDP/IP
Multicast is an extension to UDP/IP. It enables one computer to broadcast data packets to multiple
recipients. This is an ideal model for radio communications when multiple people need to monitor the
audio. A single VoIP connected radio is set up to broadcast Multicast VoIP packets when receiving
audio. Since the Multicast packets can be received by any interested party, all consoles monitoring the
audio can receive and decode the packets for playback. In addition to simplifying monitoring of audio
traffic by multiple listeners, Multicast also greatly reduces the bandwidth requirement on the network.
Instead of having to regenerate the received audio into a UDP/IP data stream to each individual
monitor, which uses the bandwidth times the number of monitoring consoles, a single data stream is
generated and monitored by all.

Implementation of a Multicast protocol requires a few things for seamless use on a network. First,
clients must all support the protocol. This is accepted as given since all Telex Radio Dispatch products
utilize Multicast for audio communications. Second, consider if the network infrastructure supports
Multicast.

Multicast packets are defined to be all packets with a destination address between 224.0.0.0 and
239.255.255.255. Some of these addresses are commonly used for broadcast audio and are not
necessarily available. When a computer opens a UDP/IP port within this address range, it also joins
the group. By joining the group, a packet is sent out to all addresses saying it is interested in seeing
the traffic on this Multicast address. Routers that receive this broadcast message to join a particular
Multicast Address then pass packets through because the router is now aware a listener is interested
in this traffic. The routers utilized in the network must support this. The protocol used to alert routers
to parties who are interested in certain Multicast Address traffic is IGMP (Internet Group Management
Protocol). Telex radio Dispatch products support IGMPv1, as defined in RFC 1112.

In addition to the joining of Multicast broadcast groups, clients on the network can also specify a
packet TTL (Time To Live). The TTL is the number of routers the packet goes through before being
stopped. As an example, the TTL for a particular broadcasting node on the network is set to 3. This
means when a packet is transmitted, it arrives at the first router in the network. This router examines
the TTL value in the packet and determines if it should pass it through since it is not zero. When it
passes the packet, the router decrements the TTL value by 1 to a value of 2. The next router
encountered by packets does the same, reducing the value of TTL to 1. The next router does the same
and the TTL is reduced to 0. The next router the packet reaches examines the TTL value, sees it is
zero, and the packet is not to be retransmitted. Setting a large TTL value may allow for packets to get
from one host to another on a large network, but also adds additional bandwidth requirements due to
the larger number of packets being transferred.

6.3.10 Telex Radio Dispatch port-centric method
As mentioned earlier, Telex utilizes Multicast for all audio communications. Typically only one Multicast
is used for all traffic. In addition to a valid Multicast Address, a port number is required. The port is an
additional two bytes of information ranging between 1054 and 65535 that further specifies how the
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data traffic should be handled. For example, assume the base Multicast Address chosen is
225.8.11.81. Port 1054 is used to distinguish channel 1's RX traffic. Port 1072 is used to specify
channel 1's TX traffic. Channel 2 might use 1055 for RX and 1073 for TX traffic. By making each
channel’s TX and RX ports different and unique, full-duplex audio can be supported and many
channels of traffic can be supported using only one Multicast Address (full-duplex data transmission
means data can be transmitted in both directions on a signal carrier at the same time). It is through
this method a single console can pick and choose the particular radio resources available on the
network without concern for what the console right next to it is utilizing.
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7 C-Soft Designer program
The C-Soft Designer program is a console designer application used by system specialists to design
and configure custom dispatch windows. Various combinations of buttons, sliders, text, and popup
windows can be included in a window design. These elements are then configured to operate on
specific lines.

The designer can place elements in any desired location, and can include or omit functions based on
the requirements of the system and the console operator.

When you are finished designing your VoIP system, the C-Soft console can be created. Before you
begin, determine the TX and RX port of each radio, the multicast group(s) used, the number of radios
to control, and the frequencies used by each radio.

7.1 Starting the C-Soft Designer program
To start the C-Soft Designer program, do the following:
– Double-click the C-Soft Designer desktop shortcut created during program installation.
The C-Soft Designer program appears.
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8 C-Soft Designer window
When the C-Soft Designer program is started, the console window, shown in the Figure below,
appears. This window is the workspace. It contains the commands and tools needed to design and
configure a customized software console.

The C-Soft Designer workspace includes the following components:
– Title Bar
– Menu Bar
– Toolbar
– Console window
– Status Bar

Figure 8.1: C-Soft Designer workspace

Title Bar
The Title Bar is located across the top of each window. When a file is opened, the path sequence and
file name appear on the title bar.

Menu Bar
The Menu Bar is located directly below the title bar and displays menus that contain commands for
accessing the C-Soft Designer functions. For example, the Insert menu contains commands to add UI
Element Buttons, Volume Sliders, Text, Popup Windows, and more.

Toolbar
The Toolbar is located directly below the menu bar and provides quick, easy access to commonly used
tasks. Refer to the Table below for a brief description of each button on the toolbar and the action
taken when the button is selected.
To move the toolbar, do the following:
– Click, hold, and drag the move handle on the toolbar or the title bar (blue bar on a floating

toolbar) to a new location.
The toolbar can be docked on any side of the window or as a floating toolbar, inside or outside the
workspace.

Icon Tool name Description
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Open Open an existing console design. You can also use File |
Open.

Save Save the current console design. You can also use File |
Save.

Cut Delete the selected item(s). You can also use Edit | Cut or the
Delete key on the keyboard.
This does not place the cut item on the clipboard.
After information is cut, you can not retrieve it.

Copy Copy the selected item(s). You can also use Edit | Copy or
CTRL+C.
This places the copied item on the clipboard.

Paste Insert the item(s) on the clipboard into the console design.
You can also use Edit | Paste CTRL+V

About Display the software version, company contact information,
and various statistics about the console design. You can also
use Help | About C-Soft Designer.

Increase Width Increase the width of the selected element. Proportionally
increase the size of the selected text.

Decrease Width Decrease the width of the selected element. Proportionally
decrease the size of the selected text.

Increase Height Increase the height of the selected element. Proportionally
increase the size of the selected text.

Decrease Height Decrease the height of the selected element. Proportionally
decrease the size of the selected text.

Rotate Window Rotate the selected popup window 90° counter-clockwise
around the selected popup button. Rotate the selected text
90° counter-clockwise.

Move Right Move the selected item(s) to the right.

Move Left Move the selected item(s) to the left.

Move Up Move the selected item(s) up.

Move Down Move the selected item(s) down.

Start C-Soft Runtime Run C-Soft Runtime with the current .veg file loaded in C-
Soft Designer.

Table 8.1: C-Soft Designer toolbar

Console window
The Console window displays the open console design. The console window contains a grid for easy
alignment of elements on the window. The grid is a window alignment tool and is not displayed on the
console position window.



52 en | C-Soft Designer window C-Soft 8.500

2025-08 | 16 | F.01U.218.561 Technical Manual Bosch Security Systems, LLC

Status Bar
The Status Bar is located at the bottom of the workspace window.

To display or hide the status bar, do the following:
– From the View menu, select Status Bar.
The status bar view toggles on and off. If there is a check mark next to Status bar in the view menu,
the Status bar is visible.
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9 User interface element configuration
The C-Soft Designer program is heavily dependent on the mouse for interacting with the elements
that comprise the console window design. The mouse is used for selecting and moving objects, to
access a form or window, and to perform actions on the displayed element or text.

Several standard Windows shortcuts are supported and are listed next to the command on the menu.
This section describes C-Soft Designer features available to assist in component manipulation on the
console window.

To select a single item, do the following:
– Click the desired item.
A red target is displayed on the selected element or in the case of text, there is a bounding outline
around the selected text.

To select a group of items, do the following:
1. Position the mouse pointer at the top and to the side of the objects to be selected.
2. Press and hold the left mouse button while dragging the mouse over the objects to be selected. 

This draws a box around the items selected.
3. When all items are included within the box, release the mouse button.
A red target appears on the selected element(s), and, in the case of text, there is a box around the
selected text.

You can select all items by pressing Ctrl+A.

A group of items cannot be moved using the mouse. When selected, use either the positioning tools

 on the toolbar or the arrow keys on your keyboard to move the items.

To move an individual item, do the following:
1. Select the item to be moved.
2. Drag the item to its new location on the window.

To copy and move an individual item at the same time, do the following:
1. Select the item while holding down the Ctrl key.
2. Drag the item to its new location on the window.
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This moves the copied item into the new location with all the parameters of the copied item intact.
When a popup button is copied using the Ctrl key, the popup window is also copied.

The Ctrl key copies items to allow for large sections of the console window to be designed, copied,
and then modified slightly to quickly design the console window.

To change the line number associated with a group of items, do the following:
1. Select a group of items.
2. Right-click an element within the selected group. 

A shortcut menu appears.
3. From the shortcut menu, select Group Line Number. 

The UI Group Properties window appears.
4. From the Line to Associate Function With drop down menu, select the line to associate with the

selected group.
5. Click OK.
The line number for the group is changed.

To change the border color of a group of items, do the following:
1. Select a group of items.
2. Right-click an element within the selected group. 

A shortcut menu appears.
3. From the shortcut menu, select Group Border Color. 

The UI Group Border Color window appears.
4. From the Border Color drop down menu, select the color to associate to the group.
5. Click OK.
The border color for the group of items is changed.

To change the font used on the elements in the group, do the following:
1. Select a group of items.
2. Right-click an element within the selected group. 

A shortcut menu appears.
3. From the shortcut menu, select Group Font Change. 

The Font window appears.
4. Select the Font, Font style, and Size you want to display on the elements. 

A sample of the selected style displays in the Sample field at the bottom of the Font window.
5. Click OK.
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The position of the popup window in relation to the popup button can be changed. The border color of
a group can also be changed.

To change the position of a popup window, do the following:
1. Right-click a UI element popup button. 

A shortcut menu appears.
2. From the shortcut menu, select Open popup. 

A popup window appears.

3. From the toolbar, select the rotate icon.  
Each click on the tool rotates the window 90° counter-clockwise around the selected popup
button.
OR 
Use the arrow keys or directional buttons to move the popup window.

To change a text string, do the following:
1. Select the text you want to change. 

A bounding outline appears around the text.
2. Right-click on the text. 

The Font window appears.
3. In the Enter Text field, make the changes to the text.

4. Click OK to accept the changes. 
The text is changed.
OR 
Click Cancel.

To change the size of a button, volume control or text string, do the following:
1. Select an item or group of items.

2. From the menu bar, select the increase or decrease width and height icons. 
OR 
Press the Ctrl key while pressing the arrow keys on your keyboard.
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To change the size of a popup window, do the following:
1. Right-click a UI element popup button. 

A shortcut menu appears.
2. From the shortcut menu, select Open popup. 

A popup window appears.
3. Select the popup button.

4. Use the increase or decrease width and height icons  to size the popup
window.
OR 
Press the Ctrl key while pressing the arrow keys on your keyboard to size the popup window.

For more information, refer to the table on “Toolbar”.
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10 File menu
The File menu contains commands for working with files.

Open
Only files in the C-Soft Designer file format (*.veg) or Telex Design Archive (.tda) can be opened by
the C-Soft Designer program.
NAVIGATION: Select File | Open from the menu bar.

Save
C-Soft Designer saves the active design to the C-Soft Designer file format (*.veg), or the Telex Design
Archive (*.tda) file format. If the active design has not yet been saved to a file, the Save menu opens
the Save As dialog to select a destination file name and type.
NAVIGATION: Select File | Save from the menu bar.

Save As
The Save As… menu option opens the Save As dialog to select a destination file name, file type, and
sets the active design to the specified file.
To save a file by a different name, do the following:
1. From the File menu, select Save As… .

The Save dialog opens.
2. Navigate to the desired folder.
3. In the File Name field, enter the new file name.

Import SIP Contacts
To include SIP Phone contacts in your TDA file use the Import SIP Contacts menu to open a file
chooser to select a SIP Contacts (*.csv or .veg) file. After selecting the file, the file is copied and named
to the expected Design Data location corresponding to the current design. As a result, when saving
the current Design as a Telex Design Archive, the SIP contacts file is included in the Design Archive
and can be deployed to an IP-3XXX device.

File Information
The File Information menu opens the File Information window. For more information, see File
Information window, page 58.

10.1 Design Errors window
The Design Errors window appears when a file is saved and C-Soft Designer detects potential errors
in the design.
When the file is saved, the C-Soft Designer program performs a validation on the console design. The
results of the validation are displayed in the Design Errors window.



58 en | File menu C-Soft 8.500

2025-08 | 16 | F.01U.218.561 Technical Manual Bosch Security Systems, LLC

When not all the results can be displayed within the window, scroll bars are provided to navigate
through all of the test results.

Close button
The Close button is used to close the Design Errors window.

10.2 File Information window
The File Information menu is used to open the File Information window. This window displays:
– The file path for the currently open file.
– The version of C-Soft Designer used to last save the .veg file, total number of buttons, popups,

and sliders used in the current design.
– The Licensing Requirements group box lists the number of lines configured for each feature and

lists the minimum C-Soft License Feature that meets the specification.
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Figure 10.1: File Information window

Refer to
– File Information window, page 58

10.3 Telex Design Archive (TDA) files
C-Soft Designer allows the export of a container file called the TDA (Telex Design Archive), which
contains all the resource files referenced in a given design. The media contents of a design file are not
stored in the design and use static addressing to display them in C-Soft Runtime. The TDA container
allows creating a design on a separate device that then deploying it to an IP-3XXX, which unpacks
and copies the resources to the designated storage locations.

Figure 10.2: TDA Contents
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11 Edit menu
The Edit menu, shown in the Figure below, contains commands for the setup and revision of per line
and global parameters for your VoIP network. This menu also contains commands to create and
modify individual elements of the console position design.

Figure 11.1: Edit Menu
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12 Per Line Parameters window
The Per Line Parameters window, shown in the Figure below, is used to configure line types,
addresses, port information, and line frequencies for the VoIP network. This window allows
configuration of up to 300 separate entries.

The frequency, vocoder, backup IP, and signaling parameters for all lines included in the console
design must be set up on this window. If the line is not set up on this window, the line is not available
as an option when setting up the user interface elements.

Additions and changes can be made to the Per Line Parameters window at any time. However, make
sure all UI Elements, assigned to the line, are updated.

NAVIGATION: Select Edit | Setup Per Line Parameters from the menu bar.

Figure 12.1: Per Line Parameters window

Line Number Field
The Line Number field displays the number of the line. This number is used for identification purposes
in the design of the console position.

Line Type Drop Down Menu
The Line Type drop down menu identifies the type of line being configured. When a selection is made
in the line type field, the fields necessary to enter the setup information for that line type are enabled.

Available selections for this field are:
– Disabled - Line is not enabled. When the line is configured, it can be disabled without losing

configuration settings. Note that Line 1 cannot be disabled.
– Telex - Compatible with Telex VoIP radio dispatch products, such as the C-6200, IP-223 or

IP-224. Select Telex for FleetSync, MDC-1200, or MOTOTRBO (refer to “Copyright notice, page
12”) Professional Digital Two-Way Radio System.

– Phone - Allows the console to access a telephone line from across the network. Phone
configurations require the use of Telex’s PIB or TDI adapter. For more information, see the
IP-223 Phone Interface Box Technical Manual (F.01U.188.265) or the Telephone Dispatch
Interface Technical Manual (F.01U.196.107) available for download at
www.telexradiodispatch.com.

– SIP Phone - Each C-Soft License comes with two SIP lines. Additional lines can be purchased as
an additional feature, and are available in 6, and 12 line increments. For more information refer to
SIP (Session Initiation Protocol) configuration, and to “SIP Phone line configuration, page 113”.
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– P25-DFSI - For more information, refer to “Setting up a P25-DFSI Line”.
– NEXEDGE - For more information, refer to “NEXEDGE Trunking System Setup”.
– AIS - For more information, refer to “DMR-AIS”.
– P25-CSSI - For more information, refer to “CSSI Interface”.

Line Name Field
The Line Name field is used to enter a descriptive name for the line. This name is used for
identification purposes in the console position design.

i

Notice!
When you place the variable $LineX$—where X represents the line number—into the Button Up Text
and Button Down Text fields on the Colors page, the system automatically displays the Line Name on
the button. If the button is specifically defined for use with the line, you don’t need to include the X.

This field can contain up to 30 characters.

RX Multicast Address Fields
The RX Multicast Address fields identify the broadcast address for all audio traffic. This dotted quad
number must be between 224.0.0.2 and 239.255.255.255. Devices can have the same or different
Multicast Address for RX channels. Telex VoIP enabled equipment can use one Multicast Address for
all lines with the port number defining the RX channels.

Note:
– Unicast addressing (point-to-point communications) is also supported. Enter a static IP address

of the receiving gateway device.
– The RX Multicast Address must match the RX Multicast Address setup on the IP-223, IP-224, or

a C-6200 if it is the gateway.

RX Port Fields
The RX Port fields identify the RX port numbers. These numbers must be unique per channel and
must be between 1054 and 65535.

The RX port number must match the port number set up on the IP-223, IP-224, or a C-6200 if it is the
gateway.

TX Multicast Address Fields
The TX Multicast Address fields identify the broadcast address for all audio traffic. This dotted quad
number must be between 224.0.0.2 and 239.255.255.255. Devices can have the same or different
Multicast Address for TX channels. Telex VoIP enabled equipment can use one Multicast Address for
all lines with the port number defining the TX channels.

Note:
– Unicast addressing (point-to-point communications) is also supported. Enter a static IP address

of the receiving gateway device.
– The TX Multicast Address must match the TX Multicast Address setup on the IP-223, IP-224, or

a C-6200 if it is the gateway.
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TX Port Fields
The TX Port fields identify the TX port numbers. These numbers must be unique per channel and
must be between 1054 and 65535.

The TX port number must match the port number set up on the IP-223, IP-224, or a C-6200 if it is the
gateway.

Base Radio IP Field
The Base Radio IP field identifies the IP Address of the IP-223 or IP-224 used by the C-Soft program
to create a TCP connection to the specified address. This address is required for the C-Soft program
to create an internal ping command. It is also required for full-duplex mode (i.e., telephone mode) and
to generate encoded message strings (i.e., 5/6 Tone). We recommend you include a base radio IP
Address for all lines within your system design.

The base radio IP Address can be configured to periodically ping the IP gateway to determine if a
network connection still exists for a particular radio. If there is no response received from the ping, the
backup IP radio address is used.

A backup button is available for the console design. This button is used to force a switch, or to monitor
whether the primary or backup channel is used. Additional information on this feature is provided in
“Backup Line, page 233”.

TTL Field
The TTL field identifies the number of routers the Multicast audio packets go through before being
stopped. The network design dictates this value. If audio is not reaching a particular node on the
network, increasing this value may correct the problem.

The range for this field is 1 to 99.

Packet Delay Field
The Packet Delay field identifies the length of delay before playback, in 20ms packets. Some buffering
of these packets must occur before playback to help absorb network delays, jitters, and lost packets.
The typical entry for this field is 6, which translates to a delay of 120ms before playback (each packet
is 20ms of audio). Larger values may be required for complicated networks, smaller values for simpler
networks.

The range for this field is 4 to 64.

Echo Packets Enable Check Box
The Echo Packets Enable check box indicates the system operates on networks that do not support
multicast. The C-Soft program must be running at all times to translate and transfer packets from one
IP subnet to another.

A typical application has a number of radios spread throughout a network without multicast. In this
case, the radio adapters (IP-223s, IP-224s or C-6200s) are programmed to send packets to the IP
Address of the PC running the C-Soft program with Echo Packets enabled.
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An example of an Echo Packet system, where three different radios are connected through a WAN, is
shown in Appendix D - Echo Packets Diagram, page 479. In each of the subnets, a single copy of the
C-Soft program is used to communicate to the radio in its subnet. A second console is used to echo
the audio traffic to other copies of the C-Soft program. The C-Soft program also echoes all traffic to a
Multicast Address within its subnet so additional consoles can be added to the system by specifying
the Multicast Address.

Options Button
The Options button opens the Line Options Setup window, shown in the Figure below, for the
selected line.

Freqs Button
The Freqs button opens the Frequency Parameters window for the selected line. For more
information, refer to “Frequency Parameters window, page 68”.

Signal Setup Button
The Signal Setup button opens the Signaling Parameters window. For more information, refer to
“Signaling Parameters window, page 76”.

SIP Button
The SIP button opens the Configuration SIP Settings window. For more information, refer to
“Configure SIP Settings window, page 110”.

12.1 Line Options Setup window
The Line Options Setup window is used to configure the monitoring capabilities, digital format in the
line setup options and the backup IP to use if network resources of the primary radio interface
identified for the line fail.

Figure 12.2: Line Options Setup window
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i
Notice!
Vocoder configurations must be the same across devices.

To open the Line Options Setup window, do the following:
1. Select Edit | Per Line Parameter. 

The Per Line Setup window appears.
2. Click Options.
The Line Options window appears.

Line Setup Options group box

Vocoder Type drop down menu
The Vocoder Type drop down menu indicates the bit rate at which audio is converted into digital
format. This feature is used to configure communication between C-Soft and an IP-223 or IP-224.

Available selections for this field are:
TELEX 32K, G.726 16K, G726 32K (IP224 Only), G.711 64K (IP224 Only), and AMBE+2 (CSSI Only).

The G.726 32K (IP224 Only) and G.711 64K (IP224 Only) vocoders are only supported on C-Soft
version 6.000 or higher, Network Recorder version 4.500 or higher, and the IP-224.
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Figure 12.3: Vocoder Type drop down menu - Line Options Setup

i
Notice!
The TELEX 32K is the same as the previous ADPCM 32K, and the G.726 16K is the same as the
previous ADPCM 16K.

i
Notice!
AMBE+2 (CSSI Only) vocoder is only used for CSSI lines configured to use CMS gateway connections
to RFSS.

TX Monitor Enable check box
The TX Monitor Enable check box indicates the console operator can monitor TX traffic from other
console operators.
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Scannable check box
The Scannable check box indicates the console operator is allowed to control the scan list of a
particular radio. The frequency button is used in C-Soft Runtime to add or delete radio channels from
the scan list.

i
Notice!
This feature is not supported on all radios, only Kenwood TK-x80, TK-x150/180, TX-5x10, and
NEXEDGE support.

Packet Delay for Satellite Mode check box
The Packet Delay for Satellite Mode check box enables Satellite Mode which means if there is an
issue with play out audio within the correct timing (burst of packets instead of consistent 20ms
packets) no packets are dropped, but there is an audio delay based on how inconsistently the packets
are received.

If not selected, Normal mode is enabled meaning if there is an issue with playing audio within the
correct timing, packets are dropped so the audio delay is no longer than the Packet Delay plus 80ms.

Backup IP Setup group box

RX Multicast Address and Port fields
The RX Multicast Address and Port fields identify the receive Multicast Address and port to use if the
primary receive path fails.

TX Multicast Address and Port fields
The TX Multicast Address and Port fields identify the transmit Multicast Address and port to use if
the primary transmit path fails.

Base Radio IP field
The Base Radio IP field identifies the backup IP Address of the base radio, should the primary address
fail.

Encryption Setup Group Box

SRTP Encryption Check Box
The SRTP Encryption check box indicates audio received and transmitted on this line should use
secured real-time protocol encryption (SRTP).
C-Soft Runtime automatically connects the Console Management System to acquire any
cryptographic session keys. No additional operational steps to generate or enter encryption keys are
required. When transmitting or receiving an SRTP-secured call, C-Soft displays the "CRYPT" icon on
the associated line's Select button.
When a line is configured for both SRTP Encryption and Echo Packet Enable, it is import to note that
any echoed packets are sent after decryption and are not secure. Upon saving a design that possesses
a line with both setting enabled, the Design Errors window displays an error indicating this potential
security problem.

CSSI Server Encryption
From the drop down menu, select the encryption profile for this line.
Encryption keys need to be loaded before accessing this menu.



68 en | Per Line Parameters window C-Soft 8.500

2025-08 | 16 | F.01U.218.561 Technical Manual Bosch Security Systems, LLC

Buttons
The OK button saves the entries and closes the window.

The Cancel button discards any changes made and closes the window.

12.2 Frequency Parameters window
The Frequency Parameters window, shown in the Figure below, is used to enter the parameters for
the individual function tones available for the selected line.

Additions and changes can be made to the Frequency Parameters window at any time. However, if
any user interface elements have been placed on the console window, the changes made to a line
must also be changed on the individual elements, if needed.
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Figure 12.4: Frequency Parameters window

Enable Check Box
The Enable check box indicates the corresponding frequency numbers are available to the console
operator for selection on the line.

Frequency Name Field
The Frequency Name field is used to enter a descriptive name for the frequency. This name is used to
identify the frequency for the elements used in the design of the console position and is made
available for selection in a list of variables.

When a frequency name is changed, a Frequency Change button’s text does not automatically update.
This is done separately.
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This field can contain up to 20 characters.

OK Button
The OK button saves the entries and closes the window.

Load File Button
The Load File button is used to load a .csv file into the current frequency window.

i
Notice!
When the .csv file is loaded, all items in the current list are overwritten.

To load a saved frequency .csv file, do the following:
1. Click Load File. 

The Open window appears.
2. In the Open window, select the file you want to load.
3. Click Open.
The file is loaded, the Frequency Name field is populated and the Enable check box is selected.

Save File Button
The Save File button is used to save the current frequency names to a .csv file.

To save the currently enabled frequency names to a .csv file, do the following:
1. Click Save File. 

The Save As window appears.
2. In the Filename field, enter a name.
3. Click Save.
The .csv file is saved in the current folder.

Pair Mode Setup Check Boxes
The Pair Mode Setup check boxes allow function tones to have control functions not used for actual
control of the radio. There are four wildcard groups available per line. Function tones 1 and 2 are not
allowed in a wildcard group and a function tone may not be selected in more than one group. One
function tone from each group can be active at a time, plus either F1 or F2.

RX Block Lines Display Box
The RX Block Lines display box contains a list of all the lines in the system. Each line selected in the
list has its received audio blocked from the speaker when the line you are currently configuring is
selected. This allows the console operator to transmit on a radio that has overlapping coverage with
other radios without getting feedback from the radios receiving the transmitted signal. This function
also operates when a parallel console is transmitting on the line.

To mute a line during transmission, do the following:
1. Select the line(s) in the display box. 

The line is highlighted.
2. Click the line(s) a second time to clear the selection.
The line is no longer highlighted.
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i
Notice!
Individual lines must have Mute Per-Line buttons associated with them for this feature to work.

12.3 Frequency Parameters windows - MOTOTRBO
Channel Setup Page
When the Freq button for a Telex line configured for a system type of MOTOTRBO line is clicked, the
Frequency Parameters window opens to the Channel Setup page. The Channel Setup page, shown in
the Figure below, is used to enter the MOTOTRBO line’s channel, zone, channel name, pair mode
setup and RX block.

i
Notice!
The General Signal Setup window must be configured for MOTOTRBO system type before
MOTOTRBO parameters are available on this page. Refer to “Signaling Parameters Window”.
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Figure 12.5: Frequency Parameters - Channel Setup Page

Enable check box
The Enable check box indicates the corresponding frequency numbers are available to the console
operator for selection on the line.

Zone field
The Zone field is used to enter a MOTOTRBO zone number. The same zone number must also be
configured in the radio.
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Chan field
The Chan (Channel) field is used to enter a MOTOTRBO channel number. The same channel number
must also be configured in the radio.

Channel Name field
The Channel Name field is used to enter a user-recognizable name for the frequency. This name
identifies the frequency for elements used in the console design and is available for selection in C-Soft
Runtime.

This field can contain up to 20 characters.

i
Notice!
If the Channel Name field is changed, the Channel Name button’s text does not automatically update.
This is done separately.

All Call Check box
The All Call check box indicates the All Call function is enabled in C-Soft for the associated channel.
The MOTOTRBO radio must be configured for All Call.

Zone Setup Page
When the Zone Setup tab is clicked from the Frequency Parameters window, the Zone Setup page
appears. The Zone Setup page, shown in the Figure below, is used to set up zone names. The Zone
Setup window supports up to 250 different zone names.
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Figure 12.6: Frequency Parameters window - Zone Setup Page

Zone Name field
The Zone Name field is used to enter a user-recognizable name for the zone. The name should match
the zone name configured in the radio.

This field can contain up to 20 characters.
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i
Notice!
A Zone is a place channels are stored in a radio.

Channel Pool Zone field
The Channel Pool Zone field indicates the zone number used for a channel pool.

REFERENCE: If there is a fixed zone for channel pool programmed in the MOTOTRBO radio, the zone
must be entered in this field. For more information, refer to Motorola’s technical documentation.

OK button
The OK button saves the entries and closes the window.

Load File button
The Load File button is used to load a .csv file into the current frequency window.

i
Notice!
When the .csv file is loaded, all items in the current list are overwritten.

To download a saved frequency .csv file, do the following:
1. Click Load File. 

The Open window appears.
2. In the Open window, select the desired file.
3. Click Open.
The file is loaded, the Frequency Name field is populated and the Enable check box is selected.

Save File button
The Save File button is used to save the current frequency names to a .csv file.

To save the currently enabled frequency names to a .csv file, do the following:
1. Click Save File. 

The Save As window appears.
2. In the Filename field, enter a name.
3. Click Save.
The .csv file is saved in the current folder.

Pair Mode Setup check boxes
The Pair Mode Setup check boxes allow function tones to have control functions not used for actual
control of the radio. There are four wildcard groups available per line. Function tones 1 and 2 are not
allowed in a wildcard group and a function tone may not be selected in more than one group. One
function tone from each group can be active at a time, plus either F1 or F2.
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RX Block Lines display box
The RX Block Lines display box contains a list of all the lines in the system. Each line selected in the
list has its received audio blocked from the speaker when the line you are currently configuring is
selected. This allows the console operator to transmit on a radio that has overlapping coverage with
other radios without getting feedback from the radios receiving the transmitted signal. This function
also operates when a parallel console is transmitting on the line.

To mute a line during transmission, do the following:
1. Select the line(s) in the display box. 

The line is highlighted.
2. Click the line(s) a second time to clear the selection.
The line is no longer highlighted.

i
Notice!
Individual lines must have Mute Per-Line buttons associated with them for this feature to work.

12.4 Signaling Parameters window
When Telex is selected in the Line Type drop down menu, and the Signal Setup button on the Per
Line Parameters window is clicked, the General Signal Setup page, shown in the Figure below,
appears.
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System Settings Group Box

System Type drop down menu
The System Type drop down menu is used to configure the signaling type for the individual line.

Available selections for Telex Line Type are:
– Generic - For more information, refer to “Generic system type, page 79”.
– 5/6 Tone/DTMF ANI - For more information, refer to “5-6 Tone/DTMF ANI system type, page

79”.
– FleetSync - For more information, refer to “FleetSync system type, page 86”.
– iDEN - For more information, refer to “iDEN System Type”.
– Telex-Serial - For more information, refer to “Telex-Serial system type, page 89”.
– MDC-1200 - For more information, refer to “MDC-1200 system type, page 91”.
– MOTOTRBO - For more information, refer to “MOTOTRBO system type, page 95”.
– Sprint Direct Connect - For more information, refer to “Sprint Direct Connect system type, page

99”.
– Telex-Enhanced-ANI - For more information, refer to “Telex-Enhanced-ANI system type, page

101”.

Available selections for Phone Line Type are:
– Generic - For more information, refer to “Generic system type, page 79”.
– Phone - For more information, refer to “Phone system type, page 102”.

Available selections for P25-DFSI Line Type are:
– P25-DFSI - For more information, refer to Appendix E, “Setting up a P25-DFSI Line”.

Available selections for NEXEDGE Line Type are:
– NEXEDGE - For more information, refer to Appendix F, “NEXEDGE Trunking System Setup”.

Available selections for P25-CSSI Line Type are:
– P25-CSSI For more information, refer to Appendix G, “CSSI Interface”.

i
Notice!
The Signaling Setup button is disabled for lines types of Disabled and SIP.

System Name drop down menu
The System Name drop down menu is used to select a system for the selected line. If the System
Type field is set to FleetSync, MDC-1200, MOTOTRBO or Telex-Serial, this field becomes active.

i
Notice!
Systems are configured by the user. Refer to “Edit System List Window”.
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Edit System button
The Edit System button is used to open the Edit System window. From this window, you can modify
the systems included in the Per Line Parameter configuration. For more information, refer to “Edit
System List Window”.

Signaling Autofill Setup group box

Enable Signaling Autofill check box
The Enable Signaling Autofill check box indicates the signaling parameters configured on the current
line are copied and then pasted into the corresponding line numbers.

Starting Line Number field
The Starting Line Number field is used to indicate the first line to which signaling parameters are
copied.

i
Notice!
The Enable Signaling Autofill check box must be selected to enable autofill.

Ending Line Number field
The Ending Line Number field is used to indicate the last line to which signaling parameters are
copied.

i
Notice!
The Enable Signaling Autofill check box must be selected to enable autofill.

Call Logging group box

Display All Calls check box
The Display All Calls check box allows you to choose to display all calls in the Per-Line Call History
window, regardless of the call’s destination ID. If cleared, only calls sent to the console or a group
containing the console’s ID are displayed in the Per-Line Call History Window.

i

Notice!
The Display All Calls check box is only enabled when the following System Types are selected:
Generic, 5/6 Tone/DTMF ANI, FleetSync, and MDC-1200. For other system types, the Display All
Calls check box is not applicable.

OK button
The OK button saves the entries and closes the window.

Cancel button
The Cancel button discards any settings made and closes the window.
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12.5 Signal system types

12.5.1 Generic system type
The Generic system type option is used to configure the line for a system type other than those listed.

To configure the line for a Generic system, do the following:
1. Select Edit | Per Line Parameters from the menu bar. 

The Per Line Parameters window appears.
2. From the Line Type drop down menu, select Telex.
3. Click Signal Setup. 

The Signaling Parameters window appears.
4. From the System Type drop down menu, select Generic.
5. Select Display All Calls, to display all calls in the Per-Line Call History window.

12.5.2 5-6 Tone/DTMF ANI system type
The 5/6 Tone/DTMF ANI (Automatic Number Identification) system type option is used to set the line
type signal to 5/6 tone or DTMF signaling.

i
Notice!
The IP-224 does not support 5/6 Tone or DTMF encoding or decoding functions.

To configure the line for a 5/6 DTMF ANI type, do the following:
1. Select Edit | Per Line Parameters from the menu bar. 

The Per Line Parameters window appears.
2. From the Line Type drop down menu, select Telex.
3. Click Signal Setup. 

The Signaling Parameters window appears.
4. From the System Type drop down menu, select 5-6 Tone/DTMF ANI.
The 5/6 Tone DTMF ANI Setup tab and Call Setup tab appear.

5/6 Tone DTMF ANI Setup page
When 5/6 Tone DTMF ANI is selected from the System Type drop down menu, the 5/6 Tone/DTMF
ANI Setup page appears, as shown in the Figure below.
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Figure 12.7: 5/6 Tone/DTMF ANI Setup Page - Signaling Parameters

Per Line Console ID group box

Unit ID field
The Unit ID field is used to assign a numeric identifier to the console’s line. The unit ID appears when
a radio is called from the specified console line.

This field can contain up to 8 digits.

Signaling Setup group box

Signaling Type drop down menu
The Signaling Type drop down menu identifies the signaling type used when generating a call.

Available selections for this field are:
– CCIR1
– CCIR2
– DTMF
– DZVEI
– EEA
– EIA
– EURO
– KENWOOD 5-TONE
– MODAT
– NATEL
– PCCIR
– PDZVEI
– PZVEI
– ZVEI1
– ZVEI2
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Digit Duration field
The Digit Duration field represents the length of time, in ms, the digit tone plays when it is active.

The range for this field is 25 to 9999ms.

Interdigit Duration field
The Interdigit Duration field represents the length of time, in ms, between the digit tones within a
group.

The range for this field is 25 to 9999ms.

Pause Duration field
The Pause Duration field represents the length of time, in ms, allowed between transmitted groups.

The range for this field is 25 to 9999ms.

i
Notice!
The pause duration must be at least the sum of the Digit and Interdigit Duration fields.

Preamble Duration field
The Preamble Duration field represents the length of time, in ms, the first tone digit plays. With some
radio systems, the first tone needs to be longer than subsequent tones. For example, the first tone
may be used to activate a dormant (battery saving) state.

The range for this field is 25 to 9999ms.

i
Notice!
The preamble duration must be at least the amount of the Digit Duration field.

Level field
The Level field represents the relative level, in dB, the encoded message sends.

The range for this field is -20dB to +12dB.

Twist Level field
The Twist Level field represents the relative level difference, in dB, of high and low tones generated
when using DTMF tone types. This field is only active when DTMF is the selected tone type.

The range for this field is -10dB to +10dB.
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Group Digit field
The Group Digit field represents the group identification defined by the radio system. Typically this
digit is not used anywhere else in the system.

This range for this field is 0-9 or A-D, # and *.

Repeat Digit field
The Repeat Digit field identifies a repeat digit. Repeat digits are used to signal a digit has been
repeated. Repeat digits are used to maintain tone transitions at appropriate intervals, which simplifies
the decode function.

EXAMPLE: The repeat digit is E and the subscriber ID is 23335. The encoder string would actually
send a tone string of 23E35.

Defaults button
The Defaults button resets all the signal parameters back to the default values.

Auto Ack Setup group box

Auto Ack Type drop down menu
The Auto Ack Type drop down menu allows you to choose the signaling type desired to acknowledge
receipt of a call.

Available selections for this field are:
– Disabled - Indicates no acknowledgement is sent after receiving a call.
– Single-Tone - Indicates a single tone is sent after receiving a call.
– Signaling - Indicates the Auto Ack field is available for formatting.
For more information, refer to “Auto Ack Field” in “Auto Ack Field”.

Auto Ack Delay field
The Auto Ack Delay field allows you to configure the lead-in delay, in ms, for receiving messages
configured to transmit acknowledgements back to the calling radio.

The range for this field is 0 to 9999ms.

Single Tone Auto Ack Setup group box

Frequency field
The Frequency field represents the frequency, in Hz, generated during a single tone
acknowledgement.

The range for this field is 0 to 4000Hz.

Duration field
The Duration field represents the duration, in ms, of the single tone acknowledgement.

The range for this field is 25 to 9999ms.

Level field
The Level field represents the relative level, in dB, the encoded message sends.
The range for this field is -20dB to +12dB.
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Signaling Delays group box

Initial Delay field
The Initial Delay field represents the lead-in delay, in ms, for console-generated messages
transmitted to the field radios.

The range for this field is 0 to 9999ms.

End Delay field
The End Delay field identifies the delay, in ms, at the end of transmitted messages to the field. It
delimits the tone string.

The range for this field is 0 to 9999ms.

i
Notice!
A value is required for this field. Do not leave blank.

Call Setup page
When 5/6 Tone/DTMF Tone ANI is selected from the System Type drop down menu the Call Setup
page appears, shown in the Figure below.

Figure 12.8: Call Setup Page - Signaling Parameters
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Call Setup group box

Auto Ack field
The Auto Ack field represents an automatically generated acknowledgement message that is sent to
the field after receiving a select call. First, configure the “Auto Ack Type drop down menu”, then
configure this field using the proper format.

This field can contain up to 32 characters.

Field values can be: Low or High.
– DTMF Format - Allows for 0-9, *, #, A-D, G, I, K, P, R, and S.
– 5-Tone Format - Allows for 0-9, A-F, G, I, K, P, R, and S.
For more information, refer to the table “Call setup group format descriptions” below.

Emerg Resolved field
The Emerg Resolved (Emergency Resolved) field represents the message sent each time an
emergency is acknowledged (for example, when the Emergency Ack button is pressed in the Active
Emergency window).

This field can contain up to 32 characters.

i
Notice!
A message is sent only if the emergency is active.

Field values can be: Low or High.
– DTMF Format - Allows for 0-9, *, #, A-D, G, I, K, P, R, and S.
– 5-Tone Format - Allows for 0-9, A-F, G, I, K, P, R, and S.
For more information, refer to the table “Call setup group format descriptions” below.

PTT BOT field
The PTT BOT (Push-To-Talk Beginning Of Transmit) field represents the message sent each time the
PTT button is pressed on the console at the beginning of transmit.

This field can contain up to 32 characters.

Field values can be: Low or High.
– DTMF Format - Allows for 0-9, *, #, A-D, G, I, K, P, R, and S.
– 5-Tone Format - Allows for 0-9, A-F, G, I, K, P, R, and S.
For more information, refer to the table “Call setup group format descriptions” below.

PTT EOT field
The PTT EOT (Push-To-Talk End Of Transmit) field represents the message sent each time the PTT
button is pressed on the console at the end of transmit.

This field can contain up to 32 characters.
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Field values can be: Low or High.
– DTMF Format - Allows for 0-9, *, #, A-D, G, I, K, P, R, and S.
– 5-Tone Format - Allows for 0-9, A-F, G, I, K, P, R, and S.
For more information, refer to the table “Call setup group format descriptions” below.

Call (1-10) Format field
The Call (1-10) Format fields represent the message sent when selected by the console operator on
the Per Line Call History, Call List Window, or the Manual Call List window. Refer to the Figure below.

This field can contain up to 32 characters.

Field values can be: Low or High.
– DTMF Format - Allows for 0-9, *, #, A-D, G, I, K, P, R, and S.
– 5-Tone Format - Allows for 0-9, A-F, G, I, K, P, R, and S.
For more information, refer to the table “Call setup group format descriptions” below.

Call (1-10) Label field
The Call (1-10) Label fields represent the label applied to the button on the Per Line Call History, the
Manual Call Window, and the Call List Window popup button, shown in the Figure below.

This field can contain up to 31 alphanumeric characters.

Defaults button
The Defaults button resets the fields to their default values.

Value Description

I Stands for Console ID. Use the “Unit ID Field” on page 75 or “User ID Field” on page 83
to configure the Console ID. This value must match the number of digits in the Console
ID.
For example, the Console ID is 123, the value entered in the format field would be III.

G Stands for Group. This is used to make a Group Call. The Group ID is configured on the
“Edit System List Window - System Menu” on page 180 to configure Group IDs. This
value must match the number of digits in the Group ID.
For example, the Group ID is 5000A, the value entered in the format field would be
GGGGG.
NOTE: Not applicable for iDEN setup.

S Stands for Status. Use the “Status Message ID List Window” on page 172 to configure
Status IDs.

P Stands for Pause. When you want to format a pause into the string being sent out, use
a P. Pause Duration is set up in Signaling Setup.

R Stands for Radio ID. You must enter the exact number of digits in the radio ID. For
example, if you pick User ID 12356, you must enter RRRRR.

K Takes all the digits in the User ID of the type of call being made. In this format, you can
enter a K, which enters all numbers associated with the User ID column.
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NOTE: You can use any combination of these values with the numerical digits to create formats.

Table 12.1: Call setup group format descriptions

Figure 12.9: Per Line Call History Window for 5/6 Tone or iDEN Line

12.5.3 FleetSync system type
The FleetSync system type option is used to configure the line used to encode/decode FleetSync IDs
and status codes.
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Figure 12.10: FleetSync System Type

To set the system type to FleetSync, do the following:
1. Select Edit | Per Line Parameters from the menu bar. 

The Per Line Parameters window appears.
2. From the Line Type drop down menu, select Telex.
3. Click Signal Setup. 

The Signaling Parameters window appears.
4. From the System Type drop down menu, select FleetSync. 

The FleetSync Setup tab appears.
5. From the System Name drop down menu, select a system for the line.

FleetSync Setup page
When FleetSync is selected from the System Type drop down menu, the FleetSync Setup page
appears, shown in the Figure below.
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Figure 12.11: FleetSync Setup Page—Signaling Parameters

Per Line Console ID group box
The Per Line Console ID group box is used to define the Fleet ID and User ID. The Fleet ID is added to
the front of the User ID to create the Per Line Console ID. This ID appears on radio when receiving
data/audio from that console line.

EXAMPLE: To create console ID 1234567, enter 123 as the Fleet ID and 4567 as the User ID.
Whenever the operator presses the PTT button or send a FleetSync data message, the receiving
radios display the console ID configured for the line.

Fleet ID field
The Fleet ID field is used to enter the 3-digit Fleet ID number of a group of FleetSync radios and is
assigned per line.

The range for this field is 100 to 349.

Unit ID field
The User ID field is used to identify the console’s 4-digit User ID to FleetSync radios programmed for
Over-The-Air-Protocol.

The range for this field is 1000 to 4999.

Note:
– The IP-223 or IP-224 must be configured for FleetSync Encode.
– The Console ID does not appear if the mobile radio connected to the IP-224 is configured for

FleetSync Signaling.



C-Soft 8.500 Per Line Parameters window | en 89

Bosch Security Systems, LLC Technical Manual 2025-08 | 16 | F.01U.218.561

Call Permission Setup group box

Allow Broadcast Calls on this Line check box
The Allow Broadcast Calls on this Line check box is used to grant the line permission to place
FleetSync broadcast calls.

Allow InterFleet Calls on this Line check box
The Allow InterFleet Calls on this Line check box is used to grant the line permission to place calls to
fleets or units outside the console’s fleet.

User Display Options group box

Only Display Filters check box
The Only Display Filters check box indicates, in addition to the system name, that only filters
containing fleets and units display in the C-Soft Runtime FleetSync Dispatching window’s system list,
refer to the Figure below. All components in the system are visible including groups and individuals,
otherwise only filters and their components are visible.

i
Notice!
The Only Display Filters check box controls the system list appearance only. Component permissions
are controlled per line, refer to “FleetSync system type, page 86”.

Figure 12.12: FleetSync System List Filters Display in C-Soft Runtime

12.5.4 Telex-Serial system type
The Telex-Serial system type option is used to configure the line for serial radio control. The System
Type is used for a variety of radio brands. Consult the IP-224 user manual for a full list of radios
utilizing the Telex-Serial Type option.
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Figure 12.13: Telex-Serial System Type

To set the system type to Telex-Serial, do the following:
1. Select Edit | Per Line Parameters from the menu bar. 

The Per Line Parameters window appears.
2. From the Line Type drop down menu, select Telex.
3. Click Signal Setup. 

The Signaling Parameters window appears.
4. From the System Type drop down menu, select Telex-Serial. 

The Telex-Serial Setup tab appears.
5. From the System Name drop down menu, select a system for the line.
6. Click the Telex-Serial Setup Tab. 

The Telex-Serial Setup page appears.
7. In the Console ID field, enter the console ID.

Telex-Serial Setup page
The Telex-Serial Setup page, shown in the Figure below, is used to define the Per Line Console ID.
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Figure 12.14: Telex-Serial Setup Page

Per Line Console ID group box
The Per Line Console ID group box is used to define the Console ID. This ID appears on the radio
when receiving data/audio from that console line.

Console ID field
The Console ID field is used to enter the console ID for the Telex-Serial Line.

12.5.5 MDC-1200 system type
The MDC-1200 system type option is used to configure the line for MDC-1200 use.

Figure 12.15: MDC-1200 System Type
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To configure the line for a MDC-1200 type, do the following
1. Select Edit | Per Line Parameters from the menu bar. 

The Per Line Parameters window appears.
2. From the Line Type drop down menu, select Telex.
3. Click Signal Setup. 

The Signaling Parameters window appears.
4. Select MDC-1200 from the System Type drop down menu. 

The MDC-1200 Setup tab appears.
5. From the System Name drop down menu, select a system for the line.

MDC-1200 Setup page
When MDC-1200 is selected from the System Type drop down menu, the MDC-1200 Setup page
appears, shown in the Figure below.

Figure 12.16: MDC-1200 Page - Signaling Parameters

Per Line Console ID group box

Group ID: (In Hex) field
The Group ID: (In Hex) field is used to identify the group ID for the console.

This field requires a 3-digit hexadecimal number (0-EEE).

i
Notice!
Do not use the letter F in this field. It is reserved as a wild card digit used to create MDC-1200
custom call groups.
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Unit ID (In Hex) field
The Unit ID (In Hex) field is used to identify the MDC-1200 unit for the line.

This field requires a 4-digit hexadecimal number (1-DEEE).

Call type ID range

Unit call 0001-DEEE

Group call E000-EEEE

System call FFFF

Table 12.2: MDC-1200 unit ID ranges

Note:
– Apply the ID numbers as given in the Table above.
– The letter F is reserved as a wild card digit used to create MDC-1200 custom call groups.
– A call sent to an ID containing the letter F is received by all units that match all the non-F

characters.
EXAMPLE: A call sent to D1FF is received by all units with an ID between D100 and D1EE.

PTT ID Options

PTT ID Options drop down menu
The PTT ID Options drop down menu is used to indicate when an ID is sent while transmitting.

Available selections for this field are:
– None - No PTT ID is sent when transmitting from the console.
– Pre Only - The console’s PTT ID is sent before the voice stream begins.
– Post Only - The console’s PTT ID is sent after the voice stream ends.
– Pre and Post - The console’s PTT ID is sent both before and after the voice stream begins and

ends.
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Figure 12.17: PTT ID Options Drop Down Menu

Call Permission Setup group box

Allow Broadcast Calls on the Line check box
The Allow Broadcast Calls on the Line check box indicates the console operator is allowed to place
call alerts, and place select calls to the entire system.

The system user ID is FFFF.

User Display Options group box

Only Display Filters check box
The Only Display Filters check box indicates, in addition to the system name, only groups and units
contained in the filter display in the system list in C-Soft Runtime’s MDC-1200 Dispatch window,
shown in Figure 329. When selected, only filters and their components are visible. Otherwise, all
components in the system appear in the system list.

i
Notice!
The Only Display Filters check box controls the system list appearance. Component permissions are
controlled per line. For more information, refer to “Call Permission Setup Group Box”.
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Figure 12.18: MDC-1200 System List Filters Display in C-Soft Runtime

12.5.6 MOTOTRBO system type
The MOTOTRBO system type option is used to configure the line for MOTOTRBO use.

i
Notice!
There is a 10 console limit to each SOIP line.
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Figure 12.19: MOTOTRBO System Type

To configure the line for MOTOTRBO type, do the following:
1. Select Edit | Per Line Parameters from the menu bar. 

The Per Line Parameters window appears.
2. From the Line Type drop down menu, select Telex.
3. Click Signal Setup. 

The Signaling Parameters window appears.
4. From the System Type drop down menu, select MOTOTRBO. 

The MOTOTRBO Setup tab appears.
5. From the System Name drop down menu, select a system for the line.

MOTOTRBO Setup page
When MOTOTRBO is selected from the System Type drop down menu, the MOTOTRBO Setup page
appears, shown in the Figure below.
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Figure 12.20: MOTOTRBO Setup Page

Interface Type group box

MTRBi radio button
The MTRBi radio button is used to select signaling using the MTRBi interface option to IP-224 or
IP-223.

MOTOTRBO radio button
The MOTOTRBO radio button is used to select signaling using the MOTOTRBO interface option to
IP-224.

SOIP Setup group box
The SOIP Setup group box is used to set up communication between the IP-223 or IP-224 and C-
Soft to send and receive serial data. The fields in this section must match the same fields for the
specified line on the IP-223 or IP-224.

For more information, refer to the MTRBi Installation Manual (F.01U.247.183). For MOTOTRBO
support, refer to the MOTOTRBO Application Guide (F.01U.298.170).
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RX Multicast Address field
The RX Multicast Address field indicates the Multicast Address used to receive serial data over the
network. This is the same Serial Over IP RX Multicast Address set up in the IP-223’s or IP-224’s
Multicast Address Setup window for the associated MOTOTRBO line.

RX Port field
The RX Port field indicates the RX port number used to receive serial data. This is the same Serial
Over IP RX port number set up on the IP-223 or IP-224 for the associated MOTOTRBO line.

TX Multicast Address field
The TX Multicast Address field indicates the Multicast Address used to send serial data. This is the
same Serial Over IP TX Multicast Address set up in the IP-223’s or IP-224’s Multicast Address Setup
window for the associated MOTOTRBO line.

TX Port field
The TX Port field indicates the TX port number used to send serial data. This is the same Serial Over
IP TX port number set up on the IP- 223 or IP-224 for the associated MOTOTRBO line.

Control Line Setup group box
The Control Line Setup group box section is used to set up multiple C-Soft consoles to communicate
with the same MOTOTRBO radio.

Multicast Address field
The Multicast Address field indicates the Multicast Address used by the console to communicate with
MOTOTRBO radio. The Multicast Address is configured for the line in the Per Line Parameters
window.

This field is not editable.

Control Port feld
The Control Port field indicates the port used to communicate with the MOTOTRBO radio.

The default value for this field is 1000 more than the TX Port value configured for the line on the Per
Line Parameters window.

To change the TX Port value, do the following:
1. Clear the Default check box. 

The Control Port field becomes editable.
2. In the Control Port field, enter a port number.

Default check box
The Default check box is used to accept the control port’s default value. The default value is calculated
by adding 1000 to the TX Port number for the line. When the check box is selected, this value is
automatically entered in the field. Clear the check box to enter a different value.
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Network Setup group box
The Network Setup group box section is used to set up the MOTOTRBO radio to send text messages
and allow GPS (Global Positioning System) to work in C-Soft.

i
Notice!
The CAI (Common Air Interface) Network and CAI Group Network fields in C-Soft Designer must
match the CAI network and CAI Network Group configured in the MOTOTRBO CPS software.

For more information, refer to the Motorola’s technical documentation.

CAI Network field
The CAI Network field is used to enter the value for the CAI network configured on the radio.

The range for this field is 1 to 126.

CAI Group Network field
The CAI Group Network field is used to enter the value for the CAI Group Network configured on the
radio.

The range for this field is 225 to 239.

12.5.7 Sprint Direct Connect system type
Sprint Direct Connect Setup page
When Sprint Direct Connect is selected from the System Type drop down menu, the Sprint Direct
Connect Setup page appears.

To configure the line for Sprint Direct Connect type, do the following:
1. Select Edit | Per Line Parameters from the menu bar. 

The Per Line Parameters window appears.
2. From the Line Type drop down menu, select Telex.
3. Click Signal Setup. 

The Signaling Parameters window appears.
4. From the System Type drop down menu, select Sprint Direct Connect.
The Sprint Direct Connect Setup tab appears.
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Figure 12.21: Signaling Parameters - Sprint Direct Connect Setup

SOIP Setup group box

RX Multicast Address field
The RX Multicast Address field indicates the Multicast Address used to receive serial data over the
network. This is the same Serial Over IP RX Multicast Address set up in the IP-223’s or IP-224’s
Multicast Address Setup window for the associated Sprint Direct Connect line.

RX Port field
The RX Port field indicates the RX port number used to receive serial data. This is the same Serial
Over IP RX port number set up on the IP-223 or IP-224 for the associated Sprint Direct Connect line.

TX Multicast Address field
The TX Multicast Address field indicates the Multicast Address used to send serial data. This is the
same Serial Over IP TX Multicast Address set up in the IP-223’s or IP-224’s Multicast Address Setup
window for the associated Sprint Direct Connect line.

TX Port field
The TX Port field indicates the TX port number used to send serial data. This is the same Serial Over
IP TX port number set up on the IP-223 or IP-224 for the associated Sprint Direct Connect line.

Emergency Setup group box

Enable Emergency on Call Alert check box
The Enable Emergency on Call Alert check box enables C-Soft to treat incoming SDC call alerts
containing the message index specified in the Call Alert Message Index field as an Emergency. C-Soft
plays emergency alert tones, performs the Emergency button flash actions on the receiving line’s
Select button, and creates an entry in the Active Emergency window.

Call Alert Message Index drop down menu
The Call Alert Message Index drop down menu is used to select the Call Alert message triggered by
an Emergency in C-Soft. The Sprint Direct Connect handsets contain 21 preset Call Alert messages.
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Index Message Index Message

0 <no message> 11 I'll be there shortly

1 Can't talk right now 12 I love you

2 Will call you back 13 Meeting still on?

3 I'm in a meeting 14 Are you free?

4 Call me 15 Please stop by

5 Direct Connect me 16 Can I call you?

6 Yes 17 In the office?

7 No 18 On my way

8 Where are you? 19 Need help

9 Let's get lunch 20 Where you at?

10 The meeting has been
cancelled

12.5.8 Telex-Enhanced-ANI system type
The Telex-Enhanced-ANI system type option is used to configure the line for serial radio control.
Consult the IP-224 user manual for full list of radios utilizing the Telex-Enhanced-ANI Type option.

Figure 12.22: Telex-Enhanced-ANI System Type

To set the system type to Telex-Enhanced-ANI, do the following:
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1. Select Edit | Per Line Parameters from the menu bar. 
The Per Line Parameters window appears.

2. From the Line Type drop down menu, select Telex.
3. Click Signal Setup. 

The Signaling Parameters window appears.
4. From the System Type drop down menu, select Telex-Enhanced-ANI. 

The Telex-Enhanced-ANI Setup tab appears.
5. From the System Name drop down menu, select a system for the line.
6. Click the Telex-Enhanced-ANI Setup Tab. 

The Telex-Enhanced-ANI Setup page appears.
7. Select the Enable Callback check box, if applicable.

Telex-Enhanced-ANI Setup page
The Telex-Enhanced-ANI Setup page is shown in the Figure below.

Figure 12.23: Telex-Enhanced-ANI Setup Page

Per Line Settings group box
The Callback feature allows Line PTT and Main PTT buttons to send group/private call commands
depending on the last call made. This is needed on protocols that need to differentiate between the
two call types.

Enable Callback check box
The Enable Callback check box is used to enables or disables the Callback feature.

12.5.9 Phone system type
The Phone system type option is used to configure the line for standard phone use, as shown in the
Figure below.

Available selections for this field are:
– Generic - If Generic is selected no additional signaling is being used. For more information, refer

to “Generic system type, page 79”.
– Phone - Phone enables the ability to send additional DTMF signaling to IP-223. For more

information, refer to “Phone Setup Page” below.
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Figure 12.24: Phone System Type

To configure the line for a Phone type, do the following:
1. Select Edit | Per Line Parameters from the menu bar. 

The Per Line Parameters window appears.
2. From the Line Type drop down menu, select Phone.
3. Click Signal Setup. 

The Signaling Parameters window appears.
4. From the System Type drop down menu, select Phone.
The Phone Setup tab and the Call Setup tab appear.

Phone Setup page
When Phone is selected from the System Type drop down menu, the Phone Setup page appears,
shown in the Figure below.
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Figure 12.25: Phone Setup Page - Signaling Parameters

Signaling Setup group box

Signaling Type drop down menu
The Signaling Type drop down menu, shown in the Figure above, identifies the signaling type used
when generating a phone call. DTMF is the default field value and can not be changed.

Digit Duration field
The Digit Duration field represents the length of time, in ms, the digit tone plays when it is active.

Interdigit Duration field
The Interdigit Duration field represents the length of time, in ms, between the digit tones within a
group.

Pause Duration field
The Pause Duration field represents the length of time, in ms, allowed between transmitted groups.

i
Notice!
The pause duration must be at least the sum of the Digit and Interdigit Duration fields.
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Preamble Duration field

The Preamble Duration field represents the length of time, in ms, the first tone digit plays. With some
radio systems, the first tone needs to be longer than subsequent tones. For example, the first tone
may be used to activate a dormant (battery saving) state.

i
Notice!
The preamble duration must be at least the amount of the Digit Duration field.

Level field
The Level field represents the relative level, in dB, the encoded message sends.

The range for this field is -20dB to +12dB.

Twist Level field

The Twist Level field represents the relative level difference, in dB, of high and low tones generated
when using DTMF tone types. This field is only active when DTMF is the selected tone type.

The range for this field is -10dB to +10dB.

Signaling Delays group box

Initial Delay field
The Initial Delay field represents the lead-in delay, in ms, for console-generated messages
transmitted to the field radios.

The range for this field is 0 to 9999ms.

End Delay field

The End Delay field identifies the delay, in ms, at the end of transmitted messages to the field. It
delimits the tone string.

The range for this field is 0 to 9999ms.

When Phone is selected from the System Type drop down menu, the Call Setup page appears, shown
in the Figure below.
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Figure 12.26: Call Setup Page - Signaling Parameters Phone

Call Setup group box

Auto Ack field
The Auto Ack field for phone setup is disabled.

Emerg Resolved field
The Emerg Resolved field for Phone Setup is disabled.

PTT BOT field
The PTT BOT field for Phone Setup is disabled.

PTT EOT field
The PTT EOT field for Phone Setup is disabled.

Call (1-10) Format field
The Call (1-10) Format fields represent the message sent when selected by the console operator on
the Per Line Call History, Call List Window, or the Manual Call List window. Refer to the Figure below.

This field can contain up to 32 characters.

Field values can be: Low or High.
– DTMF Format - Allows for 0-9, *, #, A-D, G, I, K, P, R, and S.

For more information, refer to the table “Call setup group format descriptions” below.
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Call (1-10) Label field

The Call (1-10) Label fields represent the label applied to the button on the Per Line Call History, the
Manual Call Window, and the Call List Window popup button, shown in the Figure below.

This field can contain up to 31 alphanumeric characters.

Figure 12.27: Per Line Call History Window

Refer to
– Generic system type, page 79

12.6 AutoFill Line Parameters window
The AutoFill Line Parameters window, shown in the Figure below, is used to eliminate repetitious
data entry by automatically populating the corresponding fields on the Per Line Parameters window
with the entries shown in the AutoFill Line Properties window. The RX and TX entry automatically
increment by one for each filled line.

AutoFill button
The AutoFill button, shown in the Figure below, opens the AutoFill Line Parameters window.
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Figure 12.28: Per Line Parameters AutoFill Button

Figure 12.29: AutoFill Line Parameters Window

RX IP Address check box
The RX IP Address check box indicates the IP Address is selected for the Autofill feature.

RX IP Address field
The RX IP Address field indicates the IP Address used to receive data over the network.

TX IP Address check box
The TX IP Address check box indicates the IP Address is selected for the Autofill feature.

TX IP Address field
The TX IP Address field indicates the IP Address used to send data over the network.

Line Type check box
The Line Type check box indicates the Line Type is selected for the Autofill feature.

Line Type drop down menu
The Line Type drop down menu is used to select the type of line for the Autofill feature.

Available selections for this field are Disabled, Telex, Phone, SIP Phone, P25-DFSI, NEXEDGE, and
AIS.
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RX Port Start check box
The RX Port Start check box indicates the RX Port Number is selected for the Autofill feature.

TX Port Start check box
The TX Port Start check box indicates the TX Port Number is selected for the Autofill feature.

TTL check box
The TTL check box indicates the TTL number is selected for the Autofill feature.

TTL field
The TTL field is used to enter the number of routers the Multicast audio packets go through before
being discarded. Network design dictates this value.

The range for this field is 1 to 100.

Packet Delay check box
The Packet Delay check box indicates the Packet Delay number is selected for the Autofill feature

Packet Delay field
The Packet Delay field is sued to enter a packet delay number.

The range for this field is 4 to 27.

Vocoder Type check box
The Vocoder Type check box indicates the Vocoder Type is selected for the Autofill feature.

Vocoder Type drop down menu
The Vocoder Type drop down menu is used to select the vocoder to use for the Autofill feature.

Available selections for this field are: TELEX 32K, G.726 16K, G.726 32K (IP224 Only), and G.711 64K
(IP224 Only).

Starting Line Number field
The Starting Line Number field is used to enter a starting line number.

The range for this field is 1 to 200.

Ending Line Number field
In the Ending Line Number field is used to enter an ending line number.

The range for this field is 1 to 200.

To fill line parameters with the autofill feature, do the following:
1. From the menu bar, select File | Setup Per Line Parameters.
2. Click Autofill. 

The AutoFill Line Parameters window appears.
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3. In the RX IP Address field, enter an RX IP Address.
4. In the TX IP Address, enter a TX IP Address.
5. In the Line Type drop down menu, select a Line Type.
6. In the RX Port Start field, enter an RX Port start number.
7. In the TX Port Start field, enter a TX Port start number.
8. In the TTL field, enter a TTL.
9. In the Packet Delay field, enter a Packet Delay number.
10. In the Starting Line Number filed, enter a starting line number.
11. In the Ending Line Number field, enter an ending line number.
12. Click OK.

The IP Addresses, port numbers and TTL automatically fill in the appropriate fields starting and ending
with line numbers entered in the AutoFill Line Parameters window.

OK button
The OK button applies the selected settings and closes the window.

Cancel button
The Cancel button closes the window.

12.7 Configure SIP Settings window
The Configure SIP Settings window, shown in the Figure below, is used to register the SIP Address.

Global SIP settings are available in the SIP Global Configuration window. To open this window, select
Edit | Global SIP Phone. For more information, refer to “Global SIP Configuration window, page 164”.
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Figure 12.30: Configure SIP Settings Window

SIP Account Credentials group box

Extension field
The Extension field is used to enter the SIP extension number (for example, 211).

Domain/Server IP field
The Domain/Server IP field is used to enter the Domain or Server IP address (for example,
172.19.50.20).

Authorization Name field
The Authorization Name field is used to specify the user name used to register the SIP account on the
SIP Server.

Password field
The Password field is used to specify the password used to register to the SIP server. This is typically
known as secret on the SIP server.
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Registrar group box

Registrar Compatibility drop down menu
The Registrar Compatibility field is used to specify the compatibility level of the specified registrar
server with RFC 3581 (SIP Symmetric Response Routing).

The default selection is Fully Compliant.

Available selections for this field are:
– Fully Compliant - Registrar is fully compliant with RFC 3581 and will register any number and all

types of listeners in the SIP packet header’s Contact field.
– Cannot Use Multiple Contacts - Registrar is able to register only one contact in the SIP packet

header’s Contact field.
– Cannot Use Private Contacts - Registrar is unable to register any contacts in the SIP packet

header’s Contact field.
– Has Application Layer Gateway - Network address translations will be handled externally by a

router with an Application Layer Gateway. Network address translations should not be
performed by C-Soft.

For more information refer to “SIP Phone line configuration, page 113”.

To configure the line for a SIP phone, do the following:
1. From the menu bar, select Edit | Setup Per Line Parameters. 

The Per Line Parameters window appears.
2. From the Line Type drop down menu, select SIP phone. 

The SIP button is active.
3. In the Line Name field, enter a name for the line.
4. Select the Echo Packets check box (optional). 

NOTE: this can be used to stream audio to a recorder.
– In the RX Multicast Address field, enter the desired echo destination.
– In the RX port field, enter the desired Port number.

5. In the TTL field, enter a value between 1 and 99.
6. Click SIP.
The Configure SIP Setting For Line X - (where X is the line number) window appears.

Ring Settings group box

Ring Sound drop down menu
The Ring Sound drop down menu is used to select different ring tones for individual SIP Extensions.
One of four ring tones can be assigned to a SIP Extension.

Available selections for this field are: Ring 1, Ring 2, Ring 3, and Ring 4.

i
Notice!
If the Default option is selected, C-Soft uses the Ring Sound set in Global Settings (Edit | Setup
Global Parameters | Peripherals tab | Ring Sound).
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Proxy Server group box

Use Outbound SIP Proxy check box
The Use Outbound SIP Proxy check box indicates traffic is initially sent through the proxy server
entered in the Use Outbound SIP Proxy field. If the Use Outbound SIP Proxy check box is selected, the
specified proxy settings override the Global SIP Proxy settings found in the Global SIP Configuration
window for the specific line.

i
Notice!
The Server Address field must also be configured.

Server Address field
The Server Address field is used to enter the proxy server’s address.

i
Notice!
The Use Outbound SIP Proxy check box must also be selected.

Backup Address field
The Backup Address field is used to specify a backup proxy server address. If the parameter is set
and C-Soft fails to register using the primary Proxy Server address, C-Soft switches to the backup
proxy address and attempts to re-register.

User Name field
The User Name field is used to enter the proxy server User Name.

Password field
The Password field is used to enter the proxy server password.

Voicemail Settings group box

Enable Voicemail Notification check box
The Enable Voicemail Notification check box enables C-Soft to subscribe to voicemail notification
messages from the SIP server.

12.8 SIP Phone line configuration
C-Soft supports SIP Phone lines. SIP (Session Initiation Protocol) provides an alternative method of
telephone line installation into your dispatch system. With SIP you can easily adapt and configure
many telephone lines into a C-Soft console position without having to connect external hardware.

Each C-Soft License comes with two SIP lines. Additional lines can be purchased as an additional
feature and are available in 6, and 12 line increments.
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12.8.1 SIP features
The SIP option is used to access the following features:
– Crosspatch
– Outbound DTMF
– Per line call history
– Call directory editing on-the-fly
– Auto-answer incoming calls
– Stun and proxy server
– Auto adjustments
– Silence detection
– Network recording or monitoring
– Call hold
– Do not disturb
– 3-way-calls
– Microphone mute
– Line conference
– Consultant transfer
– Blind transfer
– Missed call history
– Call waiting
– Conditional forwarding

To configure your system for SIP calls, do the following:
1. Obtain a SIP account through your IT system administrator or internet service provider.
2. Configure a SIP phone line in C-Soft Designer, refer to SIP Phone line configuration, page 113.
3. If using a network recorder or monitor, configure echo packets in C-Soft Designer, refer to

Configure SIP for recording or monitoring, page 114.
4. Set up global SIP configurations in C-Soft Designer, refer to “Global SIP Configuration window,

page 164”.
5. Create a SIP Call Control button in C-Soft Designer, refer to SIP Call Control, page 367.
6. Test the registration parameters in C-Soft Runtime, refer to “Test the SIP Registration”.

12.8.2 Configure SIP for recording or monitoring
The SIP Phone line can be recorded or monitored. This is configured in the Per Line Parameters
window.

For more information, refer to “Per Line Parameters window, page 61”.

Figure 12.31: SIP Line Type - Per Line Parameters

To configure the SIP line for network recording or monitoring, do the following:
1. From the Per Line Parameters window, select the Echo Packets Enable check box.
2. In the RX Multicast Address field, enter an IP Address.
3. In the RX Port field, enter an RX port number.
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4. Click OK.
The Per Line Parameters window closes.
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13 Global Parameter Setup window
The Global Parameter window, shown in the Figure below, is used to navigate to the Appearance,
Audio, Control Settings, Local Consoles, Peripherals, and Recording pages to configure global
settings.

NAVIGATION: Select Edit | Setup Global Parameters from the menu bar.

13.1 Appearance page
The Appearance page, shown in the Figure below, is used to configure various C-Soft appearance
settings. This includes Unit/ID Display behavior, background display options, and button style.

Figure 13.1: Appearance Page - Global Parameters Setup
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ANI Setup group box

Enable Sticky ANI check box
The Enable Sticky ANI check box indicates the ANI displayed on the select button remains visible until
the next call is received.

Enable Residual ANI check box
The Enable Residual ANI check box indicates the previous caller’s ANI continues to display after
receiving a call from a user without ANI capabilities; otherwise, the caller’s ANI disappears when the
call is ended.

Clear ANI on PTT check box
The Clear ANI on PTT check box indicates the ANI, normally displayed on the select button, is cleared
when a PTT operation is selected.

Alias Setup group box

Always Display Unit # check box
The Always Display Unit # check box indicates the Unit ID # (ANI) is displayed on the receiving line’s
Select button in addition to the unit’s Alias. Selecting this check box causes both the user’s alias and
number to appear on the button.

Group ANI Setup group box

Hide Group ANI check box
The Hide Group ANI check box indicates the Group ANI information is not displayed on the receiving
line’s Select button when receiving a Group call on a line configured for either Sprint Direct Connect,
P25-DFSI, NEXEDGE, or iDEN operation.

Logo group box

Image Filename field
The Image Filename field identifies the file path of a image to be displayed in the background of the
Console window.

C-Soft supports 1-bit, 4-bit, 8-bit and 24-bit bitmaps, .png, .jpg, and .gif file formats.

This field can contain up to 255 characters.

Browse button
The Browse button opens the Open window, which is used to navigate to the logo image file.

To change the image file, do the following:
1. Click Browse. 

The Open window appears.
2. Select the file you want to use for the image.
3. Click Open.
The path to the image file appears in the field.

Position drop down menu
The Position drop down menu is used to select the location of the image logo on the console window.

Available selections for this field are: Upper-Left, Upper-Right, Lower-Left, Lower-Right, Center and
Stretch.
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Button Style group box
The Button Style group box is used to select a button style.

Style drop down menu
The Style drop down menu is used to select the button style.

Available options are: Classic, Glossy Circle, Glossy Rectangle, Modern, and Vista.

Classic Option
The Classic option, if selected, indicates the buttons are displayed in a classic style.

Figure 13.2: Classic Option Style

Glossy Circle Option
The Glossy Circle Option, if selected, indicates the buttons are displayed in a glossy circle style.
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Figure 13.3: Glossy Circle Option Style

Glossy Rectangle Option
The Glossy Rectangle option, if selected, indicates the buttons are displayed in a glossy rectangle
style.

Figure 13.4: Glossy Rectangle Option Style

Modern Style Option
The Modern Style option, if selected, indicates the buttons are displayed in a glossy rectangle style.
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Figure 13.5: Modern Style Option

Vista Style Option
The Vista Style option, if selected, indicates the buttons are displayed in a vista style.

Figure 13.6: Vista Button Style

Button Border group box
The Button Border group box is used to select the thickness of the border of various UI Controls. This
setting applies to all buttons, popup buttons, and frequency controls.

Thickness spin box
The Thickness spin box is used to set the thickness of the border around the UI button. The higher the
value, the thicker the border.

The range for this field is 0 to 10.
The default is 5.
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Button Flash Color group box
The Button Flash Color group box is used to set the blink color for Select buttons when receiving one
of the following call types.

Call Alert drop down palette
The Call Alert drop down palette is used to set the button color when a Call Alert is being received.
The button blinks when an alert is received.

Group Call drop down palette
The Group Call drop down palette is used to set the button color when a Group Call is being received.
The button blinks when a Group Call is received.

Emergency drop down palette
The Emergency drop down palette is used to set the button color when an Emergency call is being
received. The button blinks when an Emergency call is received.

Select Call drop down palette
The Select Call drop down palette is used to set the button color when a Select call is being received.
The button blinks when a Select call is received.

Background Color group box

Background Color drop down palette
The Background Color drop down palette displays the background color for the console and popup
windows. Use the drop down button to open a palette to select the desired color.

The default color is black.

Window Options group box

Keep Information Windows As Top Layer check box
The Keep Information Windows As Top Layer check box indicates all C-Soft information windows
are always displayed above C-Soft popup windows or any other application running on the PC.

The C-Soft information windows include:
– Active Emergency Window
– Call List Window
– Call Queue Window
– Emergency History Window
– Event Logger Window
– FleetSync Window
– Global Call History
– HB4 Global Parameters Setup Window
– HB4 Volume Window
– HB4 Speaker Select Window
– HB4 IRR Speaker Select Window
– License Dialog
– Manual Call List Window
– Manual Page Entry
– MDC-1200 Window
– MOTOTRBO Window
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– P25-DFSI Window
– Per Line Call History Window
– SIP Call Window
– Status List Window
– Supervisor
– Web Page Popup

Popup Options group box

Close Using drop down menu
The Close Using drop down menu is used to select the closure method used by all popup windows.

Available options are:
– Use the “X” in the top right
– Use the “Done” in the bottom right corner
– Use the button toggle to close. The button toggle closes the window even when using “X” or

“Done”

13.2 Audio page
The Audio page, shown in the Figure below, is used to configure audio routing and blocking.
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Figure 13.7: Audio Page - Global Parameters Setup

Audio Muting and Routing group box

Sum Unselect to Headset when On check box
The Sum Unselect to Headset when On check box indicates when an ADHB-4 is active, select and
unselect audio is combined and routed to the headset.

Mute Select Audio During PTT check box
The Mute Select Audio During PTT check box indicates select audio is muted when PTT is used.

Mute Unselect Audio During PTT check box
The Mute Unselect Audio During PTT check box indicates unselect audio is muted when PTT is used.

Mute Lines When Unselected check box
The Mute Lines When Unselected check box indicates unselected lines are automatically muted (only
selected line is heard).
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Allow Muting Selected Lines check box
The Allow Muting Selected Lines check box indicates the console operator is able to mute selected
lines on the console.

Mute Selected Channels with RX Block check box
The Mute Selected Channels with RX Block check box indicates the console operator is able to mute
channels on which RX Block is enabled.

Disable Local Talk Permit Tones check box
The Disable Local Talk Permit Tones check box indicates the console does not generate talk permit
tones. Instead, the talk permit tones are generated by a communication device attached to the system.

Lines Remain Muted for Emergencies check box
The Lines Remain Muted for Emergencies check box indicates the console will not transmit
emergency call audio when the console is muted. When the check box is not selected, a muted
console will transmit emergency call audio.

Stop Marker Tone on RX check box
The Stop Marker Tone on RX check box indicates C-Soft will stop marker tone transmissions upon
receiving any incoming audio. By default, this check box is selected.

Audio Blocking group box

RX Block Delay field
The RX Block Delay field identifies the amount of time, in ms, the release of the RX blocked line is
delayed. The RX blocked lines are selected on the Per Line Frequency Setup window, refer to “RX
Block Lines Display Box”. This delay allows any IP- and/or system-delayed audio to end before
releasing the muted lines.

The range for this field is 300 to 5000ms.
The default is 0.

To disable this feature, do the following:
– In the RX Block Delay field, enter 0 ms.

DTMF Setup group box

Flywheel field
The Flywheel field identifies the amount of time, in ms, allowed to pass between clicks of different
DTMF keypad keys before the radio is keyed down by the console.

The range for this field is 300 to 5000ms.
The default is 2000.

Level field
The Level field identifies, in dB, the relative audio level to be transmitted. The actual level transmitted
by the radio varies depending on the system. This field allows the console designer to adjust the
relative level up or down after the remainder of the system is aligned and operational.

The range for this field is -30 to 10dB.
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SOIP Audio Setup group box

PTT Hang Timer field
The PTT Hang Timer field is used to enter the amount of time to delay the PTT off command for SOIP
protocols. This delay allows the IP-223/4 to complete processing any transmit audio before C-Soft
sends a command to the serial device to stop transmitting. To calculate the Hang Timer Delay, use the
following equation:

Hang Timer Delay = IP-224 Packet Delay * 20ms + IP-224 TX Delay (EQ 1)

Currently, only Sprint Direct Connect lines are affected by this feature.

MIC AGC group box
The MIC AGC (Automatic Gain Control) group box indicates the C-Soft program supports a software
based microphone AGC.

Enable check box
The Enable check box is used to help equalize speech level variations caused by the use of different
microphones, different speaking distances to the microphone, and different volumes of speech.

Target Level field
The Target Level field identifies the audio level, in dB, the MIC AGC packets are adjusted to.
– If the measured audio level is above the target level, the audio is reduced in gain.
– If the incoming level is below the target, up to 6dB of gain is applied to bring the level up.

The range for this field is -30dB to 6dB.

Min Active field
The Min Active field identifies the audio level, in dB, at which the AGC software stops trying to adjust
the audio level. If audio below this level is detected, the AGC software does not attempt to adjust the
audio. This prevents open mics from amplifying background noise onto the transmit channel.

The range for this field is -60 to 0 dB.

Audio Filtering

Disable Audio Bandpass Filter check box
The Disable Audio Bandpass Filter check box indicates the audio bandpass filter is disabled. When
selected, audio transmitted from C-Soft is not passed through the vocoder specific bandpass filter
before being encoded. Disabling the bandpass filter results in the transmit audio sounding warmer
(more bass) than filtered audio.

Direct IP Line Gain group box

Enable Line Gain check box
The Enable Line Gain is used to help balance receive audio levels between IP-224s and the Direct IP
system. When enabled, the selected amount of gain is applied to all receive audio of every Direct IP
Lines (AIS, NEXEDGE, P25-DFSI, and P25-CSSI).

Available gain levels are 3 dB, 6 dB, 9 dB, and 12 dB.
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13.3 Control Settings page
The Control Settings page, shown in the Figure below, is used to enable various console controls, a
supervisor password and points to FleetSync, MDC1200 and MOTOTRBO system files.

Figure 13.8: Control Settings Page - Global Parameters Setup

User Control options

Allow Freq Update Anytime check box
The Allow Freq Update Anytime check box indicates frequency updates are accepted at any point in
the RX stream. Otherwise, frequency updates are accepted at the beginning of a call, before audio
playback begins.

Ignore Freq Updates check box
The Ignore Freq Updates check box is used to ignore frequency change updates from remote sources,
such as parallel consoles or IP-224s. A line’s transmit frequency can only be changed on the local
console using either Frequency Change button or the Frequency Control.
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Disable Spacebar PTT check box
The Disable Spacebar PTT check box indicates the spacebar is not used for PTT.

Kill Lines on Crosspatch check box
The Kill Lines on Crosspatch check box indicates the console operator cannot transmit on a line
included in crosspatch by a parallel console operator. Otherwise, the console operator is allowed to
transmit on the lines even if another console operator has included the lines in a crosspatch.

Control Timeouts group box

Supervisor field
The Supervisor field controls the parallel console crosspatch timeout. The timeout is controlled by the
Supervisor console initiating the action.

The range for this field is 0 to 3600 seconds.

EXAMPLE: Console 1 has supervisor timeout set to 10 seconds.
Console 2 has supervisor timeout set to 2 seconds.
– Case 1: If console 1 initiated the action, then both consoles timeout after 2 seconds.
– Case 2: If console 2 initiated the action, then console 2 times out in 2 seconds and console 1

times out in 10 seconds.

To disable supervisor timeout, do the following:
– In the Supervisor field, enter 0.

Crosspatch field
The Crosspatch field indicates the amount of time, in seconds, a crosspatch is allowed to remain
inactive before it is dropped.

The range for this field is 0 to 3600 seconds.

To disable crosspatch inactivity, do the following:
– In the Crosspatch field, enter 0.

Save Runtime Setting group box

Save Runtime Status on Close check box
The Save Runtime Status on Close check box indicates the console size, position, settings, and
selections are saved to the cposi.txt when the program is closed. Otherwise, the size position, and
selections are not saved when C-Soft Runtime is closed.

For more information, refer to “Window Sizing” on “C-Soft Console, page 466”.

i
Notice!
C-Soft opens only the current version of the cposi.txt file.
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System List group box

Filename field
The Filename field identifies the system file used by C-Soft Runtime when it opens the.veg file. If left
blank, the Edit System window opens to a blank system. The filename identifies the path to the saved
FleetSync, MDC-1200, MOTOTRBO, Telex-Serial and P25-DFSI systems.

For more information, refer to “Edit System List window, page 194”.

Browse button
The Browse button is used to select the system list file to use. When clicked, a file chooser menu
opens and allows the user to browse to the desired System List file.

Logging Setup group box

Enable Logging check box
The Enable Logging check box indicates logging is active and the console creates an event log file
when C-Soft Runtime is started.

By default the Enable Logging check box is not selected.

If the Enable Logging check box is selected, then a log file is created.

The location of the log file is C:\ProgramData\Telex Communications\C-Soft\Logs.

i

Notice!
The log file is named SystemLog_[Date][Time]_[.veg file name].txt. For example, a system log started
on June 3rd at 1:05 PM from the Denton Fire.veg file is named, SystemLog_06-03 13:05:13_Denton
Fire.txt. A new file is created anytime C-Soft Runtime is started or when the current log file reaches a
file size of 3 Mb.

Event log files are kept for at least seven days. C-Soft deletes any files older than seven days at boot-
up, or when creating a new event log file because the existing file has reached its maximum size.

Log Level drop down menu
The Log Level drop down menu is used to select type of messages to be saved in the event log file
and the event log window, if available.

Available options are:
– Error - Used for events that could cause or indicate a service failure.
– Warning - Used for minor user-level exceptions not expected during normal operation.
– Information - Used for normal user-level events (for example, incoming calls, starting a call, etc.)
– Debug - Used for debugging purposes.

i
Notice!
Error, Warning, and Debug are used by Sprint Direct Connect only. All other types use Information
only.
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Supervisor Password

Supervisor Password field
The Supervisor Password field is used to assign a password for the supervisor function and any other
password protected functions.

This field can contain up to 16 alphanumeric characters.

Window Controls group box

Window Controls check boxes
The Window Controls check boxes indicate the standard window controls are included on the
dispatch console window.

Available selections for this field are:
– Allow Minimize - allows the console operator to minimize the dispatch window to a button on

the toolbar.
– Allow Maximize - allows the console operator to maximize the dispatch window.
– Allow Resize - allows the console operator to resize the dispatch window.
– Allow Move - allows the console operator to move a dispatch window that has been resized.
– Allow Close - allows the console operator to close a dispatch window. If this selection is not

enabled, the only way to shut down the dispatch console position is to use the Windows Task
Manager (press Ctrl+Alt+Delete to open Windows Task Manager).

Keyboard Dual-Tone Format group box

DTMF radio button
The DTMF radio button indicates DTMF tones are used when keyboard number keys are pressed.

Knox radio button
The Knox radio button indicates Knox tones are used when keyboard number keys are pressed. Knox
tones are specific tones used to unlock Knox boxes. These boxes are used primarily by fire
departments.

13.4 IRR Recording page
The IRR Recording page, shown in the Figure below, is used to assign the lines to be recorded by Per
Line Recording and Per Line Recording options.



130 en | Global Parameter Setup window C-Soft 8.500

2025-08 | 16 | F.01U.218.561 Technical Manual Bosch Security Systems, LLC

Figure 13.9: IRR Recording Page - Global Parameters Setup

Line Recording Setup group box
When checked the last 60 minutes of received audio will be recorded and available for playback from
the both the Per Line History or Global Call History Window. Up to 100 lines can be selected for IRR
recording.
The recorded audio storage directory is specified in C:\ProgramData\Telex Communications C-
Soft\Settings\ClientSettings.xml and by default is C:\ProgramData\Telex Communications C-
Soft\Audio Archive. Change the recorded audio storage directory by using Telex System Manager.

Recording Settings group box

Output Speaker drop down menu
The Output Speaker drop down menu is used to designate the speaker used to playback per line call
recording audio.

Minimum Record Duration drop down menu
The Minimum Record Duration drop down menu is used to set the minimum length of time a call
must last for the audio to be recorded.

Calls lasting less than the minimum duration are not recorded and will not be available for playback.
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Default is 0.5 sec.

Options are:
– 0.5 sec
– 1.0 sec
– 1.5 sec
– 2.0 sec

Log Outgoing Calls check box
The Log Outgoing Calls check box sets C-Soft’s logging behavior in both the Per Line History and
Global Call History windows.

By default, C-Soft only logs incoming calls. If the Log Outgoing Calls check box is selected, outgoing
calls are also logged in these windows. Note, the line must be configured in the Line Recording Setup
Box to record outgoing traffic.

Additionally, if Per Line Recording is enabled for a given line and the Log Outgoing Calls check box is
checked, outgoing transmissions made on that line are recorded and available for playback.

Populate Keypad on Selection check box
The Populate Keypad on Selection check box indicates the user can select an entry in the per line call
history window and have the keypad automatically populate with the ID of the call. By default, this
option is disabled.

13.5 Local Consoles page
The Local Consoles page, shown in the Figure below, is used to configure the IP Addresses of local
consoles.
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Figure 13.10: Local Consoles Page - Global Parameters Setup

Local Console IP Addresses group box

Local Console IP Address fields
The Local Console IP Address fields identify up to 10 base IP Addresses of the Hardware IP Console
(IP-2002, IP-1616, IP-3XXX series and C-6200) and C-Soft consoles that reside in the same room.

The C-Soft program examines the source of the audio, and, if the source is from a console in this list,
the audio is muted. An exception to the muting rule is, if an ADHB-4 is connected and the headset is
attached. In this case, the received audio is routed to the headset earpiece and is played, ignoring the
crossmute condition.

i
Notice!
Individual lines must have Mute Per-Line buttons associated with them for this feature to work.
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Direct IP Console Subscriber IDs field
The Direct Console Subscriber IDs field is only used for the NEXEDGE IP, AIS, and P25 CSSI
interfaces. If an ID is entered into this field, the console treats all audio received from the entered ID as
a parallel console transmission.

Crossmute File
The Crossmute File is used to allow each position to have its own crossmute settings without
requiring a different design file by populating the Local Console IP Address fields with a .txt file.

To create a crossmute file, do the following:
1. In a .txt file, enter up to 200 IP Addresses (one per line).
2. Select File | Save from the menu bar. 

The Save window opens.
3. In the File Name field, enter csoft_crossmutes.txt.
4. From the Look in drop down menu, select C:\ProgramData\Telex Communications\C-

Soft\DesignData.
5. Click Save.
The IP Addresses are loaded from this file and replace the entries in the Global Properties Setup
window.

i
Notice!
The Crossmute File feature does not apply to either the AIS, CSSI, or NEXEDGE IP interfaces.

Crossmute Direct IP Console Subscriber IDs check box (for NEXEDGE, AIS, and CSSI Lines Only)
The Crossmute Direct IP Console Subscriber IDs check box is used to allow crossmute for the
NEXEDGE IP, AIS, CSSI interfaces in a parallel console. This means when C-Soft detects a parallel
console transmit with a console ID on the list, it mutes the transmit audio.

To enable Crossmute Direct IP Console Subscribers, do the following:
1. In the Direct IP Console Subscribers ID field, enter the IDs for all NEXEDGE, AIS, and CSSI

consoles present in the system.
2. Select the Crossmute direct IP console subscribers IDs check box.

13.6 Peripherals page
The Peripherals page, shown in the Figure below, is used to configure network settings, phone, and
peripheral devices.
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Figure 13.11: Peripherals Page - Global Parameters Setup

Network Settings group box

Radio Ping Interval field
The Radio Ping Interval field identifies the time, in seconds, between ping attempts on the base radio
IP Address. The typical amount of time is 300 seconds or five minutes. A value of zero disables the
function.

The range for this field is 0 to 9999 seconds.

TCP/IP Time Out field
The TCP/IP Time Out field indicates the amount of time, in ms, before the TCP/IP connection times
out.

The range for this field is 1000 to 20000ms.

Enable RX Multicast Loopback check box
The Enable RX Multicast Loopback check box is used to enable the current console configuration to
receive Multicast audio sent from the same PC currently running C-Soft.



C-Soft 8.500 Global Parameter Setup window | en 135

Bosch Security Systems, LLC Technical Manual 2025-08 | 16 | F.01U.218.561

Phone group box

Ring Multicast field
The Ring Multicast field identifies the IP Address to which the ring signal is broadcast. The entry in
this field should correspond to the values set in a C-6200 console with an actual phone card interface,
or to an IP-223 with Telex’s PIB or attached TDI Adapter.

Ring Port field
The Ring Port field is used to identify the port number to which the ring signal is broadcast. The entry
in this field should correspond to the values set in a C-6200 console with an actual phone card
interface, or to an IP-223 with Telex’s PIB or attached TDI Adapter.

Ring Sound drop down menu
The Ring Sound drop down menu is used to select the ring sound heard when a call is received.

Available selections for this field are: Ring 1, Ring 2, Ring 3, and Ring 4.

Ring Speaker drop down menu
The Ring Speaker drop down menu is used to select which speaker plays incoming phone ring tones.

Available selections for this field are Speaker 1, Speaker 2, Speaker 3, Speaker 4, Speaker 5, or
Speaker 6.

PTT During Phone Call Group Box

Mute Phone Mic Check Box
The Mute Phone Mic check box temporarily mutes any offhook phone line's microphone audio while
the console is transmitting on a radio line.

Phone Rx Route drop down menu
Use the Phone Rx Route drop down menu to select how audio received from a phone line is routed
while the console is transmitting. It is necessary to select the Mute Phone Mic check box to enable the
Phone Rx Route drop down menu.
Available selections: Mute, Speaker 1, and Speaker 2.

NEO-10 group box
The NEO-10 device sends out a UDP packet anytime one of its inputs or outputs changes state. The
C-Soft program monitors this traffic and allows all users of the equipment to see input and output
status changes.

Multicast field
The Multicast field identifies the Multicast Address of the NEO-10 device.

The entry in this field should correspond to the entry on the NEO-10 Multicast Setup window.

Update Port field
The Update Port field identifies the port number of the NEO-10 device.

The entry in this field should correspond to the entry on the NEO-10 Multicast Setup window.
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License Server group box

IP Address/Name fields
The IP Address/Name fields are used to specify the IP address or name of one or two Telex Licensing
Servers. Address specifications are expected in the following formats:
– <port>@<host IP>
– <port>@<servername>
– <host IP>

The default port is 27000.

i

Notice!
In C-Soft Runtime, the token “@localhost” will automatically be added to the license server
specification to instruct the license libraries to additionally connect to a locally-running license server.
As a result, for configurations using a local license server, no additional parameters need to be set in
C-Soft Designer.

ADHB-4 Speaker Volume group box

Speaker 1-6 Min Volume field
The Speaker 1-6 Min Volume field indicates the minimum selectable volume level for speakers
connected to jacks 2-6. During C-Soft operation, the volume for the specified speaker cannot be set
lower than the percentage configured for the speaker in this field.

This field ranges from 0% to 100%.

Speaker 1’s volume is controlled with the Volume Master Select button. Refer to “UI Element Function
Drop Down Menu”.

13.7 Recording page
The Recording page, shown in the Figure below, is used to configure a recording with Telex’s
Network Recorder.

For more information, refer to the Telex Network Recorder Technical Manual and Archive Database
Reviewer (F.01U.188.143).
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Figure 13.12: Recording Page - Global Parameters Setup

i
Notice!
The microphone only records during activity, such as a telephone call or PTT.

Enable check box
The Enable check box is used to enable the Select speaker, Unselect speaker, speakers 3-6,
microphone, NENA, Aux Track Left, and Aux Track Right for recording from the indicated IP Address
and port.

i

Notice!
Speakers 3-6 and NENA are used when an ADHB-4 is connected to the PC. Aux Track Left is the left
channel audio received by the Aux In port on the ADBH-4 Gen 2. Aux Track Right is the right channel
audio received by the Aux In port on the ADBH-4 Gen 2.
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Vocoder Type drop down menu
The Vocoder Type drop down menu indicates the bit rate at which audio is converted into digital
format. This feature is used to configure communication between C-Soft and an IP-223 or IP-224.

Available selections for this field are: TELEX 32K, G.726 16K, G.726 32K (IP224 Only), and G.711 64K
(IP224 Only).

Multicast field
The Multicast field indicates the console’s Multicast Address for the selected speaker, microphone, or
NENA.

i
Notice!
If multiple consoles are in use, this option requires a separate configuration for each console.

Port field
The Port field indicates the port used for the selected speaker, microphone or NENA audio.

The port number must be unique from all other ports configured on the console.

TTL field
The TTL field indicates the lifespan of data in a computer or network.
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14 Language Customization
The Language Customization window, shown in the Figure below, is used to configure call window
names, buttons, button labels, button color codes, column labels, fonts, and the number of lines to
display in the window.

i
Notice!
The Language Customization window was formerly known as “Global Call Parameters.”

NAVIGATION: Select Edit | Language Customization from the menu bar.

Figure 14.1: Language Customization Window - General Page

14.1 General page
The General page is used to set the list entry font size, maximum entry limit, formatting, and to restore
default settings.
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List Entry Font Size group box

Active Emergency Font Size field
The Active Emergency Font Size field is used to specify text size for the Active Emergency Call
History window.

The range for this field is 1 to 72.

Call List Font Size field
The Call List Font Size field is used to specify the text size for the Call List window.

The range for this field is 1 to 72.

Emergency Call History Font Size field
The Emergency Call History Font Size field is used to specify the text size for the Emergency Call
History window.

The range for this field is 1 to 72.

Per Line Call History Font Size field
The Per Line Call History Font Size field is used to specify the text size for the Per Line Call History
window.

The range for this field is 1 to 72.

Status List Font Size field
The Status List Font Size field is used to specify the text size for the Status List window.

The range for this field is 1 to 72.

Maximum Entry Limit group box

Emergency Call History Window Lines field
The Emergency Call History Window Lines field is used to set the number of lines displayed in the
Emergency Call History window. When the Call History window is full, the oldest call is removed.

The range for this field is 1 to 500 lines.

Per Line Call History Window Lines field
The Per Line Call History Window Lines field is used to set the number of lines displayed in the Per
Line Call History window. When the Call History window is full, the oldest call is removed.

The range for this field is 1 to 500 lines.

Formatting group box

Call-to-Console Color drop down menu
The Call-to-Console Color drop down menu is used to set the Call-To-Console background color. The
background color can be changed by selecting options from the drop down menu.
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i
Notice!
The Call-to-Console color is used as the background color for calls directed to C-Soft consoles in the
FleetSync, MDC-1200, Call List and Per Line Call History windows.

Date Format drop down menu
The Date Format drop down menu is used to select the date format displayed in the call logs.

Available selections for this menu are:
– MM/DD/YYYY
– DD/MM/YYYY

Default Setting group box

Restore Default button
The Restore Default button is used to reset all parameter settings to their default values.

The Restore Default button will reset all parameters in the Language Customization setup.

14.2 Button Labels window
The Button Labels group box contains fields to enter custom labels appearing on buttons in the Call
List, Per Line, Manual Call List, Set Status and Active Emergency windows.
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Figure 14.2: Language Customization Window - Button Labels Page

General Button group box

ACK field
The ACK field creates a button label that displays in the Active Emergency window. When the button
is clicked in C-Soft Runtime, the emergency is acknowledged by sending a message to the radio that
initially declared the emergency.

This field can contain up to 10 characters.

Backspace field
The Backspace field creates a button label that displays in the Manual Call window. When the button
is clicked in C-Soft Runtime, the last character entered in the User ID field is cleared.

This field can contain up to 10 characters.

Cancel field
The Cancel field creates a button label that displays in the Set Status window. When the button is
clicked in C-Soft Runtime, changes are discarded and the window closes.

This field can contain up to 10 characters.
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Clear field
The Clear field creates a button label that displays in the Manual Call List window. When the button is
clicked in C-Soft Runtime, the User ID field is cleared.

This field can contain up to 10 characters.

Done field
The Done field creates a button label that displays in all call windows. When the button is clicked in
C-Soft Runtime, the window closes.

This field can contain up to 10 characters.

Emergency Clear field
The Emergency Clear field creates a button label that displays in the Active Emergency window.
When the button is clicked in C-Soft Runtime, the Emergency is cleared from the list.

This field can contain up to 10 characters.

Set Status field
The Set Status field creates a button label that displays in the Per Line Call History, Manual Call List
and Call List windows. When the button is clicked in C-Soft Runtime, the Status List window appears
and a status ID can be selected and sent.

This field can contain up to 10 characters.

DTMF Buttons group box

Digit A-F fields
The Digit A-F fields create a button label that displays in the Manual Call window. When the button is
clicked in C-Soft Runtime, the digit it is assigned to is entered in the User ID field.

This field can contain up to 10 alphanumeric characters.

14.3 Button Images window
The Button Images group box contains fields to enter the file path of an image file (.bmp, .jpg, .gif,
and .png) to display custom images on the specified buttons.
Each button image contains the following two buttons:

Browse button
The Browse button opens the Open window, which is used to navigate to the image file.

Clear button
The Clear button resets the current file path to the default file path.

i
Notice!
To create a transparent background when using a 24-bit bitmap image, use RGB color 192, 192,
192.
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Figure 14.3: Button Images window

Activity
The Activity icon is displayed on a Popup button when audio traffic is detected on a line contained in
the popup window and the popup window is closed (see UI Element Setup window - Add Popup
Button, page 439). The default image is activity.bmp.

IC LED
The IC LED icon is displayed on a Select button when intercom traffic is detected on the Select
button’s line (see Select, page 363). The default image is icled.bmp.

Link Fail
The Link Fail icon is displayed on Select buttons when C-Soft fails to detect a device at the Select
button’s base radio IP (see Select, page 363). The default image is lfled.bmp.

Mute LED
The Mute LED icon is displayed on Select buttons when the Select button’s line is muted (see Select,
page 363). The default image is muton.bmp.

Paging
The Paging icon is displayed on Page and Manual Pages buttons while the page is being sent. The
default image is paging.bmp.
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Page Done
The Page Done icon is displayed on Page and Manual Pages buttons when the page has been
completed and the “Manually confirm pages are done sending” option has been enabled in Paging
Setup see Paging Settings window, page 151The default image is pagedone.bmp.

RX LED
The RX LED icon is displayed on Select buttons when receive traffic is detected on the Select button’s
line (see Select, page 363). The default image is rxled.bmp.

TX LED
The TX LED is displayed on Select buttons when parallel console transmit traffic is detected on the
Select button’s line (see Select, page 363). The default image is txled.bmp.

XTX LED
The XTX LED icon is displayed on Select buttons when parallel console transmit traffic, which has
been crossmuted, is detected on the Select button’s line (see Local Consoles page, page 131 and
Select, page 363). The default image is xtxled.bmp.

14.4 Column Headings page
The Heading Labels group box contains fields to enter custom labels appearing on column headings
in the Call List, Per Line, Manual Call List, Set Status and Active Emergency windows.
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Figure 14.4: Language Customization Window - Column Heading Page

Heading Labels group box

Date field
The Date field is used to create the column label applied to the date column in call windows.

This field can contain up to 31 characters.

Time field
The Time field is used to create the column label applied to the time column in call windows.

This field can contain up to 31 characters.

Channel field
The Channel field is used to create the column label applied to the channel column in call windows.

This field can contain up to 31 characters.

Freq field
The Freq field is used to create the column label applied to the frequency column in call windows.
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This field can contain up to 31 characters.

Status field
The Status field is used to create the column label applied to the status column in call windows.

This field can contain up to 31 characters.

Talkgroup field
The Talkgroup field is used to create the column label applied to the talkgroup column in call
windows.

This field can contain up to 31 characters.

User ID field
The User ID field is used to create the column label applied to the user ID column in call windows.

This field can contain up to 31 characters.

Calling ID field
The Calling ID field is used to create the column label applied to the calling ID column in call windows.

This field can contain up to 31 characters.

Status ID field
The Status ID field is used to create the column label applied to the status ID column in call windows.

This field can contain up to 31 characters.

Duration field
The Duration field is used to create the column label applied to the duration column in call windows.

This field can contain up to 31 characters.

Comments field
The Comments field is used to create the column label applied to the comments column in call
windows.

This field can contain up to 31 characters.

14.5 Text Labels window
The Text Labels group box contains fields to enter custom labels appearing in text fields in the Call
List, Per Line, Manual Call List, Set Status and Active Emergency windows.
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Figure 14.5: Language Customization Window - Text Labels Page

Text Labels group box

Alias field
The Alias field is used to create the column label applied to the alias column in call windows.

This field can contain up to 31 characters.

ID Type field
The ID Type field is used to create the column label applied to the ID type column in call windows.

This field can contain up to 31 characters.

Filters field
The Filters field is used to create the filters label applied to the Call List window.

This field can contain up to 31 characters.

No Filters field
The No Filters field is used to create the label applied when no filters are selected in the filters display
in the Call List window.
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This field can contain up to 31 characters.

No Status field
The No Status field is used to create the label applied when no statuses are selected in the status
display in call windows.

This field can contain up to 31 characters.

14.6 Window Titles window
The Window Titles group box contains fields to enter custom titles appearing on windows in the Call
List, Per Line, Manual Call List, Set Status and Active Emergency windows.

Figure 14.6: Language Customization Window - Window Titles Page

Window Titles group box

Active Emergency field
The Active Emergency field allows you to name the window that appears when the Active Emergency
button is clicked in the C-Soft Runtime program.
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This field can contain up to 10 characters.

Call List field
The Call List field allows you to name the window that appears when the Call List button is clicked in
the C-Soft Runtime program.

This field can contain up to 10 characters.

Emergency History field
The Emergency History field allows you to name the window that appears when the Emergency
History button is clicked in the C-Soft Runtime program.

This field can contain up to 10 characters.

Global Call History field
The Global Call History field allows you to name the window that appears when the Global Call
History button is clicked in the C-Soft Runtime program.

This field can contain up to 10 characters.

Per Line Call History field
The Per Line Call History field allows you to name the window that appears when the Per Line Call
History button is clicked in the C-Soft Runtime program.

This field can contain up to 10 characters.

Manual Call List field
The Manual Call List field allows you to name the window that appears when the Manual Call List
button is clicked in the C-Soft Runtime program.

This field can contain up to 10 characters.

Status List field
The Status List field allows you to name the window that appears when the Status List button is
clicked in the C-Soft Runtime program.

This field can contain up to 10 characters.
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15 Paging Settings window
The Paging Settings window, shown in the Figure below, is used to configure pager settings for both
individual and group pages. Up to 10 predefined pages can be configured.

NAVIGATION: Select Edit | Setup Pagers from the menu bar.

Figure 15.1: Pagers Window

Page Setup

Page Type drop down menu
The Page Type drop down menu, to the right of the pager number, is used to select a pre-defined
pager from a list.

Available selections for this field are:
– 2 Tone 100 (Quickcall II 100)
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– 2 Tone 1000 (Quickcall II 1000)
– DTMF
– Knox

In addition to the pager selections provided on this window, a UI element is provided.

Setup button
The Setup button is used to open the appropriate window for the type of pager selected in the drop
down menu.

For more information, refer to:
– “2 Tone 100 Page Setup window, page 153”.
– “2 Tone 1000 Setup window, page 155”.
– “DTMF Paging Setup window, page 159”.
– “Knox Paging Setup window, page 160”.

Page Send Topology

Sequential radio button
The Sequential radio button indicates the paging codes are sent on a line by line basis. The pages for
one line are completely sent before the pages on the next line are started.

Parallel radio button
The Parallel radio button indicates the paging codes are sent on different lines at the same time.

Tone Options

Correct Low Frequency Tone Levels (Flatten Levels)
The Correct Low Freq Tone Levels (Flatten Levels) check box indicates tones across 300kHz to 3kHz
spectrum are flattened for better level adjustment. Depending on the load being driven, it is possible
additional roll-off of the lower frequency tone (sub 1kHz) levels can occur.

Delay Between Stacked Pages field
The Delay Between Stacked Pages field is used to set the amount of time, in ms, C-Soft waits
between stacked pages. This feature enables page decoders to distinguish between different pages.

The range for this field is 0 to 9999ms.

i
Notice!
This field is global and affects all stacked pages regardless of page type or format. This field is added
to the Inter-Page Delay configured for the individual Page Formats.

User Control Options Group Box

Allow Programmed Page Stack Buttons to be Stacked check box
The Allowed Programmed Page Stack Buttons to be Stacked check box indicates programmed page
stack buttons can be stacked.

Always Stack Page Buttons check box
The Always Stack Page Buttons check box indicates that Page buttons are always stacked.
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Manual Confirm Pages Are Done Sending check box
The Manual Confirm Pages Are Done Sending check box indicates the Page, Manual Page, and
Programmed Page Stack buttons display the Done icon once all pages generated by a page button
have been sent by the console. The Done icon remains visible on the page buttons until the Page
Cancel button is clicked.

Revert to Initial Frequency After Sending Page check box
The Revert to Initial Frequency After Sending Page check box indicates the console returns to the
original frequency configured before sending the page.

OK button
The OK button saves the entries and closes the window.

15.1 2 Tone 100 Page Setup window
The 2 Tone 100 Page Setup window, shown the Figure below, is used to configure a 2-digit code
paging sequence for this format. To open this window, select 2 Tone 100 from the Page Type drop
down menu.

Figure 15.2: 2 Tone 100 Page Setup Window
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Page Name field
The Page Name field is used to enter a descriptive name to associate with the paging sequence for
this encoder. The name, when assigned, is displayed in the Pager Setup window next to the Pager
Number field, and is included for selection in a list of variables for the user interface element page
function.

Page Level field
The Page Level field identifies the output, in dB, of the relative paging tone.

The range for this field is -60 to 10dB.

Initial Page Delay field
The Initial Page Delay field identifies the amount of time, in ms, allowed from PTT until the first tone
is played.

The range for this field is 0 to 9999ms.

Inter-Page Delay field
The Inter-Page Delay field is used to set the amount of time, in ms, C-Soft waits between stacked
pages using the paging format.

The range for this field is 0 to 9999ms.

i
Notice!
This field only affects stacked pages using this page format. The field is added to Delay Between
Stacked Pages field on the Paging Setting window.

Tone 1 Group and Tone 2 Group fields
The Tone 1 Group and Tone 2 Group fields identify which two frequencies are played in succession.

The range for this field is 1 to 15.

To determine the entry for each field, do the following:
– Using the table on “Telex Tone Group Numbers, page 474”, find the desired Telex Tone Group

number for the first and second tones.

Tone 1 Time field
The Tone 1 Time field identifies the duration, in ms, of tone 1. The tone and gap durations for
standard paging plans are shown in “Tone and Gap Durations for Standard Paging Plans, page 475”.

The range for this field is 0 to 10000ms.

Gap Duration field
The Gap Duration field identifies the duration, in ms, of the gap duration. The tone and gap durations
for standard paging plans are shown in “Tone and Gap Durations for Standard Paging Plans, page
475”.

The range for this field is 0 to 15000ms.

Tone 2 Time field
The Tone 2 Time field identifies the duration, in ms, of tone 2. The tone and gap durations for
standard paging plans are shown in “Tone and Gap Durations for Standard Paging Plans, page 475”.
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The range for this field is 0 to 10000ms.

Group Tone Time field
The Group Tone Time field identifies the duration, in ms, of the group tone. The tone and gap
durations for standard paging plans are shown in “Tone and Gap Durations for Standard Paging
Plans, page 475”.

The range for this field is 0 to 10000ms.

Enable Diagonal check box
The Enable Diagonal check box indicates the tone specified in the Diag Tone Freq field is used in
place of either the first or second tone depending on the selection in the Diag Location check box.
Otherwise, the group tone is played for the diagonal tone duration period.

Diag Tone Freq field
The Diag Tone Freq field identifies the frequency, in Hz, of the diagonal tone when the Enable
Diagonal check box is selected.

The range for this field is 0 to 3000Hz.

Diag Location check box
The Diag Location check box indicates the diagonal tone is used in place of the first tone; otherwise,
the group tone is used.

OK button
The OK button saves the entries and closes the window.

Cancel button
The Cancel button discards any changes made and closes the window.

15.2 2 Tone 1000 Setup window
The 2 Tone 1000 Setup window, shown in the Figure below, is used to configure a 3-digit paging
code. To open this window, select 2 Tone 1000 from the Page Type drop down menu.



156 en | Paging Settings window C-Soft 8.500

2025-08 | 16 | F.01U.218.561 Technical Manual Bosch Security Systems, LLC

Figure 15.3: 2 Tone 1000 Setup Window

Page Name field
The Page Name field is used to enter a descriptive name to associate with the setup for this encoder.
The name, once assigned, is displayed on the Pager Setup window next to the Pager Number field,
and is included for selection in a list of variables for the user interface element page function.

Page Level field
The Page Level field identifies the output of the relative paging tone.

The range for this field is -60 to 10dB.

Initial Page Delay field
The Initial Page Delay field identifies the amount of time allowed from PTT until the first tone is
played.

The range for this field is 0 to 9999ms.

Inter-Page Delay field
The Inter-Page Delay field is used to set the amount of time, in ms, C-Soft waits between stacked
pages using the paging format.

i
Notice!
This field only affects stacked pages using this page format. The field is added to Delay Between
Stacked Pages field on the Paging Setting window.

The range for this field is 0 to 9999ms.
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Tone Plan Number field
The Tone Plan Number field is used to configure the first and second page tones. Refer to “Telex
Tone Group Numbers, page 474”.

The range for this field is 1 to 25.

EXAMPLE: If the pager to be reached is N349, the Telex Code Plan Number would be set to 12 which
corresponds to group Mot N. The Pager Capcode 3 corresponds to the line (3+3), in Group N (Tone
Plan Number 12), from which the 2 Tone Group Frequencies are selected.

From using Telex Code Plan #12, Tone Group #3, and Tone Group #3 for N349, the first tone (Telex
Tone Group Number 3 and Tone Group 4) sent would be 313.0, followed by the second tone (Telex
Tone Group Number 3 and Tone Group 9) 1063.2.

Table “Example tone plan number locator” shows the break down of each digit in the pager number
N349 and a description of the encoder parameters identified by the digit.

Digit Identifies Description

N Pager Locate the Mot N group
pagers in “2 Tone 1000
Plan Numbers” on page
427.

Enter the Telex
Codeplan # from the
top row in the Tone
Plan Number (12) (this
digit can also identify
the entries for the Tone
1 Time, Gap Duration,
Tone 2 Time and Group
Tone Time fields, refer
to “Tone and Gap
Durations for Standard
Paging Plans” on page
426).

Where the Telex code
plan # (12) and the
Pager Capcode (3xx)
intersect in the table to
identify the Telex
Group No. (3+3). This
identifies the
frequencies for tone 1
and Tone 2.

3 Pager Capcode Locate the Pager
Capcode (3xx) in “2
Tone 1000 Plan
Numbers” on page 427.

In the table’s left
column.

4 Tone 1 Frequency Using the first number
identified above (3),
locate the Telex Group
No. 3 and Tone Group
4 (second digit in pager

Where these two items
intersect in the table
identifies the frequency
of tone 1 (313.0).
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number), from “Telex
Tone Group Numbers”
on page 425.

9 Tone 2 Frequency Using the second
number in the Telex
Group number (3),
locate the Telex Group
No. 3 and Tone Group
9 (third digit in pager
number) from “Telex
Tone Group Numbers”
on page 425.

Where these two items
intersect in the table
identifies the frequency
of tone 2 (1063.2).

Table 15.1: Example tone plan number locator

Tone 1 Time field
The Tone 1 Time field identifies the amount of time of the duration for tone 1. The tone and gap
durations for standard paging plans are shown in “Tone and Gap Durations for Standard Paging
Plans, page 475”.

The range for this field is 1 to 10000ms.

Gap Duration field
The Gap Duration field identifies the amount of time of the gap duration. The tone and gap durations
for standard paging plans are shown in “Tone and Gap Durations for Standard Paging Plans, page
475”.

The range for this field is 1 to 15000ms.

Tone 2 Time field
The Tone 2 Time field identifies the amount of time of the duration for tone 2. The tone and gap
durations for standard paging plans are shown in “Tone and Gap Durations for Standard Paging
Plans, page 475”.

The range for this field is 1 to 10000ms.

Group Tone Time field
The Group Tone Time field identifies the amount of time of the tone duration for the group tone. The
tone and gap durations for standard paging plans are shown in “Tone and Gap Durations for Standard
Paging Plans, page 475”.

The range for this field is 1 to 10000ms.

Enable Diagonal check box
The Enable Diagonal check box indicates the frequency entered in the Diag Tone Freq field is used in
place of either the first or second tone depending on the selection made in the Diag Location check
box. Otherwise, the second tone is played for the diagonal tone duration period.

Diag Tone Freq field
The Diag Tone Freq field identifies the frequency of the diagonal tone when the Enable Diagonal
check box is selected.

The range for this field is 0 to 3000Hz.
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Diag Location check box
The Diag Location check box indicates the diagonal tone is used in place of the first or second tone. If
selected, the diagonal tone overrides either the first or second group tone. Otherwise, group tone is
used.

OK button
The OK button saves the entries and closes the window.

Cancel button
The Cancel button discards any changes made and closes the window.

15.3 DTMF Paging Setup window
The DTMF Paging Setup window, shown in the Figure below, is used to configure standard paging
tones level, delay, time length and string length.
To open this window, select DTMF from the Page Type drop down menu.

Figure 15.4: DTMF Paging Setup Window

Page Name field
The Page Name field is used to enter a descriptive name to associate with the setup for this encoder.
The name, once assigned, is displayed on the Pager Setup window next to the Pager Number field,
and is included for selection in a list of variables for the user interface element page function.

Page Level field
The Page Level field identifies the output of the relative paging tone.

The range for this field is -60 to 10dB.

Initial Page Delay field
The Initial Page Delay field identifies the amount of time allowed from PTT until the first tone is
played.

The range for this field is 0 to 9999ms.

Inter-Page Delay field
The Inter-Page Delay field is used to set the amount of time, in ms, C-Soft waits between stacked
pages using the paging format.
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The range for this field is 0 to 9999ms.

i
Notice!
This field only affects stacked pages using this page format. The field is added to Delay Between
Stacked Pages field on the Paging Setting window.

DTMF On Time field
The DTMF On Time field identifies the amount of time the DTMF digit is played.

The range for this field is 20 to 2000ms.

DTMF Off Time field
The DTMF Off Time field identifies the amount of time in between the time each DTMF digit is played.

The range for this field is 20 to 2000ms.

DTMF Digits field
The DTMF Digits field identifies the number of digits in a standard page. The number of digits
specified are expected by all pages using this option.

The range for this field is 1 to 16.

OK button
The OK button saves the entries and closes the window.

Cancel button
The Cancel button discards any changes made and closes the window.

15.4 Knox Paging Setup window
The Knox Paging Setup window, shown in the Figure below, is used to configure the pager name,
output level, digit duration, pause times, and digits required in the page.
To open this window, select Knox from the Page Type drop down menu.

Figure 15.5: Knox Paging Setup Window
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Page Name field
The Page Name field is used to enter a descriptive name to associate with the paging sequence for
this encoder. The name, when assigned, is displayed in the Pager Setup window next to the Pager
Number field, and is included for selection in a list of variables for the user interface element page
function.

Page Level field
The Page Level field identifies the output of the relative paging tone.

The range for this field is -60 to 10dB.

Initial Page Delay field
The Initial Page Delay field identifies the amount of time allowed from PTT until the first tone is
played.

The range for this field is 0 to 9999ms.

Inter-Page Delay field
The Inter-Page Delay field is used to set the amount of time, in ms, C-Soft waits between stacked
pages using the paging format.

i
Notice!
This field only affects stacked pages using this page format. The field is added to Delay Between
Stacked Pages field on the Paging Setting window.

The range for this field is 0 to 9999ms.

Knox On Time field
The Knox On Time field identifies the amount of time the knox digit is played.

The range for this field is 20 to 2000ms.

Knox Off Time field
The Knox Off Time field identifies the amount of time in between the time each Knox Digit is played.

The range for this field is 20 to 2000ms.

Knox Digits field
The Knox Digits field identifies the number of digits in a standard page. The number of digits specified
are expected by all pages using this option.

The range for this field is 1 to 16.

OK button
The OK button saves the entries and closes the window.

Cancel button
The Cancel button discards any changes made and closes the window.
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16 Tone Levels window
The Tone Levels window, shown the Figure below, is used to configure the tone level, in dB, of
individual tones heard by the operator.

NAVIGATION: Select Edit | Setup Tone Level from the menu bar.

Figure 16.1: Tone Levels Window

Emergency Tone field
The Emergency Tones field indicates the tone level at which the emergency tone is heard.

The range for this field is -60 to 0 dB.

Group Call Tones field
The Group Call Tones field indicates the tone level at which the group call tones are heard.

The range for this field is -60 to 0 dB.

Talk Permit Tones field
The Talk Permit Tones field indicates the beep level at which the iDEN beeps are heard.

The range for this field is -60 to 0 dB.

Input Beeps field
The Input Beeps field indicates the beep level at which the input beeps are heard.

The range for this field is -60 to 0 dB.

Page Beeps field
The Page Beeps field indicates the beep level at which the page beeps are heard.

The range for this field is -60 to 0 dB.

Phone Rings field
The Phone Rings field indicates the ring level at which the phone rings are heard.
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The range for this field is -60 to 0 dB.

Select Call Tones field
The Select Call Tones field indicates the tone level at which select call tones are heard.

The range for this field is -60 to 0 dB.

Sidetones field
The Sidetones field indicates the level at which sidetones are heard.

The range for this field is -60 to 0 dB.

OK button
The OK button saves the entries and closes the window.

Cancel button
The Cancel button discards any changes made and closes the window.
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17 Global SIP Configuration window
The Global SIP Configuration window, shown in the Figure below, provides access to SIP Network
settings and SIP Audio settings.

SIP extension settings are configured on a Per Line basis. For more information, see Configure SIP
Settings window, page 110.

NAVIGATION: Select Edit | Setup SIP Phone from the menu bar.

17.1 SIP Network page
The SIP Network page, shown in the Figure below, is used to enter Default Identity, STUN Settings,
Proxy Server Settings, and various other advanced settings.

Figure 17.1: Network Page - Global SIP Configuration
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Default Identity group box

Display Name field
The Display Name field is used to enter an alias name for the console for easy identification. The
display name appears on the SIP phone if the SIP phone or SIP/PSTN gateway is capable and
configured to display the alias.

STUN Server group box

Use STUN Server check box
The Use STUN Server check box indicates the STUN (Session Traversal Utilities for NAT [Network
Address Translation]) server entered in the field is used to negotiate packet routing through NAT
firewalls or NAT routers.

Server Address field
The Server Address field is used to enter a server address for packet routing.

i
Notice!
The Use Stun Server check box must also be selected.

Typically, if C-Soft is running on a computer running on a private IP network, then it is necessary to
enable the use of STUN server option. The STUN protocol allows C-Soft to use a STUN server on the
internet to determine how the NAT gateway translates the UDP addressing between the private
network and the public internet.

Proxy Server group box

Use Outbound SIP Proxy check box
The Use Outbound SIP Proxy check box indicates traffic is initially sent through the proxy server
entered in the Server Address field.

i
Notice!
The Server Address field must also be configured.

Server Address field
The Server Address field is used to enter the proxy server’s address.

i
Notice!
The Use Outbound SIP Proxy check box must also be selected.

User Name field
The User Name field is used to enter the proxy server User Name.
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Password field
The Password field is used to enter the proxy server password.

Advanced group box

Listen on Specific IP Address check box
The Listen on Specific IP Address check box indicates the IP Address you enter in the Listen on
Specific IP Address field is active.

i
Notice!
The Listen on Specific IP Address field must also be configured.

Listen on Specific IP Address field
The Listen on Specific IP Address field is used to enter the specific IP Address to use for sending and
receiving phone calls. This feature is useful when the computer has multiple NICs (Network Interface
Cards).

i
Notice!
The Listen on Specific IP Address check box must also be selected.

Use Non-Standard Port check box
The Use Non-Standard Port check box indicates the port number entered in the field is used for SIP
communication. Otherwise, the default port number 5060 is used.

i
Notice!
The Use Non-Standard Port field must also be configured.

Use Non-Standard Port field
The Use Non-Standard Port field is used to enter a port number for SIP communications.~

i
Notice!
The Use Non-Standard Port check box must also be selected.

Enable Logging check box
The Enable Logging check box enables logging for the SIP library in C-Soft. This check box is used for
Debugging Purposes Only.
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17.2 Audio page
The Audio page, shown in the Figure below, contains LAM, silence detection, and jitter buffering
configuration.

Figure 17.2: Audio Page - Global SIP Configuration

LAM Setup group box
The LAM Setup group box is used to control LAM (Line Activity Monitor) during SIP phone to radio
crosspatch activity.

LAM Level (dB) spin box
The LAM Level (dB) spin box is used to set the audio threshold at which the crosspatched line or echo
packets begin to send audio packets over the network.

The range for this field is -60 to 0 dB.

LAM Time (s) spin box
The LAM Time spin box is used to set the amount of time for radio crosspatch activity. The LAM time
determines how long the SIP line is active after the audio level is below the LAM level threshold.
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The range for this field is 0 to 60 sec.

Silence Detection group box

None radio button
The None radio button indicates there is no silence detection for any SIP phone line in the system.
Audio continues to transmit, even if silent.

Fixed Threshold radio button and Threshold spin box
The Fixed Threshold radio button is used to activate the minimum audio detection mode. When the
audio level reaches the specified threshold configured in the spin box, it is no longer considered silent.
Audio levels below the specified raw digital value in the spin box are ignored and considered silent.

This setting is used with the Voice Deadband and Silence Deadband spin boxes.

The range for this field is 0 to 8000.

Adaptive Threshold radio button and Period spin box
The Adaptive Threshold radio button is used to activate the dynamic audio detection mode and is the
recommended configuration for silence detection. The minimum audio is automatically adjusted after
the software determines the average audio received over the amount of time specified in the Period
spin box.

This setting is used with the Voice Deadband and Silence Deadband spin boxes.

The range for this field is 10 to 10000ms.

Voice Deadband (ms) spin box
The Voice Deadband (ms) spin box is used to configure the minimum duration of audio above the
threshold needed to start sending audio.

The range for this field is 10 to 10000ms.

i
Notice!
If audio is choppy after setting the value, try setting to a shorter amount of time.

Silence Deadband (ms) spin box
The Silence Deadband (ms) spin box is used to configure the minimum duration of audio below the
threshold before the audio is considered silent. The time should be long enough so that gaps between
spoken words are not detected as silence, otherwise the audio may sound choppy.

The range for this field is 10 to 10000ms.
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Jitter Buffering group box
The Jitter Buffering group box contains settings for buffering incoming audio packet delivery to
reduce jitter. When the minimum and maximum are set, the duration of jitter buffer is dynamically
adjusted between the two values. A longer duration can improve the audio quality if network latency
is variable, but when the duration is set for too long, audio delay can interfere with conversation.
Experimentation is the best way to optimize your settings.

Min Duration (ms) spin box
The Min Duration (ms) spin box is used to configure minimum buffer duration for incoming audio.

The range for this field is 10 to 10000ms.

Max Duration (ms) spin box
The Max Duration (ms) spin box is used to configure maximum buffer duration for incoming audio.

The range for this field is 10 to 10000ms.

Restore Default button
The Restore Defaults button is used to restore factory defaults. The default values appear in the
Figure above.

OK button
The OK button saves the entries and closes the window.

Cancel button
The Cancel button discards any changes made and closes the window.

Operation Test
Test the SIP registration to confirm successful connectivity and authentication to the SIP server. SIP
Server status is recorded in the Global Call History page in C-Soft Runtime and a success or failure
registration message appears in the status bar.

i
Notice!
A SIP Call Control UI element is required for each SIP line. Before testing the SIP connection, you
must create a SIP Call Control UI element button. Refer to “SIP Call Control” on page 342.

To test the SIP connection in C-Soft Runtime, do the following:
– Open the C-Soft console.
A message appears in the console status bar:

– If the connection is successful, a success message appears.
– If the connection fails a failure message appears.
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17.3 Behavior page
The Behavior page, shown in the figure below, contains settings for defining how C-Soft SIP
operates. These settings are needed for interoperability with different SIP servers, which may have
differing procedures for common SIP operations.

Figure 17.3: Global SIP Configuration - Behavior page

Hold Initiation Group Box
The Hold Initiation group box is used to set how C-Soft initiates putting a call on hold. The default
value is Allow independent stream states, and is only recommended to set Stop all streams in the case
that C-Soft audio is leaking while on hold.
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Allow independent stream states Radio Button
The Allow independent stream states radio button indicates that C-Soft, upon putting a call on hold,
sends an invite message with the parameter a=sendonly, which the SIP server and remote endpoint
negotiate media streams, ultimately putting the call on hold.

Stop all streams Radio Button
The Stop all streams radio button indicates that C-Soft, upon putting a call on hole, sends an invite
message with the parameter a=inactive, immediately ending the streams without negotiation.
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18 Setup P25
NAVIGATION: Select Edit | Setup P25 from the menu bar.
For more information about setting up P25:
– P25 DFSI Global Setup is discussed in P25 DFSI Global Setup window, page 481
– Global P25 CSSI Parameters is discussed Global P25 CSSI Parameters, page 539
– Encryption Setup is discussed in Encryption Setup window, page 515

Refer to
– P25-DFSI window, page 323
– Appendix E - P25-DFSI (Digital Fixed Station Interface), page 480
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19 GPS Mapping Setup window
The GPS Mapping Setup window is used to enable GPS data to be received and stored by C-Soft,
and to configure GPS settings, such as file name.
The .kml file is located in a directory specified in C:\ProgramData\Telex Communications C-
Soft\Settings\ClientSettings.xml and by default is C:\ProgramData\Telex Communications C-
Soft\DesignData. Change the GPS Mapping storage directory by using Telex System Manager.
NAVIGATION: Select Edit | Setup GPS Mapping from the menu bar.

Figure 19.1: GPS Mapping Setup Window

i
Notice!
GPS mapping is currently only available for the Kenwood NEXEDGE, MOTORBO, and Tait DMR
Trunking systems.

KML File Setup group box

Store received GPS data in KML File check box
The Store received GPS data in KML File check box is used to create and store GPS file.

i
Notice!
Google Earth functionality will only work if the Store received GPS data in KML File check box is
selected.

File Name field
The File Name field is used to define the file name.
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Network Setup group box

Enable GPS Output (NEXEDGE Only) check box
The Enable GPS Output check box is used to enable GPS output. If selected, the GPS IP Address and
GPS ports become active and can be modified. If the radios have GPS enabled, the console outputs
the GPS information on the console’s user selectable address and port. The format is in Degrees,
Decimal Minutes.

The remote radio must be configured in the radio programming software to send the GPS coordinates
to the console ID.

i
Notice!
The Network GPS feature is only available for the NEXEDGE IP interface.

GPS IP Address field
The GPS IP Address field indicates the console’s GPS IP Address for transmitting GPS data.

GPS Port field
The GPS Port field indicates the port used for GPS data.

The port number must be unique from all other ports configured on the console.
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20 NEXEDGE
NAVIGATION: Select Edit | Setup NEXEDGE from the menu bar.
– NEXEDGE is discussed in Appendix H - Kenwood NEXEDGE Direct IP interface, page 543
– Global NEXEDGE Conventional Parameters window is discussed in Global NEXEDGE

Conventional Parameters window, page 560
– Global NEXEDGE Trunking Parameters is discussed in NEXEDGE Trunking System setup, page

550
– NEXEDGE Encryption is discussed in NEXEDGE Encryption window, page 580
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21 Setup External Systems
Use Setup External Systems to configure and manage connections to external systems that C-Soft
uses for various specialized operations.

21.1 Console Management System
Use the Console Management System tab to configure Console Management System features.

Figure 21.1: External Systems Setup - Console Management Page

Contact Management group box

Enable Alias Updates from CMS check box
The Enable Updates from CMS check box indicates the console can receive alias updates from the
Contact Management module in the Console Management System. Whenever changes are made to
the contact list on the Console Management System website, those changes automatically propagate
to all consoles with the Enable Alias Updates configured.
By default, Alias Updates from CMS are disabled.

CryptoSync group box

Authorization Token field
Use the Authorization Token field to enter the authorization token used by CMS to verify clients are
authorized to send/receive encrypted audio. The Authorization Token is initially generated in the
CryptoSync page in CMS. These tokens must match between C-Soft and the Authorization Token
field in CMS.
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Figure 21.2: CMS - CryptoSync Settings Page

21.2 API Setup
For more information on the API Setup window, see
– Appendix K - C-Soft API Installation notes, page 603
– Setup External Systems window, page 604
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22 AIS
For more information, see AIS Global Setup window, page 595.
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23 Filter List Setup window
The Filter List Setup window, shown in the Figure below, is used to create a list of filters for the
console operator to use during FleetSync, MDC-1200, MOTOTRBO, P25-DFSI, and Telex-Serial
system creation to sort and organize units and groups or fleets of user IDs in the system. The filters
are also used by the console operator to filter units and groups while in the Call List window, the
FleetSync Dispatching window, the MOTOTRBO Dispatching window, the P25-DFSI Dispatching
window and Keypad Control.

This list can contain up to 60 filters.

NAVIGATION: Select Edit | Edit Filters from the menu bar.

Figure 23.1: Filter List Setup Window

Filter List Setup group box

Filter Entry field
The Filter Entry field is used to enter a label for a new filter.

This field can contain up to 16 alphanumeric characters.

List field
The List field displays the list of all filters created in the system.

This list can contain up to 60 filters.

Add Filter button
The Add Filter button is used to add the filter entry in the Filter Entry field to the list of filters.

To add a filter, do the following:
1. In the Filter Entry field, enter a name for the filter.
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2. Click Add Filter.
The new filter appears in the Filter Entry field.

Delete Filter button
The Delete Filter button is used to delete an unwanted entry from the list of filters.

To delete a filter, do the following:
1. In the Filter List field, select the filter name.
2. Click Delete Filter.
The filter is deleted from the list.

Clear List button
The Clear List button is used to clear the entire list of filters from the Filter List.

To clear all entries, do the following:
– Click Clear List.
The list is cleared from the window.

i
Notice!
If you accidentally click the clear list button and did not want to delete the entire list then click Cancel
and reopen the window.

OK button
The OK button saves any changes made and closes the window.

Cancel button
The Cancel button discards any changes made and closes the window.
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24 User ID List window
The User ID List window, shown in the following Figures, is used to create a list of individual users in
the system for recall later. It is used in conjunction with the ANI features of certain radios. When the
window is closed and reopened, the user IDs are sorted by Name in ascending order. Refer to the
Figure below.

NAVIGATION: Select Edit | Edit User ID List from the menu bar.

Figure 24.1: User ID List Window

i
Notice!
When the User ID List is closed and opened again, the blank rows are deleted and the list is sorted in
ascending order by Name.

i
Notice!
P-25 -CSSI selection should only be used when doing direct console to core connection. If the
console connection is through CMS, the User type is Generic.

Name field
The Name field is used to enter a descriptive name to associate with the User ID.

When the ANI is received, this name appears on the select button for the line and in the User ID
column of the Per Line Call History window, Call List window, and the Manual Call List window. If no
name is associated with a User ID, the User ID appears on the line’s button and in the history and call
list windows.

This field can contain up to 16 characters.
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For more information about ANI display configuration, refer to “ANI Setup Group Box”.

Sort By Name button
The Sort By Name button is used to sort the User ID List by Name in ascending order.

User ID field
The User ID field is used to configure the user ID number transmitted by the radio.

User ID Types:
– Generic: Up to 31 hexadecimal digits, *, and #
– FleetSync: Up to 31 decimal digits.
– iDen: Up to 31 decimal digits, *, and #
– Telex-Serial: Up to 31 decimal digits
– MDC-1200: Up to 31 hexadecimal digits
– MOTOTRBO: Up to 31 decimal digits
– NEXEDGE: Up to 5 decimal digits
– NEXEDGE All Call: The ID is 65535
– P25-DFSI: Up to 31 decimal digits
– P25-CSSI: Up to 31 decimal digits
– Phone: Up to 31 decimal digits, *, and #
– Sprint DC: Up to 31 decimal digits
– AIS: Up to 8 decimal digits
– Telex-Enhanced-ANI: Up to 32 alphanumeric characters

Some of these system types do expect certain User ID formats or ranges, which are as follows:
– Generic: This applies to many different systems, so there is no additional specification
– FleetSync: 7 decimal digits: in range of 1001000-3494999
– iDen: “<number>*<number>*<number>”
– Telex-Serial: applies to many different systems, so no additional specification
– MDC-1200: 4 hexadecimal digits 0 - FFFF
– MOTOTRBO: decimal number 0-16776125
– NEXEDGE: decimal number 0-65519
– P25-DFSI: decimal number 0-65535
– P25-CSSI: decimal number 0-65535
– Phone: decimal number of up to 15 digits
– Sprint DC: decimal number of 10 digits for an individual phone number and 15 digits for a

TeamDC group ID
– AIS: Decimal number 1 - 16777215
– Telex-Enhanced-ANI:A-Z, a-z, and 0-9

This field can contain up to 32 characters.

i
Notice!
Up to 6000 user IDs can be created.

Sort By ID button
The Sort By ID button is used to sort the User ID List by User ID in ascending order.
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Type drop down menu
The Type drop down menu is used to select the system type the user ID is associated with.

Available selections for this field are: Generic, FleetSync, iDEN, Telex-Serial, MDC-1200, MOTOTRBO,
P25-DFSI, Phone, Sprint DC, NEXEDGE-TRUNK, NEXEDGE-CONV, CSSI and AIS.

Figure 24.2: User ID List - Type Drop Down Menu

TX Inhibit check box
The TX Inhibit check box indicates the caller’s alias displays when received, but does not display as an
available destination in the Call List, FleetSync Dispatch window, MDC-1200 Dispatch window,
MOTOTRBO Dispatch window, P25-DFSI Dispatch window, or Keypad.

Filters button
The Filters button is used to assign one or more filters to the ID. When the filter button is clicked, the
Select Filters window appears and displays all filters you created earlier. Refer to “Filter List Setup
window, page 179”.

To assign filters to the user ID, do the following:
1. Click the Filter Button. 

The Select Filter window appears.
2. Select the filters you want to add the User ID to. 

All the filters you want to include the User ID in are selected.
3. Click OK.
The User IDs are added to the selected filters.

To deselect a filter, do the following:
– Click the filter.

Select Filters window
The Select Filters window is used to select filters to associate the user with. You can assign multiple
filters to a single User ID.
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Load File button
The Load File button is used to load a .csv file containing User ID information into the User ID List
window.

i
Notice!
When the .csv file is loaded, all items in the current list are overwritten.

To load a saved User ID .csv file, do the following:
1. Click Load File. 

The Open window appears.
2. In the Open window, select the file you want to load.
3. Click Open.
The file is loaded, the Username, ID, and Type field are populated. If configured in the file, TX inhibit
and filters are also populated.

Save File button
The Save File button is used to save the current User IDs to a .csv file.

To save the User ID List to a .csv file, do the following:
1. Click Save File. 

The Save As window appears.
2. In the Filename field, enter a name.
3. Click Save.
The .csv file is saved in the current folder.

OK button
The OK button saves any changes made and closes the window.

Cancel button
The Cancel button discards any changes made and closes the window.
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25 Group ID List window
The Group ID List window, shown in the Figure below, is used to configure both the decode and
encode group IDs for group ANIs. By default, the Group ID List is sorted by Group Name in ascending
order (refer to the Figure below).

Up to 5000 Group IDs can be created.

NAVIGATION: Select Edit | Edit Group ID List from the menu bar.

i
Notice!
When the Group ID List is closed and opened again, the blank rows are deleted and the list is sorted
by Group Name in ascending order.

Figure 25.1: Group ID List Window

Group field
The Group field is used to enter a descriptive name to associate with the Group ID. This name is
displayed on the Select button of the line when the ANI is received and in the Per Line Call History
Window, Call List Window, Manual Call List Window, System-specific Dispatch Windows, and the
Keypad Module. If no name is associated with a Group ID, the Group ID appears.

This field can contain up to 16 characters.

Sort By Name button
The Sort By Name button is used to sort the Group ID List by Group Name in ascending order.
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Group ID Field
The Group ID field is used to enter the particular resource group’s identification number which is used
for aliasing incoming and addressing outgoing group-related operations.

This field can contain up to 8 characters.

ID number format:
– Generic - Up to 8 hexadecimal digits, *, and #.
– FleetSync - Up to 8 decimal digits.
– iDEN - Up to 8 decimal digits, *, and #.
– Telex-Serial - Up to 8 decimal digits.
– MDC-1200 - Up to 8 hexadecimal digits.
– MOTOTRBO - Up to 8 decimal digits.
– NEXEDGE - Up to 5 decimal digits.
– P25-DFSI - Up to 8 decimal digits.
– P25-CSSI - Up to 8 decimal digits.
– AIS - Up to 8 decimal digits., 1-16777215
– Telex-Enhanced-ANI: Up to 32 alphanumeric characters

Sort By ID button
The Sort By ID button is used to sort the Group ID List by Group ID in ascending order.

Type drop down menu
The Type drop down menu is used to select the system type for the assigned group.

Available selections for this field are Generic, FleetSync, iDEN, Telex-Serial, MDC-1200, MOTOTRBO,
P25-DFSI, NEXEDGE-TRUNK, NEXEDGE-CONV, P25-CSSI and AIS

i
Notice!
P25-CSSI group type ID only used when the console directly connects to RFSS. Not applicable when
you use CMS to connect.

To assign the system type to the group, do the following:
– From the Type drop down menu, select the type of system associated to the group.

Figure 25.2: Group ID List Window - Type Drop Down Menu

TX Inhibit check box
The TX Inhibit check box indicates the caller’s alias displays when received, but does not display as an
available destination in the FleetSync Dispatch Window, MDC-1200 Dispatch Window, or Keypad
module.
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Set Color check box
The Set Color check box is used to set a color for the group ID. When the set color check box is
selected, the Set Color button can be used to assign a color to the selected items. For more
information, refer to “Set Color Button”.

Figure 25.3: Color Window

Filters button
The Filters button is used to assign a filter(s) to the group. When a filter is assigned, the group is
included any time the selected filter(s) is chosen.

Load File button
The Load File button is used to load a .csv file into the current Group ID List window.

i
Notice!
When the .csv file is loaded, all items in the current list are overwritten.

To load a saved group ID .csv file, do the following:

1. Click Load File. 
The Open window appears.

2. In the Open window, select the file you want to load.
3. Click Open.
The file loads, the Group name and Group ID fields populate. If included in the saved file, the group
color, filters and TX Inhibit also populate.

Save File button
The Save File button is used to save the current Group ID List to a .csv file.

To save the Group ID List to a .csv file, do the following:
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1. Click Save File. 
The Save As window appears.

2. In the Filename field, enter a name.
3. Click Save.
The .csv file is saved in the current folder.

Uncheck All button
The Uncheck All button clears all Set Color check boxes.

Set Color button
The Set Color button opens the color palette. With this palette you can assign a color to display as the
background for the group and group ID in C-Soft Runtime’s system-specific dispatch windows, and
the Per Line Call History window. The colors allow for customization and quick visual recognition of
configured groups.

To set a color for the group ID, do the following:
1. Select the Set Color check box for each group you want to assign a color. 

Each group ID you want to color is selected.
2. Click Set Color. 

The Color window appears.
3. Select a color. 

The color appears in preview box.
4. Click OK, to apply the color in the preview box.
The color is applied to the selected group(s).

Click Cancel to close the window and discard changes.

Reset Colors button
The Reset Colors button sets all Group ID background colors to white.

OK button
The OK button saves any changes made and closes the window.

Cancel button
The Cancel button discards any changes made and closes the window.
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26 Status Message ID List window
The Status Message ID List window, shown in the Figure below, is used to configure status
messages and status IDs that are either sent of received by the console.

This list can contain up to 5000 status messages.

Note:
– When the window is closed and reopened, the list is sorted in descending Status ID order.
– Any row left unfilled is deleted and the list is sorted by descending group ID number when the

Status Message ID List is closed and opened again.

NAVIGATION: Select Edit | Edit Status Message ID List from the menu bar.

Figure 26.1: Status Message ID List Window

Status Message field
The Status Message field creates an alias or descriptive message to associate with the Status ID. This
message appears in the Per Line Call History window, Global Call History window, System-specific
Dispatch windows, Status window, Send Status button, and on the Select button upon receiving a
Status Message.

This field can contain up to 32 characters.

Status ID field
The Status ID field identifies the message transmitted by the radio. For example, using the Figure
above, if status 98 is sent to the console, the console displays “Mandown”.
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This field can contain up to 8 characters.

Password Protected check box
The Password Protected check box is used to indicate the supervisor password is required before the
status ID can be sent. Refer to “Supervisor Password Field”.

Set Color check box
The Set Color check box is used to select specific Status Message entries to which the Set Color
button applies.

Load File button
The Load File button is used to load a .csv file into the current Status ID window.

i
Notice!
When the .csv file is loaded, all items in the current list are overwritten.

To load a saved status message .csv file, do the following:
1. On the Status Message ID List window, click Load File. 

The Open window appears.
2. In the Open window, select the file you want to download.
3. Click Open.
The file is loaded, the Status Message and ID fields are populated. If configured in the saved file,
status color and password protection is also populated.

Save File button
The Save File button is used to save the current Status Message ID List to a .csv file.

To save the Status Message ID List to a .csv file, do the following:
1. On the Status Message ID List window, click Save File. 

The Save As window appears.
2. In the Filename field, enter a name.
3. Click Save.
The .csv file is saved in the current folder.

Uncheck All button
The Uncheck All button clears all Set Color check boxes.

Set Color button
The Set Color button is used to set a color for any entries for which the Set Color check box is
selected.

To set the Status ID color, do the following:
1. Select the Set Color check box for all messages you want to assign a color.
2. On the Status Message ID List window, click Set Color. 

The Color window appears.
3. From the Basic colors group box or the palette, select a color.
4. Click OK.
The selected Status IDs are colored.
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Reset Colors button
The Reset Colors button sets all Status ID background colors to white.

OK button
The OK button saves any changes made and closes the window.

Cancel button
The Cancel button discards any changes made and closes the window.
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27 Text Message ID List window
The Text Message ID List window, shown in the Figure below, is used to configure static text
messages (aliases) and an associated ID. The Text Message ID List is used to associate sent or
received TextID codes to a readable Text Message.

This list can contain up to 500 text messages.

NAVIGATION: Select Edit | Edit Text Message ID List from the menu bar.

Figure 27.1: Text Message ID Window

Text Message field
The Text Message field is used to create a descriptive message for the Text ID. This message can be
selected by the console operator from the Per Line Call History window, MDC-1200 Dispatching
window, MOTOTRBO Dispatching window and P25-DFSI Dispatching window while in C-Soft
Runtime.

This field can contain up to 48 characters.

Text ID field
The Text ID field indicates the ID number entered on the radio to send the text message. This ID
number also appears in the Quick Text drop down menu on the MOTOTRBO Dispatching window in
C-Soft Runtime for selecting a text message to send to the radio.

This field can contain 1 to 3 digits.
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Load File button
The Load File button is used to load a .csv file in to the current Text Message ID List window.

i
Notice!
When the .csv file is loaded, all items in the current list are overwritten.

To load a saved text message .csv file, do the following:
1. In the Text Message ID List window, click Load File. 

The Open window appears.
2. In the Open window, select the file you want to load.
3. Click Open.
The file is loaded, the Text Message and ID fields are populated.

Save File button
The Save File button is used to save the Text Message ID List to a .csv file.

To save the Text Message ID List to a .csv file, do the following:
1. Click Save File. 

The Save As window appears.
2. In the Filename field, enter a name.
3. Click Save.
The .csv file is saved in the current folder.

OK button
The OK button saves any changes made and closes the window.

Cancel button
The Cancel button discards any changes made and closes the window.
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28 Edit System List window
The Edit System List window, shown in the Figure below, is used to create and manage units, groups,
and fleets included in your FleetSync, MDC-1200, MOTOTRBO, P25-DFSI, NEXEDGE IP, or Telex-
Serial system. This list can contain up to 200 systems.

Reference

For more information about creating a UI Element button for a FleetSync, NEXEDGE IP, MDC-1200,
MOTOTRBO, Telex Serial, or P25 DFSI system:
– Refer to “FleetSync, page 256”.
– Refer to “MDC-1200, page 292”.
– Refer to “MOTOTRBO Radio Setup page, page 305”.
– Refer to “P25-DFSI window, page 323”.
– Refer to “CSSI System setup, page 537”.
– Refer to “Telex-Serial Setup page” on “Telex-Serial system type, page 89”.
– Refer to “Appendix H - Kenwood NEXEDGE Direct IP interface, page 543”.

For more information about using the dispatching window that appears when the console operator
selects a FleetSync, MDC-1200, MOTOTRBO, or P25 DFSI dispatching window button in C-Soft
Runtime:
– Refer to “FleetSync Dispatching window, page 257”.
– Refer to “MDC-1200 Dispatching window, page 296”.
– Refer to “MOTOTRBO Dispatching window, page 314”.
– Refer to “P25-DFSI window, page 323”.
– Refer to “CSSI System setup, page 537”.

NAVIGATION: Select Edit | Edit System from the menu bar.
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Figure 28.1: Edit System List Window - Blank

To create a new system, do the following:
1. From the File menu, select New.
2. From the Edit System List window, select System | New System. 

The New System window appears.
3. In the New System Name field enter a name.
A new system with empty filters and empty statuses appears in the System List field.

System names cannot contain the characters shown in the following table:

“ ‘ ; & < > ( ) ,

Table 28.1: Characters not permitted in system names

28.1 File menu - Edit System List
The File menu, in the Edit System List window, shown in the Figure below, is used to create new,
open existing, save the current system list, or close the current window.

Available selections for this field are New, Open, Save, and Close.
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Figure 28.2: File Menu - Edit System List Window

New menu
The New menu clears the current System List field display so you can create a new system list in the
window.

To create a new system list from the Edit System List window, do the following:
1. From the File menu, select New. 

A prompt to save the current system appears, if one already exists.
2. From the System menu, select New System. 

The New System window appears.
3. In the name field, enter a name for your new system.
4. From the System Type drop down menu, select a system type.

Note:
– If a system(s) is currently displayed in the System List field, then you are prompted to save

changes to the current system before the window refreshes.
– If no system is currently displayed, selecting File | New has no affect. Click System | New System,

to begin to create a new system

Open menu
The Open menu opens a window to select a file from.

To open an existing system list, do the following:
1. From the File menu, select Open. 

NOTE: If a system is currently displayed in the System List field, then you are prompted to save
changes to the current system before the window refreshes.

2. From the Open window, select the system file you want to add to the System List field. 
The system file is highlighted.

3. Click Open.
The system is loaded in the System List field and system components are available for selection.
OR
Click Cancel to exit without selecting a system list file.
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Save menu
The Save menu saves the currently displayed system to a file.

To save a system list file, do the following:
1. From the File menu, click Save. 

The Save As window appears.
2. In the name field, enter a name for the system list. 

OR 
Verify the filename is the name you want to use.

3. Click Save.

i
Notice!
If this is the first time you are saving the system list, click the Save button, the Save As window
appears. Choose a filename and path to save the file or click the cancel button.

Save as Default XML File check box
The Save as Default xml File check box indicates the selected system list file is designated as the
default system list for the console position.

To save the current system list as the default .xml file, do the following:
1. From the File menu, click Save. 

The Save As window appears.
2. In the name field, enter a name for the system list. 

OR 
Verify the filename is the name you want to use.

3. Select the Save as Default xml File check box.
4. Click Save.
The system list is saved as default and appears the next time the Edit System window opens. Also,
this system list is used by Runtime the next time the .veg file is run.

This feature works in conjunction with the Filename field on “Filename Field”.

Close menu
The Close menu closes the Edit System List window.
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To close the Edit System window, do the following:
1. From the File Menu, select Close. 

A C-Soft Designer window appears.
2. Click Save to save changes.

OR
Click No to discard changes and close the window.
OR
Click Cancel to discard changes.

28.2 Edit System List window - System Menu
The System Menu, shown in the Figure below, is used to select a new system, copy from an existing
system, or automatically build a system with filters, groups, statuses, and units you defined earlier.

Available selections for this field are: New System, Copy System, and Auto Build System.

Figure 28.3: System Drop Down Menu - System List

28.2.1 New System window
The New System window, shown in the Figure below, is used configure the system type and name
the new system.

New System Setup group box
The New System Setup group box is used to enter a System Name and select a System Type.

System Name field
The System Name field is used to enter a name for your new system.

This field can contain up to 23 characters.

System Type drop down menu
The System Type drop down menu is used to select the type of system you want to configure.

Available selections for this field are: FleetSync, Telex-Serial, MDC-1200, MOTOTRBO, NEXEDGE-
CONV, NEXEDGE-TRUNK, and P25-DFSI.
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Figure 28.4: System Type Drop Down Menu - New System

To create a new system, do the following:
1. From the Edit menu, select Edit System List. 

The Edit System List Window appears.
2. From the System menu, select New System. 

The New System window appears.
3. In the System Name field, enter a name for the new system.
4. From the System Type drop down menu, select the system type (for example, FleetSync).
5. Click OK.
The system is added to the System List field.

i

Notice!
If the system already appears in the System List field, the copied system is added to the current
system list and placed at the bottom of the list. If you are creating a new system, it is placed in the
System List field with empty filters and status containers.

OK button
The OK button creates the new system and closes the window.

Cancel button
The Cancel button closes the window without creating a new systems.

i
Notice!
The new system is not saved until the system file is saved.

28.2.2 Copy System window
The Copy System window, shown in the Figure below, is used to specify one system (source system)
to copy to another system (destination system).
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NAVIGATION: Select File | Copy System from the System List menu bar.

Figure 28.5: Copy System Window

Source System drop down menu
The Source System drop down menu is used to select an existing system to copy. The list is
populated with systems defined and saved earlier. For more information, refer to “Edit System List
window, page 194”.

Destination System field
The Destination System field is used to enter a name for the new system being created.

OK button
The OK button copies the selected source system to the newly created destination system and closes
the window.

Cancel button
The Cancel button closes the window without copying any systems.

To copy a system, do the following:
1. From the Source System drop down menu, select a system to copy.
2. In the Destination System field, enter a name for the new system.
3. Click OK.
The system is added to the System List field.

If systems already appear in the System List field, the copied system is added to the current system
list and placed at the bottom of the list.
If you are creating a new system, it is placed in the System List field with empty filters and status
containers.

28.2.3 System configuration
C-Soft supports Telex-Serial, FleetSync, MDC-1200, MOTOTRBO, and P25-DFSI signaling protocols.
In C-Soft Designer, systems are created to help manage permissions, organize units and groups, and
set up status message. In C-Soft Runtime the system is accessible through the FleetSync, MDC-1200,
MOTOTRBO or P25-DFSI Dispatching windows.

For more information, refer to “FleetSync Dispatching window, page 257”.
For more information, refer to “MDC-1200 Dispatching window, page 296”.
For more information, refer to “MOTOTRBO Dispatching window, page 314”.
For more information, refer to “P25-DFSI window, page 323”.
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To configure a system, follow these steps:
1. Plan your system.
2. Create the system filters, refer to “Filter List Setup window, page 179”.
3. Set up a user ID List, refer to “User ID List window, page 181”.
4. Set up a group ID list, refer to “Group ID List window, page 185”.
5. Set up a status ID list, refer to “Status Message ID List window, page 189”.
6. Create the system, refer to “Edit System List window, page 194”, use filters and lists created in

steps 2-5.
7. Set up Per Line Parameters, refer to “Per Line Parameters window, page 61”.
8. Add the required UI elements for the selected signaling protocol, refer to “UI Element Setup

window - Add button, page 404“.
9. Manage default system file, refer to “Filename Field on “Filename Field”.
If you create more than one system file you can manage which system appears, by default, in the Edit
System List window.

28.2.4 Auto Build System command
The Auto Build System from the File menu is used to automatically create a new system based on the
current console configuration.

To build a system with the Auto Build command, do the following:
1. From the System menu, click New System.

A New System window appears.
2. In the New System Name field, enter a name for the new system.
3. From the System Type drop down menu, select the system type.
4. Click OK.

The new system is added to the system list field with empty filters and status containers.
5. In the system list field, select the check box for the new system.
6. From the System window, select Auto Build System.

The new system is populated with all Filters, User IDs, Status IDs, Group IDs, and Units IDs
saved while completing steps 2-5 in “System configuration, page 200”. Only users and groups of
the same system type are added to the new system.

Delete unwanted filters, IDs, and statuses, as needed.

System List group box
The System List group box is used to display the current system and its components.

To change the system list view, do one of the following:
– Click the expand button to view components. 
– Click the collapse button to hide components. 

System List group box

System List check boxes
The System List check boxes indicate the component is selected for removal. For more information,
refer to “Remove From List Button” on “System Components Group Box”.
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System Components check boxes
The System Components check boxes indicate the component is selected to add to the system list.
For more information, refer to “Add to List Button” on “System Components Group Box”.

System Components group box

Figure 28.6: Component Type Drop Down Menu - System List

System Components group box

Component Type drop down menu
The Component Type drop down menu, shown in the Figure above, is used to select a category to pull
data from.

Available selections for this field are Filters, Groups, Statuses, Text Messages and Units.

Filters component
The Filters component is used to select a filter. You must create filters, refer to “Filter List Setup
window, page 179”, before a list is available for selection.

When the filter component is selected, the filter aliases you created appear in the list.

Figure 28.7: Filter Alias List Example

Groups components
The Groups component is used to select groups to include in your system. You must create groups,
refer to “Group ID List window, page 185”, before a list of groups is available for selection.
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When the Groups component is selected, the group aliases you created appear in the list. See the
Figure below.

– Group Alias Column
The Group Alias column displays the alias for available groups.

– Group ID Column
The Group ID column displays the ID number used to connect to the group.

– Group Type Column
The Group Type column displays the signaling type configured for the group.

Figure 28.8: Groups Alias List

Statuses components
The Statuses components is used to select statuses to include in your system. You must create
statuses, refer to “Status Message ID List window, page 189”, before a list is available for selection.

When the Status component is selected, the status aliases you create appear in the list. See the Figure
below.

– Status Alias Column
The Status Alias column displays the alias configured for the status message.

– Status ID Column
The Status ID column displays the ID used to send the status message.
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Figure 28.9: Status Alias List Example

Text Messages
The Text Messages component is used to select text messages to include in your system. You must
create text messages, refer to “Text Message ID List window, page 192”, before a list is available for
selection.

When the Text message component is selected, the text messages you create appear in the list. Refer
to the the Figure below.

– Text Message Column
The Text Message column displays the text message.

– Text Message ID Column
The Text Message ID column displays the ID used to send the message.
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Figure 28.10: Text Messages List Example

Units components
The Units component is used to select units (individual users) to add to either a system or an
MDC-1200 group. The unit becomes a child when added to an MDC-1200 group. This helps organize
users in the system list. You must create units, refer to “User ID List window, page 181”, before a list
of units is available for selection.

To add units to a group, do the following:
1. From the Component Type drop down menu, select Units.

The list of units you created appears.
2. Select units to add to the system list.
3. Select the group’s check box to which you want to add the unit.
4. Click Add to List.
The selected units are added to the group.

Unit Alias column
The Unit Alias column displays the alias for each configured unit.

Unit ID column
The Unit ID column displays the individual ID to which the message is sent.

Unit Type column
The Unit Type column displays the unit’s signaling system type.
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Figure 28.11: Units List Example

Add to List button
The Add to List button is used to add components selected in the System Component field, to the
currently selected system.

To add a component to the current system, do the following:
1. From the System List, select the system you want to add the component to.
2. In the System Component field, select the items you want to add to the system.

The selected items are highlighted in the System Component field.
3. Click Add to List.
The highlighted components are added to the selected system in the System List field.

Remove From List button
The Remove From List button is used to remove components from the System List.

To remove a component from a system list, do the following:
1. From the System List, select the system component you want to remove from the system.
2. Click Remove From List.
The highlighted components are removed from the selected system in the System List field.

Select All button
The Select All button is used to select each component currently listed in the System Components list.
When clicked, all component’s check boxes are selected.

Deselect All button
The Deselect All button is used to deselect all components currently listed in the System Components
list. When clicked, all component’s check boxes are cleared.

Window Design Edit commands
The Window Design Edit commands include several standard Windows commands. The shortcut key
for the command is listed next to the command on the menu. Most of the Edit menu commands can be
accessed by the toolbar buttons described in the table C-Soft Designer Toolbar on “C-Soft designer
window”. A shortcut menu with a list of commands relevant to the selected item can also be displayed
by right-clicking a user interface element.

Additional details for these commands are provided in “User interface element configuration, page
53”.
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To select all elements on the window, do the following:
– Click Ctrl+A.
All elements are selected.

To deselect all, do the following:
– Click the console window background.
All elements are deselected.

Command Description

Cut Select Cut from the Edit menu to delete the selected item.
NOTE that the Cut command does not place the selected item(s) into the clipboard.
Also, the Delete key on the keyboard can be used to delete design elements from
the window.

Copy Selecting Copy from the Edit menu copies the selected item(s) to the clipboard.

Paste Select Paste from the Edit menu to insert the item(s) in the clipboard onto the
console window. The clipboard is specific to the C-Soft Designer program and
cannot be used to exchange data with other applications. Any item(s) in the
clipboard can be pasted multiple times. Each succeeding paste appears as a
cascading item off the original item pasted to allow for easy selection and
placement of the object(s).

Increase Width Select Increase Width from the Edit menu to increase the width of the selected
element. When text is selected, the size of the selected text is proportionally
increased.

Decrease Width Select Decrease Width from the Edit menu to decrease the width of the selected
element. When text is selected, the size of the selected text is proportionally
decreased.

Increase Height Select Increase Height from the Edit menu to increase the height of the selected
element. When text is selected, the size of the selected text is proportionally
increased.

Decrease
Height

Select Decrease Height from the Edit menu to decrease the height of the selected
element. When text is selected, the size of the selected text is proportionally
decreased.

Rotate Window Select Rotate Window form the Edit menu to rotate the popup window counter-
clockwise around the selected popup button.

Move Right Select Move Right from the Edit menu to move the selected item(s) to the right.

Move Left Select Move Left from the Edit menu to move the selected item(s) to the left.

Move Up Select Move Up from the Edit menu to move the selected item(s) up.

Move Down Select Move Down from the Edit menu to move the selected item(s) down.

Open popup Select Open popup from the Edit menu to open the popup window for the selected
popup button.
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Properties Select Properties from the Edit menu to open the UI Element Setup window for the
selected item, or in the case of text, a window to enter a new text string.
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29 Insert menu
The Insert menu contains commands to add controls and descriptive text to the console window.

i
Notice!
This menu also appears by right-clicking in the C-Soft Designer Workspace.

Available selections for this field are:
– Add Button
– Add Clock
– Add Frame
– Add Frequency Control
– Add Keypad
– Add Popup Button
– Add Text
– Add Text Message Control
– Add Volume Control
– Add VU Meter

When a command is selected, a button or control appears in the upper-left corner of the console
window.

i
Notice!
All available UI Elements can also be placed inside popup windows.

Learn how to position items on the console window, refer to “User interface element configuration,
page 53”.

EXAMPLE: The Figure below, shows the console workspace after Add Button is selected from the
Insert menu and the newly created button is right-clicked.

To insert a UI Element button, do the following:
– From the Insert menu, click Add UI Button.
The UI button appears in the upper left corner of the console window.
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Figure 29.1: Button Properties Flyout Menu
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30 UI Element Setup window

30.1 Type page
The Type page, shown in the Figure below, is used to select the button’s filter, function and line.

Figure 30.1: UI Element Setup for Radio Command Button - Type Page

Filter drop down menu
The Filter drop down menu is used to refine the list of all available UI Element functions to a smaller
subset of options available in the UI Element Function drop down menu.

UI Element Function drop down menu
The UI Element Function drop down menu is used to select a function type. If a Radio Command
Button function type is selected, the Global Radio Button check box appears.

Line to Associate Function With drop down menu
The Line to Associate Function With drop down menu is used to select a desired line.

Global Radio Button check box
The Global Radio Button check box, if enabled, indicates that a Radio Command Button function type
is selected in the UI Element function drop down menu.

– Select the Global Radio Button check box to send the configured radio command on any selected
line.

– If the Global Radio Button check box is not selected, the configured radio command is sent on the
specified line only.
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30.2 Colors page
The Colors page, shown in the Figure below, is used to setup the colors and text of the Radio
Command Button.

Figure 30.2: UI Element Setup for Radio Command Button - Colors Page

For information on the Button Up and Button Down color and text options, refer to the “Global
Parameter Setup window, page 116”.

Drop Down Direction group box
The Drop Down Direction group box specifies the direction the drop down list containing the list of
the available users or groups is displayed relative to the button.

Above radio button
The Above radio button indicates the drop down list displays above the button.

Below radio button
The Below radio button indicates the drop down list displays below the button.

Left radio button
The Left radio button indicates the drop down list displays to the left of the button.

Right radio button
The Right radio button indicates the drop down list displays to the right of the button.

OK button
The OK button saves the entries and closes the window.

30.3 Options page
The Options page, shown in the Figure below, is used to select the settings for list and scroll settings.
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Figure 30.3: Options Page - UI Element Setup

List Settings group box

Background Color drop down menu
The Background Color drop down menu displays the background color of the drop down list. The
background color can be changed by selecting the drop down menu to open a color palette.

Text Color drop down menu
The Text Color drop down menu displays the color of the text in the drop down list. The text color can
be changed by selecting the drop down menu to open a color palette.

Entry Spacing field
The Entry Spacing field determines the amount of space in pixels between individual entries in the
drop down list. The value entered for Entry Spacing and the font type determine the height of the
individual entries in the drop down list. The entry spacing value can be increased to allow individual
entries to be selected from a touch screen.

The range for this field is 0 to 99.
The default value for this field is 8.

Visible Entries field
The Visible Entries field determines the number of users visible in the drop down list without scrolling.

The default value for this field is 10.

Scrolling Settings group box

Scrollbar Width field
The Scrollbar Width field determines the width in pixels of the scrollbar in the drop down list.

The default value for this field is 17.
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Minimum Slider Size field
The Minimum Slider Size field determines the minimum height of the scrollbar’s thumbtack slider in
the drop down list. The thumbtack slider is sized proportionally based on the total number of entries in
the list and the number of entries which are displayed. The minimum slider size ensures the scrollbar
is always as least as large as the entered value.

The default value for this field is 17.
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31 UI Element Functions configuration
The UI Element Functions drop down menu, on the Type page, contains UI Element functions for
selection. Configuration for each function is described in the following section and listed
alphabetically, as it appears in the drop down menu.

UI ELEMENT FUNCTION CROSS REFERENCE

Add button

Active Emergency Window Opens the Active Emergency
window to display emergency
calls.

Refer to “Active Emergency
Window, page 221”.

ADHB-4 Auxiliary Audio
Control

Allows the console operator to
toggle the playing of audio
received from the ADHB-4 Gen
2’s Aux In port

Refer to “ADHB-4 Auxiliary
Audio Control button, page
222”.

ADHB-4 Mic Control Allows the user to switch
between two mic control inputs
when the ADHB-4 is connected
to C-Soft.

Refer to “ADHB-4 Mic Control,
page 223”.

ADHB-4 NENA-Hold Places a hold on the NENA line. Refer to “ADHB-4 NENA-Hold,
page 225”.

ADHB-4 NENA-Hook Control Indicates if the NENA line is off
or on-hook.

Refer to “ADHB-4 NENA-Hook
Control function, page 225”.

ADHB-4 NENA-Indication Indicates the current on or
offhook state of a NENA line.

Refer to “ADHB-4 NENA-
Indication, page 225”.

ADHB-4 NENA-Mute Mutes the NENA line. Refer to “ADHB-4 NENA-Mute,
page 226”.

ADHB-4 Select speaker Control Allows the user to turn the
selected speaker on and off
when the ADHB-4 when the
headset is connected.

Refer to “ADHB-4 Select
Speaker Control, page 226”.

Alert Configures tones and duration
for alerts.

Refer to “Alert, page 227”.

Annunciation Allows the user to send a pre-
recorded .wav file.

Refer to “Annunciation, page
229”.

Auto-Dial Assign a string to send when
the button is clicked.

Refer to “Auto-Dial, page 232”.

Backup Line Switches to backup IP Address. Refer to “Backup Line, page
233”.

Call List Window Opens the Call List window to
display a list of user IDs.

Refer to “Call List Window,
page 234”.
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Call Priority Sets an outgoing call’s priority
for AIS/DMR calls.

Refer to “Call Priority button,
page 239”.

Call Queue Window Allows users to view calls
added to call queue.

Refer to “Call Queue window,
page 240”.

Crosspatch Crosspatches two or more lines. Refer to “Crosspatch, page
247”.

Crosspatch Block Blocks a crosspatch line from
transmitting.

Refer to “Crosspatch Block,
page 248”.

Crosspatch Clear Clears a specific group from a
crosspatch.

Refer to “Crosspatch Clear,
page 249”.

Crosspatch Programmed Crosspatches a pre-defined
group.

Refer to “Crosspatch
Programmed, page 249”.

Crosspatch PTT Transmits from the console to
crosspatched lines.

Refer to “Crosspatch PTT, page
251”.

Dial Dials the number specified in
the Keypad Module.

Refer to “Dial, page 252”.

DTMF Digit Creates a DTMF digit button. Refer to “DTMF Digit, page
252”.

Emergency ACK Acknowledges an active
emergency.

Refer to “Emergency ACK, page
253”.

Emergency Clear Stops emergency tones from
playing on the console.

Refer to “Emergency Clear,
page 254”.

Emergency History Window Opens the Emergency History
window to view received calls.

Refer to “Emergency History
Window, page 254”.

Encryption Toggles encryption on/off. Refer to “Encryption, page 255”.

Encryption Key Select Select transmit P25-DFSI
encryption option and display
incoming call’s encryption
information.

Refer to “P25 Encryption” on
page 469.

Event Logger Displays system log events. Refer to “Event Logger, page
255”.

FleetSync Opens a FleetSync Dispatching
window.

Refer to “FleetSync, page 256”.

Frequency Change Changes to a pre-defined
frequency.

Refer to “Frequency Change,
page 266”.

GPS Read Reads the GPS coordinates of a
radio.

Refer to “GPS Read button,
page 267”.

GPS Trigger Off Turns off the trigger reading of
the GPS coordinates of a radio.

Refer to “GPS Trigger Off
button, page 268”.
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GPS Trigger On Reads the GPS coordinates of a
radio at a set periodic time.

Refer to “GPS Trigger On
button, page 268”.

Group Programmed Broadcasts to a pre-defined
group.

Refer to “Group Programmed,
page 269”.

Group Select Creates a pre-defined group. Refer to “Group Select, page
273”.

Group Select Limited Limits the number of lines which
can be selected simultaneously.

Refer to “Group Select Limited,
page 273”.

Input Indication Monitors NEO-10, or ADHB-4
activity.

Refer to “Input Indication, page
274”.

Instant Recall Plays back audio. Refer to “Instant Recall, page
279”.

Intercom Allows console to console
communication.

Refer to “Intercom, page 281”.

Intercom-Per Line Allows pre-defined console to
console communication.

Refer to “Intercom-Per Line,
page 282”.

Knox Digit Creates a Knox digit button. Refer to “Knox Digit, page 282”.

Instant Recall - Last Call Button Allows console operator to play
back audio from last received
call.

Refer to “Instant Recall - Last
Call button, page 281”.

Launch Application Opens specified application. Refer to “Launch Application,
page 283”.

Logout Allows dispatchers to logout of
the current C-Soft Runtime
session and cause C-Soft
Runtime to close and re-open
the Console Sign In window.

Refer to Logout, page 286.

Manual Call List Window Opens the Manual Call List
window.

Refer to “Manual Call List, page
287”.

Marker Tone Keys and sends a tone burst to
a pre-defined radio channel.

Refer to “Marker Tone, page
289”.

MDC-1200 Window Opens the MDC-1200
Dispatching window.

Refer to “MDC-1200, page
292”.

Monitor Sends packets to open squelch
or ignore CTCSS tones.

Refer to “Monitor, page 304”.

MOTOTRBO Window Opens the MOTOTRBO
Dispatching window.

Refer to “MOTOTRBO
Window”.

Mute Group Mutes audio on a pre-defined
group.

Refer to “Mute Group, page
319”.

Mute Main Mutes all currently selected
lines.

Refer to “Mute Main, page 321”.
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Mute-Per line Toggles mute on a pre-defined
line.

Refer to “Mute-Per Line, page
321”.

P25-DFSI Window Opens the P25-DFSI
Dispatching Window.

Refer to “P25-DFSI window,
page 323”.

Page Pages a specific line and
frequency.

Refer to “Page, page 324”.

Page Cancel Cancels an active page. Refer to “Page Cancel, page
328”.

Page Manual Entry Sends a page to a pager
number entered by the console
operator.

Refer to “Page Manual Entry,
page 328”.

Page Send Sends a group of pages, when
stacked.

Refer to “Page Send, page 331”.

Page Stack Stacks pages. Refer to “Page Stack, page
332”.

Page Stack Programmed Stacks a pre-defined group of
pages.

Refer to “Page Stack
Programmed, page 333”.

Per Line Call History Opens the Per line Call History
window.

Refer to “Per Line Call History,
page 335”.

Phone Flashhook Flashhooks a phone line. Refer to “Phone-Flashhook,
page 342”.

PTT Group Call Transmits audio to a group of
radios.

Refer to “PTT-Group Call, page
345”.

PTT -Main Transmits audio to all selected
lines.

Refer to “PTT-Main, page 345”.

PTT Per Line Keys a pre-defined line. Refer to “PTT-Per Line, page
346”.

PTT Private Call Transmits audio to a single
radio.

Refer to “PTT-Private Call, page
346”.

PTT - Talk Back Transmits to the last line that
received audio.

Refer to “PTT-Talk Back, page
347”.

Radio Call Alert Sends a Call alert to a Radio. Refer to “Radio Call Alert, page
347”.

Radio Call Type Selects between Broadcast and
Conference Call Types.
(NEXEDGE IP Only).

Refer to “Radio Call Type, page
348”.

Radio Check Checks if a Radio is on/off. Refer to “Radio Check, page
348”.

Radio Disable Disables a Radio. Refer to “Radio Disable, page
349”.
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Radio Enable Enables a Radio. Refer to “Radio Enable, page
349”.

Radio Regroup Temporarily reassigns
Talkgroup.

Refer to “Radio Regroup, page
350”.

Radio Remote Monitor Activates PTT on remote radio
to monitor.

Refer to “Radio Remote Monitor,
page 351”.

Radio Ungroup Resets Radio Talkgroup. Refer to “Radio Ungroup, page
350”.

Radio Select Call Sends a Select Call to a radio. Refer to “Radio Select Call, page
352”.

Radio Status Sends a Status Message to a
radio.

Refer to “Radio Status, page
351”.

Radio Status Request Requests the Status of a Radio. Refer to “Radio Status Request,
page 351”.

Radio On/Offhook Toggles radio on/off periodically
to keep the radio active.

Refer to “Radio-On/Offhook,
page 353”.

Relay Control Button Controls an ADHB-4 or NEO-10
relay.

Refer to “Relay Control Button,
page 353”.

RX All Disengages mute on selected
lines.

Refer to “RX All, page 362”.

Scan Scans the selected line. Refer to “Scan, page 363”.

Scrambler/Encrypt Key Select Selects active NEXEDGE
encryption key

Refer to “Kenwood NEXEDGE
Direct IP Interface” on page
503.

Select Selects a line. Refer to “Select, page 363”.

SIP Call Control Opens the SIP Calls window. Refer to “SIP Call Control, page
367”.

Stack Status Programmed Opens the Status Programmed
window.

Refer to “Status Stack
Programmed, page 396”.

Stack Status Window Opens the Stack Status
window.

Refer to “Status Stack window,
page 398”.

Supervisor Seizes control of a line or group
of lines.

Refer to “Supervisor, page 401”.

Talk Around Toggles the serial controlled
radio that supports talk around
feature on/off.

Refer to “Talk Around button,
page 402”.

Text Button Displays text on the console. Refer to “Text button, page
402”.

TX All Selects all lines for TX. Refer to “TX All, page 403”.

Add Clock
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Clock Displays the current time on the
console.

Refer to “UI Element Setup
window - Add Clock, page
412”.

Add Frame

Frame Displays a configurable frame
on the console.

Refer to “UI Element Setup
window - Add Frame, page
416”.

Add Frequency Control

Frequency Control Displays a customized
frequency control on the
console.

Refer to “UI Element Setup
window - Add Frequency
Control, page 418”.

Add Keypad

Keypad Provides access to an on-screen
keypad, allowing easy access to
contacts, DTMF keypad, and
operation history.

Refer to “UI Element Setup
window - Add Keypad, page
425”.

Add Popup Button

Add Popup Button Displays a Popup button. Refer to “UI Element Setup
window - Add Popup Button,
page 439”.

Popup Global Call History Opens the Global Call History
display.

Refer to “Popup Global Call
History, page 444”.

Popup Webpage Opens a window that displays a
pre-defined webpage.

Refer to “Popup Webpage,
page 442”.

Popup Window Control Configures popup window
controls

Refer to “Popup Window Setup
page, page 440”.

Add Text

Font Window Displays customizable text lines
to console design.

Refer to “The Done button is
used to close the window”.

Add Text Message Control

Text Message Provides an interface for
sending and receiving text
messages.

Refer to “UI Element Setup
window - Add Text Message
Control, page 450”.

Add Volume Control

Volume-ADHB-4 NENA Controls the NENA volume on
an ADHB-4.

Refer to “Volume-NENA” on
Type page, page 453.

Volume-Auxiliary Track Left Controls the left channel volume
of the auxiliary audio when
operating with an ADHB-4 Gen
2.

Refer to “Volume-Auxiliary
Track Left” on Type page, page
453.
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Volume-Auxiliary Track Right Controls the right channel
volume of the auxiliary audio
when operating with an
ADHB-4 Gen 2.

Refer to “Volume-Auxiliary
Track Right” on Type page,
page 453.

Volume-Master Select Controls the volume on all select
lines.

Refer to “Volume-Master
Select” on Type page, page 453.

Volume-Master Unselect Controls the volume on all
unselected lines.

Refer to “Volume-Master
Unselect” on Type page, page
453.

Volume-Per Line Controls volume per line. Refer to “Volume-Per Line” on
Type page, page 453.

Add VU Meter

VU Meter Control Displays the volume
level of a particular line.

Refer to “UI Element Setup
window - Add VU Meter, page
457”.

Table 31.1: UI elements

Refer to
– UI Element Setup window - Add Text, page 449

31.1 Active Emergency Window
The Active Emergency Window, shown in the Figure below, function displays a list of current active
emergencies.

When clicked in the C-Soft Runtime program, the Active Emergency window automatically appears,
and the Select button on the line receiving the emergency blinks. The Active Emergency window is
also accessible by clicking the Active Emergency button. For more information, refer to “Emergency
Button” on page 282 and to “Emergency Type” on page 284.

When an emergency call is received, the Active Emergency window automatically appears, and the
Select button on the line receiving the emergency blinks. The Active Emergency window is also
accessible by clicking the Active Emergency button. One of two actions can be taken on an emergency
call listed in the window:
– Clear the emergency - By clearing the emergency, the emergency entry turns orange and the

tones stop. Pressing the Clear button clears all Active Emergencies in the list.
– Acknowledge the emergency - By acknowledging the emergency, the selected emergency entry

is removed from the Active Emergency window. The user can acknowledge only one emergency
at a time. This can be accomplished without first clearing the emergency. For supported radio
protocol the emergency acknowledge message is sent to the individual radio that declared the
emergency.
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Figure 31.1: Active Emergency Window Setup

Behavior group box

Automatically Populate Keypad On Acknowledgement check box
The Automatically Populate Keypad On Acknowledgement check box indicates when the Active
Emergency Window’s ACK button is pressed, the keypad’s destination is set to a selected Emergency
entry. Since the keypad’s contents are context specific to the currently selected line, the keypad only
updates if the currently selected line’s Signaling/System type match those of the selected Emergency
entry.

To add an Active Emergency button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select Active Emergency Window.

The Active Emergency Window Setup tab appears.
5. Click the Active Emergency Window Setup tab.

The Active Emergency Window Setup page appears.
6. Select the Automatically populate keypad on acknowledgement check box, if desired.
7. Click OK.
The button color changes and Active Emergency appears on the button.

31.2 ADHB-4 Auxiliary Audio Control button

i
Notice!
Unless specified, the ADHB-4 and the ADHB-4 Gen 2 function the same.

The ADHB-4 Auxiliary Audio Control button allows the console operator to toggle the playing of
audio received from the ADHB-4 Gen 2’s Aux In port. When the button is in the up state, the auxiliary
audio is muted. When the button is in the down state, the selected auxiliary audio channel is played in
the designated speaker. The button can be configured by the user to either the left or right track audio.

The ADHB-4 Auxiliary Audio Control buttons are muted when a Main Mute button is pressed and un-
muted when an RX All button is pressed. The ADHB-4 Auxiliary Audio Control buttons can be added
to a crosspatch, with the limitation of one ADHB-4 Auxiliary Audio Control button per crosspatch.
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ADHB-4 Auxiliary Audio Setup page
The ADHB-4 Auxiliary Audio Setup page is used to setup which auxiliary track to use.

To open the ADHB-4 Auxiliary Audio Setup page, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select ADHB-4 Auxiliary Audio Control.

The Auxiliary Audio Setup tab appears.
5. Click the ADHB-4 Auxiliary Audio Setup tab.
The ADHB-4 Auxiliary Audio Setup page appears.

Auxiliary Track selection

Left radio button
The Left radio button indicates the ADHB-4 Auxiliary Audio Control button is controlling the Auxiliary
Audio Left track.

Right radio button
The Right radio button indicates the ADHB-4 Auxiliary Audio Control button is controlling the
Auxiliary Audio Right track.

31.3 ADHB-4 Mic Control
The ADHB-4 Mic Control allows the user to switch between two microphone control inputs when the
ADHB-4 is connected to C-Soft.

i

Notice!
The microphone source selected for the up state of the button is active when the button is in the up
position; conversely, the microphone source selected for the down state is active when the button is
depressed.

ADHB-4 Mic Control Button Setup page
When the ADHB-4 Mic Control is selected from the UI Element Function drop down menu, the
ADHB-4 Mic Control Button Setup page appears.
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The ADHB-4 Control button can operate in one of two behaviors: Toggle or Selectable.

When configured as a toggle button, C-soft uses the ADHB-4 Control button’s up or down state to
determine the active ADHB-4 input source. Upon pressing the button, C-Soft toggles between
sources configured for the Up and Down states. Each state may select one of the following:
– Controller - the headset/mic input on the main ADHB-4 unit.
– RHB1 - remote headset box 1.
– RHB2 - remote headset box 2.
– Desk Mic.

When configured as a selectable button, the ADHB-4 Mic Control Button is displayed as a Split
Button. Pressing the button displays a drop down list of options, allowing the user to select which mic
source to use.

The list is configurable by selecting the check box next to each option in the list of Available Options.

Figure 31.2: ADHB-4 Mic Control Button Setup

To add an ADHB-4 Mic Control button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element Function drop down menu, select ADHB-4 Mic Control.

The ADHB-4 Mic Control Button Setup tab appears.
5. Click on the ADHB-4 Mic Control Button Setup tab.
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6. From the ADHB-Mic Toggle States drop down menu, select one of the following for either or the
up and/or down state:
– Controller - the headset/mic input on the main ADHB-4 Unit.
– RHB1 - remote headset box 1
– RHB2 - remote headset box 2
– Desk Mic

7. Click OK.
The button color changes and ADHB-4 Mic Control appears on the button.

31.4 ADHB-4 NENA-Hold
The ADHB-4 NENA-Hold function allows the console operator to place a NENA (National Emergency
Number Association) audio line connected to an ADHB-4, on hold. If the NENA is on hold, the TX
audio is not sent to the NENA and RX audio is routed to a specified speaker. Otherwise the TX and RX
are sent from the NENA line.

To add a ADHB-4 NENA-Hold button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select ADHB-4 NENA-Hold.
5. Click OK.
The button changes color and NENA Hold appears on the button.

31.5 ADHB-4 NENA-Hook Control function
The ADHB-4 NENA-Hook Control function allows the console operator to change the NENA phone
line logic that is connected to an ADHB-4, between ON or OFF-Hook.

To add ADHB-4 NENA-Hook Control button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select ADHB-4 NENA-Hook Control.
5. Click OK.
The button changes color and NENA On Hook Control appears on the button

31.6 ADHB-4 NENA-Indication
The ADHB-4 NENA-Indication function indicates the current on- or offhook state of a NENA phone
line connected to an ADHB-4. A speaker icon appears on the button to indicate audio routing for the
NENA line.
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i
Notice!
If the NENA Mute button is clicked (for example, line is muted) the mute icon appears on the NENA
Indication button.

To add NENA-Indication button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select ADHB-4 NENA-Indication.
5. Click OK.
The button changes color and NENA Indication appears on the button.

31.7 ADHB-4 NENA-Mute
The ADHB-4 NENA-Mute function allows the console operator to mute the RX audio of a NENA
phone line.

To add a NENA-Mute button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select ADHB-4 NENA-Mute.
5. Click OK.
The button changes color and NENA Mute appears on the button.

31.8 ADHB-4 Select Speaker Control
The ADHB-4 Select Speaker Control allows the user to turn the selected speaker on and off when
the headset is connected.

To add an ADHB-4 Select Speaker Control button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select ADHB-4 Select Speaker Control.
5. Click OK.
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The button color changes and Speaker Off appears on the button.

31.9 Alert
The Alert function allows the console operator to send a tone to all selected lines.

In C-Soft Runtime, if PTT is not active when an Alert button is pressed, the PTT button is
automatically activated to key the remote radios before the tones are generated.

Alert Setup page
When the Alert function is selected from the UI Element Function drop down menu, the Alert Setup
page appears. Refer to the Figure below.

Figure 31.3: Alert Setup Page - UI Element Setup

Tone Type group box
The Tone Type group box identifies the type of tone to play. When a selection is made, the fields
necessary to enter the setup information for the tone type are enabled on the page.

Tone radio button
The Tone radio button indicates a single steady tone is used as an alert tone.

To add a tone alert button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select Alert.

The Alert Setup tab appears.
5. Click the Alert Setup tab.

The Alert Setup page appears.
6. In the Tone Type group box, select the Tone radio button.
7. In the Low Frequency field, enter the frequency (in Hz).
8. In the Tone Level field, enter the tone level (in dB).
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9. Click OK.
The button changes color and Alert appears on the button.

Pulsed Tone radio button
The Pulsed Tone radio button indicates a pulsed tone is used as an alert tone.

To add a Pulsed Tone alert button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select Alert.

The Alert Setup tab appears.
5. Click the Alert Setup tab.

The Alert Setup page appears.
6. From the Tone Type group box, select the Pulsed Tone radio button.
7. In the Low Frequency field, enter the frequency (in Hz).
8. In the Low/On Duration field enter the duration (in ms).
9. In the Hi/Off Duration field, enter the duration in ms.
10. From the Tone Level field, enter the tone level (in dB).
11. Click OK.
The button changes color and Alert appears on the button.

Hi-Lo radio button
The Hi-Lo radio button indicates a Hi-Lo warble is used as an alert tone.

To add a Hi-Lo alert button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select Alert.

The Alert Setup tab appears.
5. Click the Alert Setup tab.

The Alert Setup page appears.
6. From the Tone Type group box, select the Hi-Lo radio button.
7. In the Low Frequency field, enter the frequency (in Hz).
8. In the Low/On Duration field, enter a duration (in ms).
9. In the Hi Frequency field, enter a frequency (in Hz).
10. In the Hi/Off Duration field, enter the duration (in ms).
11. From the Tone Level field, enter the tone level (in dB).
12. Click OK.
The button changes color and Alert appears on the button.
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Low Frequency field
The Low Frequency field identifies the frequency of the low tones sent when the button is pressed.

The range for this field is 0 to 3000Hz.

Low/On Duration field
The Low/On Duration field identifies the duration at which the frequency is played.

The range for this field is 0 to 2000ms.

Hi Frequency field
The Hi Frequency field identifies the frequency of the high tones sent when the button is pressed.

The range for this field is 0 to 3000Hz.

Hi/Off Duration field
The Hi/Off Duration field identifies the duration at which the frequency is stopped.

The range for this field is 0 to 2000ms.

Tone Level field
The Tone Level field identifies the relative change allowable in the level of the tone generated.

The range for this field is -30 to 0dB.

31.10 Annunciation
The Annunciation function allows the console operator to send a pre-recorded .wav file to radio users.
When clicked the .wav file waits for all console TX and RX traffic to clear before sending the recording.
If multiple annunciation buttons are clicked, the .wav files are sent in the order they were clicked.

Annunciation Setup page
When the Annunciation function is selected from the UI Element drop down menu the Annunciation
Setup page appears.
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Figure 31.4: Annunciation Setup Page - UI Element Setup

Annunciation Setup group box

File Path field
The File Path field is used to specify the path for the .wav file recording. When preparing the .wav file,
ensure the file is saved with a 16-bit, 8.000kHz sample rate.

i
Notice!
We recommend using Audacity, an open source software application (http://
audacity.sourceforge.net/), to make changes to your .wav files.

Browse button
The Browse button is used to browse for and select the .wav file to be used.

Level field
The Level field indicates the relative level change, in dB, for the .wav file.

The range for this field is -30dB to 10dB.

Send on Selected Lines check box
The Send on Selected check box indicates the console operator can select which line(s) the .wav file
can be sent on.

If unselected, the .wav file is sent only on the line associated to the UI Element button currently being
configured. Otherwise, the .wav file is sent to all selected lines.
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Frequency drop down menu
The Frequency drop down menu is used to select the frequency for the Annunciation. This field
contains all the frequencies defined for “Frequency Parameters window, page 68”.

Stay Selected After Annunciation check box
The Stay Selected After Annunciation check box indicates the line used for the annunciation is
selected after the annunciation ends and unselect all other lines.

i
Notice!
This setting does not change the Select state of the line when the line is in a crosspatch.

Relay Setup group box

Active Relay With Annunciation check box
The Active Relay With Annunciation check box indicates a configured relay activates when an
annunciation is sent.

Relay Destination group box
The Relay Destination radio buttons identify the relay to be controlled. When a selection is made, the
fields necessary to enter the setup information for the relay are enabled.

ADHB-4 Settings group box
The ADHB-4 Settings radio buttons identify which ADHB-4 relay is activated when the Annunciation
is sent.

None radio button
The None radio button indicates none of the ADHB-4 relays is activated.

Relay 1 radio button
The Relay1 radio button indicates the first relay in the ADHB-4 is being controlled.

Relay 2 radio button
The Relay 2 radio button indicates the second relay in the ADHB-4 is being controlled.

NEO Settings group box
The NEO Settings field identifies the IP Address and the relay, if any, for the NEO-10.

IP field
The IP field identifies the IP Address of the NEO-10.

Relay drop down menu
The Relay drop down menu is used to select the desired relay.

Available selections for this field are None, Port 1, Port 2, Port 3, Port 4, Port 5, Port 6, Port 7, Port 8,
Port 9 and Port 10.

Active Duration field
The Active Duration field is used to enter the length of time, in ms, the relay remains active from the
start of the Annunciation.
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The range for this field is 300-3000ms.

31.11 Auto-Dial
The Auto-Dial function allows the console operator to quickly dial a pre-defined number.

Auto-Dial String Entry page
When the Auto-Dial String Entry function is selected from the UI Element drop down menu the Auto-
Dial String Entry page appears. Refer to the Figure below.

Figure 31.5: Auto-Dial String Entry Page - UI Element Setup

To add an Auto-Dial button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select Auto-Dial.

The Auto-Dial String Entry tab appears.
5. Click the Auto-Dial String Entry tab.

The Auto-Dial String Entry page appears.
6. In the Enter Dial String field, enter the Auto-Dial number for the button.

NOTE: Commas entered in this field add a 2 second delay.
7. Click OK.
The color of the button changes and Dial appears on the button.

Enter Dial String field
The Enter Dial String field indicates the number to dial when the button is clicked in C-Soft Runtime.

This field can contain up to 16 characters.

Tone Standard group box

DTMF radio button
The DTMF radio button indicates DTMF tones are transmitted to place the call.
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Knox radio button
The Knox radio button indicates Knox tones are transmitted to place the call.

31.12 Backup Line
The Backup Line function forces the line to route packets to and from either the primary or secondary
radio interface. If the ping routine fails to receive a reply from the Base Radio IP, it automatically
switches to the Backup IP settings specified in the Per Line Parameters window.

In C-Soft Runtime, the button changes to show the current condition. If there is a failure on both the
primary and secondary radio interfaces, LINK FAIL is displayed on the Select button.

i
Notice!
When the Backup Line function is selected, a line must be selected from the Line to Associate
Function With drop down menu.

Backup Control Line Setup page
When the Backup Line function is selected from the UI Element drop down menu, the Backup Control
Line Setup page appears. Refer to the Figure below.

Figure 31.6: Backup Control Line Setup Page - UI Element Setup

Allow User to Switch Primary/Backup check box
The Allow User to Switch Primary/Backup check box indicates the console operator is allowed to
manually switch between the primary and secondary radios. Otherwise, the button functions as an
indicator only, and the console operator cannot control the radio in use.

i
Notice!
The C-Soft program needs to be restarted to reset from the backup radio to the primary radio.

To add a Backup Line button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.



234 en | UI Element Functions configuration C-Soft 8.500

2025-08 | 16 | F.01U.218.561 Technical Manual Bosch Security Systems, LLC

4. From the UI Element drop down menu, select Backup Line.
The Backup Control Line Setup tab appears.

5. From the Line to Associate Function With drop down menu, select the line to setup the backup
control.

6. Click the Backup Control Line Setup tab.
The Backup Control Line Setup page appears.

7. Select the Allow User To Switch Primary/Backup check box, if desired.
8. Click OK.
The button changes color and Primary appears on the button.

31.13 Call List Window
The Call List Window function creates a button used to view a list of User IDs.

In C-Soft Runtime, if the console operator clicks the Call List button, the Call List window for the
selected line, shown in the Figure below, appears. From this window, the user can make outgoing calls
and send status messages based upon programming setup. The Call List displays generic, iDEN, and
phone type users and groups.

To add a call list button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select Call List.
5. Click OK.
The color of the button changes and Call List appears on the button.

31.13.1 Call List window
The Call List window, shown in the Figure below, is used to view and select from a list of IDs. Default
messages are configured by the console administrator and assigned to the buttons on the bottom of
the window.
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Figure 31.7: Call List Window - C-Soft Runtime

ID Type drop down menu
The ID Type drop down menu is used to select a sort type for the list.

Available selections for this field are:
– Alias - Select Alias from the menu to sort the User IDs by alias in ascending alphabetical order.
– ID - Select ID from the menu to sort the User IDs by ID number in ascending numerical order. The

selected ID type determines the User ID drop down menu entries.

User ID drop down menu
The User ID drop down menu is used to select a user ID for placing a call. Either the alias or the ID
number appears in the menu depending on the ID Type drop down menu selection. Alternatively, the
status can be selected from the list at the bottom of the window.

Filters drop down menu
The Filters drop down menu is used to select a filter from the list. When selected, the list populates
with users assigned to the filter by the console administrator.

Available selections for this field are:
– No Filter - Displays a complete list of user IDs.
– User-defined System Filter - Displays only user IDs belonging to the filter.

Status field
The Status field indicates the currently selected status. If no status is selected, No Status appears in
the field.
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Set Status button
The Set Status button is used to select a status to send. When clicked, the Status List window
appears. Refer to the Figure below.

To view the Call List, do the following:
1. Click Call List.
2. From the Filter drop down menu, select a filter to sort the list.

OR
Select No Filter.

To select a user ID to place a call to, do the following:
1. Select the line you want to place the call from.
2. Click Call List.

The Call List window appears.
3. From the Filter drop down menu, select a filter to sort the list.

OR
Select No Filter.

4. From the User ID drop down menu, select an alias or user ID.
The selected user ID in the call list is highlighted.

5. Click Done.
If a password is required to send the status ID, the Password Entry window appears.

6. Using the monitor keypad or your keyboard, enter the password.
For each character you enter, asterisks fill the empty field at the top of the window.
OR 
If the password is unknown, click Cancel.
The Password Window closes.

7. Click Done.
The Password Entry and Status List windows close and the selected status’s alias appears in the
Status Message field or, if the password is incorrectly entered, an error message appears.

To send a status ID from the Call List window in C-Soft Runtime, do the following:
1. While in C-Soft Runtime, select the line you want to place the call from.
2. Select a Call List button.

The Call List window appears.
3. From the ID Type drop down menu, select an alias or an ID number.

The selected User ID in the User List is highlighted.
4. Select Set Status.

The Status List window appears.
5. From the ID type drop down menu, sort the list by alias or status ID number.

The list is sorted depending on the selected type.
6. From the Status drop down menu, select a status ID to send.

The selected status ID is highlighted.
OR
From the status ID list, select a status ID to send.
The selected status ID is highlighted.

7. Click Done.
If a password is required to send the status ID, the Password Entry window appears.
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8. Using the monitor keypad or your keyboard, enter the password.
For each character you enter, asterisks fill the empty field at the top of the window.

9. Click Enter.
The Password Entry window closes and the selected status’s alias appears in the Status
Message field. If the password is incorrectly entered, an error message appears.
OR
Click Cancel.

10. Click a Call button to place the call.
The message is sent and a confirmation or error message appears in the dispatching status bar.

11. Click Done to close the window.

Call (1-10) buttons
The Call (1-10) buttons are used to place user-defined calls configured in the 5-6 Tone/DTMF ANI
system type, page 79. The labels configured on the 5/6 Tone/DTMF ANI Setup page appear on these
buttons in the Call List window.

i
Notice!
The Call1-Call10 buttons may have different labels assigned by the console administrator.

To place a call from the Call List window, do the following:
1. Select an ID from the list.

Available call buttons on the bottom of the window become active.
2. Select a call button.
The call is placed.

Done button
The Done button is used to close the Call List window.

31.13.2 Status List window
The Status List window, shown in the Figure below, is used to select from a list of preprogrammed
status IDs. When a status ID is selected and the window is closed, the selected status appears in the
Status field located on the Status List window.
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Figure 31.8: Status List Window

ID Type drop down menu
The ID Type drop down menu is used to select a sort type for the list.

Available selections for this field are:
– Alias - Selecting Alias from the menu, sorts the status IDs by alias in alphabetical order.
– Status ID - Selecting ID from the menu, sorts the status IDs by ID number in ascending numerical

order.

Status drop down menu
The Status drop down menu is used to select the status to send. Either the alias or the ID number
appear in the list and is determined by the selection in the ID Type drop down menu. Alternatively, the
status can be selected from the list at the bottom of the window.

Refer to Call 1-10 Buttons on the “Call List window, page 234” or to “Per Line Call History Setup
Page” on “Per Line Call History, page 335” to continue with sending a message to the selected ID.
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Cancel button
The Cancel button discards any changes made and closes the window.

Enter button
The Enter button is used to close the Status List window.

Refer to
– Call List window, page 234

31.14 Call Priority button
The Call Priority button is used to set the transmit call priority for calls on AIS lines sent from the
consoles.

There are five levels of priority:
– Off (0)
– Low (1)
– Normal (2)
– High (3)
– Emergency - generates an emergency response on the radios

By default, all calls are set to a priority of Off (0).
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31.15 Call Queue window
The Call Queue window contains a list of calls that require a response from the dispatcher. The status
of individual calls is updated across all consoles as dispatchers answer and complete calls.

Signalling/ Call
Type

Call Alert Group Call Private Call Select Call Group Status

5/6 Tone,
DTMF

N/A Yes N/A Yes N/A

Fleet Sync N/A Yes Yes Yes N/A

Telex-Seriala Yesa Yesa Yesa Yesa N/A

MDC-1200 Yes Yes Yes N/A N/A

MOTOTRBO Yes Yes Yes N/A N/A

NEXEDGE
Direct IP

Yes Yes Yes Yes Yes

AIS Yes Yes Yes N/A N/A

Telex-
Enhanced ANI

Yes Yes Yes Yes N/A

a. support varies based on attached mobile

The Call Queue Window Setup page is used to configure the Call Queue Window.
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31.15.1 Call Queue Setup page
Event Selection group box
The Event Selection group box allows users to select call types to be added to the call queue window.
When the C-Soft console receives one of the selected radio call events, an entry is created in the call
queue window.

Call Alert check box
The Call Alert check box indicates call alerts can be added to the call queue window.

Group Call check box
The Group Call check box indicates group calls can be added to the call queue window.

Private and Selective Call check box
The Private Call check box indicates private and selective calls can be added to the call queue
window.

Group Statuses check box
The Group Statuses check box indicates group statuses can be added to the call queue window.

Behavior group box

Automatically Populate Keypad on Answer check box
The Automatically Populate Keypad on Answer check box indicates the user ID information for a call
entry is automatically added to the User Entry field in the Keypad control when the call is answered. A
call is answered when the Answer button is clicked.

Play Audible Alert for Waiting Entries
The Play Audible Alert for Waiting Entries check box indicates an audible alert is played on Speaker
1 when receiving a new call queue event. The audible alert serves as a notification, and is played each
time a call event is added to the Call Queue Window.

Remove Completed Entries from Window
The Remove Completed Entries from Window check box indicates call entries with a call state of
Completed are removed from the Call Queue window. A Call entry is removed from the window once
the Clear button is clicked.

Event Priority group box
The Event Priority group box is used to configure how call queue events are ordered in the Call Queue
Window.

Time Event Received radio button
The Time Event Received radio button indicates the incoming call events are sorted by the time the
event was received, with the most recently received events being displayed at the top of the window.
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Event Status ID - Ascending
The Event Status ID - Ascending radio button indicates incoming call events are sorted by the value
of the event’s Status ID. An event with a lower numbered status ID will be displayed above an event
with a higher status ID (i.e. Status #1 will be shown above Status #2).

Event Status ID - Descending
The Event Status ID - Descending radio button indicates incoming call events are sorted by the value
of the event’s Status ID. An event with a higher numbered status ID will be displayed above an event
with a higher status ID (i.e. Status #2 will be shown above Status #1).

Window Appearance group box

Maximum Number of Visible Entries field
The Maximum Number of Visible Entries field is used to enter and identify the number of call entries
saved in the call queue window. Once the maximum number has been reached the last call entry is
removed from the end of the list.

The range for this field is 1 to 50.

Set Font button
The Set Font button, when selected, opens the Font window. The Font window is used to select a
font type and font size to use for the call queue window. When the format is changed, a preview of
the text appears in the Sample field.

Figure 31.9: Font Window

31.15.2 Call Queue Columns page
The Call Queue Window Setup page is used to configure which columns are visible in the Call Queue
Window.
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Column Setup group box
The Column Setup group box allows users to determine which columns are visible in the Call Queue
window. The respective column will be displayed in the Call Queue window if checked and hidden if
unchecked.

Call State check box
The Call State check box is used to add a call state column to the Call Queue window.

The possible call states are:
– Waiting
– Processing
– Complete

Console ID check box
The Console ID check box is used to add a console ID column to the Call Queue window.

Date check box
The Date check box is used to add a date column to the Call Queue window.

Frequency check box
The Frequency check box is used to add a frequency column to the Call Queue window.

Line Name check box
The Line Name check box is used to add a line name column to the Call Queue window.
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Status check box
The Status check box is used to add a status column to the Call Queue window.

Time check box
The Time check box is used to add a time column to the Call Queue window.

User ID check box
The User ID check box is used to add a user ID column to the Call Queue window.

31.15.3 Group Statuses page
The Group Statuses page is used to configure which statuses trigger an entry in the Call Queue
Window. The Group Statuses page is visible when the Group Statuses check box is checked in the
Event Selection group box in the Call Queue Window Setup page.

i
Notice!
A maximum of 20 statuses can be configured for the Call Queue Window.

Available field
The Available field displays all statuses in the system. This list is used to select a status to add to the
Enabled field.
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Enabled field
The Enabled field displays statuses which will trigger an entry in the Call Queue Window.

Move Right button
The Arrow Right button is used to move statuses from the Available field to the Enabled field.

Move Left button
The Arrow Left button is used to move statuses from the Enabled field to the Available field.

31.15.4 Call Queue window
The Call Queue window is used to view calls added to the call queue. In C-Soft Runtime, click the Call
Queue Window button to open the Call Queue window. This window contains a Call Queue list. You
can resize and move this window, as needed.

Figure 31.10: Call Queue Window

Answer button
The Answer button is used to change the call entry status from Waiting to Processing.

Clear button
The Clear button is used to change the call entry status from Processing to Complete.

Done button
The Done button is used to close the Call Queue window.

To use the Call Queue Window in C-Soft Runtime, do the following:
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1. Select the call entry in the list.

2. Click the Answer button.

Note:
– Incoming calls are added to the Call Queue window. Call entries have a status of Waiting until

answered by a dispatcher.
– Selecting the call entry causes the background color of the call entry to change to the selected

color configured in Microsoft Windows.
– After the call has been answered, the call status updates to Processing. After a call has been

answered, any dispatcher on a parallel console position can clear the call entry. Dispatchers on
parallel console positions can determine the dispatcher who answers and clears a particular call
by viewing the Console ID field for the call entry.

To clear a call, do the following:
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1. Select the call entry in the list.

2. Click the Clear button.
NOTE: Selecting the call entry causes the background color of the call entry to change to the
selected color configured in Microsoft Windows.

The call event is complete. If the Remove Completed Entries from Window check box is unchecked,
the call entry remains on the screen until the maximum number of viewable entries (configured in C-
Soft Designer) is reached.

31.16 Crosspatch
The Crosspatch function allows the console operator to connect two or more radios/phone lines,
enabling different lines to talk to other lines configured as full-duplex become simplex in operation
when placed into a crosspatch.
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i
Notice!
Only the console creating the crosspatch is able to clear the crosspatch. All other consoles display X-
PATCH on lines in a patch group.

Patch Group page
When the Crosspatch function is selected from the UI Element drop down menu, the Patch Group
page appears. Refer to the Figure below.

Figure 31.11: Patch Group Page - UI Element Setup

To add a Crosspatch button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select Crosspatch.

The Patch Group tab appears.
5. Click the Patch Group tab.

The Patch Group page appears.
6. From the Select Patch Group drop down menu, select the number of the crosspatch group

(1-30).
7. Click OK.
The color of the button changes and Patch appears on the button.

31.17 Crosspatch Block
The Crosspatch Block function allows a particular crosspatch line to be blocked from transmitting.

EXAMPLE: If the line is stuck in receive mode due to noise, that line can be blocked, releasing its
control of the crosspatch. After the line completes a transmit cycle, then it is eligible to transmit/
receive as part of the patch.

Patch Group page
When the Crosspatch function is selected from the UI Element drop down menu, the Patch Group
page appears. Refer to the Figure below.
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To add a Patch Block button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select Crosspatch Block.

The Patch Group tab appears.
5. Click the Patch Group tab.

The Patch Group page appears.
6. From the Select Patch Group drop down menu, select the crosspatch group number.
7. Click OK.
The color of the button changes and a Patch Block button appears in the console window.

31.18 Crosspatch Clear
The Crosspatch Clear function allows the console operator to drop the patch for the crosspatch
group.

Patch Group page
When the Crosspatch function is selected from the UI Element drop down menu, the Patch Group
page appears. Refer to the Figure below.

To add a Patch Clear button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select Crosspatch Clear.

The Patch Group tab appears.
5. Click the Patch Group tab.

The Patch Group page appears.
6. From the Select Patch Group drop down menu, select the number of the crosspatch group.
7. Click OK.
The color of the button changes and Patch Clear appears on the button.

31.19 Crosspatch Programmed
The Crosspatch Programmed function allows the console operator to create a crosspatch on a pre-
defined group of lines.
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i
Notice!
Telex recommends you assign a unique color to this button because it is applied to all lines in the
crosspatch.

Line Group page
When the Crosspatch Programmed function is selected from the UI Element drop down menu, the
Line Group page appears. Refer to the Figure below.

Figure 31.12: Line Group Page - UI Element Setup

Select Lines for Group field
The Select Lines for Group field contains a list of all the lines configured on “Per Line Parameters
window, page 61”. Selecting a line from this list assigns the line to the group.

Group Patch Number drop down menu
The Group Patch Number drop down menu is used to assign a unique crosspatch group number to
the selected line.

Autostart Crosspatch check box
The Autostart Crosspatch check box indicates the crosspatch is automatically created when the C-
Soft program is started.

To add a Crosspatch Programmed button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
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4. From the UI Element drop down menu, select Crosspatch Programmed.
The Line Group tab appears.

5. Click the Line Group tab.
The Line Group page appears.

6. On the Line Group page, select the line(s) from the Select Lines for Group field.
7. From the Group Patch Number drop down menu, select the group patch number.
8. From the Options field, select the Autostart Crosspatch check box to automatically start the

crosspatch, if desired.
9. Click OK.
The color of the button changes and Preset Patch appears on the button.

i
Notice!
Autostart Crosspatch does not work for Phone or SIP lines.

Refer to
– Per Line Parameters window, page 61

31.20 Crosspatch PTT
The Crosspatch PTT function allows the console operator to transmit audio to all lines included in the
crosspatch.

Patch Group page
When the Crosspatch PTT function is selected from the UI Element drop down menu, the Patch
Group page appears. Refer to the Figure on “Crosspatch, page 247”.

To add a Crosspatch PTT button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select Crosspatch PTT.

The Patch Group tab appears.
5. Click the Patch Group tab.

The Patch Group page appears.
6. From the Select Patch Group drop down menu, select the number of the crosspatch group.
7. Click OK.
The color of the button changes and Crosspatch PTT appears on the button.

Refer to
– Crosspatch, page 247
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31.21 Dial
The Dial function dials the user selected in the keypad. For more information on the Keypad Module,
refer to “Dial” on page 234.

To add a Dial button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select Dial.
5. Click OK.
The color of the button changes and Dial appears on the button.

31.22 DTMF Digit
The DTMF Digit function adds one digit of a DTMF keypad. Multiple buttons can be added to the
console to form a DTMF keypad. All 16 digits are supported.

DTMF Digit page
When the DTMF Digit function is selected from the UI Element drop down menu, the DTMF Digit
page appears. Refer to the Figure below.

Figure 31.13: DTMF Digit Page - UI Element Setup

DTMF Digit drop down menu
The DTMF Digit drop down menu provides a list of numbers and letters for the DTMF keypad.

This range for this field is 0-9 or A-D, # and *.

Note:
– Each digit must be assigned to its own button.
– When creating a telephone keypad, the corresponding letters for the keypad are automatically

inserted.

In C-Soft Runtime, if a DTMF digit button is clicked, the digit is sent to all selected lines during a PTT
operation, or it generates its own PTT if clicked outside of a PTT operation.
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To assign a digit to a button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select DTMF Digit.

The DTMF Digit tab appears.
5. Click the DTMF Digit tab.

The DTMF Digit page appears.
6. From the DTMF Digit drop down menu, select the digit you want to appear on the button.
7. Click OK.
The color of the button changes and the selected number (or letter) appears on the button.

31.23 Emergency ACK
The Emergency ACK function creates a button to indicate the emergency is acknowledged and stops
the Select buttons blinking.

i
Notice!
When the Emergency ACK function is selected, a line must be selected from the Line to Associate
Function With drop down menu.

In C-Soft Runtime, if an emergency signal is received, the C-Soft program sends an emergency Hi-Lo
tone to the selected speaker to notify the console operator. In addition, the Select button for the line
that received the emergency call blinks.

To add an Emergency ACK button, do the following:
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1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button. 
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select the Emergency ACK button.
5. From the Line to Associate Function With drop down menu, select the desired line to associate

with this function.
6. Click OK.
The color of the button changes and Emergency ACK appears on the button.

31.24 Emergency Clear
The Emergency Clear function stops the Hi-Lo tone from playing on the selected speaker.

To add an Emergency Clear button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select Emergency Clear.
5. Click OK.
The color of the button changes and Emergency Clear appears on the button.

31.25 Emergency History Window
The Emergency History Window function creates a button to access the emergency call history list.

In C-Soft Runtime, if the Emergency History window button is clicked, the Emergency History window
appears. From this window, you can view all emergencies, cleared emergencies, and acknowledged
emergencies.

To add an Emergency History Window button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select Emergency History Window.
5. Click OK.
The color of the button changes and Emergency History appears on the button.
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31.26 Encryption
The Encryption function allows the console operator to selectively turn on and off encryption message
sent to an IP-223 or IP-224.

i
Notice!
When the Encryption function is selected, a line must be selected from the Line to Associate Function
With drop down menu.

Encryption Setup page
When the Encryption function is selected, the Encryption Setup page appears, shown in the Figure
below.

Figure 31.14: Encryption Setup Page - UI Element Setup

Default Secure check box
The Default Secure check box indicates encryption is enabled when C-Soft boots up.

To configure encryption on a line, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select Encryption.
1. From the Line to Associate Function With drop down menu, select the desired line to associate

with this function.
2. Click OK.
The color of the button changes and Clear appears on the button.

31.27 Event Logger
The Event Logger function opens a window that displays all the messages written to the Event Log
file viewable by the dispatcher.
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Note:
– The Event Logger window only displays log messages if logging is enabled.
– To set the log level and which level of logging messages to record, see “Logging Setup Group

Box”.

To add an Event Logger button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select Event Logger.
5. Click OK.
A button with Event Logger on it appears.

31.28 FleetSync
The FleetSync function creates a button to open the FleetSync Dispatching window, shown in the
Figure in “FleetSync Dispatching window, page 257”.

In C-Soft Runtime, when the window is open the user can view the system list, call history and status
history, send status IDs, voice messages and data messages, select groups and individuals to place
calls.

FleetSync Setup page
When the FleetSync function is selected from the UI element drop down menu, the FleetSync Setup
page appears, shown in the Figure below.

Figure 31.15: FleetSync Setup Page - UI Element Setup

Console Requests group box

Timeout field
The Timeout field is used to configure the amount of time, in seconds, the console waits after sending
a status request command before indicating a response was never received.

The range for this field is 1 to 10 seconds.

To add a FleetSync button, do the following:
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1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button. 
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select FleetSync.
5. Click OK.
A button with FleetSync on it appears.

Refer to
– FleetSync Dispatching window, page 257

31.28.1 FleetSync Dispatching window
The FleetSync Dispatching window is used by the console operator in C-Soft Runtime to place calls,
view call history, and send status and text messages. Console action feedback is provided in the
Dispatching Status bar.

Figure 31.16: FleetSync Dispatching Window

System Type drop down menu
The System Type drop down menu is used to change from the currently selected system to another
system in the console position.

The default systems included in the drop down menu depend on the currently selected line’s
configuration.
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Up to 200 systems can be created.

System List field
The System List field populates with components that belong to the system currently selected from
the System drop down menu. Filters components are listed next in the hierarchy. When a filter
component is expanded, individual unit and fleet components are visible.

Systems can be configured, by the console admin, to display filters only. In that case, only components
affiliated with a filter, shown in the Figure below, appear in the filter list. Otherwise, all components,
including components with deny icons (permission to place calls is denied), shown in the Figure
above, appear in the list.

Figure 31.17: System Displays Only Filters Example

Icon Type Description

Filter The Filter icon indicates the component is a filter. Filters are used to group,
sort, and label the components contained in the filter, refer to the Figure
above.

To view or hide filters, do one of the following:
– Click the expand button to view components. 
– Click the collapse button to hide components. 

Allow The Allow icon indicates the component is available for selection.

The console operator can place calls and send status and text messages to
these components, refer to the Figure above.
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Deny The Deny icon indicates the component does not allow broadcast calls, when
a system is tagged, or, does not allow interfleet calls when Fleets or Units are
tagged, refer to the Figure above.

System List flyout menu
The System List flyout menu, shown in the Figure below, is a quick method of accessing the Select
Type commands also available in the Data Messaging Group Box.

Available selections for this field are Status, Text Messages, Select Calls and Request Status.

Figure 31.18: System List Flyout Menu

To access the System List flyout menu, do the following:
1. In the System List, right-click the unit or group to send the call or message to.

The System List flyout menu appears.
OR
In the System List, right-click the system to send the call or message to.
The System List flyout menu appears.

2. Click Status.
OR
Click Text Message.
OR
Click Select Call.
OR
Click Status Request.

Reference
– For more information, refer to “Status Message Radio Button” on “Select Type Group Box”.
– For more information, refer to “Text Message Radio Button” on “Select Type Group Box”.
– For more information, refer to “Select Call Radio Button” on “Select Type Group Box”.
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– For more information, refer to “Request Status Radio Button” on “Select Type Group Box”.

Selected Items page
The Selected Items page is used to view the currently selected component’s ID information. The
selected item list is used to determine where the call or status message is sent.

Selection of only one component per system is allowed. Grayed out items with deny icon tags are not
available for selection.

For more information, refer to “Manual Select Group Box”.

To add a component’s ID to the Selected Items page, do the following:
1. In the System list field, select the component.

The component is highlighted.
2. Click Add to Selected.
The item appears in the list.

To remove an ID from the Selected Items page, do the following:
1. Right-click the unwanted component.
2. Click Remove Item.
The item disappears from the list.

Manual Select group box
The Manual Select group box is used to manually enter Fleet and User ID numbers for placing calls,
sending status messages and text messages.

Fleet ID field
The Fleet ID field is used to enter the Fleet ID portion of the ID number for placing and sending
interfleet calls and messages. The Fleet ID field is populated, by default, with the Fleet ID when the
system is selected and broadcast calls are allowed on the line.
– If interfleet calls are not allowed on the selected line, the Fleet ID field is not editable for any

component. It is possible, however, to place an individual intrafleet call manually. The selected
line’s Fleet ID-grayed out-is added on to the unit ID number you enter manually.

– If a Fleet ID and User ID are both 0, then the console displays the following message: Cannot add
a system! Allow Broadcast Call option is disabled, appears.

User ID field
The User ID field is used to manually enter the unit ID portion of the ID number. It is used to place a
call or send a message when the ID is not available for selection from the system list.

The User ID field is also used to place broadcast calls using zeros, indicating it is a broadcast call, and
is sent to all members of the fleet.

History page
The History page is used to view past FleetSync calls and messages received by the console.
Additionally, calls or messages can be sent by selecting the ID in the history log. When selected, the
ID is added to the Selected Items page.

This list is configured by the console administrator. It can contain up to 500 IDs. For more information,
refer to “Per Line Call History Window Lines Field” on “Per Line Call History Window Lines Field”.
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Note:
– Calls are not saved to the history list if C-Soft Runtime is closed.
– The FleetSync Call History list includes calls received from parallel console positions.

Figure 31.19: History Page - FleetSync Dispatching Window

Call History View group box
The Call History View group box is used to control the log display.

All Lines radio button
The All Lines radio button is used to display all calls and messages received by the console.

Selected Line radio button
The Selected Line radio button is used to display all calls and messages received on the selected line.

Call Details group box
The Call Details group box is used to display additional call information for the currently selected ID
type.

Add to Selected button
The Add to Selected button is used to add the manually entered Fleet and Unit ID to the selected
items page. When the ID number displays in the Selected Items page, the call can be placed or
message sent.

To manually place an individual call inside the current system, do the following:
1. In C-Soft Runtime, select a line.
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2. Click the FleetSync button.
The FleetSync Dispatching window appears.The Fleet ID field is, by default, populated with the
current system’s fleet ID.

3. In the User ID field, enter the individual’s unit ID number.
4. Click Add to Selected.
The system name you are currently working with appears in the Selected Items page.

i
Notice!
The name on the FleetSync button is configured by your console administrator. FleetSync is used
generically to refer to any button configured for FleetSync functions.

To manually place an interfleet call, do the following:
1. Select a line with interfleet calls allowed.
2. Click FleetSync.

The FleetSync Dispatching window appears.
3. In the Fleet ID field, enter the individual’s fleet ID number.
4. In the User ID field, enter the individual’s unit ID number.

1. Click Add to Selected.
The system name you are currently working with appears in the Selected Items page.

To manually place a broadcast call, do the following:
1. Select a line with broadcast calls allowed.
2. Click FleetSync.

The FleetSync Dispatching window appears. The Fleet ID field contains the system Fleet ID
number, and is not editable.

3. In the System List field, select the system name.
The system name is highlighted.

4. In the Unit ID field, enter 0000.
5. Click Add to Selected.
The system name you are currently working with appears in the Selected Items page.

Note:
– Lines can be configured to allow or deny both broadcast calls or interfleet calls.
– Permission to place calls can be determined by the window’s appearance. Refer to the two

Figures below.

Icon Type Description

Deny Broadcast calls are not allowed as indicated by the deny icon. When the
system name is selected, the Selected Items page is empty and the Fleet ID
field is grayed out, refer to the Figure below.

Allow Broadcast calls are allowed as indicated by the allow icon. When the system
name is selected the ID number appears in the Selected Items page and the
Fleet ID field is active, refer to the Figure below.
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Figure 31.20: Broadcast Call Permissions

Icon Type Description

Deny Interfleet calls are not allowed as indicated by the deny icon. When the Fleet
name is selected, the Selected Items page is empty and the Fleet ID field is
grayed out, refer to the Figure below.

Allow Interfleet calls are allowed as indicated by the allow icon. When the Fleet
name is selected, the ID appears in the Selected Items page and the Fleet ID
field is active, see to the Figure below.
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Figure 31.21: Interfleet Call Permission

Status Message field
The Status Message field indicates the currently selected status message. If no status is selected, No
Status appears in the field. The Set Status button is used to change the status ID.

Set Status button
The Set Status button is used to select a status to send. When the Set Status button is clicked, the
Status List window appears. Refer to the Figure on “Status List window, page 237”.

To set the status ID, do the following:
1. Select Set Status.

The Status List window appears.
2. Select a Status ID from the list.

The ID is highlighted.
OR
From the Status drop down menu, select a Status ID.
The ID is highlighted.

3. Click Done.
The selected Status ID appears in the Status Message field.

Select Type group box
The Select Type group box is used to select the type of message or call sent when the Send button is
clicked.

Status Message radio button
The Status Message radio button indicates the currently selected status message is sent to the ID
number listed in the Selected Item page.
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To send the current status message, do the following:
1. Select the Status Message radio button.
2. Click Send.
The message is sent and a confirmation appears in the status bar.

i
Notice!
Status ID codes must be between 10 and 99. See manufacturer’s technical data for specific Status ID
codes.

Text Message radio button
The Text Message radio button indicates the current entry in the Enter Text Message text box is sent
to the ID number listed in the Selected Item page.

To send the current text message, do the following:
1. Select the Text Message radio button.
2. Click Send.
The message is sent and a confirmation appears in the status bar.

Text messages can contain up to 48 characters.

Select Call radio button
The Select Call radio button indicates a select call is placed to the current ID in the Selected Items
page.

To place a select call to the ID, do the following:
1. Select the Select Call radio button.
2. Click Send.
The message is sent and a confirmation appears in the status bar.

Request Status radio button
The Request Status radio button is used to send a request for status from the ID currently listed in the
Selected Items page.

To request a status from the ID, do the following:
1. Select the Request Status radio button.
2. Click Send.
The message is sent and a confirmation appears in the status bar.

Send button
The Send button is used to send the currently selected call, status, or message to the ID listed on the
Selected Items page. When selected, a confirmation or error message appears in the status bar at the
bottom of the window.

Done button
The Done button is used to close the FleetSync Dispatching window.
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FleetSync Dispatching window status bar
The FleetSync Dispatching window status bar, shown in Figure on “FleetSync Dispatching window,
page 257”, indicates console activity. Confirmation and error messages appear when calls, statuses, or
messages are sent.

31.29 Frequency Change
The Frequency Change function sends a burst of packets onto the Ethernet network requesting the
remote radio change to the new frequency of the selected line. Additionally, all other consoles on the
network change to display the new frequency of the radio on that particular line.

i
Notice!
When the Frequency Change function is selected, a line must be selected from the Line to Associate
Function with drop down menu.

Freq Set page
When the Frequency Change function is selected from the UI Element drop down menu, the Freq Set
page appears. Refer to the Figure below.

Figure 31.22: Freq. Set Page - UI Element Setup

Given that frequencies change, it is common to place frequency selection buttons in a popup window.
The console operator opens the popup window to change frequencies and closes the window when
they are done.

However, with the popup window closed, it becomes impossible to see exactly what frequency is
currently selected for the line. By placing the variable $FREQX$, where X represents the line number,
into the Button Up Text and Button Down Text field on the Colors page, the frequency for that line is
automatically updated on the button when it changes.



C-Soft 8.500 UI Element Functions configuration | en 267

Bosch Security Systems, LLC Technical Manual 2025-08 | 16 | F.01U.218.561

When Scannable is selected for the line, refer to “Scannable Check Box” on “Line setup options group
box”, right-click the button to display a shortcut menu that provides the console operator the ability to
add or remove this channel from the scan list.

When a frequency is in the scan list, a scan icon appears on the frequency change button. Parallel
consoles are also alerted to update their display if a frequency is added or removed from the scan list.

Select PTT Frequency drop down menu
The Select PTT Frequency drop down menu is used to select the frequency for the line. This field
contains all the frequencies configured on “Freqs Button”.

To add or change a Frequency button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the UI button.

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select Frequency Change.

The Freq Set tab appears.
5. From the Line to Associate Function With drop down menu, select the desired line to associate

with this function.
6. Click the Freq Set tab.

The Freq Set page appears.
7. From the Select PTT Frequency drop down menu, select the desired frequency for the line

selected.
8. Click OK.
The color of the button changes and FreqX (X representing the line of the frequency) appears on the
button. Also, the frequency is changed for the line.

Additions and changes can be made to the Per Line Frequency Setup window at any time. However, if
any user interface elements have been placed on the console window, the changes made to a line
must also be changed on the individual elements, if needed.

31.30 GPS Read button
The GPS Read button is used to query the current GPS coordinates of the selected radio. This
functionality is currently supported on lines using NEXEDGE or MOTOTRBO signaling only.

To query a radio of its GPS coordinates, do the following:
1. From the GPS Read drop down list, select the unit you want to send this command.

OR
If using the a Keypad, select the unit you want to send the GPS Read Request.

2. Click GPS Read.
The command is sent.

To add a GPS Read button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
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2. Right-click the None button. 
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select GPS Read.
5. Click OK.
The color of the button changes and GPS Read appears on the button.

GPS Trigger Setup page
The GPS Trigger Setup page is used to select the settings for the GPS Trigger.

31.31 GPS Trigger Off button
The GPS Trigger Off button is used to stop periodic GPS coordinate updates from the selected radio.
The functionality is currently supported on lines using NEXEDGE or MOTOTRBO signaling only.

To stop receiving periodic GPS coordinates from a radio, do the following:
1. From the GPS Trigger Time drop down menu, select the unit you want to send the GPS Trigger

Off command.
OR
If using a Keypad, select the unit you wish to send the GPS Trigger Off command.

2. Click GPS Trigger Off.
The command is sent.

To add a GPS Trigger Off button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select GPS Trigger Off.
5. Click OK.
The color of the button changes and GPS Trigger Off appears on the button.

31.32 GPS Trigger On button
The GPS Trigger On button is used to start periodic GPS coordinate updates from the selected radio.
The functionality is currently supported on lines using NEXEDGE or MOTOTRBO signaling only.

To start receiving periodic GPS coordinates from a radio, do the following:
1. From the GPS Trigger Time drop down menu, select the unit you want to send the GPS Trigger

On command.
OR
If using a Keypad, select the unit you wish to send the GPS Trigger On command.

2. Click GPS Trigger On.
The command is sent.
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GPS Trigger Setup page
When the GPS Trigger On Button function is selected from the UI Element drop down menu, the GPS
Trigger Setup page appears. See the Figure below.

GPS Trigger Time drop down menu
The GPS Trigger Time drop down menu is used to select the time duration between GPS coordinate
updates.

The time duration between GPS coordinate updates is determined by the GPS Trigger Time drop
down menu.

Figure 31.23: GPS Trigger Setup Page - UI Element Setup

Available options are:
– 30 Seconds
– 1 Minute
– 2 Minutes
– 4 Minutes
– 8 Minutes

To add a GPS Trigger On button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select GPS Trigger On.
5. Click OK.
The color of the button changes and GPS Trigger On appears on the button.

31.33 Group Programmed
The Group Programmed function allows the console operator to broadcast to a pre-defined group.
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Line Group page
When the Group Programmed function is selected from the UI Element drop down menu, the Line
Group page appears. Refer to the Figure below.

Figure 31.24: Line Group Page - UI Element Setup

Select Lines for Group field
The Select Lines for Group field contains a list of all the lines configured on “Per Line Parameters
window, page 61”. Selecting a line from this list assigns it to the group. Pressing the Group
Programmed button in the C-Soft Runtime program places the defined lines into a select condition.

To add a group programmed button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select Group Programmed.

The Line Group tab appears.
5. Click the Line Group tab.

The Line Group page appears.
6. From the Select Lines for Group field, select the line(s) for the group.
7. Click OK.
The color of the button changes and Preset Group appears on the button.

To remove a line from the Group Programmed, deselect the line.

Group Programmed Enhanced button
The Group Programmed Enhanced button allows the console operator to broadcast to a pre-defined
group of lines and frequencies. The group’s lines and transmit frequencies are configured in the Group
Programmed Enhanced setup dialog.

Up to 25 selected lines can be stored in a pre-defined group.
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i
Notice!
The Allow Programmed Group to be changed in Runtime feature is not accessible with a mouse used
on the IP-3XXX devices.

Group Programmed Enhanced Setup page
When Group Programmed Enhanced button is selected from the UI Element drop down menu, the
Group Programmed Enhanced Setup page appears. This button has the ability to configure line and
frequencies selected when the button is pressed.

To open the Group Programmed Enhanced Setup page, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select Group Programmed Enhanced.

The Group Programmed Enhanced Setup tab appears.
5. Click the Group Programmed Enhanced Setup page.

Available Lines and Frequencies group box
The Available Lines and Frequencies group box displays the list of lines and the line’s corresponding
frequencies available in the design configuration file.
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Line drop down menu
The Line drop down menu identifies the desired line to be selected.

Freq drop down menu
The Freq drop down menu identifies the desired frequency to use per selected line.

Programmed Group List
The Programmed Group List displays the list of line/frequency combinations which are selected when
the Group Programmed Enhanced button is pressed. To remove a line/frequency combination from the
list, select the desired row in the list and then click the Delete button.

Group Programmed Enhanced Options page
The Group Programmed Enhanced Options page is used to identify whether or not Programmed
Groups can be changed in Runtime by the dispatcher.

Allow Programmed Group to be changed in Runtime check box
The Allow Programmed Group to be changed in Runtime check box indicates the setup allows the
defined group to be modified by the dispatcher in C-Soft Runtime.

To edit the Group Programmed Enhanced button in Runtime, do the following:
1. Right-click the Group Programmed Enhanced button.
2. Select the Edit option.

The border of the Group Programmed Enhanced button blinks to signify the console is in Edit
mode.

3. Select or unselect lines.
4. Set the desired transmit frequency for the selected lines.
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5. Right-click the Group Programmed Enhanced button.
6. Select the Save Option.
The new group configuration is now saved to the button.

To exit Edit mode without saving, do the following:
1. Right-click the Group Programmed Enhanced button.
2. Select the Cancel option or any button other than a select or frequency control.

To clear a button’s defined group, do the following:
1. Right-click the Group Programmed Enhanced button.
2. Select the Clear option.

31.34 Group Select
The Group Select function creates a button used to create a group of users to call.

i
Notice!
Group Select Limited and Group Select buttons cannot co-exist on the same console.

To add a Group Select button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select Group Select.
5. Click OK.
The color of the button changes and Group Select appears on the button.

When the button is selected in C-Soft Runtime, a group can be defined manually.

To manually select a group of IDs to call, while in C-Soft Runtime, do the following:
1. In C-Soft Runtime, click the Group Select button.
2. Click the desired lines.

The lines are added to the group.
3. Click the Group Select button a second time.
The group clears.

31.35 Group Select Limited
The Group Select Limited function is similar to the Group Select function, except the number of lines
the console operator can select is limited.
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i
Notice!
Group Select Limited and Group Select buttons cannot co-exist on the same console.

Group Select Limited page
When the Group Select Limited function is selected from the UI element drop down menu, the Group
Select Limited page appears. Refer to the Figure below.

Figure 31.25: Group Select Limited Page - UI Element Setup

Max Number of Simultaneous Selected Lines field
The Max Number of Simultaneous Selected Lines field identifies the number of lines a console
operator can select for a group.

The range for this field is 0 to 200 lines.

To add a group select limited button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select Group Select Limited.

The Group Select Limited tab appears.
5. Click the Group Select Limited tab.

The Group Select Limited page appears.
6. From the Select Lines for Group field, enter the maximum number of line(s) for the group.
7. Click OK.
The color of the button changes and Group Limited appears on the button.

31.36 Input Indication
The Input Indication function allows the console operator to monitor an ADHB-4, NEO-10, or MQTT
inputs, as well as configure the parameters particular to an input source.
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Input Indication Setup page
When the Input Indication function is selected from the UI element drop down menu, the Input
Indication Setup page appears. Refer to the Figure below.

Figure 31.26: Input Indication Setup Page - UI Element Setup

Input Source group box
The Input Source group box identifies the input source to be monitored. When either ADHB-4, NEO,
or MQTT is selected, the fields necessary to enter the setup information for input sources are enabled.

ADHB-4 radio button
The ADHB-4 radio button indicates an ADHB-4 device is used as the input source.

NEO radio button
The NEO radio button indicates a NEO-10 is used as the input source.

MQTT radio button
The MQTT radio button indicates an MQTT device is used as the input source.

i
Notice!
MQTT functionally requires the CMS (Console Management System) to be part of the dispatch
system.

Indication of Input Change group box

Beep for check box
The Beep for check box indicates a beep sound is played when there is a change in input. When the
Beep for check box is selected, the Beep for seconds field becomes active. Otherwise, there is no beep
sound when the input changes.
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Beep for seconds field
The Beep for seconds field is used to set the amount of time, in seconds, the indicator beeps after the
input is changed. The Beep for radio button must be selected.
The range for this field is 0 to 20 seconds.

Blink for check box
The Blink for check box indicates the border of the Input Indication button blinks when an input
change is detected.

Blink for seconds field
The Blink for seconds field is used to enter the number of seconds the border of the Input Indication
button blinks after a change in input is detected.
The range for this field is 0 to 30 seconds.

Play check box
The Play check box indicates the .wav file configured for the selected annunciation button plays when
the input changes.

i

Notice!
When a system is configured with parallel consoles, only one console should be configured to play
a .wav file on input change. This prevents multiple consoles attempting to transmit the .wav file
simultaneously.

Play drop down menu
The Play drop down menu is used to select an annunciation button from a list that exist in the design
file. The .wav file format is: X:text (where X represents the line number associated with the
Annunciation button and text is the button name of the Annunciation button). When the input
changes, the .wav file is played on the line the annunciation button is configured on.
The Play check box must be selected to activate the play function.

Input Destination ADHB-4 group box
The Input Destination radio buttons identify the ADHB-4 input destination.

None radio button
The None radio button indicates there is no input indication assigned to the button or there is no
ADHB-4 connected.

Input 1 radio button
The Input 1 radio button is used to configure the Input Indication button to signal the console operator
if the first relay is currently in control of an ADHB-4.

Input 2 radio button
The Input 2 radio button is used to configure the Input Indication button to signal the console operator
if the second relay is in control of an ADHB-4.

NEO/MQTT Settings group box

IP field
The IP field identifies the IP Address of the NEO-10 or for MQTT control this is the IP address of the
system CMS server.

Input drop down menu
The Input drop down menu identifies the input port for relays.
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Available selections for this field are None and Ports 1 through 10.
If MQTT is selected as the Input Source, the Input field changes from a drop down to a number field
where the user can enter a number from 1 to 255.

MAC field
The MAC field indicates the MAC address of the MQTT device.

Polarity group box

Active High check box
The Active High check box indicates the input is set to active high. If selected, the status button
changes when the input goes to a positive (high) state.

Relay Setup group box

Active Relay With Input check box
The Active Relay With Input check box indicates a configured relay activates when the input state
changes to active.

Relay Destination group box
The Relay Destination radio buttons identify the relay to be controlled. When a selection is made, the
fields necessary to enter the setup information for the relay are enabled.

ADHB-4 Settings group box
The ADHB-4 Settings radio buttons identify which ADHB-4 relay is activated when an input is active.

None radio button
The None radio button indicates none of the ADHB-4 relays is activated.

Relay 1 radio button
The Relay1 radio button indicates the first relay in the ADHB-4 is being controlled.

Relay 2 radio button
The Relay 2 radio button indicates the second relay in the ADHB-4 is being controlled.

NEO/MQTT Settings group box
The NEO/MQTT Settings field identifies the IP Address and the relay, if any, for the NEO-10.

IP field
The IP field identifies the IP Address of the NEO-10 or for MQTT control this is the IP address of the
system CMS server.

Relay drop down menu
The Relay drop down menu is used to select the desired relay.
Available selections for this field are None and Ports 1 through 10.
If MQTT is selected as the Relay destination, the Relay field changes from a drop down to a number
field where the user can enter a number from 1 to 255.

MAC Field
The MAC field indicates the MAC address of the MQTT device.

Active Duration field
The Active Duration field is used to enter the length of time, in ms, the relay remains active after the
input state changes to active.
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The range for this field is 300-3000ms.

To configure and add an ADHB-4 Input Indications button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select Input Indication.

The Input Indication Setup tab appears.
5. Click the Input Indication Setup tab.

The Input Indication Setup page appears.
6. From the Input Source group box, select ADHB-4.

The Input Destinations group box is active.
7. From the Indication of Input Change group box, select Beep for, Blink for, and/or Play.
8. In the seconds field, enter number of seconds the beep or blink is active, if applicable.
9. From the Input Destination area, select None, Input1, or Input2.
10. From the Input drop down menu, select the desired input.
11. From the Polarity group box, select the Active High check box for active high inputs.
12. From the Relay Setup group box, select the Activate Relay with Input check box.
13. In the Relay Destination, select the ADHB-4, NEO, or MQTT radio button.

If NEO or MQTT are selected, the NEO/MQTT Settings group box becomes active. Fill in the IP
address of the NEO or the CMS server, select or enter the relay port, and enter the MAC address
of the destination device.

14. From the ADHB-4 Settings group box, select None, Relay 1 or Relay 2 radio button.
To configure and add a NEO Input Indication button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select Input Indication.

The Input Indication Setup tab appears.
5. Click the Input Indication Setup tab.

The Input Indication Setup page appears.
6. From the Input Source group box, select NEO.

The NEO Settings group box is active.
7. From the Indication of Input Change group box, select Beep for, Blink for, and/or Play.
8. In the seconds field, enter number of seconds the beep or blink is active, if applicable.
9. In the NEO/MQTT group box, enter the IP Address of the NEO.
10. From the Input drop down menu, select the desired input.
11. From the Polarity group box, select the Active High check box for active high inputs.
12. From the Relay Setup group box, select the Activate Relay with Input check box.
13. In the Relay Destination, select the ADHB-4, NEO, or MQTT radio button.

If NEO or MQTT are selected, the NEO/MQTT Settings group box becomes active. Fill in the IP
address of the NEO or the CMS server, select or enter the relay port, and enter the MAC address
of the destination device.
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14. Select the NEO radio button.
15. In the IP field, enter the IP Address of the NEO.
16. From the Relay drop down menu, select the relay port to use.
17. In the Active Duration field, enter the amount of time the relay stays active.

To configure and add an MQTT Input Indication button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select Input Indication.

The Input Indication Setup tab appears.
5. Click the Input Indication Setup tab.

The Input Indication Setup page appears.
6. From the Indication of Input Change group box, select Beep for, Blink for, and/or Play.
7. In the seconds field, enter number of seconds the beep or blink is active, if applicable.
8. In the NEO/MQTT group box, enter the IP Address of the system CMS server.
9. In the Input field, enter the source input port.
10. From the Polarity group box, select the Active High check box for active high inputs.
11. From the Relay Setup group box, select the Activate Relay with Input check box.
12. In the Relay Destination, select the ADHB-4, NEO, or MQTT radio button.

If NEO or MQTT are selected, the NEO/MQTT Settings group box becomes active. Fill in the IP
address of the NEO or the CMS server, select or enter the relay port, and enter the MAC address
of the destination device.

13. Select the MQTT radio button.
14. In the IP field, enter the IP Address of the CMS System server.
15. In the Relay field, enter the relay port to use (1 to 255).
16. Enter the MAC address of the MQTT device.
17. In the Active Duration field, enter the amount of time the relay stays active.

31.37 Instant Recall
The Instant Recall function allows the console operator to play back a predetermined amount of
receive audio only.

The recall starts with the oldest call first.

Multiple Instant Recall buttons can be placed on the console window with each button set to playback
a certain amount of audio.

The button must be held down for the complete duration of the recording time to hear all audio in
buffer.

The C-Soft program function constantly maintains a record of the last 600 seconds (or 10 minutes) of
both parallel transmit and receive audio. The recorder only records the audio when the call is active,
allowing for a long conversation to be replayed without the loss of audio.
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31.37.1 Duration page
When the Instant Recall function is selected on the UI Element Setup window, the Duration page
appears. Refer to the Figure below.

Figure 31.27: Duration Page - UI Element Setup

Audio Playback Start field
The Audio Playback Start field identifies the amount of time to record from the end of the call
backwards.

The field value can range from 0 to 600 seconds.

Audio Source drop down menu
The Audio Source drop down menu determines the source from which the audio is recorded.
Available selections for this field are:
– Select
– Unselect
– Speaker 3 [ADHB-4]
– Speaker 4 [ADHB-4]
– Speaker 5 [ADHB-4]
– Speaker 6 [ADHB-4]

Figure 31.28: Audio Source Drop Down Menu

To configure and add an Instant Recall button, do the following:
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1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button. 
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select Instant Recall.
The Duration tab appears.

5. Click the Duration tab.
The Duration page appears.

6. In the Audio Playback Start field, enter the number of seconds you want to play back audio.
7. From the Audio Source drop down menu, select the audio source to play back.
8. Click OK.
The duration and audio source are configured. The color of the button changes and IRR Select 10
appears on the button.

31.38 Instant Recall - Last Call button
The Instant Recall - Last Call button allows users to play back audio from the last received call on the
configured line.

Clicking the Last Call button prompts the audio from the last call to start playing. To stop the audio
from playing, click the Last Call button again. The Last Call button is only available for lines that have
Per Line Call Playback enabled.

To add a Last Call button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select Instant Recall - Last Call.

The Line to Associate Function With drop down menu becomes active.
5. From the Line to Associate Function With drop down menu, select the line to associate the Last

Call function.
6. Click OK.
The color of the button changes and Last Call appears on the button.

31.39 Intercom
The Intercom function allows communication between consoles without keying remote radios. The
Intercom button works just like the PTT- Main button, except additional information is included in the
transmission that prevents the generation of PTT and radio keying.

To add an Intercom button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
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2. Right-click the None button. 
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select Intercom.
5. Click OK.
The color of the button changes and Intercom appears on the button.

31.40 Intercom-Per Line
The Intercom-Per Line function allows console operators to communicate with each other without
keying up a radio connected to the line. This button is similar to the Intercom button, except it works
only on the line selected in the Line to Associate Function With field, and it does not transmit on the
selected line.

The Intercom Per Line function is usually activated on a non-priority channel so existing audio traffic is
not interrupted.

To add an Intercom-Per Line button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select Intercom-Per Line.

The Line to Associate Function With drop down menu becomes active.
5. From the Line to Associate Function With drop down menu, select the line to associate the

Intercom-Per Line function.
6. Click OK.
The color of the button changes and Intercom appears on the button.

31.41 Knox Digit
The Knox Digit function is used to assign a Knox tone to the button. These digits must be assigned to
UI elements individually.

Available selections for this field are: 1, 2, 3, 4, 5, 6, 7, 8, 9, A, B, C, D, *, and #.

To create a Knox digit button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select Knox Digit.

The Knox Digit tab appears.
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5. Click the Knox Digit tab.
6. From the Know Digit drop down menu, select a digit.
7. Click OK.
The Knox Digit button is created.

31.42 Launch Application
The Launch Application function creates a button called Launch Application.

In C-Soft Runtime, if the Launch Application button is clicked, the specified application, such as a
messaging software is started. The maximum number of Launch Application buttons in a design is 64.

31.42.1 Launch Application Setup page
When the Launch Application function is selected from the UI Element Setup window, the Launch
Application Setup page and Application Triggers page appear. Refer to the Figure below.

Figure 31.29: Launch Application Setup Page - UI Element Setup

File Path field
The File Path field displays the path to the application you want to launch. For example, F:
\RadioDispatch\CSoftDesigner.exe. You can either find the file with the browse button or enter the
path in the field.

Parameters field
The Parameters field is used to specify command line arguments to the application being started. The
parameters that can be entered are dependent on the application.

EXAMPLES:
– If the application is Internet Explorer and www.Telex.com is entered in the Parameters field, the

Telex webpage opens in Internet Explorer.
– If the application file path is Notepad, and C:\Logs\notebook.txt is entered in the Parameters field,

the notebook.txt file opens.

This field can contain up to 1024 characters.
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Browse button
The Browse button opens a Windows folder from which you can navigate to the application you want
to start with the Launch Application button.

Autostart Application check box
The Autostart Application check box indicates the application automatically starts running the
configured application when C-Soft is launched.

To create a launch application button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select Launch Application.

The Launch Application Setup tab appears.
5. Click the Launch Application Setup tab.

The Launch Application Setup page appears.
6. Click the browse button.

A Windows folder appears.
7. Navigate to the application you want to start when the Launch Application button is clicked.
8. Click OK.
The UI Properties window closes.

31.42.2 Application Triggers page
When the Launch Application function is selected from the UI Element Setup window, the Launch
Application Setup page and Application Triggers page appear. Refer to the Figure below.
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Figure 31.30: Application Triggers Page

Custom Text Message field
The Custom Text Message field is used to enter a custom text message that can be added to the
Open Application group box.

Text Message List field
The Text Message List field is used to select text message that were pre-created in Text Message ID
list.

Status List field
The Status List field is used to select statuses that were pre-created in Status Message ID. list

Add button
The Add button is used to add the selected text messages or status messages to the application
launch list.

Remove button
The Remove button is used to remove the selected text messages or status messages from the
application launch list.

Open Application field
The Open Application field displays the text messages and status messages that have been moved to
the open application list. When text messages or status messages are received that are in the
application list, the application specified on the Launch Application Setup page starts.
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OK button
The OK button saves any changes made and closes the window.

To create text message/status message application launch button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element Function drop down menu, select Launch Application.

The Launch Application Setup and Application Triggers tabs appear.
5. Click the Application Triggers tab.

The Application Triggers page appears.
6. In the Custom Text Message field, enter a custom text message that is not in the Text Message

List.
OR
From the Text Message List group box, select the text message desired to launch the designated
application.
The list of text messages are pulled from the Text Message ID List.
OR
From the Status List group box, select the status desired to launch the designated application.
The list of status messages are pulled from the Status Message ID List.

7. Click the Add button to add the text messages or status messages to the Open Applications
group box.
OR
Click the Remove button to remove the text messages or status messages from the Open
Applications group box.
IMPORTANT: Whenever the designated text/status is received in C-Soft Runtime, the
designated application launches.

8. Click OK.
The color of the button changes and Text Message Control or Status Message Control appears on the
button.

31.43 Logout
The Logout function allows dispatchers to logout of their current C-Soft Runtime session and cause
C-Soft Runtime to close and reopen the Console Sign In window. This function should be used with
the Design Management feature in Console Management System.
To create a logout button, do the following:
1. From the Insert menu, select Add Button.
2. Right-click on the new button.

The UI Element dialog opens.
3. From the UI Element function drop down menu, select Logout.
4. Click OK.
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31.44 Manual Call List
The Manual Call List function creates a button called Manual Call List. The Manual Call List window is
used to place calls by manually entering the user ID number.

In C-Soft Runtime, if the Manual Call List button is clicked, the manual call list for the selected line
appears. From this window, the user can manually send calls or status messages on the selected line
based on programming set up in “Signaling Parameters window, page 76”.

To add a Manual Call List button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select Manual Call List.
5. Click OK.
The color of the button changes and Manual Call List appears on the button.

31.44.1 Manual Call List window
The Manual Call List window is used to manually send messages, alerts and statuses. The User ID is
entered by the console operator.
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Figure 31.31: Manual Call List Window - C-Soft Runtime Application

User ID field
The User ID field is used to enter an ID number to call or send status to.

Graphic DTMF keypad
The Graphic DTMF keypad is used to enter DTMF digits to place calls and send status messages.

Clear button
The Clear button is used to clear all digits from the User ID field.

Backspace button
The Backspace button is used to backup one space to clear the last digit entered.
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Set Status button
The Set Status button is used to select from a list of preprogrammed status IDs. When a status ID is
selected and the window is closed, the selected status appears in the Status field in the Status List
window.

For more information, refer to “Status List window, page 237”.

A-F Buttons
The A-F buttons are valid digits for 5/6 Tone. Each digit corresponds to a different tone frequency.

Call (1-10) Buttons
The Call (1-10) buttons are used to place user-defined calls configured in the “5/6 Tone DTMF ANI
Setup Page” on “5-6 Tone/DTMF ANI system type, page 79”. The labels configured on the 5/6 Tone/
DTMF ANI Setup page appear on these buttons in the call list window.

To place a manual call, do the following:
1. Select a line to call from.
2. Select a Manual Call List button.

The Manual Call List window appears, refer to the Figure above.
3. Using the monitor keypad or your keyboard, enter a user ID number.

The number appears in the User ID field.
4. Press a configured call button to place the call.
The call is placed.

Done button
The Done button is used to close the Manual Call List window.

31.45 Marker Tone
The Marker Tone function controls a periodic automatic keyup of a radio channel, along with an
associated tone burst transmission for a particular line.

i
Notice!
If the Marker Tone function is selected, a line must be selected from the Line to Associate Function
With drop down menu on the Type page.

Marker Tone Setup page
When the Marker Tone function is selected from the UI Element drop down menu, the Marker Tone
Setup page appears. Refer to the Figure below.
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Figure 31.32: Marker Tone Setup Page - UI Element Setup

Tone Type group box
The Tone Type group box identifies the type of tone to play. When a selection is made, the fields
necessary to enter the setup information for that tone type are enabled on the page.

Tone radio button
The Tone radio button indicates a single steady tone is used as an alert tone.

To add a marker tone button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select Marker Tone.

The Marker Tone Setup tab appears.
5. Click the Marker Tone tab.

The Marker Tone Setup page appears.
6. In the Tone Type group box, select the Tone radio button.
7. In the Low Frequency field, enter the frequency (in Hz).
8. In the Tone Level field, enter the tone level (in dB).
9. In the Key-up Duration field, enter the duration (in ms).
10. In the Time Between Tones field, enter a time (in seconds).
11. Click OK.
The Marker Tone button is created.

Pulsed Tone radio button
The Pulsed Tone radio button indicates a pulsed tone is used as an alert tone.

To add a pulsed marker tone button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.



C-Soft 8.500 UI Element Functions configuration | en 291

Bosch Security Systems, LLC Technical Manual 2025-08 | 16 | F.01U.218.561

2. Right-click the None button. 
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select Marker Tone.
The Marker Tone Setup tab appears.

5. Click the Alert Setup tab.
The Alert Setup page appears.

6. From the Tone Type group box, select the Pulsed Tone radio button.
7. In the Low Frequency field, enter the frequency (in Hz).
8. In the Low/On Duration field enter the duration (in ms).
9. In the Hi/Off Duration field, enter the duration (in ms).
10. In the Tone Level field, enter the tone level (in dB).
11. In the Key-up Duration field, enter the duration (in ms).
12. In the Time Between Tones field, enter a time (in seconds).
13. Click OK.
The Marker Tone button is created.

Hi-Lo radio button
The Hi-Lo radio button indicates a Hi-Lo warble is used as an alert tone.

To add a hi-lo marker tone button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select Marker Tone.

The Marker Tone Setup tab appears.
5. Click the Marker Tone tab.

The Marker Tone Setup page appears.
6. From the Tone Type group box, select the Hi-Lo radio button.
7. In the Low Frequency field, enter the frequency (in Hz).
8. In the Low/On Duration field, enter a duration (in ms).
9. In the Hi Frequency field, enter a frequency (in Hz).
10. In the Hi/Off Duration field, enter the duration (in ms).
11. In the Tone Level field, enter the tone level (in dB).
12. In the Key-up Duration field, enter the duration (in ms).
13. In the Time Between Tones field, enter a time (in seconds).
14. Click OK.
The Marker Tone button is created.

Low Frequency field
The Low Frequency field identifies the frequency, in Hz, of the low tone sent when the button is
pressed.

The range for this field is 0 to 3000Hz.
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Low/On Duration field
The Low/On Duration field identifies the duration, in ms, the low frequency is played.

The range for this field is 0 to 5000ms.

i

Notice!
If Tone is selected, this field is ignored because the tone is continuous. If Pulsed Tone is selected, this
field indicates the length of each tone off period. If Hi-Lo is selected, this field indicates how long the
high tone is played.

Hi Frequency field
The Hi Frequency field identifies the frequency of the Hi tone sent when the button is pressed.

The range for this field is 0 to 3000Hz.

Hi/Off Duration field
The Hi/Off Duration field identifies the duration the Hi frequency is turned off.

The range for this field is 0 to 5000ms.

Tone Level field
The Tone Level field identifies the relative change for allowable tone level.

The range for this field is -40 to 10dB.

i

Notice!
If Tone is selected, this field is ignored because the tone is continuous. If Pulsed Tone is selected, this
field indicates the length of each tone off period. If Hi-Lo is selected, this field indicates how long the
high tone is played.

Key-up Duration field
The Key-up Duration field identifies the duration of the tone.

The range for this field is 0 to 10,000ms.

Time Between Tones field
The Time Between Tones field identifies the duration between key-ups.

The range for this field is 0 to 32 seconds.

31.46 MDC-1200
The MDC-1200 function, creates a button to open the MDC-1200 Dispatching window.
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In C-Soft Runtime, when the window is open the user can view the system list, call and status history,
status IDs, voice and data messages and select groups and individuals to place calls.

MDC-1200 Setup page
When the MDC-1200 window function is selected from the UI Element drop down menu, the
MDC-1200 Setup page appears.

Figure 31.33: MDC-1200 Setup Page - UI Element Setup

Console Requests group box

Timeout sec field
The Timeout sec field is used to configure the amount of time, in seconds, the console waits when
sending status requests, radio checks, radio enable, and radio disable messages. If the radio is unable
to respond, No Response, appears in the status bar of the dispatching window depending on the
current state of the radio.

The range for this field is 1 to 10 seconds.

Password Protection group box

Emergency check box
The Emergency check box indicates the console operator is prompted for the supervisor password
before they are allowed to send an emergency message.

Radio Enable/Disable check box
The Radio Enable/Disable check box indicates the console operator is prompted for the supervisor
password before they are allowed to enable or disable the radio.
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Radio Remote Monitor check box
The Radio Remote Monitor check box indicates the console operator is prompted for the supervisor
password before they are allowed to remotely monitor the radio.

Remote Monitor group box

Enable Global Multiplier check box
The Enable Global Multiplier check box indicates the values entered in the RX Multiplier and TX
Multiplier fields are multiplied by two.

Remote Monitor Type drop down menu
The Remote Monitor Type drop down menu is used to select a mode for radio transmission
indications.

Available selections for this field are:
– Non-Silent - Radio indicates transmission is occurring by flashing TX LED on the radio display

when using radio remote monitor.
– Silent - No transmit indication appears during transmission.

Figure 31.34: Remote Monitor Type Drop Down Menu

RX Multiplier drop down menu
The RX Multiplier drop down menu indicates the amount of time the radio receiving the remote
monitor command is unable to receive calls after transmitting. The value is multiplied by the remote
monitor time programmed in the radio to determine the total time.

Available selections for this field are: 0 to 3.
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Figure 31.35: Rx Multiplier Drop Down Menu

TX Multiplier drop down menu
The TX Multiplier drop down menu is used to indicate how long the radio receiving the remote
monitor command is allowed to transmit. The value is multiplied by the remote monitor time
programmed in the radio to determine total transmit time.

Available selections for this field are: 0 to 3.

Figure 31.36: Tx Multiplier Drop Down Menu

To add an MDC-1200 Window button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
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3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select MDC-1200 Window.
The MDC-1200 Setup tab appears.

5. Click the MDC-1200 Setup tab.
The MDC-1200 Setup page appears

6. From the Console Request group box, enter a time for the timeout.
7. From the Password Protection group box, select the password protection radio button.

NOTE: For more information, refer to “Password Protection Group Box”.
8. From the Remote Monitor group box, configure a multiplier.

NOTE: For more information, refer to “Remote Monitor Group Box”.
9. Click OK.
A button with MDC-1200 on it appears.

31.46.1 MDC-1200 Dispatching window
The MDC-1200 Dispatching window, shown in the Figure below, is used by the console operator in
C-Soft Runtime to send and receive MDC-1200 messages. The status bar provides feedback about
MDC-1200.

Figure 31.37: Selected Items Page - MDC-1200 Dispatching Window

System Type drop down menu
The System Type drop down menu is used to change from the currently selected system to another
system in the console position. When a system is selected, the system list populates with filters and
components contained in the system.
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Up to 200 systems can be created.

The default systems included in the drop down menu depend on the currently selected line’s
configuration.

System List
The System List populates with system components that belong to the system currently selected in
the System drop down menu. The system name is the first item to appear in the list. Filter components
are listed next in the hierarchy. When a filter component is expanded individual units and groups are
visible.

Systems can be configured, by the console admin, to display filters only. In that case, only components
affiliated with a filter appear in the System List. Otherwise, all components, including components
with deny icons (permission to place calls denied), appear in the list. Refer to the Figure below.

Icon Type Description

Filter The Filter icon indicates the component is used to group, sort, and label the
components contained in the filter.

To view or hide filters, do one of the following:
– Click  to expand the filter list.
– Click  to collapse the filter list.

Deny The Deny icon indicates the tagged item does not allow the console operator
to place a call or send messages to this component.

Allow The Allow icon indicates the component is available for selection. The console
operator can place calls to these components.
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Figure 31.38: MDC-1200 System Displays Only Filters Example

System List flyout menu
The System List flyout menu is used as a quick method of accessing the Select Type commands that
are also available with the MDC Message buttons.

Available selections for this field are:
– Call Alert
– Radio Check
– Request Status
– Select Call
– Radio Status
– Remote Monitor
– Emergency

To access the System List flyout menu, do the following:
– In the system list, right-click the system, individual, or group to send the call or message to.
The System List flyout menu appears.
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Selected Items page
The Selected Items page is used to view the currently selected component’s ID information. The
selected item list is used to determine where a call or status message is sent to. The operator can
select one component per system in the list. Up to 200 messages can be sent simultaneously as long
as they are each sent to a different system. When a system component in the system list is selected it
is added to the selected items page.

Grayed out icons with deny tags are not available for selection.

To add a component’s ID to the Selected Items page, do the following:
– In the System List field, select the component.
The component is highlighted, and appears in the Selected Items list.

Refer to “Manual Select Group Box” to learn how to manually enter an ID.

To remove an ID from the Selected Items page, do the following:
1. Right-click the unwanted component.

A flyout menu appears.
2. Click Remove Item.
The item disappears from the list.

Manual Select group box
The Manual Select group box is used to communicate with system users not in the system list.

User ID field
The User ID field is used to enter an MDC ID (in hexadecimal format) for selection to add to the list.

Add to Selected button
The Add to Selected button is used to add the MDC ID entered in the User ID field to the selected
items list.

To manually place an individual radio ID in the selected items list, do the following:
– In the User ID field, enter an ID from 001-DFFF.
The ID appears in the Selected Items list.

To manually place a group ID in the selected items list, do the following:
– In the User ID field, enter an ID from 000-FFF.
The ID appears in the Selected Items list.

To manually place a system ID in the selected items list, do the following:
– In the User ID field, enter FFFF.
The ID appears in the Selected Items list.

i
Notice!
The character F behaves like a wildcard.
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The MDC Message buttons, located at the bottom of the MDC-1200 Dispatching window, are used to
send calls, alerts, statuses, and messages. When a button is clicked, the status bar confirms activity.

MDC offers ANI capabilities on PTT. When transmitting on a line, C-Soft sends the console’s ID to the
radio. A PTT call displays in the history pages as a Voice message type. The ID alias or ID appear on
the line’s Select button.

Call Alert button
The Call Alert button is used to send an alert message.

To send a call alert, do the following:
1. From the system list, select the unit ID to send the alert message to.

OR
From the system list, select the group to send the alert message to
The highlighted item is added to the selected items list.

2. Click Call Alert.
An alert is sent to the selected user(s) MDC-1200 radio.

Radio Check button
The Radio Check button indicates a message is sent to check for radio activity.

To send a radio check message to an MDC-1200 radio, do the following:
1. In the system list, select a unit ID to send the radio check message to.

The highlighted item is added to the selected items list.
2. Click Radio Check.

If the selected radio is able to respond, Acknowledge appears on the line’s select button, History
window, and in the item list on the History page.
If the radio is unable to respond within the configured time allowed, No Response appears on the
select button, the Per Line Call History window, and the list on the History page.

Status Request button
The Status Request button is used to request status from a unit in the system.

To request a status from a unit, do the following:
1. In the system list, select a unit ID to send the alert message to.

The highlight item is added to the selected items list.
2. Click Status Request.

If the selected radio is able to respond, the (status message) appears on the line’s select button, the
Per Line Call History window, and in the item list on the History page.
If the radio is unable to respond within the configured time allowed, No Response appears on the
select button, the Per Line Call History window, and the list on the History page.

Select Call button
The Select Call button is used to place a select call.

To place an MDC-1200 select call, do the following:
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1. In the system list, select a unit ID to place the select call to.
The highlighted item is added to the selected items list.
OR
In the system list, select a group to place the select call to.
The highlighted item is added to the selected items list.

2. Click Select Call.
The select call message is sent and the receiving radio performs select call actions.

Radio Disable button
The Radio Disable button is used to disable a radio in the field from use by unauthorized persons.

To disable a radio, do the following:
1. In the system list, select a unit you want to disable from use.

The highlighted item is added to the selected items list.
2. Click Radio Disable.
The disable radio message is sent and the radio no longer functions.

If the selected radio is able to respond, Acknowledge appears on the line’s select button, History
window, and in the item list on the History page.
If the radio is unable to respond within the configured time allowed, No Response appears on the
select button, the Per Line Call History window, and the list on the History page.

Radio Enable button
The Radio Enable button is used to enable a radio that has been disabled.

To enable a radio, do the following:
1. In the system list, select a unit you want to enable for use.

The highlighted item is added to the selected items list.
2. Click Radio Enable.
The microphone on the selected unit is open for monitoring.

If the selected radio is able to respond, Acknowledge appears on the line’s select button, History
window, and in the item list on the History page.
If the radio is unable to respond within the configured time allowed, No Response appears on the
select button, the Per Line Call History window, and the list on the History page.

Remote Monitor button
The Remote Monitor button is used to remotely keyup a microphone for monitoring purposes.

To monitor a unit, do the following:
1. In the system list, select a unit ID you want to monitor remotely.

The highlighted item is added to the selected items list.
2. Click Remote Monitor.
The microphone on the selected unit is open for monitoring.

Emergency button
The Emergency button is used to send an emergency alert.
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To send an emergency call, do the following:
1. In the system list, select the unit ID to which the emergency alert is sent.

The highlighted item is added to the selected items list.
OR
In the system list, select the group to which the emergency alert is sent.
The highlighted item is added to the selected items list.

2. Click Emergency.
The emergency alert is sent and the receiving unit performs emergency actions.

31.46.2 History page
The History page is used to view a log of received messages. Calls received from parallel consoles are
included in the log. The history page is also used to place calls. Status, group and call color coding is
supported. Click and drag column headings to rearrange column order. Messages can be sent to an ID
in the history list. Items in the history list can not be removed. When C-Soft Runtime is closed all call
history is cleared.

For more information, refer to “Per Line Call History Window Lines Window Field” on “Per Line Call
History Window Lines Field”.

Note:
– Received messages also appear on the line’s select button while receiving a call and in the Per

Line Call History window, refer to “Per Line Call History Window” on page 314.
– MDC-1200 call history can also be found on the Per Line Call History window.

Figure 31.39: History Page - MDC Dispatching Window
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To place a select call from the History page, do the following:
1. From the history log, select a unit ID entry in the history log.
2. Click Select Call.
The call is sent.

For more calling options, refer to “Selected Items Page” on MDC-1200 Dispatching window, page
296.

Date column
The Date column displays the date the message was received.

Time column
The Time column displays the time the message was received.

Channel column
The Channel column displays the frequency the message was sent on.

Call Type column
The Call Type column displays the type of message received.

There are seven call type possibilities:

– Call Alert Type
Call Alert indicates an alert message was received from an MDC-1200 radio. When a call alert
message is received, all alerts and the caller’s alias or ID appears on the receiving line’s button. If
annunciations are configured, they are played when an alert is received. Refer to “Annunciation of Call
Alert Group Box” on page 341.

– Emergency Type
Emergency indicates an emergency message was received from an MDC-1200 radio.

– Group Call Type
Group Call indicates a group call was received from an MDC-1200 radio. When a group call is
received, the group call initiator’s ANI or ID appear on the receiving line’s select button. If
annunciations are configured, they are heard when a group call is received. Refer to “Annunciation of
Select Call Group Box” on page 339.

– Select Call Type
Select Call indicates a select call was received from an MDC-1200 radio. When an individual call is
received, the caller’s ANI or ID appears on the receiving line’s select button. If annunciations are
configured, they are heard when a select call is received. Refer to “Annunciation of Select Call Group
Box” on page 339.

– Status Type
Status indicates a status message was received from an MDC-1200 radio. When a status message is
selected, the alias or ID appears in the Calling ID field and a status message appears in the Status
message field.
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– Txt msg Type
Txt msg (Text Message) indicates a text message was received from an MDC-1200 radio. When a
text message is selected, the alias or ID appear in the Calling ID field and the text message appears in
the Test Message field.

– Voice Type
Voice indicates a voice message was received from an MDC-1200 radio. If available, the ANI displays
on the receiving line’s select button, otherwise the ID appears.

Call Details group box
The Call Details group box gives information about a selected item in the history list.

Calling ID
The Calling ID is the alias or ID number of the MDC-1200 radio that sent the selected message.

Status Message field
The Status Message field is used to display the status message received by the selected message.

If a text message appears in the field, the label changes to Text Message.

Text Message field
The Text Message field is used to display the text message received by the selected message.

If a status message appears in the field, the label changes to Status Message.

Call History View group box

All Lines radio button
The All Lines radio button indicates the history list displays all messages received on all lines.

Selected Line radio button
The Selected Line radio button indicates the history list displays messages received on selected lines
in the system.

31.47 Monitor
The Monitor function allows the console operator to send a packet burst, similar to a frequency
change, to a remote radio, instructing the radio to open squelch or ignore CTCSS tones.

To add a monitor button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select Monitor.
5. Click OK.
The button changes color and MON appears on the button.
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31.48 MOTOTRBO Radio Setup page
When the MOTOTRBO function is selected from the UI Element drop down menu, the MOTOTRBO
Radio Setup window appears.

i
Notice!
Each line controlling either a MTRBi or MOTOTRBO requires its own window.

The MOTOTRBO Radio Setup page, shown in the Figure below, is used for setting Dispatch Window
features and entering time intervals to check for the Master Console.

Figure 31.40: MOTOTRBO Radio Setup Page Example

MOTOTRBO Dispatch Window Setup group box

Enable MOTOTRBO Dispatch Window check box
The Enable MOTOTRBO Dispatch Window check box, if selected, allows the user to open the
Dispatch Window in Runtime. If not selected, the user is not able to open the Dispatch Window in
Runtime.

Dispatch Window Config button
The Dispatch Window Config button is used to open the Dispatch Window settings. The button text
and color of the Dispatch Window can be updated in this view.

For more information on Dispatch Window Config button, refer to the Figure below.
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MOTOTRBO Radio List Font Size field
The MOTOTRBO Radio List Font Size field is used to enter the font size of the ID List.

Text Message RX Button Blink Color drop down palette
The Text Message TX Button Blink Color drop down palette is used to select the color that the
MOTOTRBO Dispatch Window button blinks when a text message is received. The button will not
blink if the MOTOTRBO Dispatch Window’s Text Message tab is already open.

MOTOTRBO Timing group box

Master Heartbeat Send Time field
The Master Heartbeat Send Time field is used to enter an interval for the master console to send its
heartbeat out to all other consoles on the control line (i.e., 1).

The range for this field is 1 to 999 seconds.
The default is 1.

MTRBi Check Send Time field
The MTRBi Check Send Time field is used to enter an interval for C-Soft to verify the MTRBi on a
certain line is alive (i.e., 4).

Note:
– Allow one second for the check function to complete.
– This function is only available when MTRBi is selected on the MOTOTRBO Setup tab.

EXAMPLE: If this field is set to four seconds, the console sends an MTRBi check command then waits
for four minus one second, or three seconds for a response.

The range for this field is 2 to 999 seconds.
The default is 4.

Slave Check Time field
The Slave Check Time field is used to enter an interval for the console to wait to receive a heartbeat
from the master before it changes into the master. (i.e., 4)

EXAMPLE: At startup, the console waits four seconds for a heartbeat, if nothing is received, the
console changes to the master console. If a heartbeat is detected, the console remains a slave and
resets to four seconds.

The range for this field is 3 to 999 seconds.
The default is 4.

Master Resend Command Time field
The Master Resend Command Time field is used to enter an interval for C-Soft to resend a
MOTOTRBO command (i.e., 1).
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EXAMPLE: If C-Soft sends a MOTOTRBO command and does not get a response in one second, it
sends the command again, waits one second, if nothing sends again, waits one second. If no response
is received after three tries the command is cleared and goes to the next command to send to the
buffer. The maximum tries is three.

The range for this field is 1 to 999 seconds.
The default is 1.

PTT Hangtime field
The PTT Hangtime field is used to enter the amount of time C-Soft waits before sending the end of
call command to the MTRBi. This delay allows the IP-224 to finish processing the outgoing audio
before the mobile stops transmitting.

The value entered in this field is multiplied by 20ms to calculate the total delay. This value should
match the Packet Delay Before Playback field in the Ethernet Setup section of the IP-223 technical
manual and the IP-224 technical manual.

The range for this field is 0 to 99 x 20ms.

EXAMPLE: A value of 10 delays sending the end of call command by 200ms.

This feature is only enabled when MTRBi is selected from the MOTOTRBO Setup tab in Signaling
Setup.

Password Protection group box
The Password Protection group box enables the user to set up functions that require a user
password before allowing the user access.

If not selected, no password is required.

Radio Monitor check box
The Radio Monitor check box indicates the user must enter a password to use these functions.

Radio Inhibit/Uninhibit check box
The Radio Inhibit/Uninhibit check box indicates the user must enter a password to use the function.

Call Alert check box
The Call Alert check box indicates the user must enter a password to use the function.

MOTOTRBO Misc group box

Talk Permit Tones check box
The Talk Permit Tones check box, if selected, enables the user to hear go ahead Tones when PTT is
pressed in Runtime.

Channel Alias Read check box
The Channel Alias Read check box indicates the channel’s aliases are read automatically from the
mobile radio.
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This feature is only enabled when MOTOTRBO is selected from the MOTOTRBO Setup tab in the
Signaling Setup Window.

31.48.1 Dispatch Window
The Dispatch Window, shown in the Figure below, is used to select the color, font and font size of the
Dispatch Window settings.

Figure 31.41: Dispatch Window Example

Dispatch Window Color drop down menu
The Dispatch Window Color drop down menu is used to select the color of the Dispatch Window.

To select the color of the Dispatch Window, do the following:
– From the Dispatch Window Color drop down menu, select the desired color for the dispatch

window.

Set Font button
The Set Font button opens the Font window.



C-Soft 8.500 UI Element Functions configuration | en 309

Bosch Security Systems, LLC Technical Manual 2025-08 | 16 | F.01U.218.561

Figure 31.42: Dispatch Window Font Drop Down Menu

To set the font of the Dispatch Window, do the following:
– From the Font window, select the desired font for your text.

Main Control Page
The Main Control page, shown in the Figure “Dispatch Window Example” on Dispatch Window, page
308, is used to change the color, font type, and font size for the following buttons:
– InPTT
– Private Call
– Group Call
– Mute
– Select
– Numerical Pad
– Delete

Figure 31.43: Select Color and Text
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Button Color Up drop down menu
The Button Color Up drop down menu is used to select the color of the button as it is released.

Button Color Down drop down denu
The Button Color Down drop down menu is used to select the color of the button as it is pressed.

Button Text Color drop down menu
The Button Text Color drop down menu is used to select a color for the button text.

Enable Button check box
The Enable Button check box is used to enable the button in C-Soft Runtime. If disabled, the button’s
operation is not available.

Button Text field
The Button Text field is used to add text to the button.

OK button
The OK button is used to accept the changes to the button.

Cancel button
The Cancel button is used to discard any changes to the button.

To select color and text of the desired button, do the following:
1. From the Main Control menu, press the desired button.

Select Color and Text appears.
2. From the Button Color Up drop down menu, select the desired color.
3. From the Button Color Down drop down menu, select the desired color.
4. From the Button Text Color drop down menu, select the desired color.
5. Select the Enable Button check box to enable the button’s functionality in C-Soft Runtime.
6. In the Button Text field, enter the desired text for the button.
7. Click OK.
The entries are saved.

Unit Control Page
The Unit Control page, shown in Figure below is used to change the color, font type, and font size for
the following buttons:
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Figure 31.44: Unit Control Page Example

Radio Check button
The Radio Check button is used to select the color of the button and text of the Radio Check button.

Remote Monitor button
The Remote Monitor button is used to select the color of the button and text of the Remote Monitor
button.

Call Alert button
The Call Alert button is used to select the color of the button and text of the Call Alert button.

Radio Disable button
The Radio Disable button is used to select the color of the button and text of the Radio Disable
button.

Radio Enable button
The Radio Enable button is used to select the color of the button and text of the Radio Enable button.

GPS Trigger On button
The GPS Trigger On button is used to select the color of the button and text of the GPS Trigger On
button.

GPS Read button
The GPS Read button is used to select the color of the button and text of the GPS Read button.

GPS Trigger Off button
The GPS Trigger Off button is used to select the color of the button and text of the GPS Trigger Off
button.
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Keypad
The Keypad buttons are used to select the color of the buttons and text of the Keypad buttons.

To select color and text of the desired button, do the following:
1. From the Unit Control window, select the desired button.

Select Color and Text appears.
2. From the Button Color Up drop down menu, select the desired color.
3. From the Button Color Down drop down menu, select the desired color.
4. From the Button Text Color drop down menu, select the desired color.
5. Select the Enable Button check box to enable the selected color and text of the button.
6. In the Button Text field, enter the desired text for the button.
7. Click OK.
The entries are saved.

Text Message page
The Text Message page, shown in the Figure below, is used to select the color of the button and text
of the text message.

Figure 31.45: Text Message Page Example

Clear History button
The Clear History button is used to select the color of the button and text of the Clear History button.

Send Unit Text button
The Send Unit Text button is used to select the color of the button and text of the Send Unit Text
button.

Send Group Text button
The Send Group Text button is used to select color of the button and text of the Send Group Text
button.

To select color and text of the desired button, do the following:
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1. From the Text Message menu, press the desired button.
Select Color and Text appears.

2. From the Button Color Up drop down menu, select the desired color.
3. From the Button Color Down drop down menu, select the desired color.
4. From the Button Text Color drop down menu, select the desired color.
5. Select the Enable Button check box to enable the selected color and text of the button.
6. In the Button Text field, enter the desired text for the button.
7. Click OK.
The entries are saved.

History page
The History Message page, shown in the Figure below, is used to change the color, font type, and font
size for the following buttons:

Figure 31.46: History Message Page Example

Private Call button
The Private Call button is used to select the color of the button and text of the Private Call button.

To select color and text of the desired button, do the following:
1. From the History menu press the desired button.

Select Color and Text appears.
2. From the Button Color Up drop down menu, select the desired color.
3. From the Button Color Down drop down menu, select the desired color.
4. From the Button Text Color drop down menu, select the desired color.
5. In the Private text field, enter the desired text to be displayed when a call from an individual is

selected.
6. In the Group Text field, enter the desired text to be displayed when a call from a group is

selected.
7. Click OK.
The entries are saved.
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i
Notice!
The Private Call Button uses the Enable Button setting from the DFSI Window’s Main Control tab’s
Private Call and Group Call buttons.

31.48.2 MOTOTRBO Dispatching window
The MOTOTRBO Dispatching window, shown in the Figure below, is used by the console operator in
C-Soft Runtime to manage a MOTOTRBO line’s call history, channel changes, send text messages and
alerts, read GPS coordinates and read remote radio positions. Volume adjustments, radio checks, and
radio enable/disable are also conducted from this window.

During operation, all parallel consoles on the same network synchronize to each other. Consoles on
the same network display the same channel and zone, received ID, alias, history and notifications.

Each line controlling a MTRBi (MOTOTRBO) or MOTOTRBO Interface requires its own window.

To add a MOTOTRBO button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select MOTOTRBO.

The MOTOTRBO Radio Setup page appears.
5. In the Master Heartbeat Sent time field, enter a time interval to send a heartbeat.
6. In the MTRBi Check Send Time field, enter a time interval to check MTRBi status.
7. In the Slave Check Time field, enter the amount of time C-Soft waits before changing to the

master console.
8. In the Master Resend Command Time field, enter the amount of time C-Soft waits before

resending a command.
9. From the MOTOTRBO drop down menu, select a background color for the window.
10. Click OK.
The MOTOTRBO button is added to the console.

Main Control page
The MOTOTRBO window displays the most frequently used MOTOTRBO fields.

The drop down menu selections are set up in C-Soft Designer and the MOTOTRBO radio
programming software.
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Figure 31.47: MOTOTRBO Dispatching Window

Channel drop down menu
The Channel drop down menu is used to change the channel of the selected line. If a parallel console
or the radio changes the channel, this field updates with the current channel information.

Available selections for this field are configured in the radio.

Zone drop down menu
The Zone drop down menu is used to change the zone of the selected line. If a parallel console or the
radio changes the zone, this field updates with the current zone information.

Available selections for this field are configured in the radio.

Volume Slider
The Volume Slider is used to increase or decrease the volume to the speaker or handset currently
connected. The volume indicator gives a graphical representation of the total volume.

i
Notice!
MOTOTRBO is compatible with the ADHB-4 which can also be used to adjust volume.

Trbo Ptt button
The Trbo Ptt button is used the same as a normal key up of a mobile radio.
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Private Call button
The Private Call button is used to select what is entered in the ID field for a private call.

Group Call button
The Group Call button is used to select what is entered in the ID field for a group call.

Mute button
The Mute button is used to mute or amplify the selected line’s volume. If the console speaker is muted,
the universal no symbol appears on the speaker icon.

Select button
The Select button is used to select or deselect the MOTOTRBO Line.

Status Information field
The Status Information field displays all incoming and outgoing MOTOTRBO radio status information.

MOTOTRBO Connection Indicator
The MOTOTRBO Connection Indicator indicates the status of the connection to the MOTOTRBO
currently displayed in the MOTOTRBO window. If green, the unit is online and functional. If red, the
unit is offline or disconnected.

Unit Control page
When the Unit Control tab is clicked from the MOTOTRBO window, the Control Buttons page
appears. The Unit Control page is used to access MOTOTRBO functions. When a radio is selected in
the ID field, a button can be clicked to perform an action.

Figure 31.48: MOTOTRBO Window - Unit Control
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Radio Check button
The Radio Check button is used to verify if the target radio is currently online and functional.

Radio Disable button
The Radio Disable button is used to disable a target radio from use. This feature can be used in the
case of a lost or stolen radio.

Radio Enable button
The Radio Enable button is used to enable the target radio for use. This feature is used to enable a
radio if it has been disabled with the Radio Disable button.

Remote Monitor button
The Remote Monitor button is used to monitor the target remote radio.

Call Alert button
The Call Alert button is used to send an alert to the target remote radio.

GPS Read button
The GPS Read button is used to request a read of the selected radio’s current location and navigate to
the radio’s location on Google Earth.

GPS Trigger On button
The GPS Trigger On button is used to enable the GPS to send status at a regular interval to the
console. The interval is determined by the value entered in the GPS Trigger On field.

GPS Trigger Off button
The GPS Trigger Off button is used to disable the radio from periodic GPS coordinate updates status
to the console.

GPS Trigger On field
The GPS Trigger On field is used to configure the interval with which the selected radio sends a GPS
location to the console.

Available options for this field are: 30 sec, 1 min, 4 min, 8 min, 10 min, 20 min, and 30 min.

Text Message page
When the Text Message tab is clicked the Text Message page appears. Refer to the Figure on 441.

The Text Message page is used to send text messages to the selected individual or a group of radios
and to view text messages sent and received during the current C-Soft Runtime session.

Radio Name column
The Radio Name column displays the name assigned to the radio the text message was sent or
received.

Time column
The Time column displays the time the text message was sent or received.
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Text Message column
The Text Message column displays the text message sent to or received from the radio.

Quick Text drop down menu
The Quick Text drop down menu is used to select a text ID number assigned to a preprogrammed
text message. When a text ID is selected, its message appears in the Text field.

Text field
The Text field displays a preview of the text message to be sent when Send Text is clicked. A text
message can be entered using the Quick Text drop down menu or it can be entered manually.

This field can contain up to 100 characters.

Send Unit Text button
The Send Unit Text button is used to send the message in the Text field to the selected radio. When
clicked, the message is sent to the radio.

To send a text message, do the following:
1. In the Text field, enter a text message to send.

OR
From the Quick Text drop down menu, select a Text ID.

2. From the ID drop down menu, select an individual to send the text message to.
OR
From the ID drop down menu, select a group to send the text message to.

3. Click Send Unit Text.
The text message is sent to the selected user.
OR
Click Send Group Text.

The text message is sent to the selected group.

Clear History button
The Clear History button is used to clear all text messages in the list.

To clear text message history, do the following:
– Click Clear History.
The text message history list is deleted.

History page
The History page appears when MOTOTRBO window is maximized. The History page is global for all
MOTOTRBO lines. All MOTOTRBO active and previous calls appear in the list. Each call’s radio name,
radio ID, date, time, call type, and the call’s current state appear.

i
Notice!
When C-Soft Runtime is closed, this list is cleared.
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Date column
The Date column displays the date the call was received.

Time column
The Time column displays the time the call was received.

Freq column
The Freq column displays the frequency the call came from.

Status column
The Status column displays the current status of the call.

Available options for this field are Mobile PTT, In Progress, Call RX., GPS Position, On, Off, Passed and
Failed.

User ID column
The User ID column displays the caller’s user ID.

Call Type column
The Call Type column displays the type of call.

Available options for this field are Private, Group, Alert, Enable, Disable, Check, Scan, Monitor and
GPS Read.

Private Call button
The Private Call button is used to initiate a private call to the User ID displayed in the selected entry’s
User ID column.

31.49 Mute Group
The Mute Group function allows the console operator to mute the audio on a pre-defined group of
lines.

Line Group page
When the Mute Group function is selected from the UI Element drop down menu, the Line Group
page appears. Refer to the Figure below.

i
Notice!
The Line Group page is used to select the lines that belong to a specific Mute Group.
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Figure 31.49: Line Group Page - UI Element Setup

Select Lines for Group field
The Select Lines for Group field contains a list of all the lines configured on the “Per Line Parameters
window, page 61”. Selecting a line from this list, assigns the line to the group.

Click the Group Programmed button in the C-Soft Runtime program to place the lines defined on the
Line Group page into a select condition.

To add a Mute Group button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select Mute Group.

The Line Group tab appears.
5. Click the Line Group tab.

The Line Group page appears.
6. From the Select Line for Group field, select the line(s) you want to add to the group.
7. Click OK.
The selected lines are assigned to the group. The button color changes and Mute Group appears on
the button.

i
Notice!
Deselect the highlighted line, to remove a line from the Mute Group List.
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31.50 Mute Main
The Mute Main function allows the console operator to mute all lines not currently selected.

i
Notice!
Selected lines can also be muted when the Allow Muting Selected Lines option is selected on the
Global Parameters page. Refer to “Global Parameter Setup window, page 116”.

To add a Mute Main button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select Mute Main.
5. Click OK.
The button changes color and Mute appears on the button.

31.51 Mute-Per Line
The Mute-Per Line function allows the console operator to mute a particular line. It is a toggle button
that is active when clicked and inactive when released.

Mute Icon
A Mute Icon, shown in the Figure below, appears on a line’s Select button, a group select button, a
phone onhook/offhook button, a SIP button or a NENA indication anytime the line is muted, RX
blocked, or group muted.

This icon can be customized by selecting an image for the Mute icon in the Button Images window,
page 143.

Figure 31.50: Mute Icon - Select Button

31.51.1 Per Line Mute Button Setup page
When the Mute - Per Line function is selected from the UI Element drop down menu, as shown in the
Figure below, the Per Line Mute Button Setup page appears.

The Per Line Mute Button setup tab is used to set the Mute Time and Minimum Mute Level.
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Figure 31.51: Per Line Mute Button Setup Page - UI Element Setup

Mute Time field
The Mute Time field identifies the duration audio is muted before the audio is automatically restored.
A value of zero disables this feature.

The range for this field is 0 to 180 seconds.

Min Mute Level field
The Min Mute Level field identifies the level the unselected audio level is reduced at the speaker. Enter
a value from -20 to -1dB to reduce the level on the muted line accordingly without completely muting
the line. This ensures the console operator is unable to completely turn off audio being monitored. A
value of zero completely mutes the line.

The range for this field is -20 to -1dB.

i
Notice!
Selected lines can also be muted when the Allow Muting Selected Lines option is selected on the
Global Parameters page. Refer to “Global Parameter Setup window, page 116”.

To add a Mute-Per Line button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select Mute - Per Line.

The Line to Associate Function With drop down menu becomes active. The Per Line Mute Button
Setup tab appears.

5. From the Line to Associate Function With drop down menu, select the line you want to associate
with the Mute - Per Line function.

6. Click the Per Line Mute Button Setup tab.
The Per Line Mute Button Setup page appears.

7. In the Mute Time field, enter the amount of time the line is muted before audio is automatically
restored.

8. In the Min Mute Level field, enter the audio level for the unselected line.
9. Click OK.
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The button changes color and Mute appears on the button.

31.52 P25-DFSI window
The P25-DFSI window allows the console operator to open the P25-DFSI Dispatching window.

P25-DFSI Misc page
When the P25-DFSI function is selected from the UI Element drop down menu, the P25-DFSI Misc
page appears. Refer to the Figure below.

Figure 31.52: P25-DFSI Misc - UI Element Setup

Misc group box

Enable P25-DFSI Dispatch Window check box
The Enable P25-DFSI Dispatch Window check box gives the user to open the Dispatch Window in
Runtime. If not selected, the user is not able to open the Dispatch Window in Runtime.

Receive All Talk Groups check box
The Receive All Talk Groups check box indicates all incoming Talk Groups can be heard. If not
selected, only incoming calls with Talk Groups matching the current Talk Group will be heard, all
others are muted.

Receive All Private Calls check box
The Receive All Private Calls check box indicates all incoming Private Calls can be heard. If not
selected, only incoming Private Calls sent directly to the console will be heard, all others are muted.
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P25-DFSI Radio List Font Size field
The P25-DFSI Radio List Font Size field is used to select a font size for the P25-DFSI Radio List.

The range for this field is 0 to 99.
The default is 12.

Dispatch Window Config button
The Dispatch Window Config button is used to open the Dispatch Window settings. The button text
and color of the Dispatch Window can be updated in this view. For more information, refer to
“Appendix E - P25-DFSI (Digital Fixed Station Interface), page 480”.

Password Protection group box
The Password Protection group box enables the user to set up functions that require a user
password before allowing the user access.

If not selected, no password is required.

Radio Monitor check box
The Radio Monitor check box, if enabled, indicates the Radio Monitor function is password protected.

For more information, refer to “Global Parameter Setup window, page 116”.

Radio Inhibit/Uninhibit check box
The Radio Inhibit/Uninhibit check box, if enabled, indicates the Radio Inhibit/Uninhibit function is
password protected.

For more information, refer to “Global Parameter Setup window, page 116”.

Call Alert check box
The Call Alert check box, if enabled, indicates the Call Alert function is password protected.

For more information, refer to “Global Parameter Setup window, page 116”.

Vote Select/Disable check box
The Vote Select/Disable check box, if enabled, indicates the Vote Select/Disable function is password
protected.

For more information, refer to “Global Parameter Setup window, page 116”.

OK button
The OK button saves the entries and closes the window.

31.53 Page
The Page function allows the console operator to send a single page to a specific line on a specific
frequency.
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Page Setup page
When the Page function is selected from the UI Element drop down menu, the Page Setup page
appears. Refer to the Figure below.

Figure 31.53: Page Setup Page - UI Element Setup

Page Setup group box

Format drop down menu
The Format drop down menu is used to select the desired pager. This field contains all the pagers
defined for the line in the “Paging Settings window, page 151”.

Frequency drop down menu
The Frequency drop down menu is used to select the frequency for the page. This field contains all of
the frequencies defined for “Freqs Button”.

Talk Time field
The Talk Time field is used to enter the amount of time, in ms, allowed for the console operator to add
a voice message to a page after the page has been sent.

The range for this field is 0 to 32000ms.

Page String field
The Page String field is used to enter the page string specific to the pager selected in the format field.

This field can contain up to 35 characters.
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Use Manual Cap Code Entry check box
The Use Manual Cap Code Entry check box indicates a page string is manually entered by the user in
Runtime, instead of using the predefined page string entered in the Page String field.

i
Notice!
Selecting this option disables the Page String field.

In C-Soft Runtime, when the page button is clicked, the Manual Paging Entry window appears. The
user enters the number to page and clicks Send Page.

Figure 31.54: Manual Page Entry Window

Send on Selected (not steered) check box
The Send on Selected (not steered) check box indicates the page is sent to the selected line or the
unselected line. Otherwise, the page is sent to the line configured for the page button.

Relay Setup group box

Active Relay With Page check box
The Active Relay With Page check box indicates a configured relay activates when a page is sent.

Relay Destination group box
The Relay Destination radio buttons identify the relay to be controlled. When a selection is made, the
fields necessary to enter the setup information for the relay are enabled.

ADHB-4 Settings group box
The ADHB-4 Settings radio buttons identify which ADHB-4 relay is activated when the page is sent.

None radio button
The None radio button indicates none of the ADHB-4 relays is activated.
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Relay 1 radio button
The Relay1 radio button indicates the first relay in the ADHB-4 is being controlled.

Relay 2 radio button
The Relay 2 radio button indicates the second relay in the ADHB-4 is being controlled.

NEO Settings group box
The NEO Settings field identifies the IP Address and the relay, if any, for the NEO-10.

IP field

Relay drop down menu
The Relay drop down menu is used to select the desired relay.

Available selections for this field are None, Port 1, Port 2, Port 3, Port 4, Port 5, Port 6, Port 7, Port 8,
Port 9 and Port 10.

Active Duration field
The Active Duration field is used to enter the length of time, in ms, the relay remains active from the
start of the Annunciation.

The range for this field is 300-3000ms.

To add a Page button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select Page.

The Line to Associate Function With drop down menu becomes active. The Page Setup tab
appears.

5. From the Line to Associate Function With drop down menu, select the line you want to associate
with the Page function.

6. Click the Page Setup tab.
The Page Setup page appears.

7. From the Format drop down menu, select the type of pager being used.
8. From the Frequency drop down menu, select the frequency for the pager.
9. In the Talk Time field, enter the amount of time allowed for the console operator to add a voice

message to the page.
10. In the Page String field, enter the page string or code specific to the pager.
11. Select the Send on Selected (not steered) check box, if desired.
12. Click OK.
The button changes color and Page appears on the button.
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31.54 Page Cancel
The Page Cancel function is used to cancel the transmission of one or more pages while the pages are
being sent.

If the Manually Confirm When Pages Are Done Sending check box is selected (“Paging Settings
window, page 151”), the Page Cancel button clears the Paging Done icons from all paging buttons.

Figure 31.55: Paging Button

Note:
– These icons can be customized by using the Button Images window, page 143.
– If you do not want to use one of the icons, you must make a 1 pixel bmp file and call it out

properly (see above). If you delete the .bmp file, the C-Soft Runtime uses the default icons.

31.55 Page Manual Entry
The Page Manual Entry function allows the incorporation of up to five single tones in sequence for a
specific line.

31.55.1 Manual Page Setup
When the Page Manual Entry function is selected from the UI Element drop down menu, the Manual
Page Setup page appears. Refer to the Figure below.
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Figure 31.56: Manual Page Setup Page - UI Element Setup

Initial Lead-In Delay field
The Initial Lead-in Delay field identifies the amount of time to use for the lead-in delay.

The range for this field is 0 to 20000ms.

Frequency drop down menu
The Frequency drop down menu identifies the frequency to send the page on. This field contains all of
the frequencies defined for the line in “Freqs Button”.

Tone Level field
The Tone Level field identifies the audio level of the tone.

The range for this field is -60 to 10dB.

Tone (1-5) fields
The Tone (1-5) fields identify the frequency for the tone.

The range for this field is 0 to 3000Hz.

Tone (1-5) Level fields
The Tone (1-5) Level fields identify the length for the tone.

The range for this field is 0 to 65000ms.
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Talk Time field
The Talk Time field identifies the maximum amount of time, allowed for talk time.

The range for this field is 0 to 65000ms.

Send on Selected (not steered) check box
The Send on Selected (not steered) check box indicates the page is sent to the selected line.
Otherwise, the page is sent to the line configured for the page button.

Relay Setup group box

Active Relay With Annunciation check box
The Active Relay With Annunciation check box indicates a configured relay activates when an Page
is sent.

Relay Destination group box
The Relay Destination radio buttons identify the relay to be controlled. When a selection is made, the
fields necessary to enter the setup information for the relay are enabled.

ADHB-4 Settings group box
The ADHB-4 Settings radio buttons identify which ADHB-4 relay to activate when the page is sent.

None radio button
The None radio button indicates none of the ADHB-4 relays is activated when sending a page.

Relay 1 radio button
The Relay1 radio button indicates the first relay in the ADHB-4 is being controlled.

Relay 2 radio button
The Relay 2 radio button indicates the second relay in the ADHB-4 is being controlled.

NEO Settings group box
The NEO Settings field identifies the IP Address and the relay, if any, for the NEO-10.

IP field
The IP field identifies the IP Address of the NEO-10.

Relay drop down menu
The Relay drop down menu is used to select the desired relay.

Available selections for this field are None, Port 1, Port 2, Port 3, Port 4, Port 5, Port 6, Port 7, Port 8,
Port 9 and Port 10.

Active Duration field
The Active Duration field is used to enter the length of time, in ms, the relay remains active from the
start of the Annunciation.

The range for this field is 300-3000ms.
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Page Generation options

Page Tone Iteration Count field
The Page Tone Iteration Count field is used to determine the number of times the button’s tone
sequence is sent during the page and allows for tone sequences to be repeated a specified number of
times.

The range for this field is 1 - 100.
The default value for this field is 1.

To add a Manual Page button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select Page-Manual Entry.

The Line to Associate Function With drop down menu becomes active. The Manual Page Setup
tab appears.

5. From the Line to Associate Function With drop down menu, select the line you want to associate
with the Manual Page function.

6. Click the Manual Page Setup tab.
The Manual Page Setup page appears.

7. In the Initial Lead in Delay field, enter the lead-in delay for the pager.
8. From the Frequency drop down menu, select the type of frequency for the pager.
9. In the Tone 1 through Tone 5 fields, enter the level and amount of time for each tone.
10. In the Talk Time field, enter the amount of time allowed for the console operator to add a voice

message to the page.
11. Select the Send on Selected (not steered) check box, if desired.
12. Click OK.
The button changes color and Page appears on the button.

31.56 Page Send
The Page Send function allows a console operator to send a group of pages selected using the Page
Stack button. This option also works when the Always Stack Page Buttons check box is selected, refer
to “Always Stack Page Buttons Check Box” on “Always Stack Page Buttons Check Box”.

In C-Soft Runtime, the console operator is notified when the last stacked page is sent. A voice
message can be sent to page recipients.

To add a Page Send button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select Page Send.
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5. Click OK.
The button changes color and Page Send appears on the button.

31.57 Page Stack
The Page Stack function allows the console operator to select the number of pages to be sent in
succession.

In C-Soft Runtime, after pressing the Page Stack button, the console operator can select multiple Page
buttons. Normally, a page is sent the moment the Page button is pressed, but when the Page button
is pressed after the Page Stack button, all selected pages are stacked first and sent when the Page
Send button is clicked.

i

Notice!
When the Page Send button is clicked, pages assigned to the same line number are sent in the order
they were selected, but pages assigned to different line numbers are sent in order of ascending line
number.

For example, when the Page Send button is pressed, pages that were selected in this order: XYZ (line
5), XYY (line 5), XXY (line 4), ZZY (line 3) are sent in this order: ZZY (line 3), XXY (line 4), XYZ (line 5),
XYY (line 5).

31.57.1 Page Stack Setup
When the Page Stack function is selected from the UI Element drop down menu, a Page Stack Setup
page appears. Refer to the Figure below.

Figure 31.57: Options Page - UI Element Setup

Unlatch stack button after page check box
The Unlatch stack button after page check box indicates the Page Stack button automatically
unlatches (toggle off) after pages are sent.

To add a Page Stack button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
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3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select Page Stack.
The Option tab appears.

5. Click the Options tab.
The Options page appears.

6. Select the Unlatch stack button after page check box to automatically unlatch after the pages
are sent, if desired.

7. Click OK.
The button changes color and Stack Pages appears on the button.

31.58 Page Stack Programmed
The Page Stack Programmed function creates a button used to select a pre-defined group of pages.
While in C-Soft Runtime, clicking the Page Stacked Programmed button causes the pre-defined
pages to be stacked.

i

Notice!
When the Page Send button is clicked, pages assigned to the same line number are sent in the order
they were selected, but pages assigned to different line numbers are sent in order of ascending line
number.

For example, when the Page Send button is pressed, pages that were selected in this order: XYZ (line
5), XYY (line 5), XXY (line 4), ZZY (line 3) are sent in this order: ZZY (line 3), XXY (line 4), XYZ (line 5),
XYY (line 5).

To send stacked pages, do the following:
1. From C-Soft Runtime, click the Page Stacked Programmed button.

The pages are stacked in the order defined in the Selected Pages list.
2. Click the Page Send button.
The Pages are sent.

31.58.1 Programmed Stack Setup page
When Pages Stack Programmed is selected from the drop down menu, the Programmed Stack Setup
page appears. Refer to the Figure below.

A maximum of 50 pages can be configured for a single Page Stack Programmed button.
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Figure 31.58: Programmed Stack Setup - UI Element Setup

All Pages field
The All Pages field displays all pages in the system. This list is used to select a page to add to the
Selected pages field.

Selected Pages field
The Selected Pages field displays pages selected for the stack. When the console operator clicks the
Page Stack Programmed button, a page is sent to members in this field.

Move Right button

The Arrow Right button  is used to move pages from the All Pages field to the Selected
Pages field.

Move Left button

The Arrow Left button  is used to move pages from the Selected Pages field to the All
Pages field.

Move Up Button

The Move Up button  is used to move the selected page up in the Selected Pages list.

Move Down Button

The Move Down button  is used to move the selected page down in the Selected Pages list.

To add a Page Stack Programmed button, do the following:
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1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button. 
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select Page Stack Programmed.
The Programmed Stack Setup tab appears.

5. Click the Programmed Stack Setup tab.
The Programmed Stack Setup page appears.

6. Select pages from the All Pages panel.
7. Click >>> to move them to the Selected Pages pane.
8. Click OK.
The button changes color and Page Send appears on the button.

31.59 Per Line Call History
The Per Line Call History function creates a button used to open a list of past calls received on the
associated line.

In C-Soft Runtime, the Per Line Call History window is used to view incoming calls, make outgoing
calls, and playback call audio based upon programming setup.

To add a Per Line Call History button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select Per Line Call History.
5. From the Line to Associate Function With drop down menu, select the line to display call history.
6. Click OK.
The color of the button changes and Per Line Call History appears on the button.

Per Line Call History Setup page
The Per Line Call History Setup window allows users to determine which columns are visible in the
Per Line Call History window. The respective columns display in the Per Line Call History window if
selected and hidden if not checked.
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Column Setup group box

Call Duration check box
The Call Duration check box is used to add a Call Duration column to the Per Line Call History
window.

Caller ID check box
The Caller ID check box is used to add a Caller ID column to the Per Line Call History window.

Comments check box
The Comments check box is used to add a Comments column to the Per Line Call History window.

Date check box
The Date check box is used to add a Date column to the Per Line Call History window.

Direction check box
The Direction check box is used to add a Direction column to the Per Line Call History window.

Frequency check box
The Frequency check box is used to add a Frequency column to the Per Line Call History window.

Line Name check box
The Line Name check box is used to add a Line Name column to the Per Line Call History window.

Status check box
The Status check box is used to add a Status column to the Per Line Call History window.
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Talkgroup check box
The Talkgroup check box is used to add a Talkgroup column to the Per Line Call History window.

i
Notice!
This field is only available when the associated line is configured for a P25-DFSI line.

Time check box
The Time check box is used to add a Time column to the Per Line Call History window.

User ID check box
The User ID check box is used to add a User ID column to the Per Line Call History window.

31.59.1 Per Line Call History window
The Per Line Call History window is used to view the associated line’s call history. Each entry in the
call history contains details regarding an individual call. Icons in the left column display the current
status of the call entry. The console operator can also send messages, statuses, and alerts to the ID
listed in the window by clicking a Call button at the bottom of the window.

Figure 31.59: Per Line Call History Window - C-Soft Runtime

Icon Status column
The Icon Status column displays an icon representative of the call entry state.

 The call entry is pinned. A pinned call entry is always located at the top of the call list control
and cannot be deleted until the call is unpinned.
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 The call entry contains audio that can be played.

 The call entry contains audio that can be played and the call entry is pinned.

 The call entry contains audio, but the line was muted when the call was received. The un-
muted audio can still be played.

 The call entry contains audio, but the line was muted when the call was received and the call
entry was pinned. The un-muted audio can still be played.

 The audio for a call entry is currently being played.

 The audio for a pinned call entry is currently being played.

Date column
The Date column displays the date of the call or operation.

Time column
The Time column displays the time of the call or operation.

Freq column
The Freq column displays the frequency of the call or operation.

Status column
The Status column displays additional call or operation information. For example, if a status message
is received, the Status column contains a Status Alias. If the entry represents an outgoing Select Call,
the Status column contains “Sent Select Call”.

User ID column
The User ID column displays the source User Alias/ID or Group Alias/ID of the call or operation.

Calling ID Column
The Calling ID column displays the destination User Alias/ID or Group Alias/ID of the call or operation.

Direction column
The Direction column displays the call or operation’s direction. Incoming calls or operations display Rx
and outgoing calls or operations display Tx.

Duration column
The Duration column displays the duration of the recorded call audio.

Comments column
The Comments column displays comments from the user.
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31.59.2 Per Line Call History window - 5/6 Tone line
The Status List window displays the status of a call. If the configured line is set to 5/6 Tone DTMF ANI
signaling, and one or more call formats have been configured in the Call Setup tab, the Per Line Call
History window displays the user defined call buttons as shown in the Figure below.

Figure 31.60: Per Line Call History Window: 5/6 Tone Line

Set Status button
The Set Status button is used to open the Status List window and select a status to send. Refer to the
Figure on “Status List window, page 237”.

To send a status ID from the Per Line Call History window in C-Soft Runtime, do the following:
1. While in C-Soft Runtime, select the line you want to place the call from.
2. Select a Per Line Call History button.

The Per Line Call History window appears.
3. From the ID Type drop down menu, select an alias or an ID number.

The selected User ID in the User List is highlighted.
4. Select Set Status.

The Status List window appears.
5. From the ID type drop down menu, select an alias or ID number to sort the list.

The list is sorted depending on the selected type.
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6. From the Status drop down menu, select a status ID to send.
The selected status ID is highlighted.
OR
From the status ID list, select a status ID to send.
The selected status ID is highlighted.

7. Click Done.
If a password is required to send the status ID, the Password Entry window appears.

8. Using the keypad, enter the password.
For each character you enter, asterisks fill the empty field at the top of the window.

9. Click Enter.
The Password Entry window closes and the selected status’s alias appears in the Status
Message field or, if the password is incorrectly entered, an error message appears.

10. Click a Call button to place the call.
The message is sent and a confirmation or error message appears in the Dispatching status bar.

11. Click Done.
The window closes.

To open the Status List window, do the following:
1. Open a Per Line Call History window associated with a 5/6 Tone line.
2. Click the Set Status button.
The Status List window appears.

i
Notice!
The Status field is used only for 5/6 Tone/DTMF ANI Signaling.
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Call (1-10) Buttons
The Call (1-10) buttons are used to place user-defined calls configured in the “5-6 Tone/DTMF ANI
system type, page 79”. For the call buttons panel to be enabled, the line must be configured for 5/6
Tone DTMF Signaling, and at least one Call Format must be set up. The labels used only for 5/6 Tone/
DTMF ANI Setup page appear on these buttons in the Call List window.

To place a call from the Per Line Call History window, do the following:
1. Select an ID in the list.

Available call buttons on the bottom of the window become active.
2. Select a call button.
The call is placed.

31.59.3 IRR Playback Control window

i

Notice!
For the IRR Playback control to appear, the line must be configured for IRR Recording. If IRR
Recording is enabled on the line, the Per Line Call History Window will display the Audio Playback
Control.

Figure 31.61: Per Line Call History Window

Save to File button
The Save to File button is used to save the currently selected items to a .csv file.

To save a .csv file of the items in the list, do the following:
1. From the Per Line Call History list, select the items you want to save.
2. Click Save to File.

The Save window appears.
3. In the File name field, enter a name for your .csv file.
4. Click Save.

Done button
The Done button is used to close the Per Line Call History window.

Note:
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When an ADHB-4 is installed in the system:
– Master Select audio will also affect the IRR playback audio level if Output Speaker 1 is selected in

the Recording Settings.
– Master Unselect audio will also affect the IRR playback audio level if Output Speaker 2 to 6 is

selected in the Recording Settings.

31.59.4 Comments window
The Comments window, shown in the Figure below appears when the user right clicks on a call entry
in either the Per Line window or the Global Call History window and selects the Edit Comment menu
item. The Comments window is used to either create a new comment or modify an existing comment
for a menu item.

Up to 100 characters can be entered in a single comment.

Figure 31.62: Comments window

i
Notice!
Phone functions listed below are specific to PSTN lines attached to a C-6200 or IP-223 with TDI or
PIB adapters. These should not be confused with SIP Phone operation.

31.60 Phone-Flashhook
The Phone-Flashhook function allows the console operator to perform a flashhook operation on the
phone line. This button is generally included as part of a DTMF keypad.

To add a Flash button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
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4. From the UI Element drop down menu, select Phone - Flashhook.
5. Click OK.
The button changes color and Flash appears on the button.

31.61 Phone-Hold
The Phone-Hold function allows the console operator to place a particular line on hold. While a line is
in hold status, no TX audio is sent to the line and RX audio is sent to the unselect speaker.

To add a Hold button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select Phone - Hold.

The Line to Associate Function With drop down menu becomes active.
5. From the Line to Associate Function With drop down menu, select the line to associate the Hold

function.
6. Click OK.
The button changes color and Hold appears on the button.

31.62 Phone-On/Offhook
The Phone-On/Offhook function is available to add a line set up as a phone line.

A phone, like a radio circuit, can be used as a network device. A C-6200 console with a phone card
offers phone lines for use by anyone on the network. A phone line can be used for direct phone
communications by a console operator, or to add a crosspatch to telephone capability for radio users.

When the console operator presses the Phone-On/Offhook button, the line goes offhook and a dial
tone is audible. All radio traffic is moved to the unselect speaker. Full-duplex audio is present from the
microphone while the line is offhook and not on hold. Placing the line on hold mutes the transmit audio
and places the receive audio on the unselect speaker.

When a hard-wired phone card receives an incoming call, a ring signal is sent out. The C-Soft
program generates a ringing sound and places a RING icon on the on/offhook button. When the line is
taken offhook, the first console to answer the call takes control of the line and all others are denied.

i

Notice!
A Mute-Per Line button can be associated with a Phone line to mute the phone line’s mic. The mute
icon appears when the Phone line is muted, RX blocked, or when a Mute Main button is selected.
Refer to “Mute-Per Line, page 321”.

To add a Phone On/Offhook button, do the following:
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1. From the Insert menu, select Add UI Button.
A None button appears on the console window.

2. Right-click the None button. 
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select Phone - On/Offhook.
The Line to Associate Function With drop down menu becomes active and the Remote Phone
Select tab appears.

5. From the Line to Associate Function With drop down menu, select the line to associate the On/
Offhook function.

6. Click the Remote Phone Select tab.
The Remote Phone Select page appears.

7. From the Remote Phone Number drop down menu, select the physical line of the device the
PSTN line is attached to.

– When specifying a specific line using an IP-223, valid options are 1 or 2.
– When specifying a specific line for a C-6200 choices can be 1-18.
– To use any line on the device, select Pool.
8. Click OK.
The button changes color and Phone Onhook appears on the button.

31.62.1 Remote Phone Line Select page
When the Phone On/Offhook function is selected from the UI Element drop down menu, the Remote
Phone Line Select page appears. Refer to the Figure below.

Figure 31.63: Remote Phone Line Select Page - UI Element Setup
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Remote Phone Number drop down menu
The Remote Phone Number drop down menu identifies the line to force the use of a particular phone
line on the console.

To use any line, do the following:
– From the Remote Phone Number drop down menu, select Pool.
C-Soft creates a ring only if the selected line is ringing.

31.63 PTT-Group Call
The PTT-Group Call button is used to call a specific group/talk group.

Refer to the Table “Radio Operations Supported by System Type,” on page 394 for radio operations
supported by Group PTT.

To send a group call, do the following:
1. If the Keypad is present, select the group from the Contacts tab or manually enter a group ID.

OR
From the Group-PTT drop down menu, select the group you want to call.

2. Press and hold the Group PTT button and begin speaking.
3. Release the Group PTT button to stop transmitting.

The PTT-Group Call function allows the console operator to transmit audio to a group of radios.
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select PTT-Group Call.
5. Click OK.
The button changes color and PTT appears on the button.

31.64 PTT-Main
The PTT-Main function allows the console operator to transmit audio to all selected channels. This
button is generally included on all console designs. In C-Soft Runtime, if the console operator presses
the PTT-Main button, audio is sent to all selected channels.

To add a PTT-Main button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select PTT-Main.
5. Click OK.
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The button changes color and PTT appears on the button.

31.65 PTT-Per Line
The PTT-Per Line function, or instant PTT function, allows the console operator to immediately key up
a specific line on the current frequency.

When the PTT-Per Line function is selected, a line must be selected from the Line to Associate
Function With drop down menu on the Type page.

31.65.1 Per Line PTT Setup page
When the PTT-Per Line function is selected from the UI Element drop down menu, the Per Line PTT
Setup page appears. Refer to the Figure below.

Figure 31.64: Per Line PTT Setup Page - UI Element Setup

Select PTT Frequency drop down menu
The Select PTT Frequency drop down menu identifies the desired frequency to use per selected line.

To add a PTT-Per Line button, do the following:
1. From the UI Element drop down menu, select PTT-Per Line.

The Line to Associate Function With drop down menu becomes active.
2. From the Line to Associate Function With drop down menu, select the line to associate with PTT

Per Line.
3. Click the Per Line PTT Setup tab.

The Per Line PTT Setup page appears.
4. From the Select PTT Frequency drop down menu, select the frequency.
5. Click OK.
The color of the button changes and Freq X (where X is the frequency) appears on the button.

31.66 PTT-Private Call
The PTT-Private Call button is used to call an individual radio user.
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Refer to the table “Radio Operations Supported by System Type,” on “Keypad, page 433” to see radio
operations supported by PTT-Private Call.

To add a PTT-Private Call button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select PTT-Private Call.
5. Click OK.
The button changes color and PTT-Private Call appears on the button.

To send a private call, do the following:
1. If the Keypad is present, select the User from the Contacts tab or manually enter a User ID.

OR
From the PTT-Private Call drop down menu, select the user you want to call.

2. Press hold the PTT-Private Call button and begin speaking.
3. Release the PTT-Private Call button to stop transmitting.

31.67 PTT-Talk Back
The PTT-Talk Back function allows the console operator to transmit back to the last line from which
audio was received.

To add a PTT-Talk Back button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select PTT-Talk Back.
5. Click OK.
The button changes color and PTT-Talk Back appears on the button.

31.68 Radio Call Alert
The Radio Call Alert button is used to send an alert message to a target radio.

Refer to the table “Radio Operations Supported by System Type,” on Keypad, page 433 to see radio
operations supported by Radio Call Alert.

To add a Radio Call Alert button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
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2. Right-click the None button. 
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select Radio Call Alert.
5. Click OK.
The button changes color and Call Alert appears on the button.

To send a radio call alert message, do the following:
1. If the Keypad is present, select the User from the Contacts tab or manually enter a User ID.

OR
Select the User ID to send the call alert.

2. Click Radio Call Alert.
The command is sent.

31.69 Radio Call Type
The Radio Call Type button is used to switch between Conference Call and Broadcast Call. This
feature is only available for the NEXEDGE IP interface.

To add a Radio Call Type button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. Click OK.
The button changes color and Call Type appears on the button.

31.70 Radio Check
The Radio Check function is used to send a message to check for radio activity.

Refer to the table “Radio Operations Supported by System Type,” on “Keypad, page 433” to see radio
operations supported by Radio Check.

To add a Radio Check button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select Radio Check.
5. Click OK.
The button changes color and Radio Check appears on the button.
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To send a radio check message, do the following:
1. If the Keypad is present, select the User from the Contacts tab or manually enter a User ID.

OR
Select the User ID to send the radio check message to.

2. Click the command button on the Radio Check button.

31.71 Radio Disable
The Radio Disable button is used to disable a radio in the field from use by unauthorized persons.

Refer to the table “Radio Operations Supported by System Type,” on “Keypad, page 433” for radio
operations supported by Radio Disable.

To add a Radio Disable button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select Radio Disable.
5. Click OK.
The button changes color and Radio Disable appears on the button.

To disable a radio, do the following:
1. If the Keypad is present, select the User from the Contacts tab or manually enter a User ID.

OR
Select the Unit ID to disable.

2. Click Radio Disable.
The command is sent.

31.72 Radio Enable
The Radio Enable button is used to enable a radio that has been disabled.

Refer to the table “Radio Operations Supported by System Type,” on “Keypad, page 433” for radio
operations supported by Radio Enable.

To add a Radio Enable button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select Radio Enable.
5. Click OK.
The button changes color and Radio Enable appears on the button.
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To enable a radio, do the following:
1. If the Keypad is present, select the User from the Contacts tab or manually enter a User ID.

OR
Select the Unit ID to enable.

2. Click Radio Enable.
The command is sent.

31.73 Radio Regroup
The Radio Regroup button allows the dispatcher to temporarily reassign a radio to a different
talkgroup.

To add a Radio Regroup button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select Radio Regroup.
5. Click OK.
The button changes color and Radio Regroup appears on the button.

31.74 Radio Ungroup
The Radio Ungroup button allows the dispatcher to reset a radio to their original talkgroup after using
the Radio Regroup button.

To add a Radio Ungroup button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select Radio Ungroup.
5. Click OK.
The button changes color and Radio Ungroup appears on the button.

i
Notice!
The Radio Regroup and Radio Ungroup buttons are only available for the NEXEDGE IP interface.
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31.75 Radio Remote Monitor
The Radio Remote Monitor button allows the dispatcher to open the mic of a targeted radio and hear
any audio in the vicinity of that radio.

Refer to the table “Radio Operations Supported by System Type,” on “Keypad, page 433” for radio
operations supported by Radio Remote Monitor.

To add a Remote Monitor button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select Remote Monitor.
5. Click OK.
The button changes color and Remote Monitor appears on the button.

To monitor a unit, do the following:
1. If a Keypad is present, select a User from the Contacts tab.

OR
From the Remote Monitor drop down menu, select the unit to monitor.

2. Click Remote Monitor.
The command is sent.

31.76 Radio Status
The Radio Status function is used to send a status message to a unit.

Refer to the table “Radio Operations Supported by System Type,” on “Keypad, page 433” for radio
operations supported by radio status. The list of statuses which can be sent from the button
configured in the Radio Status Setup window.

To send a radio status, do the following:
1. From the Contacts tab of the Keypad, select a user.

OR
Manually enter a User ID.

2. From the Radio Status drop down menu, select the status to be sent.
3. Click the Radio Status button.
The status message is sent to the user selected in the Keypad or manually entered.

31.77 Radio Status Request
The Radio Status Request button is used to send message to request status from a unit in the
system.

Refer to the table “Radio Operations Supported by System Type,” on “Keypad, page 433” for radio
operations supported by Radio Status Request.
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To add a Radio Status Request button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select Radio Status Request.
5. Click OK.
The button changes color and Status Request appears on the button.

To request a status from a unit, do the following:
1. If the Keypad is present, select the User from the Contacts tab or manually enter a User ID.

OR
From the Radio Status Request drop down menu, select the User to send the radio status
message to.

2. Click Radio Status Request.
The command is sent.

31.78 Radio Select Call
The Radio Select Call function is used to send a Select Call to a unit in the system.

Refer to the table “Radio Operations Supported by System Type,” on “Keypad, page 433” for radio
operations supported by Radio Select Call.

To add a Radio Select Call button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select Radio Select Call.
5. Click OK.
The button changes color and Radio Select Call appears on the button.

To send a select call, do the following:
1. If the Keypad is present, select the User from the Contacts tab or manually enter a User ID.

OR
Select the Unit ID to enable.

2. Click Radio Select Call.
The command is sent.
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31.79 Radio-On/Offhook
The Radio-On/Offhook function allows the console operator to control a radio using a standard PSTN
(Public Switched Telephone Network) phone line. Radio - On/Offhook is similar to “Phone-On/
Offhook, page 343”, except radio-on/offhook has a Keep-Alive tone generated to keep the phone line
from dropping. A keep-alive tone goes between the radio and console so the system knows to stay
active until after the connection is broken.

i
Notice!
Requires an IP-223 with TDI’s at both ends.

To add a Radio On/OffHook button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select Radio - On/Offhook.

The Line to Associate Function With drop down menu becomes active and the Remote Phone
Select tab appears.

5. From the Line to Associate Function With drop down menu, select the line to associate the On/
Offhook function.

6. Click the Remote Phone Line Select tab.
The Remote Phone Line Select page appears.

7. From the Remote Phone Number drop down menu, select the line to force the use of a particular
phone line on the console.

8. Click OK.
The button changes color and Radio OnHook appears on the button

31.80 Relay Control Button
The Relay Control Button function allows the console operator to control the relays on an attached
ADHB-4 or a network-connected NEO-10.

31.80.1 Relay Control Setup page
When Relay Control Button is selected from the UI Element drop down menu, the Relay Control
Setup page appears.
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Figure 31.65: Relay Control Setup Page - C-Soft

To open the Relay Control Setup page, do the following:
1. Select Insert | Add IU Button.

A None button is added to the console.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element Function drop down menu, select Relay Control.
The Relay Control Setup tab appears.

Relay Destination group box
The Relay Destination radio buttons identify the relay to be controlled. When a selection is made, the
fields necessary to enter the setup information for the relay are enabled.

ADHB-4 radio button
The ADHB-4 radio button indicates an ADHB-4 is controlled by the Relay Control button.

NEO radio button
The NEO radio button indicates a NEO-10 is controlled by the Relay Control button.

MQTT radio button
The MQTT radio button indicates an MQTT device is controlled by the Relay Control button.

i
Notice!
MQTT functionally requires the CMS (Console Management System) to be part of the dispatch
system.
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ADHB-4 Settings group box
The ADHB-4 Settings radio buttons identify which ADHB-4 relay is activated when the button is
pressed, or when the configured input conditions are met.

None radio button
The None radio button indicates none of the ADHB-4 relays is activated when the button is pressed.

Relay 1 radio button
The Relay1 radio button indicates the first relay in the ADHB-4 is being controlled.

Relay 2 radio button
The Relay 2 radio button indicates the second relay in the ADHB-4 is being controlled.

NEO/MQTT Settings group box
The NEO Settings group box identifies the IP Address and the relay, if any, for the NEO-10 or MQTT
device.

IP field
The IP field identifies the IP Address of the NEO-10 or for MQTT control , this is the IP address of the
system CMS server.

Relay drop down menu
The Relay drop down menu is used to select the desired relay.
Available selections for this field are None, Port 1, Port 2, Port 3, Port 4, Port 5, Port 6, Port 7, Port 8,
Port 9 and Port 10.
If MQTT is selected as the Relay Destination, the Relay field changes from a drop down to a number
field where the user can enter a number from 1 to 255.

MAC field
The MAC field indicates the MAC address of the MQTT device.

To configure and add an ADHB-4 Relay Control button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select Relay Control Button.

The Relay Control Setup tab appears.
5. Click the Relay Control Setup tab.

The Relay Control Setup page appears.
6. From the Relay Destination group box, select the ADHB-4 radio button.

The ADHB-4 Settings group box becomes active.
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7. From the ADHB-4 Settings group box, select the None radio button.
OR
From the ADHB-4 Settings group box, select the Relay1 radio button.
OR
From the ADHB-4 Settings group box, select the Relay2 radio button.

8. Click OK.
The button changes color and Relay Off appears on the button.

To configure and add a NEO Relay Control button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select Relay Control Button.

The Relay Control Setup tab appears.
5. Click the Relay Control Setup tab.

The Relay Control Setup page appears.
6. From the Relay Destination group box, select NEO.

The NEO Settings group box becomes active.
7. From the Relay Behavior group box, select the desired mode radio button for the relay control.
8. In the NEO/MQTT group box, enter the IP Address of the NEO.
9. From the Relay drop down menu, select the desired relay.
10. Click OK.

To configure and add a MQTT Relay Control button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select Relay Control Button.

The Relay Control Setup tab appears.
5. Click the Relay Control Setup tab.

The Relay Control Setup page appears.
6. From the Relay Destination group box, select MQTT.

The NEO/MQTT Settings group box becomes active.
7. From the Relay Behavior group box, select the desired mode radio button for the relay control.
8. In the IP field, enter the IP Address of the CMS server.
9. In the MAC field, enter the MAC address of the MQTT device.
10. In the Relay field, enter the relay number (1 to 255).
11. Click OK.
The button changes color and Relay Off appears on the button.

Relay Behavior group box
The Relay Behavior radio buttons identify the mode for the relay control.
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Latch Relay On/Off radio button
The Latch Relay radio button indicates the relay’s latch is controlled by the operator. When the Relay
Control button is clicked the device is active. When the Relay Control button is pressed again the
device is inactive.

Momentary Relay radio button
The Momentary Relay radio button indicates the relay is active when the button is pressed. When the
button is released, the relay is inactive.

Timed Relay radio button
The Timed Relay radio button indicates that when an Relay Control button is clicked, it remains active
for the amount of time configured in the Timed field. When the radio button is selected, you must
configure a time in the Timed field.

Timed Relay field
The Time Relay field is used to set the time, in ms, when the Timed Relay radio button is selected.

The range for this field is 0 to 30000ms.

Emergency Relay Trigger group box
The Emergency Relay Trigger group box is used to configure how the relay behaves when an
emergency call is received.

Activate Relay on Emergency Call check box
The Activate Relay on Emergency Call check box indicates an emergency call activates the
configured relay. If the check box is selected, a radio emergency deactivation radio button can be
selected.

Relay Control Button Only radio button
The Relay Control Button Only radio button is used to configure the relay to deactivate when the
relay control button is released.

Emergency Clear and Acknowledge radio button
The Emergency Clear and Acknowledge radio button indicates the relay is deactivated when the
emergency is acknowledged, cleared, or when the relay control button is released.

Emergency Acknowledge radio button
The Emergency Acknowledge radio button indicates the relay is deactivated when the emergency is
acknowledged or when the relay control button is released.

Phone Relay Trigger group box
The Phone Relay Trigger group box is used to configure how the relay behaves when a phone call is
received.

Activate Relay in Call check box
The Activate Relay in Call check box indicates the relay is activated while C-Soft is in a phone call.
This setting includes both a phone line going offhook as well as C-Soft participating in a SIP call.
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Activate Relay on Phone Ring check box
The Activate Relay on Phone Ring check box indicates a phone ring activates the configured relay.
When the check box is selected, the phone ring behavior can be configured. This setting includes both
a ringing phone line as well as an incoming SIP call.

Cadence radio button
The Cadence radio button indicates the relay is activated when an individual phone ring starts and
deactivated when the phone ring ends.

EXAMPLE: A phone ringing three times, produces an on/off/on/off /on/off pattern.

Steady radio button
The Steady radio button indicates the relay is activated when the first phone ring is received and
deactivates when the call is answered or the caller terminates the call.

EXAMPLE: A phone ringing three times, produces a on/off pattern.

PTT Relay Trigger group box

Activate Relay on PTT check box
The Activate Relay on PTT check box indicates the configured relay is active when any console-
generated transmit event, with the exception of intercom and intercom per line, occurs.

31.80.2 Text Message Control page
To open the Text Message Control page, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element Function drop down menu, select Relay Control Button.

The Relay Control Setup, Text Message Control, and Status Control tabs appear.
5. Click the Text Message Control tab.
The Text Message Control page appears.
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Figure 31.66: Text Message Control Page

Custom Text Message field
The Custom Text Message field is used to enter a text message that is not in the Text Message ID
List.

Text Message List field
The Text Message List field is used select a status that was pre-created in the Text Message ID List.

Add button
The Add button is used to add the custom or selected text message to the Relay On field.

Remove button
The Remove button is used to add the custom or selected text message to the Relay On field.

Relay On field
The Relay On field is used to list the different text messages that are sent when the relay is turned on.

Add button
The Add button is used to add the custom or selected text message to the Relay Off field.

Remove button
The Remove button is used to add the custom or selected text message to the Relay Off field.

Relay Off field
The Relay Off field is used to list the different text messages that are sent when the relay is turned off.
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OK button
The OK button saves the modifications and closes the window.

To create a text message relay control button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element Function drop down menu, select Relay Control Button.

The Relay Control Setup, Text Message Control, and Status Control tabs appear.
5. Click the Text Message Control tab.

The Text Message Control page appears.
6. In the Custom Text Message field, enter a custom text message that is not listed in the Text

Message ID List.
OR
From the Text Message List Group Box, select the status desired to trigger relays on and off.
The list of text messages is pulled from the Text Message ID List.

7. Click the Add button to add the status to either the Relay On group box or the Relay Off group
box.
The Text Message moves from the Custom Text Message field or the Text Message List.
IMPORTANT: A status cannot be used for both a trigger on and a trigger off. If the relay control
type is timed, the Relay Off group box is disabled since the relay automatically latches off when
the designated time has elapsed.

8. Click OK.
The modifications are made and the window closes.

To remove status from the relay on or relay off lists, do the following:
1. From the UI Element Function drop down menu, select Relay Control Button.

The Relay Control Setup, Text Message Control, and Status Control tabs appear.
2. Click the Text Message Control tab.

The Text Message Control page appears.
3. From the Relay On list, select the text message to remove from the list.

OR
From the Relay Off list, select the text message to remove from the list.

4. Click the Remove button to remove the status from either the Relay On group box or the Relay
Off group box.
The Text Message is removed from the Relay On or the Relay Off list.

5. Click OK.
The modifications are made and the window closes.

31.80.3 Status Control page
To open the Status Control page, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
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2. Right-click the None button. 
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element Function drop down menu, select Relay Control Button.
The Relay Control Setup, Text Message Control, and Status Control tabs appear.

5. Click the Status Control tab.
The Status Control page appears.

Figure 31.67: Status Control Page

Status List field
The Status List field is used to select the status to add to the Relay On field or Relay Off field.

Add button
The Add button is used to add the custom or selected status to the Relay On field.

Remove button
The Remove button is used to add the custom or selected status to the Relay On field.

Relay On field
The Relay On field is used to list the different statuses that are sent when the relay is turned on.

Add button
The Add button is used to add the custom or selected status to the Relay Off field.

Remove button
The Remove button is used to add the custom or selected status to the Relay Off field.
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Relay Off field
The Relay Off field is used to list the different statuses that are sent when the relay is turned off.

OK button
The OK button saves the modifications and closes the window.

To create a status control button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element Function drop down menu, select Relay Control Button.

The Relay Control Setup, Text Message Control, and Status Control tabs appear.
5. Click the Status Control tab.

The Status Control page appears.
6. From the Status List group box, select the status desired to trigger relays on and off.

The list of statuses is pulled from the Status Message ID List.
7. Click the Add button to add the status to either the Relay On group box or the Relay Off group

box.
The Status moves from the Status List to the Relay On or Relay Off group box.
IMPORTANT: A status cannot be used for both a trigger on and a trigger off. If the relay control
type is timed, the Relay Off group box is disabled since the relay automatically latches off when
the designated time has elapsed.

8. Click OK.
The modifications are made and the window closes.

To remove status from the relay on or relay off lists, do the following:
1. From the UI Element Function drop down menu, select Relay Control Button.

The Relay Control Setup, Text Message Control, and Status Control tabs appear.
2. Click the Status Control tab.

The Status Control page appears.
3. From the Relay On list, select the status to remove from the list.

OR
From the Relay Off list, select the status to remove from the list.

4. Click the Remove button to remove the status from either the Relay On group box or the Relay
Off group box.
The status is removed from the Relay On or the Relay Off list.

5. Click OK.
The modifications are made and the window closes.

31.81 RX All
The RX All function allows the console operator to remove mute on selected lines if Allow Muting
Selected Lines is selected.

In C-Soft Runtime, if the console operator presses the RX All button it does not change the select
status of any line.
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To add an RX All button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select RX All.
5. Click OK.
The button color changes and RX All appears on the button.

31.82 Scan
The Scan function allows the console operator to scan a selected line.

To add a Scan button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select Scan.

The Line to Associate Function With drop down menu becomes active.
5. From the Line to Associate Function With drop down menu, select the line to associate with

Scan.
6. Click OK.
The button color changes and Scan Off appears on the button.

To activate or deactivate a radio’s scan mode in Runtime, do the following:
1. Press the Scan button.

The radio’s scan mode is activated.
2. Press the Scan button again.
The radio’s scan mode is deactivated.

31.83 Select
The Select function allows the console operator to toggle transmission channels when a master or
accessory PTT button is selected. DTMF and Alert tones are also transmitted to all selected lines.
Select buttons also indicate the type of activity on a line, such as: audio receive, audio transmit, mute,
crossmute, intercom, link fail, and supervisor status.

The Supervisor icon cannot be customized.

– A Mute-Per Line button can be associated with the line assigned to the Select button to mute the
RX (incoming) audio. The mute icon appears when the Select line is muted, RX blocked, or when
a Mute-Main button is selected. Refer to “Mute-Per Line, page 321”.
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For more information, refer to Button Images window, page 143.

Select Button Setup page
When Select is chosen from the UI Element drop down menu, the Select Button Setup page appears.

To open the Select Button Setup page, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select Select.

The Select Button Setup tab appears.
5. Click the Select Button Setup tab.

The Select Button Setup page appears.

Figure 31.68: Select Button Setup - UI Element Setup

Annunciation of Select Call group box

Blink Select Button check box
The Blink Select Button check box is used to indicate the button blinks light blue when the console
receives a select call.

No Beep radio button
The No Beep radio button indicates no tones are heard when a select call is received.
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Beep for radio button
The Beep for radio button is used to indicate a select call alert tone is heard when a select call is
received.

Beep for seconds field
The Beep for seconds field indicates the amount of time the select call alert tone plays.

The Beep for radio button must be selected for this field to be active.

The range for this field is 1-10 seconds.

Beep Until PTT radio button
The Beep Until PTT radio button indicates the select call alert tone is heard until a PTT operation is
performed on the line that received the select call.

To configure a blinking button indication, do the following:
– From the Select Button Setup page, select the Blink Select Button check box.

To configure the desired notification, select one of the following:
– No Beep radio button - no beep sound is played when a select call is received.
– Beep For radio button - a beep sounds for the specified the number of second.
– Beep Until PTT radio button - a beep sounds until a PTT when a select call is received.

Action On Select Call group box

No Action radio button
The No Action radio button indicates an active mute button is not opened during a select call.

Open Mute for radio button
The Open Mute for radio button indicates a muted line is opened upon receiving a select call.

The Open Mute for seconds field must also be configured.

Open Mute for seconds field
The Open Mute for seconds field indicates the amount of time a muted line is unmuted upon receiving
a select call.

The range for this field is 1 to 20 seconds.

To configure the desired action, select one of the following:
– No Action radio button - no action occurs.
– Open Mute for radio button - specifies the duration, in seconds, muted line remains open

(unmuted).

To add a Select button, do the following
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
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3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select Select.
The Line to Associate Function With drop down menu becomes active and the Select Button
Setup tab appears.

5. From the Line to Associate Function With drop down menu, select the line to associate with
Select.

6. Click the Select Button Setup tab.
The Select Button Setup page appears.

7. In the DTMF Digits for Select Call field, enter the digits required to activate the select call feature.
8. From the Annunciation of Select Call group box, select the type of notification to be used.
9. From the Action on Select Call group box, select the mute action during a select call.
10. Click OK.
The button changes color and Select appears on the button.

Annunciation of Call Alert group box

Blink Select Button check box
The Blink Select Button check box indicates the button blinks orange when the console receives a call
alert.

No Beep radio button
The No Beep radio button indicates no tones are heard when a call alert is received.

Beep for check box
The Beep for check box indicates a call alert tone is heard when a call alert is received.

The Beep for seconds field indicates the amount of time the alert tone plays.

Blink Border on Receive group box

No Blinking radio button
The No Blinking radio button indicates the Select button does not blink when receiving a call.

Blink for radio button
The Blink for radio button indicates upon receiving a call the Select button’s border blinks for the
amount of time set in the seconds field. When the line is transmitting the blinking stops.

When selected, the Blink for Radio button field is active.

Blink for field
The Blink for field indicates the amount of time, in seconds, the Select button blinks upon receiving a
call.

Blink Until PTT radio button
The Blink Until PTT radio button indicates upon receiving a call, the Select button’s border blinks until
a PTT is generated on the line.

Blink Color drop down palette
The Blink Color drop down palette indicates the color of the button border when it blinks.
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DTMF Digits for Select Call fields
The DTMF Digits for Select Call fields identifies the digits required to activate the select call feature.
C-Soft can respond up to five different DTMF strings.

This field can contain up to 10 characters.

Beep for seconds field
The Beep for seconds field indicates the amount of time the call alert tone plays.

The Beep for radio button must be selected for this field to be active.

The range for this field is 1 to 10 seconds.

Beep Until PTT radio button
The Beep Until PTT radio button indicates the alert tone is heard until a PTT operation is performed
on the line that received the call alert.

To configure a blinking button indication, do the following:
– From the Select Button Setup page, select the Blink Select Button check box.

To configure the desired notification, select one of the following:
– No Beep radio button - no beep sound is played when a select call is received.
– Beep For radio button - a beep sounds for the specified number of second (0-10 seconds) when

a Select Call is received.
– Beep Until PTT radio button - a beep sounds until a PTT when a select call is received.

DTMF Digits for Select Call group box
The DTMF Digits for Select Call group box contains five fields to specify DTMF digit strings to trigger
a select call in C-Soft. When the console receives any of the DTMF strings configured in the select call
setup, the button notifies the operator by either blinking or beeping depending on the console
configuration.

Trigger Emergency check box
The Trigger Emergency check box indicates an emergency is triggered when the string entered in the
field is received.

31.84 SIP Call Control
The SIP Call Control function creates a button to open the SIP Calls window shown in SIP Calls
window, page 374.
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Figure 31.69: SIP Window - SIP Call Control

31.84.1 SIP Window page
Incoming Call Answer Behavior group box
The Incoming Call Answer Behavior group box is used to determine how C-Soft responds to
incoming calls.

Automatic button
The Automatic button indicates incoming calls are answered automatically by C-Soft.

Manual button
The Manual button indicates incoming calls are answered by clicking the Answer button in the SIP
Call Control window.

Answer Call on SIP Call Control Click check box
The Answer Call on SIP Call Control Click check box indicates incoming calls are answered using the
SIP Call Control button. This option also allows calls to be answered in a single button press.

Allow Do Not Disturb check box
The Allow Do Not Disturb check box indicates the Do Not Disturb feature is available. If unchecked,
the Do Not Disturb button is disabled.
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SIP Call Options group box

Figure 31.70: Normal Window Size
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Figure 31.71: Large Window Size

Display Missed Call Notifications check box
The Display Missed Call Notifications check box indicates if any missed call notifications should be
displayed to the user. When selected, missed calls generate notifications on the SIP Call Control
button and in the SIP Call Control window.

In configurations where the extension is configured for one or more Ring Groups, it may be useful to
not display missed call notifications.

Display Extension on Incoming Call check box
The Display Extension on Incoming Call check box indicates the incoming extension number is
displayed in addition to any alias information in the SIP Call Display window.

When not selected, the incoming SIP extension number is only displayed if there is no caller ID
information included in the incoming call.

SIP Window options

Window Size radio buttons
The Window Size radio buttons are used to specify the size of the SIP window.
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Available options are Normal and Large.

i
Notice!
The Large window size is recommended for touch-screen operation.

Display Backspace Button check box
The Display Backspace Button check box is used to display an on-screen backspace button in the top
right corner of the SIP Call Control window. The on-screen backspace button is useful for touchscreen
operations when using C-Soft without a keyboard.

Background drop down palette
The Background drop down palette is used to change the background color of the SIP Call Display
window.

A light color is recommended.

Text drop down palette
The Text drop down palette is used to change the color of the SIP Call Display window.

A dark color is recommended.

Filter + Contact Text button
The Filter + Contact Text button is used to select a font for the SIP Call Control’s Contact and Filter
list.

31.84.2 SIP Speed Dial page
The SIP Speed Dial page allows entry of 12 numbers. These provide an easy and convenient way to
access commonly-called extensions. Additionally, each entry contains a Presence check box. If an
entry’s Presence check box is selected, C-Soft attempts to subscribe to presence notifications for the
extension.



372 en | UI Element Functions configuration C-Soft 8.500

2025-08 | 16 | F.01U.218.561 Technical Manual Bosch Security Systems, LLC

Figure 31.72: Speed Dial Page

Refer to “Speed Dial Pane” for additional information on the Presence feature.

In C-Soft Runtime, when the window is open, the user can receive, place, and transfer phone calls,
control the call volume, view history or view a list of missed calls. Monitor the Status Bar at the top of
the console window for success or failure messages.

To initiate a connection to the SIP server, do the following:
– Open C-Soft Runtime.
C-Soft attempts to connect to the server.
– If the SIP server connection is successful, the message appears on the console status bar.
– If the SIP server connection fails, the message appears on the console status bar.
– If the SIP server connection becomes disconnected during use, the failure message appears in

the status bar.

During SIP calls, some status messages and icons appear directly on the SIP Call control button during
SIP call activity. These same indications as well as status messages, appear in the SIP Calls window.
Refer to the Figure below.

Note:
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– A Mute Per Line button can be associated with a SIP Call Control button to mute the SIP line’s
RX (incoming) audio. The mute icon, refer to the Figure below, appears when the SIP line is
muted per line, RX blocked, or when a Mute-Main button is selected.

– If the line is muted, and a call is initiated from the SIP Calls window, the line is automatically
unmuted.

Registration failed Ringing

Incoming call Connected

On hold Do not disturb

Mic mute Mute (per line)

Table 31.2: SIP Call Buttons with Status Indications

SIP Incoming Call popup menu
The SIP Incoming Call popup menu, shown in the Figure below, can be used to quickly access the
incoming SIP call. During an incoming call, the status indicator changes to RING. Right-click the
incoming SIP call button to access the popup menu.

Available selections for this menu are:
– Open SIP Window - Opens the SIP Calls window. For more information, refer to “SIP Calls

window, page 374”.
– Answer - Answers the incoming call. For more information, refer to “Call/Answer Button” onCall

page, page 374.
– Ignore - Ignores the incoming call. For more information, refer to “Hang Up/Hang Up >/Ignore

Button” on Call page, page 374.
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Figure 31.73: SIP Incoming Call popup Menu

31.84.3 SIP Calls window
The SIP Calls window is used to manage SIP Calls, view call history and view missed calls.

31.84.4 Call page
When a SIP Call Control button is clicked in C-Soft Runtime, the SIP Calls window opens to the Call
page. Refer to the Figure below.

The Call page is used to place incoming and outgoing SIP phone calls, place holds, initiate 3-way
calling, mute the microphone, transfer calls, and activate do not disturb.

Figure 31.74: SIP Calls Window - Call Page

SIP Call display
The SIP Call display is used to enter a phone number to call. It also provides status messages and
icons to indicate the state of the associated SIP line.

To enter a phone number to call, do the following:
1. Ensure the SIP Calls window is open.
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2. Using the Keypad pane or the keyboard keypad, enter the phone number to call.
The digits appear in the SIP display.

3. Click Call.
OR
While the SIP display has focus, press Enter.

When the call is connected, the Connected icon appears in the display.

Call/Answer button
The Call/Answer button is used to place or answer a call.

This button is disabled until a number is entered or an incoming call is received.
– If a contact is selected from the Contacts pane, or a phone number is entered in the SIP Call

display, the Call button is enabled.
– If a call is being received on a line while the SIP Calls window is open, a ring icon appears on the

SIP Call display, the Call/Answer button changes to Answer, and the Call/Answer and Ignore
buttons are enabled.

Figure 31.75: SIP Calls - Incoming Call

To answer a call, do the following:
– Click Answer.
The incoming call is connected.

If the line is already engaged in a call, the existing call is placed on hold and the Cancel button label
changes to Switch.

To return to a caller on hold while on another call, do the following:
– Click Switch.
The current caller is placed on hold and the other call is taken off hold.
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To answer and merge a waiting call with the current call, do the following.
1. While already engaged in a call, click Answer.

The current call is placed on hold and the incoming call is answered.
2. Click 3-way Call.
The on-hold call is taken off hold, and joined with the other call. The two callers and console operator
are connected in one conversation. The 3-Way Call button label changes to Leave Call.

Figure 31.76: SIP Calls - Outgoing Call

To place an outgoing call, do the following:
1. Using the Keypad pane or keyboard, enter the phone number.

The number appears in the SIP Calls display.
2. Click Call.

OR
Press Enter.

The call is placed to the phone number entered in step 1.

To disconnect from the call, click Hang Up.

Hang Up/Hang Up >/Ignore Button
The Hang Up/Hang Up >/Ignore button is used to disconnect the current SIP call or ignore an
incoming call.
– During a call, the Hang Up button is enabled.
– If multiple parties are connected via consultant transfer, 3-way calling, or call waiting the Hang

Up > button appears. Click the Hang Up > button to open a popup menu containing all currently
connected calls.

– While an incoming call is ringing, the Hang Up button’s text changes to Ignore.
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Figure 31.77: Hang Up > Button with popup Menu

To disengage a 2-way call, do the following:
– Click the Hang Up button.
The call is disconnected and the connected icon disappears.

To disengage a call with multiple participants, do the following:
1. Click Hang Up >.

A popup menu appears. Refer to the Figure above.
2. Select an individual call to disconnect from.

OR
Select Both to disconnect both calls.

To ignore an incoming call, do the following:
– Click Ignore.
The call is ignored and the caller information is added to the list on the Missed page.

Hold button
The Hold button places the current call on hold. During hold, C-Soft does not send or receive audio.
– If multiple parties are connected at one time, the hold button places all calls on hold or takes all

calls off hold.
– If the console operator is talking to the consulting party during a consultant transfer or speaking

to one party during a call waiting event, clicking the Hold button places the active participant on
hold.

Note:
– Hold options can be configured on the SIP server.
– The SIP hold button stops both incoming and outgoing audio, whereas the console hold button

only stops the outgoing audio.
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Figure 31.78: Call Page - On Hold

To place a call on hold, do the following:
– While in a SIP call, click Hold.
The call is placed on hold and the On Hold icon appears in the SIP Call display.

To take a call off hold, do the following:
– Click the Hold button.
The call is taken off hold.

Mute Mic/Unmute Mic button
The Mute Mic button is used to stop microphone audio from reaching any connected party.
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Figure 31.79: Call Page - Mute Mic

To mute the microphone, do the following:
– While engaged in a SIP call, click Mute Mic.
The button changes to Unmute Mic, the Mute Mic icon appears in the SIP Call display, and microphone
audio is not sent.

To unmute the microphone, do the following:
– Click Unmute Mic.
The button label changes to Mute Mic, the icon disappears from the display, and the microphone is
open.

DND/Disable DND button
The DND (Do Not Disturb) / Disable DND button is used to activate do not disturb mode. While
active, callers automatically receive a message stating the number is unavailable. While DND is active,
DND icons appear on the Call page and the associated SIP button.
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Figure 31.80: Call Page - DND

To activate DND, do the following:
– Click DND.
The button label changes to Disable DND and the DND icon appears in the SIP Call display.

Calls received while in do not disturb mode are logged on the Missed page.

To disable DND, do the following:
– Click Disable DND.

The specific do not disturb message is configured on the SIP server.

Consultant Xfr/Blind Xfr button
The Consultant Xfr/Blind Xfr button is used to blind transfer a call or transfer with consultation.
– A blind transfer is a call transferred to a second party without announcing the call to the receiver.
– A consultant transfer allows the console operator to announce the transferred call to the receiver.
– The button label is changed by right-clicking the button and selecting the function from the

popup menu.
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Figure 31.81: Consultant Xfr popup Menu

To abort the transfer function at any time, click Cancel. The incoming call remains connected.

To make a consultant transfer, do the following:
1. From the Call page for the line, if the button label is Consultant Xfr, go to step 3.

OR
Right-click Blind Xfr.
A popup menu appears.

2. Select Consultant Xfr.
The button label and function changes to Consultant Xfr.

3. Click Consultant Xfr.
Enter transfer destination appears and the SIP Call display is ready to accept a transfer
destination.

4. Using the Keypad pane, keyboard, or the Contacts list, enter the new destination number in the
SIP Calls window.

5. Click Consultant Xfr.
The current call is placed on hold and a call is placed to the destination number. When the call is
answered, the Hang Up button changes to Hang Up >.

6. Announce the caller to the second party.
7. Click Consultant Xfr.

The first and second call are now connected, and disconnected from C-Soft.
8. Click Hang Up to disconnect from the call.

Both callers are disconnected from the console.

To make a blind transfer, do the following:
1. From the Call page for the line, if the button label is Blind Xfr, go to step 3.

OR
Right-click Consultant Xfr.
A popup menu appears.

2. Select Blind Xfr.
The button changes to Blind Xfr.
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3. Click Blind Xfr.
Enter Transfer destination appears in the display and the SIP Call display is ready to accept a
number.

4. Using the Keypad pane, keyboard, or Contacts list enter the destination number.
The phone number appears at the bottom of the display.

5. Click Blind Xfr.
The original call is transferred to the destination number and immediately disconnected from the
console.

Line Conf button
The Line Conf button is used to join two SIP phone calls already in progress into a line conference. A
line already involved in a 3-way call can be included in the line conference. During a line conference,
the SIP Calls window border changes to black. An example is shown in the Figure below.

Due to processing demands, a maximum of six remote parties (plus the console) can be mixed
together at one time.

Figure 31.82: SIP Calls Page - Line Conference

To place two lines into a line conference, do the following:
1. Engage two SIP calls on two separate lines.
2. From the first line’s call window, click Line Conf.

The window’s border turns black.
3. From the second line’s call window, click Line Conf.
The second line’s SIP Call window turns black. Both lines are now in communication with each other.

3-Way Call button
The 3-Way Call button is used to establish a call in which three participants are engaged.

To abort the 3-way call function at any time, click Cancel.
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The original call remains connected to the console.

To establish a 3-way call, do the following:
1. While already engaged in a call, click 3-Way Call.

Enter New Destination appears in the display.
2. Using the Keypad pane, keyboard, or Contacts list enter the new destination number.

The number appears at the bottom of the display.
3. Click 3-Way Call.

The current call is placed on hold and a call is placed to the new destination number. The Hang
Up button changes to Hang Up >.

4. Click 3-Way Call.
The first call is taken off hold and joined in the current call. Both parties and the console operator are
connected. The 3-Way Call button’s label changes to Leave Call.

Cancel/Switch button
The Cancel/Switch button is used to cancel an operation or switch to another call.
– If the button is active and Cancel appears on it, it can be used to cancel a blind transfer,

consultant transfer, 3-way call or restore a call to its previous state.
– If the button is active and Switch appears on it, it can be used to switch from the current call to a

call-waiting call.

To cancel a transfer or 3-way call operation before it is completed, do the following:
– Click Cancel.
The operation is canceled, the current caller remains on the line, and the Cancel button is disabled.

To switch to a waiting call while already in a call, do the following:
– Click Switch.
The current call is placed on hold, the waiting call becomes active.

Click Switch to switch back to the other call.

Mute icon
The Mute icon is used to instantly mute audio on the SIP line.
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Figure 31.83: Call Page - Mute Icon

To mute audio on the SIP line, do the following:
– Click Mute.
The Volume slider moves to the bottom of the volume bar. The speaker icon changes to a red mute
icon and audio is turned off.

Clicking Mute restores the Volume slider to its previous value.

Volume Slider
The Volume slider is used to adjust the speaker volume for the associated line.

To decrease the volume, do the following:
– Slide the volume slider down.

To increase the volume, do the following:
– Slide the volume slider up.

Expand Button
The Expand button is used to expand the SIP Calls window, refer to the Figure in 480. When the
Expand button is clicked, a Misc tab, Forward tab, and additional features appear on the Call, History,
and Missed pages.

– Expand button. 

Collapse button
The Collapse button is used to collapse the SIP Calls window, refer to the Figure above.

– Collapse button. 
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Contacts pane
The Contact pane is used to view, edit, or delete the list of contacts within the SIP system. This list is
managed using a popup menu. The contact list can be divided into subdirectories making it easier to
group and maintain contacts. Additionally, the Contact Search bar can be used to filter the contact list
to contain only contacts that match the entered text.

The Contact List supports 5000 SIP contacts.

The Contacts pane appears on the Call page when the expand button is clicked.

Figure 31.84: Call Page - Contacts Pane

i
Notice!
The Pop-up Menu is not accessible with a mouse on the IP-3XXX devices.

i

Notice!
Subdirectory Group names can be modified from their default names (Subdirectory 1, Subdirectory 2,
etc.) by editing the Contact Directory CSV file. The CSV file is located at C:\ProgamData\Telex
Communications\design_folder\ and is named sip_directory_<veg>.cvs (where <veg> is the name of
the C-Soft Design file. You can edit this file directly using a text editor or import the file into any
common spreadsheet application, such as Excel). The Directory file is only created after adding the
first contact to an operational position.

To place a call to a contact in the list, do the following:
1. From the Contacts pane, select a contact.

The contact’s number appears in the SIP call display.
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2. Click Call.
A call is placed to the selected contact.
OR
Double-click the contact.
The default action (the bold item in the popup menu i.e Call) is performed and the call is placed.
OR
Right-click the contact and select Call.
A call is placed to the selected contact.

To add a new contact to the list, do the following:
1. Right-click the contact list.

A popup menu appears.
2. Click Add New.

The Edit Contact window appears.

3. From the Subdirectory drop down menu, select a subdirectory to associate to a Contact, if
desired.

4. In the First Name field, enter the first name of the contact.
5. In the Last Name field, enter the last name of the contact.
6. In the Display Name field, enter a user-recognizable name for the contact.
7. In the Number field, enter the phone number for the contact.
8. In the Notes field, enter appropriate comments for the contact.
9. Click OK.
The contact is added to the contacts list.

To edit a contact in the list, do the following:
1. Right-click the contact list.

A popup menu appears.
2. Click Edit.

The Edit Contact window appears.
3. Make changes to the appropriate fields.
4. Click OK.
The changes to the contact information are saved.

To delete an entry from the contacts list, do the following:
1. Right-click a contact to delete.

The contact list popup menu appears.
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2. Click Delete.
The contact is removed from the list.

To import a contact list from a .csv file, do the following:
1. Right-click the contact list.

A popup menu appears.
2. Click Import.

The Import window appears.
3. Select a .csv file to import.
4. Click OK.
All contacts contained in the .csv file are added to the list.

To export a contact to a .csv file, do the following:
1. Right-click the contact list.

A popup menu appears.
2. Click Export.

The Export window appears.
3. From the Name drop down menu, select a name.

OR
In the Name field, enter a name for the .csv file.

4. Click OK.
All contacts are exported to the selected .csv file.

Keypad pane
The Keypad pane is used to enter DTMF digits and access voice mail messages.

The Keypad appears when the Keypad tab is clicked while in the maximized Call page. The Call page
is maximized using the Expand button.

Note:
– These digits can also be entered using the keyboard.
– While in a call, the keypad generates DTMF tones. When not in a call, the keypad inserts the

digits in the SIP call display.
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Figure 31.85: Call Page - Keypad Pane

To access the keypad pane, do the following:
1. From the Calls page, click the expand button.

The contacts page appears.
2. Click the Keypad tab.
The Keypad pane appears.

CLR button
The CLR (Clear) button is used to clear the information from the SIP Call display.

The SIP Call display entry field must be enabled.

<-- button
The <-- button is used to delete the last entered character from the SIP Call display.

The SIP Call display entry field must be enabled.

Flash button
The Flash button is used to send a hook flash signal.

This feature is only available during a SIP call.

Voice mail button
The Voice mail button is used to access a specific voice mail number. The SIP server must support this
feature.

To configure a specific voice mail number for the button, do the following:
1. Right-click Voice mail and select Configure from the popup menu.

The Edit Contact window appears.
2. In the Number field, enter the phone number for the button.
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3. Click OK.
The voice mail number is stored.

To call the stored voice mail number, do the following:
– Click the Voice mail button.
A call is placed to the specified phone number.

Voice mail notification icon
When the Voice mail notification icon, shown in the Figure above, appears in the SIP Calls display,
voice mails are waiting. The number indicated to the right of the New text, (e.g. 4), is the quantity of
voice mail messages in queue.

Speed Dial pane
If at least one speed dial extension is configured, the SIP window in C-Soft Runtime displays an
additional Speed Dial pane.

Figure 31.86: Call Page - Speed Dial Pane

In C-Soft Runtime, the current call state of the speed dial number is color coded (for example, green
means the number is available to call):
– If not currently in a call, pressing the button calls the specified number.
– If already in a call with the specified number, pressing the button hangs up the call.
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– If already in a call, but not with the specified number, pressing the button forwards the current
call to the specified extension.

If the Presence setting is enabled, C-Soft attempts to monitor the Presence State of each of the
configured button extensions. Each Speed Dial button color changes based on the corresponding
extension’s presence. Additionally, any Autodial buttons in the main console window configured to the
same extension also change color with the extension’s presence information.

The Presence states and colors are:

Presence state Color

Available (not in a call) Green

Unavailable (in a call) Red

Incoming Ring Yellow

Outgoing Ring Blue

No Presence Information Grey

31.84.5 History page
When the History tab is clicked from the SIP Calls window, the History page appears. Refer to the
Figure below. The History page is used to view past SIP Calls received on the selected line.

Figure 31.87: History Page - Maximized

Description column
The Description column displays the call’s number and url or the alias.
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Date and Time column
The Date and Time column displays the date and time the call occurred

Phone Number column
The Phone Number column displays the phone number that called.

History legend
The History legend displays the color format used for incoming and outgoing calls.

Call button
The Call button is used to place a call to the selected phone number. If no call is selected from the list,
the Call button is disabled.

The Call button appears on the History page when the Expand button is clicked.

To call a contact in the History list, do the following:
1. Select the phone number to call.
2. Click the Call button.

OR
Select Call from the entry’s popup menu.
OR
Double-click the entry.

The call is placed and the SIP Calls window switches to the Call page.

31.84.6 Missed page
When the Missed tab is clicked from the SIP Calls window, the Missed page appears. Refer to the
Figure below. The Missed page is used to view calls received, but not answered on the selected SIP
line.

Figure 31.88: Missed Page
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Description column
The Description column displays the call’s number and url or the alias.

Date and Time column
The Date and Time column displays the date and time the call occurred

Phone Number column
The Phone Number column displays the phone number that called.

This column is visible when the Expand button is clicked to maximize the window.

Missed Calls legend
The Missed Calls legend display the color format used for unanswered, ignored, do not disturb, and
forwarded calls.

Call button
The Call button is used to place a call to the selected phone number. If no call is selected from the list,
the Call button is disabled.

The Call button appears when the Missed page is maximized. Click the Expand button to maximize the
window.

Call button
The Call button is used to place a call to a phone number selected from the list. This button is visible
when the Expand button is clicked to maximize the window.

To place a call from the missed call list, do the following:
1. Select a call from the list.
2. Click Return Call.

OR
Double-click an entry.
OR
Right-click an entry and select Call from the popup menu.

The call is placed to the selected phone number.

Clear List button
The Clear List button is used to clear all calls from the list. This button is visible when the window is
maximized.

To clear all calls from the list, do the following:
– Click Clear List.
The list is cleared.

31.84.7 Misc page
The Misc page is used to view the following system information:
– Domain - Displays the registered domain of the SIP line.
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– Protocol - Displays the SIP protocol for the line.
– SIP Registration - Displays the registration information for the SIP line.

The Misc page, refer to the Figure below, becomes available in the SIP Calls window when the expand
button is clicked.

Figure 31.89: Misc Page

31.84.8 Forward page
The Forward page is used to configure forwarding options.

The Forward page, shown in the Figure below, becomes available in the SIP Calls window when the
expand button is clicked.
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Figure 31.90: Forward Page

Forward All Calls check box
The Forward All Calls check box indicates all calls received on the line are forwarded to the phone
number entered in the Destination field for this check box.

i
Notice!
This selection cannot be combined with any other forwarding option.

Destination field
The Destination field is used to enter the phone number to forward all incoming calls to.

Address Book

The Address Book button is used to locate a phone number to enter in the Destination field. 

Forward calls while busy check box
The Forward call while busy check box indicates calls received while the line is busy are forwarded to
the phone number in the Destination field for this check box

i

Notice!
This check box can be used in combination with the Forward unanswered calls option.
Some SIP servers (i.e. 3CX) have their own settings for forwarding a call when an extension is busy.
When using these servers the call forwarding logic in the server takes precedence over the call
forwarding settings in C-Soft.
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Destination field
The Destination field is used to enter the phone number to forward incoming calls to when the line is
busy.

Address Book
The Address Book button is used to locate a phone number to enter in the Destination field.

Forward unanswered calls after check box
The Forward unanswered calls after check box indicates calls left unanswered are forwarded to the
phone number entered in the Destination after the amount of time configured in the Forward
unanswered all after seconds field.

i
Notice!
This check box can be used in combination with the Forward calls while busy option.

Forward unanswered calls after seconds field
The Forward unanswered calls after seconds field is used to enter the amount of time, in seconds,
the call is left unanswered before it is forwarded to the phone number in the Destination field.

Destination field
The Destination field is used to enter the phone number to forward unanswered calls after [X]
seconds.

Address Book
The Address Book button is used to locate a phone number to enter in the Destination field.

Apply button
The Apply button is used to save changes made to the Forward page.

To set up call forwarding, do the following:
1. From the Forward page, select the Forward all calls check box.

OR
Select the Forward calls while busy check box.
OR
Select the Forward unanswered calls check box.

2. In the Forward unanswered calls after seconds field, enter the amount of time in seconds.
3. In the Destination field for the selected check box, enter the phone number the call is to be

forwarded to.
OR
Click the Address Book button.
The address book appears.

4. Select a phone number to forward calls to.
The phone number appears in the Destination field.
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5. Click Select.
The window closes and the phone number appears in the selected field.
OR
Click Cancel
The changes are not accepted and the window closes.

6. Click Apply to accept changes.
The changes are applied.

Close button
The Close button is used to close the SIP Calls window.

31.85 Status Stack Programmed
The Status Stack Programmed window, shown in the Figure below, is used to pre-configure a stack
status which defines the user or group a particular status is sent. Programmed stack statuses are used
to execute an existing stack status in C-Soft Runtime.

Stack Setup page
When Status Stack Programmed is chosen from the UI Element drop down menu, the Stack Setup
page appears.

i
Notice!
This feature is only supported in FleetSync and NEXEDGE Direct IP.

To open the Stack Setup page, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select Status Stack Programmed.

The Stack Setup tab appears.
5. Click the Stack Setup tab.
The Stack Setup window appears.
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Figure 31.91: Status Stack Programmed - Stack Setup Page

Add Status group box

Status drop down menu
The Status drop down menu is used to select an existing status you want to configure for the stack
setup.

To create statuses, refer to “Status Message ID List window, page 189“.

Unit ID drop down menu
The Unit ID drop down menu is used to select an existing Unit ID to send the status.

Group ID drop down menu
The Group ID drop down menu is used to select an existing Group ID to send the status.

Add button
The Add button is used to add the selected status and either the selected Unit ID or Group ID to the
Status/Destination display pane.

Status/Destination display pane
The Status/Destination display pane displays the preprogrammed status messages and the
destination each is sent to when the configured button is clicked.

Remove button
The Remove button is used to remove the selected preprogrammed status from the Status/
Destination display pane.

To remove a status from the Status/Destination display pane, do the following:
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1. From the Status/Destination display pane, select the Status you want to remove.
2. Click the Remove button.
The Status is removed from the Status/Destination display pane.

31.86 Status Stack window
The Status Stack window, shown in the Figure below, is used to configure the window appearance
and functionality of the status stack, including the number of visible entries and the actions to take
when a failed attempt occurs. The Status stack window allow users to select multiple statuses and
send them.

Stack Setup page
When Status Stack Window is chosen from the UI Element drop down menu, the Stack Setup page
appears.

To open the Stack Setup page, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select Status Stack Window.

The Stack Setup tab appears.
5. Click the Stack Setup tab.
The Stack Setup window appears.
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Figure 31.92: Stack Status Window - Stack Setup Page

31.86.1 Window Appearance group box
Maximum Number of Visible Entries field
The Maximum Number of Visible Entries field is used to set the maximum number of visible entries
inside a Stack window at one time.

The range for this field is 0-9.

Set Font button
The Set Font button is used to open the Font window. From this window you can set the font you
want to display in the Stack Status window.

31.86.2 Failed Attempts group box
Number of Retries field
The Number of Retries field is used to set the number of times the system retries the status.

The range for this field is 0-9999.

Retry Wait field
The Retry Wait field is used to set the amount of time to wait between status tries.

The range for this field is 0-9.
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Resend Immediately radio button
The Resend Immediately radio button is used to set the system to resend the failed status
immediately, regardless of the status of the status stack.

Resend After Stack Completion radio button
The Resend After Stack Completion radio button is used to set the system to resend the failed status
after the status stack has completely finished.

31.86.3 Status Stack window
The Status Stack window is used to display the status of stacks being sent such as the date, time,
channel, etc. This window is also used to administer status stacks - sent and failed sends.

i
Notice!
This feature is only supported in FleetSync and NEXEDGE Direct IP.

Figure 31.93: Stacked Status Window

Status Stack display pane
The Status Stack display pane displays columns of different information:
– Date Column - The date the status stack was sent.
– Time Column - The time the status stack was sent.
– Channel Column - The channel the status is sent from.
– Status Alias Column - The name of the status sent.
– Unit ID Column - The User ID of the recipient of the status.
– Group ID Column - The Group ID of the group receiving the status.
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– Status Column - The Status of the stack sent. Available Statuses are:

Status drop down menu
The Status drop down menu is used to select the status alias. Doing this, refines the list of statuses
shown in the display pane, making it easier to find the particular status you are searching. The
selections listed in this menu are directly related to the statuses you created in the Status Message ID
List window. For more information, refer to “Status Message ID List window, page 189”.

Groups display pane
The Groups display pane displays the groups, if any, associated with the selected status.

Users display pane
The Users display pane displays the users, if any, associated with the selected status.

Resend button
The Resend button resends a failed status. You can select more than one status to resend by pressing
the Ctrl key and selecting with the mouse which statuses you want to resend.

Clear button
The Clear button clears the Stacked Status window of all statuses.

Done button
The Done button closes the Stacked Status window.

Add button
The Add button adds more statuses to send

Send button
The Send button sends the selected statuses to the appropriate users or groups.

Refer to
– Status Message ID List window, page 189

31.87 Supervisor
The Supervisor function allows a single dispatch location to seize control of a line or group of lines.

In C-Soft Runtime, after clicking the Supervisor button, the console operator enters the 4-digit PIN
number. When the PIN is entered, a supervisor packet burst is sent to all selected lines. When a
console receives a packet burst, those lines are removed from local control. The console operator of
those lines is no longer able to hear receive traffic or create transmit traffic.

Supervisor password and timeout are configured on the “Control Settings page, page 126”.

To add a Supervisor button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
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2. Right-click the None button. 
A shortcut menu appears.

3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element drop down menu, select Supervisor.
5. Click OK.
The button changes color and Supervisor appears on the button.

31.88 Talk Around button
The Talk Around button is used, on a per line basis, to toggle the radio talk around feature. Talk
around bypasses a radio repeater system, permitting direct radio-to-radio communication.

In C-Soft Runtime, after clicking the talk around button, the button changes colors and talk around is
enabled (the button position is down). After clicking the button again, talk around is disabled (the
button position is up).

To add a Talk Around button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select Talk Around.
5. Click OK.
The button changes color and Talk Around appears on the button.

31.89 Text button
The Text button displays text or can serve as a colored space filler.

i
Notice!
There is no action associated with this UI Button.

To add a text button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select Text Button.
5. Click the Colors tab.
The Colors page appears.
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From the Colors page you can enter the text and change the color you want on the button. Also, you
can leave the text field blank and change the color of the button to serve as a colored space filler. For
more information, refer to “Colors page, page 407”.

31.90 TX All
The TX All function allows the console operator to place all lines into a selected mode. A subsequent
PTT is then transmitted on all lines.

To add a TX All button, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select TX All.
5. Click OK.
The button color changes and TX All appears on the button.
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32 UI Element Setup window - Add button
The UI Element Setup window is used to configure the button to perform the assigned command
when clicked in C-Soft Runtime.

To open the UI Element Setup window for a UI Button, do the following:
1. Right-click the UI Element button.

The properties menu appears.
2. Click Properties.

The UI Element window appears.
– Double-click the UI Element button.
The UI Element window appears.

i

Notice!
The first field on the UI Element Setup window identifies the type of button you are configuring and
cannot be changed. In this case, it is UI Element: Button. The type is determined by the button you
right-click.

32.1 Type page
The Type page, shown in the Figure below, is used to configure the type of function for the UI Element
button. Some UI Elements require further configuration and when selected from the function drop
down menu, additional configuration pages appear.

Figure 32.1: Type Page - UI Element Setup

Filter drop down menu
The Filter drop down menu is used to select a filter that shows only elements associated with the type
of filter chosen.

Available selections for this field are:
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– All - All UI Elements are available
– FleetSync - UI Elements which can be used with FleetSync are available
– MDC-1200 - UI Elements which can be used with MDC-1200 are available
– MOTOTRBO - UI Elements which can be used with MOTOTRBO are available
– P25-DFSI - UI Elements which can be used with P25-DFSI are available
– Phone - UI Elements which can be used with Phone are available
– SIP - UI Elements which can be used with SIP are available
– ADHB-4 Only - Only UI Elements associated with the ADHB-4 are available
– Crosspatch Only - Only UI Elements associated with Crosspatch are available
– FleetSync Only - Only UI Elements associated with FleetSync are available
– MDC-1200 Only - Only UI Elements associated with MDC-1200 are available
– P25-DFSI Only - Only UI Elements associated with P25-DFSI are available
– Paging Only - Only UI Elements associated with Paging are available
– Phone Only - Only UI Elements associated with Phone are available
– PTT Only - Only UI Elements associated with PTT are available
– SIP Only - Only UI Elements associated with SIP are available

UI Element Function drop down menu
The UI Element Function drop down menu is used to select an operation for the button. For more
information on individual function configurations, refer to “UI Element Functions configuration, page
215”.

Figure 32.2: UI Element Function Drop Down Menu

Line to Associate Function With drop down menu
The Line to Associate Function With drop down menu is used to select a line to associate the
function with. Not all functions are associated per line. This field is grayed out if the UI element
function is a global function.

OK button
The OK button saves the entries and closes the window.
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Figure 32.3: Alert Setup Page - UI Element Setup

i

Notice!
If the console contains a UI Element button with no assigned function, ERROR! Button with no a/
ssigned UI element function appears in the Design Errors window when the C-Soft Designer is saved.
Refer to the Figure below.
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Figure 32.4: Design Errors Window

32.2 Colors page
When Add UI Button or Add popup Button is selected from the Insert Menu the Colors page appears.
This page also provides a visual display of the button in the up position with the selected attributes,
and can be pressed to display the button in its down state. Refer to the Figure below.
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Figure 32.5: Colors Page - UI Element Setup

Button Up and Button Down group box

Button drop down menu
The Button drop down menu displays the color of the button when it is available for selection (Button
Up) or when it is selected (Button Down). Default button colors are defined for each UI element
function. The button colors can be changed by selecting the drop down menu to open a color palette.

Text drop down menu
The Text drop down menu displays the color of the text on the button when it is available for selection
(Button Up) or when it is selected (Button Down). Default text colors are defined for each UI element
function. The text colors can be changed by selecting the drop down menu to open a color palette.

Button Images group box
The Button Images group box is used to add a graphic to a button. The Button Images group box
supports image types of .bmp, .png, .jpg, and .gif.

Note:
– For a transparent button when using a 24-bit color bitmap, use RGB color 192, 192, 192.
– Suggested maximum image size is 1680 x 1050 pixels.
– Suggested maximum resolution is 72dpi.
– Only 24-bit and 32-bit .png files are supported.

Up Position and Down Position Image fields
The Up Position and Down Position image fields identify the image to use on the button. Use the

browse button  located next to the field to select the image.

To use the same image on the Up and Down button position, do the following:
– Using the browse button located next to the Down Position Image field, select the image.
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To use a different image for the Up and Down button position, do the following:
– Using the browse button located next to the image field, select the image for each field.

To clear an entry from the Up and Down button position Image fields, do the following:
– Click the X button located next to the image field.

Button Up Text field
The Button Up Text field identifies the text displayed on the button when the button is available for
selection.

This field can contain up to 49 characters.

Button Down Text field
The Button Down Text field identifies the text displayed on the button when the button is selected.

This field can contain up to 49 characters.

Border Color drop down menu
The Border Color drop down menu displays the color of the border around the button. The border
color can be changed by opening the palette with the drop down menu to select the desired color. The
button border is half of the grid size on the console window. This allows UI Elements with the same
color border to be grouped together, or to help create a visual separation between groups of buttons.

Set Font button
The Set Font button displays a Font window used to select the text attributes for the button text.

OK button
The OK button saves the entries and closes the window.

32.3 Radio Command buttons
The Radio Command buttons, shown in the Figure below, allow the user to send a radio command to
specific user or group. If a keypad is present in the design file, Radio Command buttons contain a
single button and use the keypad’s destination as the command’s target. However, if no keypad is
present the button comprised of two individual buttons; the command button and a drop down
button.

Figure 32.6: Radio Command Button

Radio Command drop down button
The Radio Command drop down button is used to display all the users or groups associated with the
radio command.
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If no keypad is present, the following button function types display users in the drop down list:
– GPS Read
– GPS Trigger On
– GPS Trigger Off
– Private Call
– Radio Call Alert
– Radio Call Type
– Radio Check
– Radio Disable
– Radio Enable
– Radio Select Call
– Radio Status Request
– Radio Regroup
– Radio Ungroup
– Remote Monitor

The following statuses display statuses in the drop down list:
– Radio Status

The following button function types display groups in the drop down list:
– Group Call

The following button function types display call priorities in the drop down list:
– Call Priority

To select a user from the drop down list, do the following:
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1. Click the Radio Command button.
The drop down list opens displaying users/groups configured in the line’s signaling system.

2. From the Radio Command drop down list, select an entry.
The Command Button displays the selected user name. When the command button is pressed, the
button’s configured command is sent to the selected.
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33 UI Element Setup window - Add Clock
The Add Clock option inserts a clock on the console. C-Soft can support multiple clocks on a design
file for radio resources covering different time zones. The time and button format are controlled with
the Clock Control page.

While in C-Soft Runtime, the clock displays as configured. An example is shown in the Figure below.

Figure 33.1: Console Clock Example

To insert a clock button, do the following:
– From the menu bar, select Insert | Add Clock.
A clock button appears on the console.

33.1 Clock Control page
The Clock Control page, shown in the Figure below, appears when the clock is right-clicked.
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Figure 33.2: Clock Control Page

Time Format group box

12 Hour radio button
The 12 Hour radio button indicates the time displays in civilian time format.

24 Hour Radio Button
The 24 hour radio button indicates the time displays in military time format.

Appearance group box

Background Color drop down palette
The Background Color drop down palette is used to set the clock background color.

Border Color drop down palette
The Border Color drop down palette is used to set the clock border color.

Test Color drop down palette
The Text Color drop down palette is used to set the clock text color.

Border Thickness field
The Border Thickness field is used to set the clock border thickness.

The range for this field is 0 to 20.

Set Font button
The Set Font button is used to open the font window.
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Font window
The Font window, shown in the Figure below, indicates the font used to display the time on the clock
display. The font window includes standard options for Font, Font Style, and Size. When you change
the format, a preview of the text appears in the Sample field.

Figure 33.3: Font Window - Clock Control

Time Source group box

Use Local Computer Time check box
The Use Local Computer Time check box indicates the time that displays on the clock is derived from
the PC running C-Soft. Otherwise, an offset time must be selected from the Time Offset drop down
menu.

Time Offset drop down menu
The Time Offset drop down menu is used to select an offset time for the clock. The Use Local
Computer Time check box must be cleared for this field to be active.

Available selections for this field are:

GMT-12:00 GMT-11:00 GMT-10:00 GMT-09:00 GMT-08:00 GMT-07:00

GMT-06:00 GMT-05:00 GMT-04:00 GMT-03:30 GMT-03:00 GMT-02:00

GMT-01:00 GMT GMT+01:00 GMT+02:00 GMT+03:00 GMT+03:30

GMT+04:00 GMT+04:30 GMT+05:00 GMT+05:30 GMT+05:45 GMT+06:00

GMT+06:30 GMT+07:00 GMT+08:00 GMT+09:00 GMT+09:30 GMT+10:00

GMT+11:00 GMT+12:00 GMT+13:00
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Date Format drop down menu
The Date Format drop down menu is used to select the display format for the clock. The clock control
displays in the selected format.

Available selections for this field are:

Selection Console clock display format

None Date is not displayed. The clock only displays the
time.

Wednesday, March 17, 2010 Day of the Week, Month Day, Year (4-digit)

Wednesday March 17 Day of the Week Month Day

Wed March 17 Day of the Week Abbreviated Month Day

Wednesday Mar 17 Day of the Week Month Abbreviated Day

March 17, 2010 Month Day, Year (4-digit)

Mar 17, 2010 Month Abbreviated Day, Year (4-digit)

17-Mar-2010 Day-Month Abbreviated-Year (4-digit)

17-Mar-10 Day-Month Abbreviated-Year (2-digit)

March 17 Month Day

03/17/10 dd/mm/yy

03/17/2010 mm/dd/yyyy

17/03/2010 dd/mm/yyyy

17.03.2010 dd.mm.yyyy

2010-03-17 yyyy-mm-dd

17 March 2010 Day Month Year (4-digit)

17 Mar 2010 Day, Month Abbreviated, Year (4-digit)

2010 March 17 Year (4-digit) Month Day

2010 Mar 17 Year (4-digit), Month Abbreviated Day
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34 UI Element Setup window - Add Frame
The Add Frame option inserts a Frame on the console. The button format and color are controlled with
the Frame Setup page.

To insert a Frame, do the following:
– From the menu bar, select Insert | Add Frame.
A Frame appears on the console.

Figure 34.1: Insert/Add Frame from Insert Drop Down Menu

Frame Setup page
The Frame Setup page, shown in the Figure below, appears when the Frame button is right-clicked
on the edge of the frame.

Figure 34.2: Frame Setup Page

Border Width field
The Border Width field is used to enter the border width of the frame.

The range for this field is 0 to 999.
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Border Color field
The Border Color field is used to select the border color of the frame.

Use Image check box
The Use Image check box indicates the frame displays the selected image file.

To select an image file, do the following:
– Click the Browse button.
The Frame supports image types of .bmp, .png, .jpg, and .gif.

Figure 34.3: Use Image Check Box
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35 UI Element Setup window - Add Frequency Control
The Frequency Control
The Frequency Control is used to change the frequency on a line. When a frequency is changed, a
burst of packets is sent onto the Ethernet network requesting the remote radio to change to the new
frequency of the selected line. Additionally, all other consoles on the network must change to display
the new frequency of the radio on that particular line.

A Frequency Control is composed of two buttons, (frequency up and frequency down) and the current
frequency display area.

Figure 35.1: Frequency Control

The Frequency Control automatically contains all frequencies configured for the line, except for
frequencies configured for Pair Mode and are non-transmittable.

For more information, refer to “Freqs Button”.

Frequency Down button
The Frequency Down button is used to select the previous configured frequency.

Frequency Up button
The Frequency Up button is used to advance to the next configured frequency.

Current Frequency display
The Current Frequency display displays the active frequency on the line associated to the frequency
control. The selected frequency can be changed by either; clicking the Frequency Down or Frequency
Up buttons, or by clicking on the Current Frequency Display area and selecting a frequency from a
drop down list.

To scroll through the available frequencies, do the following:
– Press and hold the Frequency Down or Up buttons.
The Frequency Control begins cycling through the available frequencies on the configured line.

To select a frequency while scrolling, do the following:
– Release the Frequency Up or Down button when the desired frequency is visible.

To select a frequency from the drop down list, do the following:
1. Click the Current Frequency Display area.

A drop down menu containing all available frequencies are displayed. Frequencies are displayed
in ascending numeric order starting at Frequency 1.
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2. From the drop down menu, select the desired frequency.

Figure 35.2: Frequency Control Drop Down

When Scannable is selected for the line, right-click the frequency control to display a shortcut menu
that provides the console operator the ability to add or remove the currently selected frequency from
the scan list.

When a frequency is in the scan list, the  icon appears next to the frequency in the Frequency
Display area and in the Frequency drop down list. Parallel consoles are also alerted to update their
display if a frequency is added or removed from the scan list.

For more information refer to “Scannable Check Box” on “Scannable Check Box”.

Add Frequency Control
The Add Frequency Control function inserts a Frequency Control on the console. The button format
and color are controlled with the Frequency Control page.

To insert a frequency control button, do the following:
– From the menu bar, select Insert | Add Frequency Control.
A Frequency Control appears on the console.

35.1 Colors page
The Colors page, shown in the Figure below, is used to select the settings for the Orientation, Arrow
Button Settings, and Text settings.
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Figure 35.3: Colors Page - UI Element Setup

Orientation group box
The Orientation group box specifies whether the Frequency Up and Down buttons are placed to the
left and right of the control or the top and bottom of the control.

Horizontal radio button
The Horizontal radio button indicates the Frequency Up and Down buttons are drawn to the right and
left of the frequency display area.

Figure 35.4: Frequency Control in the Horizontal Orientation

Vertical radio button
The Vertical radio button indicates the Frequency Up and Down buttons are drawn to the top and
bottom of the frequency display area.

Figure 35.5: Frequency Control in the Vertical Orientation
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Border Color group box

Border Color drop down menu
The Border Color drop down menu displays the color of the border around the frequency control. The
border color can be changed by opening the palette with the drop down menu to select the desired
color. The frequency control border is half of the grid size on the console window. The frequency
control border being half the size of the grid size allows UI Elements with the same color border to be
grouped together, or to help create a visual separation between groups of UI Elements.

Arrow Button Settings group box
The Arrow Button Settings group box contains settings which control the appearance of the
Frequency Up and Down buttons.

Button Size field
The Button Size field sets the height (if the orientation is set to vertical) or width (if the orientation is
set to horizontal) of the Frequency Up and Down buttons The button size field allows for a larger drop
down button to accommodate users of touch screen monitors.

The range for this field is 0 to 200.
The default value for this field is 17.

Up Color drop down menu
The Up Color drop down menu displays the color of the button when it is available for selection
(Button Up). The button colors can be changed by selecting the drop down menu to open a color
palette.

Down Color drop down menu
The Down Color drop down menu displays the color of the button when it is selected (Button Down).
The button colors can be changed by selecting the drop down menu to open a color palette.

Arrow Color drop down menu
The Arrow Color drop down menu displays the color of the arrow in the drop down button. The arrow
color can be changed by opening the palette with the drop down menu to select the desired color.

Text Settings group box
The Text Settings group box properties control the appearance of the Frequency Display area and the
Frequency drop down list.

Background Color drop down menu
The Background Color drop down menu displays the background color of the Frequency Display area
and Frequency drop down list. The background color can be changed by selecting the drop down
menu to open a color palette.

Text Color drop down menu
The Text Color drop down menu displays the color of the text in the Frequency Display area and
Frequency drop down list. The text colors can be changed by selecting the drop down menu to open a
color palette.
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Set Font button
The Set Font button displays a Font window used to select the text attributes for the Frequency
Display area and Frequency drop down list.

OK button
The OK button saves the entries and closes the window.

35.2 Frequency Control page
The Frequency Control page, shown in the Figure below, is used to select the Frequency List Settings
and the Scrolling Settings.

Figure 35.6: Frequency Control Page - UI Element Setup

Frequency List Settings group box
The Frequency List group box properties control the appearance and the display location of the
Frequency drop down list. The Frequency List appears when the user clicks the Frequency Display
area and disappears when either a frequency has been selected or the user has clicked on another
control.

Drop Down Direction radio buttons
The Drop Down Direction group box is used to select the direction the drop down list containing the
list of available frequencies is displayed relative to the frequency control.

Above radio button
The Above radio button indicates the drop down list is displayed above the frequency control.



C-Soft 8.500 UI Element Setup window - Add Frequency Control | en 423

Bosch Security Systems, LLC Technical Manual 2025-08 | 16 | F.01U.218.561

Below radio button
The Below radio button indicates the drop down list is displayed below the frequency control.

Left radio button
The Left radio button indicates the drop down list is displayed to the left of the frequency control.

Right radio button
The Right radio button indicates the drop down list is displayed to the right of the frequency control.

Entry Spacing field
The Entry Spacing field is used to enter the amount of space in pixels between individual entries in
the drop down list. The valued entered for Entry Spacing and the font type determine the height of the
individual entries in the drop down list. When using a touch screen monitor the entry spacing value
can be increased to allow individual entries to be selected from a touch screen.

The range for this field is 0 to 99.
The default value for this field is 8.

Visible Entries field
The Visible Entries field is used to enter the number of frequencies visible in the drop down list
without scrolling.

The default value for this field is 10.

Scrolling Settings group box

Scrollbar Width field
The Scrollbar Width field is used to set the width in pixels of the scrollbar in the drop down list.

The default value for this field is 17.

Minimum Slider Size field
The Minimum Slider Size field is used to set the minimum height of the scrollbar’s thumbtack slider in
the drop down list. The thumbtack slider is sized proportionally to the total number of entries in the list
and the number of entries which are displayed. The minimum slider size ensures the scrollbar will
always be as large as the entered value.

The default value for this field is 17.

Initial Delay field
The Initial Delay field is used to set the number of milliseconds a Frequency Up or Down button must
be held down before the frequency control begins scrolling through the available frequencies. The
larger the value, the longer the Frequency Up or Down buttons must held before scrolling begins.

The range for this field is 10 to 9999.
The default value for this field is 500.
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Repeat Delay field
The Repeat Delay field is used to set the number of milliseconds between frequency changes once
the Frequency Control begins scrolling. The larger the value, the slower the Frequency Control will
cycle though the available Frequency List.

The range for this field is 10 to 9999.
The default value for this field is 100.
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36 UI Element Setup window - Add Keypad
Use the Keypad UI Element Properties to configure the colors associated with each Mode; Common,
Contact, Manual, and History. The Keypad GUI Element Settings window contains five pages: Type,
Common, Contact Tab, Manual Tab, and History Tab.

To customize the Keypad Graphical User Interface, do the following:
1. From the Insert menu, select Add Keypad.

The keypad module is created on the Designer desktop.
2. Right-click on the keypad.

A popup menu appears.
3. From the popup menu, select Properties.

The UI Element Setup window appears.

4. Click each tab to configure colors for the associated buttons and fields.

36.1 Common page
The Common page is used to set the appearance settings for common keypad window elements
shared between multiple pages.
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Figure 36.1: Keypad GUI Element - Common Page

Line Contact display settings

Line Background Color drop down palette
The Line Background Color drop down palette is used to set the background color of the selected
contact area.

Line Text Color drop down palette
The Line Text Color drop down palette is used to set the text color of the selected contact area.

Line Font button
The Line Font button opens the Font window. From this window, you can set the font of the selected
contact area.

User/Alias Background Color drop down palette
The User/Alias Background Color drop down palette is used to set the background color of the User/
Alias display area.

User/Alias Text Color drop down palette
The User/Alias Text Color drop down palette is used to set the text color of the User/Alias display
area.

ANI/Alias Font button
The ANI/Alias Font button opens the font window. From this window, you can set the font of the
User/Alias display area.
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Search/UserID Background Color drop down palette
The Search/UserID Background Color drop down palette is used to set the background color of the
Search/UserID area.

Search/UserID Text Color drop down palette
The Search/UserID Color drop down palette is used to set the text color of the Search/UserID entry
area.

Search/UserID Font button
The Search/User ID Font button opens the Font window. From this window, you can set the font of
the Search/UserID Entry area.

Separator/Background group box

Separator/Background Color drop down palette
The Separator/Background Color drop down palette is used to set the color of other non-defined
background areas.

Mode Button Settings group box

Color Up Color drop down palette
The Color Up Color drop down palette is used to set the color of the mode buttons in the unpressed
state.

Color Down Color drop down palette
The Color Down Color drop down palette is used to set the color of the mode buttons in the
depressed state.

Text Color Up Color drop down palette
The Text Color Up Color drop down palette is used to set the text color of the mode buttons in the
unpressed state.

Text Color Down Color drop down palette
The Text Color Down Color drop down palette is used to set the text color of the mode buttons in the
depressed state.

Mode Font button
The Mode Font button opens the Font window. From this window, you can set the of the Mode
buttons.

Contact Button Label field
The Contact Button Label field is used to enter the text shown on the Contacts button.

Manual Button Label field
The Manual Button Label field is used to enter the text shown on the Manual button.

History Button Label field
The History Button Label field is used to enter the text shown on the History button.
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Border Settings group box

Border Width field
The Border Width field is used to set the border width for the entire keypad control.

Border Color drop down palette
The Border Color drop down palette is used to set the border color for the entire keypad control.

Status Settings group box

Background Color drop down palette
The Background Color drop down palette is used to set the background color of the status display
area.

Status Text Color drop down palette
The Status Text Color drop down palette is used to set the text color of the status display area.

Status Font button
The Status Font button opens the Font window. From this window, you can set the font of the status
display area.

Default button
The Default button is used to return all the Common Tab settings back to the factory default settings.

Apply button
The Apply button is used to apply the modifications made to the Common Tab settings.

36.2 Contact Tab page
The Contact Tab page is used to set the appearance settings for the Contact window.
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Figure 36.2: Keypad GUI Element - Contact Tab Page

Contact Filter Settings group box

Background Color drop down palette
The Background Color drop down palette is used to set the background color of the filter area.

Text Color drop down palette
The Text Color drop down palette is used to set the text color of the filter area.

Button Color drop down palette
The Button Color drop down palette is used to set the color of the button in the filter area.

Button Text Color drop down palette
The Button Text color drop down palette is used to set the color of the arrow on the button in the
filter area.

Entry Spacing field
The Entry Spacing field is used to enter the spacing between entries in the filter entry list.

Button/Scrollbar Width field
The Button/Scrollbar Width field is used to enter the width of the filter selection button and filter
entry list scrollbar.

Scroll Slider Height field
The Scroll Slider Height field is used to enter the height of the filter entry list scrollbar’s slider.
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Visible Entries field
The Visible Entries field is used to enter the number of entries displayed at once in the filter entry list.

Contact List Settings group box

Background Color drop down palette
The Background Color drop down palette is used to set the background color of every odd row of the
Contact List area.

Alternate Color drop down palette
The Alternate Color drop down palette is used to set the background color of every even row of the
Contact List area.

Text Color drop down palette
The Text Color drop down palette is used to set the text color of the Contact List area.

Row Height field
The Row Height field is used to enter the height of each row in the Contact List.

Scrollbar Width field
The Scrollbar Width field is used to enter the width of the Contact List scrollbar.

Minimum Slider Height field
The Minimum Slider Height field is used to set the minimum slider height of the Contact List area.

Display drop down menu
The Display drop down menu is used to set how the Contacts information is displayed in the Contact
List.

Available options are:
– Alias + ID
– Alias

Shared Settings group box

Filter + Contact Font button
The Filter + Contact Font button opens the Font window. From this winder you can set the font of
both the filter entry list and the contact list.

Apply button
The Apply button is used to apply the modifications made to the Contact Tab settings.

36.3 Manual Tab page
The Manual Tab page is used to set the appearance settings for the Manual window.
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Figure 36.3: Keypad GUI Element - Manual Tab Page

Delete Button Settings group box

Button Up drop down palette
The Button Up drop down palette is used to set the color of the Delete button in the unpressed state.

Button Down drop down palette
The Button Down drop down palette is used to set the color of the Delete button in the depressed
state.

Arrow Color drop down palette
The Arrow Color drop down palette is used to set the color of the arrow on the Delete button.

Keypad Button Settings group box

Button Up drop down palette
The Bottom Up drop down palette is used to set the color of the manual entry button in the unpressed
state.

Button Down drop down palette
The Button Down drop down palette is used to set the color of the manual entry button in the
depressed state.

Button Text Up drop down palette
The Button Text Up drop down palette is used to set the text color of the manual entry button in the
unpressed state.
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Button Text Down drop down palette
The Button Text Down drop down palette is used to set the text color of the manual entry button in
the depressed state.

Button Font button
The Button Font button opens the Font window. From this window, you can set the font for the
manual entry buttons.

Apply button
The Apply button is used to apply the modifications made to the Manual Tab settings.

36.4 History Tab page
The History Tab page is used to set the appearance settings for the History window.

Figure 36.4: Keypad GUI Element - History Tab Page

History List Settings group box

Background Color drop down palette
The Background Color drop down palette is used to set the background color of every odd row of the
History List area.

Alternate Color drop down palette
The Alternate Color drop down palette is used to set the background color of every even row of the
History List area.
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Text Color drop down palette
The Text Color drop down palette is used to set the text color of the History List area.

Row Height field
The Row Height field is used to enter the height of each row in the History List.

History List Font button
The History List Font button opens the Font window. From this window you can set the font for the
History List window.

36.5 Keypad
The Add Keypad option is used to add the keypad module, shown in the Figure below, to your C-Soft
Console. The keypad module is used to specify a destination address for radio operations. Use the
following Table to see the different radio operations for the different system types.

FleetSync Telex-
Serial

MDC-
1200

MOTOTRBO P25-
DFSI

Sprint
Direct
Connect

AIS NEXEDGE
Control
Station

NEXEDG
E IP
Interface

Telex-
Enhanced-
ANI

Radio
Check

x x x x

Radio
Enable/
Disable

x x x x x x x x x x

Call Alert x x x x x x x

Select Call x x x x x x

Remote
Monitor

x x x x x x x x

Status
Request

x x x x x x x x

Status
Message

x x x x x x x

GPS
Operations

x x x x

Private PTT x x x x x x x x x

Group PTT x x x x x x x x

Radio
Regroup

x x

Radio
Ungroup

x x

Table 36.8: Radio Operations Supported by System Type
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NAVIGATION: Select Insert | Add Keypad from the menu bar.

Figure 36.5: Keypad Module - C-Soft

The keypad module has three modes of operation:
– Contacts Mode - Used to search for contact/user IDs.
– Manual Mode - Displays a numeric keypad on the screen while allowing for keyboard input.
– History Mode - Displays a list of recently used contact/user IDs and can be used to specify

destination for new operations.
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Figure 36.6: Keypad Module - Common Controls

Selected Line Display
The Selected Line display shows the currently selected line. For example, Line 1.

Selected Contact display
The Selected Contact display shows the currently selected contact. The selected contact is the
destination of any radio command messages sent from the corresponding radio command buttons.

User Entry field
The User Entry field is used to enter information necessary for keypad operation. Depending on the
current mode selected, this field behaves differently.

– In Contact mode, the user entry field is used to search contacts. When text is entered, the
contact list updates to only show contacts whose User IDs or Aliases match (or partially match)
the entered text. This search is not case sensitive. If no users match the entered text, the entered
text becomes the selected contact (for example, manually entering an ID).

– In Manual mode, the user entry field is used to display the entered digits.
– In History mode, the user entry field is used to display the entered digits.

Contacts Mode button
The Contacts Mode, shown in the Figure below, is used to search for contacts. The use of filters
further narrows the search parameters when looking for contacts.
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Figure 36.7: Keypad Module - Contacts Pane

Filter drop down menu
The Filter drop down menu is used to select a filter to use when looking for contacts. When a filter is
selected from the list, only contacts contained within the specified filter are shown.

Filters are created using the Filter List Setup window, refer to “Filter List Setup window, page 179”.
Once filters are created, user IDs are associated with filters in the User ID List Setup window, refer to
“User ID List window, page 181”. Group IDs are associated with filters in the Group ID List Setup
window, refer to “Group ID List window, page 185”.

Contact List pane
The Contact List pane displays all contacts associated with the selected line. When a contact entry is
selected, the selected Contact Display is updated with the selected contact information. Any radio
operations use the selected contact’s as the destination.

If the contact uses a System List, only contacts within the system list are shown.

Signaling/System Types Requiring a System
List

Signaling/System Types Not Requiring a
System List

– FleetSync
– Telex-Serial
– MDC-1200
– MOTOTRBO
– P25-DFSI
– NEXEDGE

– Generic
– 5/6 Tone
– iDen
– Sprint Direct Connect
– AIS
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Manual Mode
The Manual Mode, shown in the Figure below, is used to manually enter the desired ID. The numeric
keypad can be used with a mouse, but is used largely for touch-screen users or users without a
keyboard.

If the manually entered ID matches a known User ID or Group ID, the selected contact display area
display the matching contact information.

i
Notice!
The ABC button displays the DTMF buttons A - F.

Figure 36.8: Keypad Module - Manual Panel

History Mode
The History Mode, shown in the Figure below, is used to view any operations initiated that use the
keypad’s destination as a target. When a history event is selected, the contact associated with the
selected history event appears in the Selected Contact area. Each entry includes:
– Operation Destination (the Contact ID or Alias, if known)
– Operation Type
– Line name on which the operation was sent
– Timestamp of when the operation occurred.



438 en | UI Element Setup window - Add Keypad C-Soft 8.500

2025-08 | 16 | F.01U.218.561 Technical Manual Bosch Security Systems, LLC

Figure 36.9: Keypad Module - History Pane

Status Bar
The Status Bar displays relevant operation information. This includes notifications of specifying an
invalid User ID, operation sent notifications, and operation results notification.

Figure 36.10: Keypad Module - Status Bar
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37 UI Element Setup window - Add Popup Button
Select Add UI Popup Button from the Insert menu to place a popup button in the upper left hand
corner of the console window. Popup buttons can also be added to a popup window. The popup
button displays an activity icon when a line inside the popup window has incoming audio traffic. The
activity icon can be customized by creating a graphic file named activity.bmp. This file must be located
in the same directory as the csoftruntime.exe file.

To add a popup button to the C-Soft Console window, do the following:
– From the Insert menu, select Add popup Button.
A popup button appears on the C-Soft console window.

To open a popup window in C-Soft Designer, do the following:
1. Right-click a UI element popup button. 

A shortcut menu appears.
2. From the shortcut menu, select Open popup. 

A popup window appears.

To close a popup window, do the following
– Click the X in the upper-right corner of the popup window.
The popup window closes.

To resize the popup window in C-Soft Designer, do the following:
1. Right-click the popup button.
2. From the Shortcut menu, select Open popup.

3. Click resize buttons  to increase/reduce width/height.
OR
Press the Ctrl key while pressing the arrow keys on your keyboard.

Note:
– If, as a result of resizing, the window extends past the window view, move the popup button to a

new position.
– The popup window cannot be resized in C-Soft Runtime.

To insert items into the popup window, do the following:
1. Right-click the Popup button.

A flyout menu appears.
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2. From the flyout menu, select Open Popup.
The Popup window opens.

3. Right-click anywhere inside the Popup window.
A flyout menu appears.

4. From the flyout, select the desired element.
5. Repeat as necessary.

i
Notice!
The popup button must be selected in order to insert items into a popup window.

To edit items in the popup window, do the following:
1. Open a popup window as described above.
2. Select the item(s) in the popup window.

Red targets appear on the items.
3. Perform the desired action on the selected item(s).

i
Notice!
The parameters for the item(s) can be changed, and the item(s) can be cut, copied, or moved in the
same way as an item(s) is when it is placed directly on the console window.

37.1 Popup Window Setup page
The Popup Window Control function creates a popup window to which additional controls and button
can be added. The popup window is one of the most versatile user interface options. Popup windows
can be used to group together similar line functions, pages, alerts, or any combination of button and
slider controls. Popup buttons can even be included within a popup window allowing for nested
controls. When popup Window Control is selected from the UI Element Function drop down menu,
the Popup Window Setup page appears.

Figure 37.1: Popup Window Setup Page
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37.1.1 Window Options group box
Allow window to be moved check box
The Allow window to be moved check box indicates the popup window can be moved in C-Soft
Runtime.

Restore to original position on open check box
The Restore to original position on open check box restores the popup's position to match the
window's position you configure in Designer each time the window opens in Runtime.
Only available when the Allow window to be moved check box is selected.

Automatically close children popup windows check box
The Automatically close children popup windows check box indicates when a popup window is
closed, any associated children popup windows automatically close. When cleared, the children popup
windows remain open after the parent window has closed.

Open Window on Activity check box
The Open Window on Activity check box indicates the popup window automatically opens when
activity is occurring within the popup window.

Link popup state to line active state check box
The Link popup state to line active state check box indicates the Telex line associated with an Select
button contained within the popup is only unmuted while the popup is open.
If a line's Select button is contained within a popup with this configuration, certain buttons and
operations open the popup. This includes:
– TX All button
– Group Programmed
– Group Programmed Enhanced
– Page with nonzero talk time
– Page Manual Entry with nonzero talk time
– Page Stack Programmed containing page with nonzero talk time
– Annunciation with Stay After Annunciation checked

Background Color drop down palette
The Window Background Color drop down palette is used to set a background color for the popup
window.

37.1.2 Button Options group box
Highlight button on focus check box
The Highlight button on focus check box is used to indicate to the user when the button’s child
window is in focus.

Focus Color drop down palette
The Focus Color drop down palette is used to select the color the button changes to when the button
window it opens is under focus.
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37.1.3 Logo group box
Image Filename field
The Image Filename field identifies the file path of a image to be displayed in the background of the
Console window.

This field can contain up to 255 characters.

C-Soft supports 1-bit, 4-bit, 8-bit and 24-bit bitmaps, .png, .jpg, and .gif file formats.

Browse button
The Browse button opens the Open window, which is used to navigate to the logo image file.

To change the image file, do the following:
1. Click Browse. 

The Open window appears.
2. Select the file you want to use for the image.
3. Click Open.
The path to the image file appears in the field.

Position drop down menu
The Position drop down menu is used to select the location of the image logo on the console window.

Available selections for this field are: Upper-Left, Upper-Right, Lower-Left, Lower-Right, Center and
Stretch.

37.2 Popup Webpage
The Popup Webpage function provides the ability to embed a webpage in the popup window. When
the popup Webpage button is pressed, the specified webpage is displayed in the popup window.

A maximum of three webpages are allowed on any console design.

37.2.1 Popup Webpage Setup page
When the popup Webpage function is selected, the Popup Webpage Setup page appears. Refer to
the Figure below.



C-Soft 8.500 UI Element Setup window - Add Popup Button | en 443

Bosch Security Systems, LLC Technical Manual 2025-08 | 16 | F.01U.218.561

Figure 37.2: Popup Webpage Setup Page - UI Element Setup

Webpage URL field
The Webpage URL field identifies the URL of the webpage to display in the popup window.

This field can contain up to 98 characters.

Refresh Interval field
The Refresh Interval field identifies the amount of time that passes before the webpage displayed in
the popup window is automatically refreshed. For example, if a radar weather map is displayed on the
console operator’s window, an entry of 300 in this field automatically refreshes the radar image every
five minutes. A value of zero indicates the webpage refreshes on C-Soft application startup.

The range for this field is 0 to 999.

Refresh when a popup button is pressed check box
The Refresh when popup button is pressed check box indicates the webpage display is refreshed
when the popup Webpage button is pressed.

37.3 Type page
The Type page is used to configure the type of function for the UI Element Popup (Control) button.
Some UI Elements require further configuration and when selected from the function drop down menu
additional configuration pages appear. Refer to the Figure below.
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Figure 37.3: Type Page - UI Element Setup Popup Control

UI Element Function drop down menu
The UI Element Function drop down menu is used to select an operation for the popup button. Each
function configuration is described in the following section.

Available selections for this field are:
– Popup Call History
– Popup Webpage
– Popup Window Control

Refer to
– Instant Recall, page 279

37.4 Popup Global Call History
The Popup Global Call History function creates a button used to open the Global Call History
window.

In C-Soft Runtime, the Global Call History is used to view per line calls received and stored in the
history log. The Global Call History window also logs the state changes of input indication and relays
from an ADHB-4 or NEO-10. In addition to displaying the global call history, the log can be used to
play back received audio. Transmitted audio is only recorded on Phone or SIP Phone lines.

Global Call History stores up to 10 minutes of audio across all lines not enabled for Per Line
Recording. For lines enabled for Per Line Recording, Global Call History window displays an additional
60 minutes of audio for each enabled line. Silence between calls is not stored.

Note:
– C-Soft supports one Global Call History window per console. If a Global Call History window

button already exists, the Popup Call History function is not available for selection.
– Recording calls is also accomplished by adding an Instant Recall Recording button to the console,

refer to “Instant Recall, page 279” for details.
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– While the call history audio is playing, the recorder continues to record incoming calls.

37.4.1 Call List Options page
When the popup Call History function is selected, the Call List Options page appears. Refer to the
Figure below.

Figure 37.4: Call List Options Page - UI Element Setup

Logging Options group box

Include Muted Calls in List check box
The Include Muted Calls in List check box indicates muted calls are included in the call history log.

Include NEO Changes in List check box
The Include NEO Changes in List check box indicates the NEO-10 event changes are included in the
call history log.

List appearance

Call Window Lines field
The Call Window Lines field identifies the number of lines of text saved in the call history log.

The range for this field is 1 to 500 lines.

Call Window Font Size field
The Call Window Font Size field identifies the font size of the text in the call history log.

The range for this field is 0 to 72.
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The default is 8 point.

Column Setup group box
The Column Setup group box allows the user to determine which columns are visible in the Global
Call History window. The respective columns display in the Global Call History window if selected and
hidden if not selected.

Call Duration check box
The Call Duration check box is used to add a Call Duration column to the Global Call History window.

Caller ID check box
The Caller ID check box is used to add a Caller ID column to the Global Call History window.

Comments check box
The Comments check box is used to add a Comments column to the Global Call History window.

Date check box
The Date check box is used to add a Date column to the Global Call History window.

Direction check box
The Direction check box is used to add a Direction column to the Global Call History window.

Frequency check box
The Frequency check box is used to add a Frequency column to the Global Call History window.

Line Name check box
The Line Name check box is used to add a Line Name column to the Global Call History window.

Status check box
The Status check box is used to add a Status column to the Global Call History window.

Talkgroup check box
The Talkgroup check box is used to add a Talkgroup column to the Global Call History window.

i
Notice!
Only lines configured for P25-DFSI use the Talkgroup column.

Time check box
The Time check box is used to add a Time column to the Global Call History window.

User ID check box
The User ID check box is used to add a User ID column to the Global Call History window.
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37.5 Global Call History window
The Global Call History window provides a log of past calls received by the console. The operator
uses the log to view previously received calls. In addition, the calls can be selected for playback.

This log can contain up to 500 calls.

i
Notice!
To Pin or make Comment on Calls shown in the History window, the operator needs to right-click the
call line and select either option.

Figure 37.5: Global Call History Window

Save to File button
The Save to File button is used to save the currently selected items to a .csv file.

i
Notice!
IP-3XXX devices do not have the Save to File button.

To save a .csv file of the items in the list, do the following:
1. From the Per Line Call History list, select the items you want to save.
2. Click Save to File.

The Save window appears.
3. In the File name field, enter a name for your .csv file.
4. Click Save.
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Done button
The Done button is used to close the window.
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38 UI Element Setup window - Add Text
The Add Text option opens the Font window, shown in the Figure below.

NAVIGATION: Select Insert | Add Text from the menu bar.

Font window
The Font window is used to add descriptive text to the console window or to a popup window. The
Font window includes standard options for Font, Font Style, Size, and Color formatting. When you
change the format, a preview of the text appears in the sample field.

For more information, refer to “User interface element configuration, page 53”.

Figure 38.1: Font Window

Horizontal check box
The Horizontal check box indicates the text is displayed on the console window in a horizontal
orientation. If not selected, the text is displayed vertically.

Enter Text field
The Enter Text field identifies the text to place on the console window.

This field can contain up to 50 characters.

OK button
The OK button saves the entries and closes the window.

Cancel button
The Cancel button discards any changes made and closes the window.
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39 UI Element Setup window - Add Text Message Control
The Add Text Message Control window is used to send and receive text messages.

Figure 39.1: UI Element Setup window - Text Message

Text Message page
When the Text Message Control function is selected from the UI Element drop down menu, Text
Message page appears. Refer to the Figure above.

Common Settings group box

Border Width field
The Border Width field is used to set the outside border width of the control.

The range for this field is 0 to 20.

Border Color drop down menu
The Border Color drop down menu is used to set the outside border color.

Background Color drop down menu
The Background Color drop down menu is used to set the color of non-control areas.

Title group box

Background Color drop down menu
The Background Color drop down menu is used to set the background color of the title area.

Text Color drop down menu
The Text Color drop down menu is used to set the text color of the title area text.



C-Soft 8.500 UI Element Setup window - Add Text Message Control | en 451

Bosch Security Systems, LLC Technical Manual 2025-08 | 16 | F.01U.218.561

Title Font button
The Title Font button is used to sets the font of the title area text.

History group box

Incoming Text Color drop down menu
The Incoming Text Color drop down menu is used to set the text color of incoming text messages.

Incoming Bk Color drop down menu
The Incoming Bk Color drop down menu is used to sets the background color of incoming text
messages.

Outgoing Text Color drop down menu
The Outgoing Text Color drop down menu is used to set the text color of outgoing text messages.

Outgoing Bk Color drop down menu
The Outgoing Bk Color drop down menu is used to set the background color of outgoing text
messages.

Scrollbar Width field
The Scrollbar Width field is used to set the scrollbar width.

The range of this field is 10 to 100.

Minimum Slider Height field
The Minimum Slider Height field is used to set the slider height.

The range of this field is 10 to 100.

History Font button
The History Font button is used to set the font for all incoming and outgoing text messages.

Text Entry group box

Text Color drop down menu
The Text Color drop down menu is used to set the text color for the text entry area.

Text Entry Font button
The Text Entry Font button is used to set the text font for the text entry area.

Status group box

Text Color drop down menu
The Text Color drop down menu is used to set the color for the status area text.

Bk Color drop down menu
The Bk Color drop down menu is used to set the background color of the status area.

Status Font button
The Status Font button is used to set the font of the status area text.
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Default button
The Default button is used to reset all parameter settings to their default values.

Apply button
The Apply button is used to save changes made to the Text Message page.

To use the Text Message Control, do the following:
1. Select the line on which to send the text message.
2. Using the keypad, select the destination for the text message.

The selected destination appears in the Destination Display of the Text Message Control.

3. Enter text into the entry field.
OR
Click the QuickText button to select a pre-defined text message.

4. When finished, press the Send button.
The text message is sent, and displays as an outgoing message in the Text Message History List. In
addition, the Status Notification Area displays a notification that the text was sent.
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40 UI Element Setup window - Add Volume Control
The Add Volume Control option is used to place a volume control slider, shown in the Figure below, in
the upper left-hand corner of the console window. This section provides information on the
functionality of the different volume controls selected from the UI Element Function drop down menu.

Figure 40.1: Volume Control Slider

Figure 40.2: Type Page - UI Element Setup Volume Control

To access the UI Element Setup window for Volume Control, do the following:
1. From the Insert menu, select Add Volume Control.

A Volume Control slider appears on the C-Soft console window.
2. Right-click the Volume Control slider.

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.

40.1 Type page
When Add Volume Control is selected from the menu bar, the UI Element window opens to the Type
page. Refer to the Figure above.

UI Element Function drop down menu
The UI Element Function drop down menu is used to select the desired functionality for the volume
control.

Available selections for this field are:
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– Volume-Master Select - Allows a single volume control that manipulates the volume of all
selected audio.

– Volume-Master Unselect - Allows the console operator to change the unselect volume for all
lines.

– Volume-ADHB-4 NENA - Allows the console operator to change the volume of NENA audio
when operating with ADHB-4.

– Volume-Auxiliary Track Left - Allows the console operator to change the left channel volume of
the Auxiliary audio when operating with an ADHGB-4 Gen 2.

– Volume-Auxiliary Track Right - Allows the console operator to change the right channel volume
of the Auxiliary audio when operating with an ADHGB-4 Gen 2.

– Volume-Per Line - Allows the console operator to control the relative level of the selected line
with respect to other lines.

Line to Associate Function With drop down menu
The Line to Associate Function With drop down menu is used to select the line to associate the
button or volume control with. This field is only enabled when the selected entry in the UI Element
Function field requires a line association.

OK button
The OK button saves the entries and closes the window.

i
Notice!
If the associated line is muted, the volume control for the line is disabled.

40.2 Vol. Control page
When the Vol Control tab is selected from the UI Element Setup window, the Vol. Control page
appears. Refer to the Figure below.
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Figure 40.3: Vol. Control Page - UI Element Setup Volume Control

Orientation group box
The Orientation group box contains buttons to orient the volume control.

Horizontal radio button
The Horizontal radio button is used to position the volume control horizontally.

Vertical radio button
The Vertical radio button is used to position the volume control vertically.

Minimum Volume field
The Minimum Volume field identifies the minimum volume level for the control.

The range for this field is -20 to -1dB.
Zero (0) mutes the audio.

Maximum Gain drop down menu
The Maximum Gain drop down menu identifies the maximum volume level for the control.

Available selections for this field are: 0, 3, 6, 9, and 12.
The default for this field is 0. It is advisable to add some gain to every volume control.

Slider Background Color drop down menu
The Slider Background Color drop down menu displays the color of the volume control slider. Use the
drop down color palette to select the desired color.

To add a volume control, do the following:
1. From the Insert menu, select Add Volume Control.

A Volume Control slider appears on the C-Soft console window.
2. Right-click the Volume Control slider.

A shortcut menu appears.
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3. From the shortcut menu, select Properties.
The UI Element Setup window appears.

4. From the UI Element Function drop down menu, select a volume function.
The Vol. Control tab appears.

5. Click the Vol. Control tab.
The Vol. Control page appears.

6. In the Orientation field, select the desired orientation radio button of the volume control slider.
7. In the Minimum Volume field, enter a minimum volume.
8. From the Maximum Gain drop down menu, select the maximum gain.
9. From the Slider Background Color drop down menu, select the background color for the slider

control.
10. Click OK.
A volume control appears on the console.
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41 UI Element Setup window - Add VU Meter
The Add VU Meter option inserts a VU Meter on the console. The control format and color are
controlled with the VU Meter Control page.

To insert a VU Meter control, do the following:
– From the menu bar, select Insert | Add VU Meter.
A VU Meter control appears on the console.

41.1 VU Meter Control page
The VU Meter Control page, shown in the Figure below, is where the control format and color are
configured.

Figure 41.1: VU Meter Control Page

To access the VU Meter Control page, do the following:
1. Right-click the VU Meter control.

A shortcut menu appears.
2. From the shortcut menu, select Properties.

The UI Element Setup window appears.

Orientation group box

Horizontal radio button
The Horizontal radio button indicates the VU Meter Control is in the horizontal position on the
console.

Vertical radio button
The Vertical radio button indicates the VU Meter Control is in the vertical position on the console.

VU Meter Background Color drop down menu
The VU Meter Background Color drop down menu is used to select the VU Meter Control background
color.



458 en | View menu C-Soft 8.500

2025-08 | 16 | F.01U.218.561 Technical Manual Bosch Security Systems, LLC

42 View menu
The View menu contains commands used to change the window view.

Toolbar toggle
The Toolbar toggle indicates whether the toolbar is visible or not.
– If the toolbar is toggled on (selected), the toolbar is visible on the console window.
– If the toolbar is toggled off (not selected), the toolbar is not visible on the console window.

Status Bar toggle
The Status Bar toggle indicates whether the Status bar is visible or not.
– If the Status Bar is toggled on (selected), the status bar is visible on the console window.
– If the Status Bar is toggled off (not selected), the status bar is not visible on the console window.
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43 Configure menu
The Configure Menu contains configuration settings for target devices and external key mapping.
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44 Device Setup
The Device Setup window contains settings to configure the design file for operation on a specific
hardware platform along with other peripheral settings.

Figure 44.1: Device Setup

Design Target
Sets the target hardware platform for the design. Options are: Desktop, IP-3X0X, and IP-3X18.
Setting the Design Target to IP-3X0X sets the Design’s window size to dimensions matching the
IP-3X0X device, making it easier to create a Design compatible with the IP-3X0X’s screen dimensions.

Keypad Module check box
Specifies that the Design is intended to use Side Car Button Module. If checked, additional hardware
key mapping options are available in the Key Mappings Setup window (see Global Key Mapping, page
461). Global Key Mapping is only enabled when IP-3X0x or IP-3X18 is the design target.

Hide Mouse Cursor check box
Specifies that C-Soft hides the mouse cursor, which is desirable when running C-Soft on a
touchscreen.
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45 Global Key Mapping
The Global Key Mapping window is used to map physical hardware buttons of the IP-3XXX to buttons
in the C-Soft Design.
When opened, the Global Key Mapping window displays a tab representing the Main Console
window, as well as dynamically creating tabs for each Popup button that exists in the Design. While a
specific Popup is opened, pressing the specified hardware key entry activates the configured button
for that specific popup button / tab. If a button mapping is not configured for a specific popup, the
button’s behavior is defined by the configured button in the Main Console tab.
Each tab contains a list of all available Keys, as defined by settings in the Device Setup, page 460
page.
Each KeyMap_ButtonX entry represents the physical hardware buttons on the front of the IP-3XXX
device, numbered from left to right. For example, the IP-3XXX’s leftmost button is button 1, and the
rightmost is button 6.
Each Sidecar_ButtonX represents physical hardware buttons if using a Sidecar Button Module,
numbered top to bottom, left to right. For example, the topmost row are buttons 1-4, the second row
are buttons 5-8, and so on.

Figure 45.1: Global Key Mapping window

To configure an IP-3XXX hardware key to a button, do the following:
1. Configure the Design Target to the correct hardware (see Device Setup, page 460).
2. Select Configure | Global Key Mapping.

The Global Key Mapping window appears
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3. In the Main Console tab, on the row corresponding to the desired button, click the empty Line
column
Upon selecting the column entry, the dropdown displays a list of available lines, as well as a
Global option.

4. Select the desired line or Global if the button is to operate globally.
5. In the same row, click the empty column Button Name : Type column.

Upon selecting the column entry, the dropdown displays a list of buttons on the main console
window, filtered by the selected line.

6. When finished, press the OK button to close the window.
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46 Run menu
The Run menu, shown in the Figure below, is used to either launch the current C-Soft Design or open
a .veg file you desire.

Figure 46.1: Run Menu - C-Soft

To open the current C-Soft design in C-Soft Runtime, do the following:
– From the Run menu, select Run C-Soft.
The currently open C-Soft Design file is launched in C-Soft Runtime.

To select a C-Soft Runtime executable to run, do the following:
1. From the Run menu, select Select C-Soft Location.

A file navigation window appears.

2. Navigate to and select the C-Soft Runtime executable you want to run.
3. Click the Open button.
4. From the Run menu, select Run C-Soft.
The current C-Soft design file is launched in the specified C-Soft Runtime executable.
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47 About C-Soft Designer
The About C-Soft Designer window is used to view C-Soft version information, Bosch’s mailing
address and website URL.

NAVIGATION: Select Help | About C-Soft Designer.
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48 C-Soft Runtime program
Once the design is created and saved, the C-Soft Designer program generates a file read by the C-
Soft Runtime program. The C-Soft Runtime software does the actual IP communications with the
other radio elements available on the network. The C-Soft Console appears when the C-Soft Runtime
program is opened.

Upon starting C-Soft Runtime, C-Soft will automatically attempt to acquire all necessary Telex
software-based licenses based on the line types and enabled features configured in the Design file. C-
Soft checks for licenses on the local computer, as well as any Telex License Servers specified in the
License Server settings set in the Design file. Refer to “Peripherals page, page 133” for instructions on
how to specify a License Server.

Dealer Mode
Dealer Mode is a feature license specifically designed for Telex Radio Dispatch certified dealers to
demonstrate C-Soft's capabilities for a limited amount of time. It allows C-Soft to operate as if the
following licenses are available:
– 50 lines
– 12 SIP lines
– 24 P25-DFSI lines
– 24 NEXEDGE lines
– 100 lines of per-line call playback
– 24 AIS lines
– 24 P25 CSSI Lines
– P25 Encryption
– API license

Upon startup, if C-Soft Runtime detects a Dealer Mode license, it will display the Dealer Mode License
window to indicate that C-Soft is operating in Dealer Mode, and that the license is not for resale. Every
15 minutes, the Dealer Mode License window reappears. After 60 minutes, the license expires, and C-
Soft will cease to function and need to be restarted.

Figure 48.1: Dealer Mode License Window

Finally, the Status bar will display Dealer License: Not for Resale whenever it would otherwise be
clear.

Figure 48.2: Dealer License Status Bar
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Demo Mode
If no software licenses are detected, C-Soft will display the License Error dialog, blocking access to its
user interface. It is still possible to open and test the user interface by entering Demo Mode. While in
Demo Mode, C-Soft is unable to transmit or receive audio.

To run C-Soft Runtime in Demo mode, do the following:
1. Double-click the C-Soft Runtime desktop shortcut.

The C-Soft License Error window appears.

2. Click the Demo button to enter Demo Mode.

48.1 C-Soft Console
The C-Soft Console opens to the configuration stored in the default file. If no default file is specified
by the user, the Set Default.Veg File window appears.

Alternatively, any .veg file can be double-clicked to open the C-Soft Console. In this case, the Set
Default Veg File window does not appear.

Set Default Veg File window
The Set Default Veg File window is used to locate and set the default .veg file that opens when C-
Soft Runtime is opened. This window appears the first time C-Soft Runtime is opened or when the
default .veg file is reset to none. For more information, refer to “Reset Default .Veg File” below.

To set the default .veg file, do the following:
1. Double-click the C-Soft Runtime shortcut installed on your desktop during C-Soft installation.

The Set Default .Veg File window appears.
2. Browse to the .veg file created in C-Soft Designer.
3. Select the .veg file.



C-Soft 8.500 C-Soft Runtime program | en 467

Bosch Security Systems, LLC Technical Manual 2025-08 | 16 | F.01U.218.561

4. Click Open.
The default file is set to the selected configuration and C-Soft Runtime opens.

Example Console
When the C-Soft Runtime program is started, the C-Soft Console displays the console design. A six
line console design, along with several other user interface elements, is shown in the Figure below.

The Title Bar contains the C-Soft Console label and is used to access a shortcut menu. For more
information, refer to “C-Soft Console Title Bar Shortcut Menu” below.

The status bar, located directly below the title bar, is divided into seven panes providing different
status information. From left to right, these panes display: text messages, connection status, the IR
playback position, the NENA on an ADHB-4, the connected ADHB-4, the PTT status, the VU meter,
and the current time, as set on the computer clock.

The recording icon  is used to indicate if the console is configured and able to record per line
audio to the hard drive. The icon appears in the menu bar if a line is enabled for IRR Line Recording
and the audio recording directory is valid. For more information, refer to “IRR Recording page, page
129”.
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Figure 48.3: C-Soft Console Window

C-Soft Console Title Bar shortcut menu
The C-Soft Console Title Bar shortcut menu is used to set the window size, find the current C-Soft
version, view license information, and set the default .veg file.

To open the title bar shortcut menu, do the following:
– Right-click the Title Bar to open the shortcut menu.
The menu shown in the Figure below appears.

Figure 48.4: C-Soft Console Title Bar Shortcut menu - Minimize
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Restore
Restore is used to restore the window to the last-set window size.

To shrink the window to the size last set by the console operator, do the following:
1. Right-click the title bar.

The Title Bar shortcut menu appears.
2. Click Restore.
The window is restored.

Move
Move is used to the move window. This option is not available (grayed out) if the window is
maximized.

i
Notice!
The window can also be sized when the move cursor is active.

To move the window, do the following:
1. Right-click the title bar.

The Title Bar shortcut menu appears.
2. Click Move.

The Move cursor appears.
3. Click and hold the title bar.
4. Drag the window into place.

Size
Size is used to change the height and/or width of the window. This option is not available (grayed out)
if the window is maximized.

i
Notice!
The window can also be moved when the size cursor is active.

To size the window, do the following:
1. Right-click the title bar.

The Title Bar shortcut menu appears.
2. Click Size.

The Size cursor appears.
3. Click and hold the cursor on the edge of the window.

The cursor changes.
4. Drag the window to the desired size.
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Minimize
Minimize is used to shrink the window to a minimized icon on the task bar.

i
Notice!
If the current view is already minimized, this selection is grayed out.

Maximize
Maximize is used to change the window to full screen view.

i
Notice!
If the current view is already maximized, this selection is grayed out.

Close
Close is used to close the C-Soft Runtime program.

About C-Soft Runtime
About C-Soft Runtime is used to open the about C- Soft Runtime window.

This window contains the following information:
– Version
– Telex’s address
– Sales Support Phone Number
– Website Address

License Information
The License Information window displays all Telex License Keys detected by C-Soft.

Each row in the License List represents a detected software license. The Source column displays the
license’s source, and Option column contains the detected license. Licenses that have been
successfully checked out and are currently in use by the instance of C-Soft are displayed in blue.

Reset Default .Veg File
Reset Default .Veg File is used to change the default file to none. When reset, and C-Soft Runtime is
opened, the Set Default Veg File window appears.
NOTE: This menu option is only visible based on the following settings in the Console Configuration
Tool:
– The Use Console Management System check box is not selected.

OR
– The Use Remote Design Management System check box is not selected.

AND
– Allow the Allow local designs check box is selected.
To reset the default file to none, do the following:
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1. Right-click the title bar.
The Title Bar shortcut menu appears.

2. Select Reset Default Veg File.
The default file is set to none.

Set Default .Veg File
Set Default .Veg File is used to set the current configuration as the default file. When a .veg file is
double-clicked C-Soft Runtime opens to the selected configuration. This configuration can be set as
the default file.
NOTE: This menu option is only visible based on the following settings in the Console Configuration
Tool:
– The Use Console Management System check box is not selected.

OR
– The Use Remote Design Management System check box is not selected.

AND
– Allow the Allow local designs check box is selected.

To set the current C-Soft Console configuration as the default .veg file, do the following:
1. Right-click the title bar.

The Title Bar shortcut menu appears.
2. Select Set Default Veg File.

Window Sizing
By default, the C-Soft Runtime program window fills the entire monitor window. However, this may
not be acceptable for a single monitor system, when only a small monitor is available, or if the console
operator views the software on a multi-monitor computer. In these cases, the size of the console
window can be changed to match the size of the console operator’s monitor window.

When the C-Soft Runtime program starts it looks for the file cposi[.veg file name].txt. This file is
created each time the C-Soft Runtime program is closed. The cposi[.veg file name].txt (for example,
cposi_Default.txt) file records the size and position of the C-Soft Runtime program window. In
addition to storing the position information, the cposi[.veg file name].txt file also stores the console
state at shutdown. This includes information such as the selected channels, mute states, volumes,
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channel frequencies, and the entries in the call log (without the IRR audio). Since the cposi.txt file does
not exist the first time the C-Soft Runtime program is started, the C-Soft Runtime window fills the
entire screen.

i
Notice!
If one console design is closed and a different console design is started, the states do not match.

To change the size of the program window, do the following:
1. Ensure the following fields are selected, refer to “Window Controls Check Boxes” on page 121

for details.
– Allow Minimize
– Allow Maximize
– Allow Resize
– Allow Close

For more information, refer to “Save Runtime Status on Close Check Box” on page 120.
TIP: If this is an existing design, verify these controls are enabled for the design. If they are
not, select the Windows controls listed above, and then proceed to the next step.

2. Save the designer file (.veg).
3. Open the .veg file you just saved.
4. Resize and position the console window, as desired.

The elements on the window do not rescale to fit the window size and some may be hidden from
view when the window is resized. This step is only to create the size and position of the window.
The next time the console window is opened, all of the elements on the console window are
automatically scaled to fit the console window by the C-Soft Runtime program.

5. Close the C-Soft Runtime program when the console window is set to the desired size and
position.
The cposi.[veg file name].txt file is created by the program is when it is closed

6. Open the .veg file.
The window opens using the last location and size with the buttons, sliders, VU Meter, and clock
in the correct locations.

7. If the console display needs further adjustment, repeat the above steps until the console window
is the desired size.

Connection Status
The status bar displays a connection state icon that indicates connection states to local and CMS
services. The icon is directly to the left of the VU meter.

Figure 48.5: Connection Status

– If all configured connections are active, the connection state icon displays a green checkmark.
– If some services are not active, the icon displays a yellow warning symbol.
– If no services are active, the connection state icon displays a red warning symbol.

Connection Status Window
The Connection Status window displays connection statuses to the local Console Administrator
Service and to CMS services. Use this window to diagnose connection issues on a service/feature
basis.
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Figure 48.6: CMS Connections window

Connection Description

CAS Indicates C-Soft's connection to locally-running Console Administrator Service

CMS-Alias Indicates C-Soft's connection to CMS Contact Management Module
Only used if the Enable Alias Updates from CMS check box is selected.

CAS<->Atlas Indicates CAS's connection state to CMS-Design Management Module

CMS-CryptoSync Indicates C-Soft's connection to CMS CryptoSync Module
Only used if CryptoSync is configured in the current design.

Table 48.1: Connection Descriptions

Connection Description

Not Configured The position and design settings are not configured to create this connection

Disconnected Unable to connect to the module

Connected Connection to the module has been established and is operating correctly

Table 48.2: Connection Status Descriptions

CMS Alias Versions Window
The CMS Alias Versions window displays the design's current database versions for each alias target.
Each version can be compared to the corresponding CMS Contact page to verify that the current
design is synchronized with CMS Contact Management.

Figure 48.7: CMS Alias Versions window
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49 Appendix A - Telex Tone Group Numbers and Paging
Plans

49.1 Telex Tone Group Numbers
Telex
Group No.

1 2 3 4 5 6 7

Tone
Group

Mot 1 Mot 2 Mot 3 Mot 4 Mot 5 Mot 6 Mot A

0 330.5 569.31 1092.4 321.7 553.9 1122.5 358.9

1 349.0 600.9 288.5 339.6 584.8 1153.4 398.1

2 368.5 634.5 296.5 358.6 617.4 1185.2 441.6

3 389.0 669.9 304.7 378.6 651.9 1217.8 489.8

4 410.8 707.3 313.0 399.8 688.3 1251.4 543.3

5 433.7 746.8 953.7 422.1 726.8 1285.8 602.6

6 457.9 788.5 979.9 445.7 767.4 1321.2 668.3

7 483.5 832.5 1006.9 470.5 810.2 1357.6 741.3

8 510.5 879.0 1034.7 496.8 855.5 1395.0 822.2

9 539.0 928.1 1063.2 524.6 903.2 1433.4 912.0

Diagonal 569.1 979.9 569.1 569.1 979.9 979.9 979.9

Table 49.1: Telex Tone Group Numbers (1-7)

Telex
Group
No.

8 9 10 11 12 13 14 15

Tone
Group

Mot B Mot Z GE A’ GE B’ GE C’ Mot 10 Mot 11 Custom

0 371.5 346.7 682.5 652.5 667.5 1472.9 1930.2 1034.9

1 412.1 384.6 592.5 607.5 712.5 1513.5 1989.0 953.9

2 457.1 426.6 757.5 787.5 772.5 1555.2 2043.8 0

3 507.0 473.2 802.5 832.5 817.5 1598.0 2094.5 0

4 562.3 524.8 847.5 877.5 862.5 1642.0 2155.6 0

5 623.7 582.1 892.5 922.5 907.5 1687.2 2212.2 0

6 691.8 645.7 937.5 967.5 952.5 1733.7 2271.7 0

7 767.4 716.1 547.5 517.5 532.5 1781.5 2334.6 0

8 851.1 794.3 727.5 562.5 577.5 1830.5 2401.0 0

9 944.1 881.0 637.5 697.5 622.5 1881.0 2468.2 0
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Diagonal 979.9 979.9 742.5 742.5 742.5 None None None

Table 49.2: Telex Tone Group Numbers (8-15)

49.2 Tone and Gap Durations for Standard Paging Plans
Tone #1 (ms) Gap (ms) Tone #2 (ms) Group Call (ms) Type

1000 - 3000 8000 GE std, Mot std
Tone and Voice

400 0 800 8000 Mot Tone Only

1000 0 3000 6000 NEC-B

1000 300 3000 6000 NEC-A

1000 0 1000 4000 NEC-C

400 0 800 4000 NEC-M

500 0 500 3000 NEC-L

400 0 400 3000 NEC-D

Table 49.3: Tone and Gap Durations for Standard Paging Plans
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50 Appendix B - 2 Tone 1000 Plan Numbers
Telex
Code Plan
#

1 2 3 4 5 6 7 8 9

Pager
Capcodes

Mot A Mot C Mot D Mot E Mot F Mot G Mot H Mot J Mot K

0xx 2+4 N/A N/A N/A N/A N/A N/A N/A N/A

1xx 1+1 1+1 1+1 1+1 1+1 1+1 1+1 1+1 1+1

2xx 2+2 2+2 2+2 2+2 1+3 1+3 1+3 1+4 1+4

3xx 3+3 1+2 1+2 1+2 3+3 3+3 3+3 4+1 4+1

4xx 1+2 4+4 1+5 2+1 4+4 3+1 3+1 4+4 4+4

5xx 1+3 1+4 5+5 1+6 3+1 5+5 1+6 5+5 1+6

6xx 2+1 2+1 2+1 6+6 1+4 1+5 6+6 1+5 6+6

7xx 3+1 4+1 5+1 6+1 4+1 5+1 6+1 4+5 6+1

8xx 2+3 2+4 2+5 2+6 3+4 3+5 3+6 5+4 4+6

9xx 3+2 4+2 5+2 6+2 4+3 5+3 6+3 5+1 6+4

Table 50.1: 2 Tone 1000 Plan Numbers (1-9)

Telex
Code Plan
#

10 11 12 13 14 15 16 17

Pager
Capcodes

Mot L Mot M Mot N Mot P Mot Q Mot R Mot S Mot T

0xx N/A 4+2 4+2 4+2 4+2 4+2 4+2 4+2

1xx 1+1 2+3 2+3 2+3 2+4 2+4 2+5 3+4

2xx 1+5 2+2 2+2 2+2 2+2 2+2 2+2 4+3

3xx 5+1 3+3 3+3 3+3 4+2 4+2 5+2 3+3

4xx 1+6 4+4 3+2 3+2 4+4 4+4 2+6 4+4

5xx 5+5 3+2 5+5 2+6 5+5 2+6 5+5 5+5

6xx 6+6 2+4 2+5 6+6 2+5 6+6 6+6 3+5

7xx 6+1 4+2 5+2 6+2 4+5 6+2 6+2 4+5

8xx 5+6 3+4 3+5 3+6 5+4 4+6 5+6 5+4

9xx 6+5 4+3 5+3 6+3 5+2 6+4 6+5 5+3

Table 50.2: 2 Tone 1000 Plan Numbers (10-17)



C-Soft 8.500 Appendix B - 2 Tone 1000 Plan Numbers | en 477

Bosch Security Systems, LLC Technical Manual 2025-08 | 16 | F.01U.218.561

Telex
Code Plan
#

18 19 20 21 22 23 24 25

Pager
Capcodes

Mot U Mot V Mot W Mot Y Mot MT GE X GE Y GE Z

0xx 4+2 4+2 4+2 N/A 4+2 10+10 11+11 10+10

1xx 3+4 3+5 4+6 7+7 1+1 11+10 12+11 12+10

2xx 4+3 5+3 6+4 8+8 2+2 11+11 12+12 12+12

3xx 3+3 3+3 5+6 9+9 1+2 10+11 11+12 10+12

4xx 4+4 3+6 4+4 7+8 4+4 12+12 N/A N/A

5xx 3+6 5+5 5+5 7+9 5+5 12+10 N/A N/A

6xx 6+6 6+6 6+6 8+7 2+1 12+11 N/A N/A

7xx 6+3 6+3 4+5 9+7 4+5 10+12 N/A N/A

8xx 4+6 5+6 5+4 8+9 5+4 11+12 N/A N/A

9xx 6+4 6+5 6+5 9+8 2+4 N/A N/A N/A

Table 50.3: 2 Tone 1000 Plan Numbers (18-25)
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51 Appendix C - Supported Tone Frequencies
Tone
Numb

er

Cod
e

Digi
t

European Tone Frequencies in Hz Motorola

ZVEI1 ZVEI
2

KEN PZV
E I

DZV
EI

PDZV
EI

CCIR
1

CCIR
2

PCCI
R

EEA EURO
SIGNAL

NATE
L

EIA MODA
T

TONE
0

0 2400 2400 815 2400 2200 2200 1981 1981 1981 1981 979.8 1633 600 637.5

TONE
1

1 1060 1060 882 1060 970 970 1124 1124 1124 1124 903.1 631 741 787.5

TONE
2

2 1160 1160 954 1160 1060 1060 1197 1197 1197 1197 832.5 697 882 937.5

TONE
3

3 1270 1270 1032 1270 1160 1160 1275 1275 1275 1275 767.4 770 1023 1087.
5

TONE
4

4 1400 1400 1117 1400 1270 1270 1358 1358 1358 1358 707.4 852 1164 1237.
5

TONE
5

5 1530 1530 1209 1530 1400 1400 1446 1446 1446 1446 652.0 941 1305 1387.
5

TONE
6

6 1670 1670 1308 1670 1530 1530 1540 1540 1540 1540 601.0 1040 1446 1537.
5

TONE
7

7 1830 1830 1415 1830 1670 1670 1640 1640 1640 1640 554.0 1209 1587 1687.
5

TONE
8

8 2000 2000 1531 2000 1830 1830 1747 1747 1747 1747 510.7 1336 1728 1837.
5

TONE
9

9 2200 2200 1657 2200 2000 2000 1860 1860 1860 1860 470.8 1477 1869 1987.
5

GROU
P

TONE

A 2800 885 1939 970 825/
885

825 2400 1050 1055 2151

B 810 810 2270 810 740 886 930 930 930 2292

RESE
T

TONE

C 970 970 2098 2800 2600 2600 2247 2400 2247 2010

D 885 680 2457 885 885 856 991 2110 991 991 2292

REPE
AT

TONE

E 2600 970 1792 2600 2400 2400 2110 2400 2110 2110 1062.9 1805 459 487.5

F 680 2600 680 680 1055 2400 1995 1091 1995 1091
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52 Appendix D - Echo Packets Diagram
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53 Appendix E - P25-DFSI (Digital Fixed Station Interface)

53.1 P25-DFSI C-Soft Architecture
A C-Soft console can be configured for two different types of system architectures; a Stand Alone
console, or a Client/Server console.

A Stand Alone console is defined as a single console connection to n (where n is the number of
repeaters or Fixed Stations).

A Client/Server console is defined as multiple consoles connected to a server console which is
connected to n (where n is the number of repeaters or Fixed Stations).

i
Notice!
The maximum total number of consoles connected to one P25 DFSI is 25.

A Stand Alone Console is a simple configuration, requiring the least amount of setup time. Refer to the
Figure below.

Figure 53.1: Stand Alone Console Configuration

If more than one console operator is controlling the fixed stations, a Client/Server configuration should
be used. Refer to the Figure below. One console is set up as a server, two consoles are set up as
clients and one console is set up as a client console providing back up to the main server console.
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Figure 53.2: Server/Client Console Configuration

i
Notice!
There is no special software needed between consoles. Any C-Soft console can be configured as a
Stand Alone, Server, Client or Backup console via user setting in C-Soft designer.

53.2 P25 DFSI Global Setup window
The P25 DFSI Global Setup window, shown in the Figure below, is used to determine what type of
console is required for the system.

For example, if you require a stand alone system, then you have only one console, and an equal
number of lines to base stations in your system. Only one .veg file needs to be created with the global
console type set to stand alone.

If you require a client/server system, you must create one. veg file with a global console type set to
server and a second .veg file with the console type set to client or client and backup server console.

i
Notice!
Each Client console has a unique Console ID, therefore, it is required to have a different veg file for
each console position in the system.

i
Notice!
The parameters on this page affect all line types set to P25-DFSI.
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A Console ID must first be added. Refer to the Figure below. This ID is used by the individual radios to
make Private Calls with the console. This ID shows up as the radio ID when implementing a PTT from
the console.

Figure 53.3: P25 DFSI Global Setup Window

To set up P25 DFSI Global Values, do the following:
– From the Edit menu, select Setup P25-DFSI.
P25 DFSI Global Setup window appears.

53.2.1 Console Type group box
The Console Type group box is used to make a selection between Stand Alone Console, Server
Console, Client Console and Client and Backup Server Console.
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Stand Alone radio button
The Stand Alone radio button indicates one console is used.

Server Console radio button
The Server Console radio button indicates multiple consoles are used.

i
Notice!
Only one server per system.

Client Console radio button
The Client Console radio button indicates the C-Soft Console is connected with a Server Console.

Client & Backup Server Console radio button
The Client & Backup Server Console radio button indicates a Server is already setup and a backup
Server is needed, in case the server computer goes down.

i
Notice!
Only one Backup Server per system.

Console ID field
The Console ID field is used to enter the ID of the console. This ID is used by the individual radios to
make Private Calls with the console, and appears as the radio ID when implementing a PTT from the
console.

53.2.2 Backup Server Ping Address group box
The Backup Server Ping Address group box is used for communication between all C-Soft Consoles
to determine if the Server is operational or if the Server is down.

IP field
The IP field is a multicast address. It is used for communication between all the C-Soft Consoles to
determine if the primary server is operational or is down. IP field number is the same among all of the
consoles in the system.

Port Field
The Port field is a multicast port. It used for communication between all the C-Soft Consoles to
determine if the primary server is operational or is down. The Port field number is the same among all
of the consoles in the system.



484 en | Appendix E - P25-DFSI (Digital Fixed Station Interface) C-Soft 8.500

2025-08 | 16 | F.01U.218.561 Technical Manual Bosch Security Systems, LLC

53.2.3 Heartbeats group box
The Heartbeats group box is used to configure a Fixed Station Heartbeat Time, a Host Heartbeat
Time, and the Number of Missed Heartbeats Allowed.

Fixed Station Heartbeat Time field
The Fixed Station Heartbeat Time field indicates the time, in seconds, the fixed station sends
heartbeats to the C-Soft Console. This field is only enabled if the console type is set to Server Console
or Client & Backup Server Console mode.

The range for this field is 5 to 255.
The default is 30.

Host Heartbeat Time field
The Host Heartbeat Time field indicates the time, in seconds, the C-Soft Console sends heartbeats to
the fixed station. This field is only enabled if the console type is set to Server Console or Client &
Backup Server Console mode.

The range for this field is 5 to 255.
The default is 30.

Number of Missed Heartbeats Allowed field
The Number of Missed Heartbeats Allowed field indicates the number of missed heartbeats from the
Fixed Station before C-Soft terminates communication with the fixed station and tries to connect
again.

The range for this field is 0 to 5.
The default is 2.

53.2.4 Radio/Repeater Control Signals group box
The Radio/Repeater Control Signals group box is used to configure the number of control retries and
the wait time between retries from the server to establish contact with the radio.

Number of Control Retries field
The Number of Control Retries field indicates the number of times a control command is sent if no
acknowledgment is received.

The range for this field is 0 to 5.
The default is 3.

Control Retry Time
The Control Retry Time field indicates the time, in ms, C-Soft waits before sending the same control
command.

The range for this field is 500 to 1000.
The default is 600.
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53.2.5 Packet Controls group box
The Packet Controls group box is used to set the packet delay for the C-Soft Console.

Control Packet Delay field
The Control Packet Delay field is used to enter a value that is multiplied by 20ms to set the delay
between P25 DFSI Control Packets sent from C-Soft. This field is only enabled if the console type is
set to Server Console or Client & Backup Server Console mode.

The range for this field is 0 to 99.
The default is 0.

Setting up a P25-DFSI Line

To set up a P25-DFSI Line, do the following:
1. From the Edit Window, select Setup Per Line Parameters.

The Per Line Parameters window appears.
2. From the Line Type drop down menu, select P25-DFSI.
3. Click the Signal Setup button.
The P25-DFSI Setup window appears.

Figure 53.4: P25-DFSI Line Type

i

Notice!
Below are four examples of how a console can be configured, depending the Console Type selected
in P25 DFSI Global Setup window (i.e. Stand Alone, Server or Client). Refer to the Figure on P25 DFSI
Global Setup window, page 481.

Refer to
– P25 DFSI Global Setup window, page 481

53.3 Console Type Setup
The Console Type Setup is used to configure the console depending on the Console Type selected in
P25 DFSI Global Setup window.

53.3.1 Stand Alone Console
Stand Alone Console type
The Stand Alone Console is the easiest console type to set up and should be the starting point for
building a Client/Server system.

The three parameters to be set up are:
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– The Per Line IP connections which consist of the control Unicast Address of FS and the Voice
Address of the FS

– The channel numbers to a single base station
– P25 Manufacturer

i
Notice!
The Control Port of FS must match the DFSI control port of the Base Station. The Voice Port of FS
can be the same as, or different than the DFSI Voice Port of the base station.

The Signaling Parameters window, shown in the Figure below, is used to set up the per line IP
connections and channel numbers to a single base station.

Figure 53.5: P25-DFSI Setup-Stand Alone Console

Fixed Station (FS) Connections group box
The Fixed Station (FS) Connections group box contains the Control Address of Fixed Station group
box and the Voice Address of Fixed Station group box.

Control Address of Fixed Station group box

Control Unicast Address of FS field
The Control Unicast Address of FS field is used to enter an IP Address of the P25 base station.
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Control Port of FS field
The Control Port of FS field is used to enter the port number of the P25 base station.

The range for this field is 1054 to 65536.

i
Notice!
The Control Port of FS field must match the DFSI Control Port of the P25 base station.

Voice Address of Fixed Station group box

Voice IP Address of FS field
The Voice IP Address of FS field is used to enter the voice IP address of the P25 base station.

Voice Port of FS field
The Voice Port of FS field is used to enter the unique port number of the P25 base station.

The range for this field is 1054 to 65536.

Backup Enabled check box
The Backup Enabled check box enables the backup FS setup button. It is used when the system
needs to have a secondary P25 base station for backup in the event the primary base station is down.

53.4 Backup FS Setup window
The Backup FS Setup button opens the Backup Fixed Station Setup window.

To open the Backup Fixed Station Setup window, do the following:
1. Select the Backup Enabled check box.
2. Click Backup FS Setup.

The Backup Fixed Station Setup window appears.

3. Configure your backup station.
NOTE: If connection is lost to a Fixed Station, C-Soft automatically switches to the Backup Fixed
Station if Backup Enabled is selected.

4. Restart C-Soft to return to the original Fixed Station.
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Control Address of Fixed Station group box

Control Unicast Address of FS field
The Control Unicast Address of FS field is used to enter an IP Address of the P25 base station.

Control Port of FS field
The Control Port of FS field is used to enter the port number of the P25 base station.

The range for this field is 1054 to 65536.

i
Notice!
The Control Port of FS field must match the DFSI Control Port of the P25 base station.

Voice Address of Fixed Station group box

Voice IP Address of FS field
The Voice IP Address of FS field is used to enter the IP Address of the P25 base station.

Voice Port of FS field
The Voice Port of FS field is used to enter the unique port number of the P25 base station.

The range for this field is 1054 to 65536.

P25 Manufacture drop down menu
The P25 Manufacture drop down menu is used to select the manufacturer of the repeater.

Available selections for this field are:
– Codan
– Tait

i
Notice!
Since there may be small differences between radio designs, this field is important to insure C-Soft
works correctly with the repeater.

Channel Setup button
The Channel Setup button is used to open the DFSI Channel Table window. For more information,
refer to “Channel Table window, page 498”.

Edit Global DFSI Parameters button
The Edit Global DFSI Parameters button is used to open the P25 DFSI Global Setup window, shown
in Figure on P25 DFSI Global Setup window, page 481.
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53.5 Server Console
The Signaling Parameters window, shown in the Figure below, is used to set up the Server Console
Configuration. The FS (Fixed Station) Connection portion of the window is the same as that for a
Stand Alone Console. As in the case of the “Stand Alone Console”, one line of the Server Console
connects to one base station. The difference between the Stand Alone and Server is the client(s) now
connects and talks to the server on a per line basis in order to control and communicate with the base
station connected to this line.

Figure 53.6: P25-DFSI- Server Console

To change settings to a Server Console, do the following:
1. From the menu bar, select Edit | Setup P25 | DFSI.

The P25 DFSI Global Setup window appears.
2. In the Console Type group box, click the Server Console radio button.

Server Console is the console for the system.
3. From the menu bar, select Edit | Setup Per Line Parameters. 

The Per Line Parameters window appears.
4. With P25-DFSI selected in the Line Type drop down menu, click Signal Setup.
The P25-DFSI Setup - Console configuration: Server Console window appears.

Fixed Station (FS) Connections group box
The Fixed Station (FS) Connections group box contains the Control Address of Fixed Station group
box and the Voice Address of Fixed Station group box.
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Control Address of Fixed Station group box

Control Unicast Address of FS field
The Control Unicast Address of FS field is used to enter an IP Address of the P25 base station.

Control Port of FS field
The Control Port of FS field is used to enter the port number of the P25 base station.

The range for this field is 1054 to 65536.

i
Notice!
The Control Port of FS field must match the DFSI Control Port of the P25 base station.

Voice Address of Fixed Station group box

Voice IP Address of FS field
The Voice IP Address of FS field is used to enter the IP Address of the P25 base station.

Voice Port of FS field
The Voice Port of FS field is used to enter the voice port number of the P25 base station. The Voice
Port of FS field must match the voice port number configured in Codan P25 base station and unique
for Tait P25 base station.

The range for this field is 1054 to 65536.

Backup Enabled check box
The Backup Enabled check box enables the backup FS setup button. It is used when the system
needs to have a secondary P25 base station for backup in the event the primary base station is down.

53.6 Backup FS Setup window
The Backup FS Setup button opens the Backup Fixed Station Setup window.

To open the Backup Fixed Station Setup window, do the following:
1. Select the Backup Enabled check box.
2. Click Backup FS Setup.

The Backup Fixed Station Setup window appears.
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3. Configure your backup station.
NOTE: If connection is lost to a Fixed Station, C-Soft automatically switches to the Backup Fixed
Station if Backup Enabled is selected.

4. Restart C-Soft to return to the original Fixed Station.

Control Address of Fixed Station group box

Control Unicast Address of FS field
The Control Unicast Address of FS field is used to enter an IP Address of the P25 base station.

Control Port of FS field
The Control Port of FS field is used to enter the port number of the P25 base station.

The range for this field is 1054 to 65536.

i
Notice!
The Control Port of FS field must match the DFSI Control Port of the P25 base station.

Voice Address of Fixed Station group box

Voice IP Address of FS field
The Voice IP Address of FS field is used to enter the IP Address of the P25 base station.

Voice Port of FS field
The Voice Port of FS field is used to enter the voice port number of the P25 base station.

The range for this field is 1054 to 65536.

i
Notice!
The Voice Port of FS field must match the voice port number configured in Codan P25 base station
and unique for Tait P25 base station.

Server Connections group box

IP Address of this Computer field
The IP Address of this Computer field cannot be modified. When a client is configured, it must
connect to the IP Address of the PC the server console resides on.

Server Control Port field
The Server Control Port field is used to enter the port number the client connects to the server and to
control the base station/radio functionality.

The range for this field is 1054 to 65536.

Server's Voice Address group box
The Server’s Voice Address group box is used to configure the (MCA) Multicast Address and ports
the server uses to communicate with the client and client consoles.
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Rx MCA field
The Rx MCA field is used to enter the receive Multicast Address used to receive P25 audio.

Port field
The Port field is used to enter the port number used to receive P25 audio.

The range for this field is 1054 to 65536.

Tx MCA field
The Tx MCA field is used to enter the transmit Multicast Address used to transmit P25 audio.

Port field
The Port field is used to enter the port number used to transmit P25 audio.

The range for this field is 1054 to 65536.

P25 Manufacture drop down menu
The P25 Manufacture drop down menu is used to select the manufacturer of the repeater.

Available selections for this field are:
– Codan
– Tait

i
Notice!
Since there may be small differences between radio designs, this field is important to insure C-Soft
works correctly with the repeater.

Channel Setup button
The Channel Setup button is used to open the DFSI Channel Table window. For more information,
refer to “Channel Table window, page 498”.

The Channel Table window displays all of the channels open for a selected line.

Edit Global DFSI Parameters button
The Edit Global DFSI Parameters button is used to open the P25 DFSI Global Setup window. For
more information, refer to “P25 DFSI Global Setup window, page 481”.

The P25 DFSI Global Setup window is used to select the type of console required for the system.

53.7 Client Console
The Signaling Parameters window, shown in the Figure below, is used to set up the Client Console
Configuration. Each client requires a different .veg file because of the console ID.
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i
Notice!
The server console must have the number of lines equal to the number of base stations; clients
cannot directly access the base station without going through the server.

Figure 53.7: P25-DFSI Client Console

To change settings to a Server Console, do the following:
1. From the menu bar, select Edit | Setup P25 | DFSI.

The P25 DFSI Global Setup window appears.
2. Select the Client Console radio button to make the console type a Client Console.
3. From the menu bar, select Edit | Setup Per Line Parameters. 

The Per Line Parameters window appears.
4. From the Line Type drop down menu, select P25-DFSI.
5. With P25-DFSI selected in the Line Type drop down menu, click Signal Setup.
The P25-DFSI Setup - Console configuration Client Console window appears.

Client Connections
The Client Connections group box is used to configure per-line signaling setup address fields.

Control Address of Server group box

Control Unicast Address of Server field
The Control Unicast Address of Server field is used to enter the IP Address of the server PC.
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Control Port of Server field
The Control Port of Server field is used to enter the port address of the server control port for this
line.

i
Notice!
The Port Address must match the value setting of the Server Control Port on the Server Console
setup.

Voice Address of Server group box

Rx MCA field
The Rx MCA field is used to enter the receive Multicast Address used to receive P25 audio.

Tx MCA field
The Tx MCA field is used to enter the transmit Multicast Address used to transmit P25 audio.

P25 Manufacture drop down menu
The P25 Manufacture drop down menu is used to select the manufacturer of the repeater.

Available selections for this field are:
– Codan
– Tait

i
Notice!
Since there may be small differences between radio designs, this field is important to insure C-Soft
works correctly with the repeater.

Channel Setup button
The Channel Setup button is used to open the DFSI Channel Table window. For more information,
refer to “Channel Table window, page 498”.

The Channel Table window displays all of the channels open for a selected line.

Edit Global DFSI Parameters button
The Edit Global DFSI Parameters button is used to open the P25 DFSI Global Setup window. For
more information, refer to “P25 DFSI Global Setup window, page 481”.
The P25 DFSI Global Setup window is used to select the type of console required for the system.

53.8 Client Console with Server Backup
The Signaling Parameters window, shown in the Figure below, is used to set up the Server Console
Configuration. The backup client console or .veg file must have the same number of lines the server
console or .veg file does.

The top half of the page, shown in the Figure below, is exactly the same as the setting for a Stand
Alone Console or for a Server Console. The bottom half of the page is exactly the same as the setting
for a client console.
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Figure 53.8: P25-DFSI Client Console with Server Backup

To change settings to a Server Console, do the following:
1. From the menu bar, select Edit | Setup P25 | DFSI.

The P25 DFSI Global Setup window appears.
2. Click the Client & Backup Server Console radio button to make the console type Client and

Backup Server.
Client & Backup Server Console is now the console for the system.

3. From the menu bar, select Edit | Setup Per Line Parameters. 
The Per Line Parameters window appears.

4. From the Line Type drop down menu, select P25-DFSI.

Fixed Station (FS) Connections (For Backup Server) group box
The Fixed Station (FS) Connections (For Backup Server) group box is used to connect with the
backup FSI if the Server Console fails to receive heartbeats from the Primary FSI.

Address of Fixed Station (For Backup Server) group box

Control Unicast Address of FS field
The Control Unicast Address of FS field is used to enter an IP Address of the P25 base station.

Control Port of FS field
The Control Port of FS field is used to enter the port number of the P25 base station.
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The range for this field is 1054 to 65536.

i
Notice!
The Control Port of FS field must match the DFSI Control Port of the P25 base station.

Voice Address of Fixed Station (For Backup Server) group box

Voice IP Address of FS field
The Voice IP Address of FS field is used to enter the voice IP address of the P25 base station.

Voice Port of FS field
The Voice Port of FS field is used to enter the voice port number of the P25 base station. The Voice
Port of FS field must match the voice port number configured in Daniels P25 base station and unique
for Tait P25 base station.

The range for this field is 1054 to 65536.

Backup Enabled check box
The Backup Enabled check box enables the backup FS setup button.

53.9 Backup FS Setup window
The Backup FS Setup button opens the Backup Fixed Station Setup window.

To open the Backup Fixed Station Setup window, do the following:
1. Select the Backup Enabled check box.
2. Click Backup FS Setup.

The Backup Fixed Station Setup window appears.

3. Configure your backup station.
NOTE: If connection is lost to a Fixed Station, C-Soft automatically switches to the Backup Fixed
Station if Backup Enabled is selected.

4. Restart C-Soft to return to the original Fixed Station.

53.9.1 Client Connections group box
The Client Connections group box is used to configure per-line signaling setup address fields.
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53.9.2 Control Address of Server group box
Control Unicast Address of Server field
The Control Unicast Address of Server field is used to enter the IP Address of the server PC.

Control Port of Server field
The Control Port of Server field is used to enter the port address of the server control port for this
line.

i
Notice!
The Port Address must match the value setting of the Server Control Port on the Server Console
setup.

53.9.3 Voice Address of Server group box
Rx MCA field
The Rx MCA field displays the RX Multicast Address and Port that the server and clients use to
receive P25 voice (a different value for each line). The MCA and ports must match the MCA and ports
you entered in the server console.

Tx MCA field
The Tx MCA field displays the TX Multicast Address and Port that the server and clients use to
transmit P25 voice (a different value for each line). The MCA and ports must match the MCA and ports
you entered in the server console.

P25 Manufacture drop down menu
The P25 Manufacture drop down menu is used to select the manufacturer of the repeater.

Available selections for this field are:
– Codan
– Tait

i
Notice!
Since there may be small differences between radio designs, this field is important to insure C-Soft
works correctly with the repeater.

Channel Setup button
The Channel Setup button is used to open the DFSI Channel Table window. For more information,
refer to “Channel Table window, page 498”.

The Channel Table window displays all of the channels open for a selected line.



498 en | Appendix E - P25-DFSI (Digital Fixed Station Interface) C-Soft 8.500

2025-08 | 16 | F.01U.218.561 Technical Manual Bosch Security Systems, LLC

Refer to
– Server Console, page 489

53.10 Channel Table window
The Channel Table window, shown in the Figure below, is used to view channel information.

To open the Channel Table window, do the following:
– In the Per Line Parameters window with P25 DFSI line type selected, click the Freqs button.
The Channel Table appears.

Figure 53.9: DFSI Channel Table

Channel Number column
The Channel Number column displays the physical channel number assigned to the radio.

i
Notice!
The Channel Number must match the Channel Number set up in the Fixed Station.

Channel Label column
The Channel Label column displays the name of the channel.
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RX-NAC (Hex) column
The RX-NAC (Hex) column displays the receive NAC (Network Access Code). This code must match
the incoming NAC from a radio so the audio can be heard on C-Soft.

i
Notice!
The RX-NAC must match the RX-NAC set up in the Fixed Station.

TX-NAC (Hex) column
The TX-NAC (Hex) column displays the TX-NAC (Transmit Network Access Code).

i
Notice!
The TX-NAC must match the TX-NAC, set up in the Fixed Station.

TGID NAC (Hex) column
The TGID (Talk Group ID) (Hex) column displays the Talk Group ID for the channel and is an
additional filter, used in both TX and RX directions.

Analog/Digital column
The Analog/Digital column displays the type of voice encoding/decoding by the console for the
selected channel. (A setting of P25 Digital causes the channel to transmit and receive in P25 digital
audio).

Analog uses G711 encoding/decoding for both transmit and receive. Mixed mode receives in either
analog or digital and transmit audio is selectable (analog or digital) via a user defined button.

Available options are:
– P25 Digital - The channel transmits and receives in P25 digital audio
– Analog - The channel transmits and receives using G711 encoding/decoding.
– Mixed Mode - Receives audio in either analog or digital. Transmit audio is selectable (analog or

digital) through the use of a user-defined button.

RX Block Lines panel
The RX Block Lines panel is used to select lines that have their receive audio blocked when having
their configurations modified. This allows the console operator to transmit on a radio that has
overlapping coverage with other radios, without getting feedback from the radios receiving the
transmitted signal. This function also operates when a parallel console is transmitting on the line.

To mute a line during transmission, do the following:
1. From the RX Block Lines panel, select the lines you want to block.

The line is highlighted.
2. Click the line(s) a second time to clear the selection.
The line is no longer highlighted.
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Load File button
The Load File button is used to load a saved Channel Table from a saved .csv (comma separated
values) file.

Save File button
The Save File button is used to save the Channel Table to a .csv file.

Add Channel button
The Add Channel button is used to manually configure another line.

Delete Channel button
The Delete Channel button is used to delete a channel from the channel table.

To delete a channel, do the following:
1. From the Channel Table, highlight the channel row to be deleted.
2. Click the Delete Channel button.
The channel is deleted.

Edit Global DFSI Parameters button
The Edit Global DFSI Parameters button is used to open the P25 DFSI Global Setup window. For
more information, refer to “P25 DFSI Global Setup window, page 481”.

The P25 DFSI Global Setup window is where the type of console required for the system is selected.

Refer to
– P25 DFSI Global Setup window, page 481

53.11 Setting Up Additional P25-DFSI lines
When adding multiple lines, the procedure is repeated from above.

i
Notice!
When setting up multiple lines, each line must have unique Unicast Addresses, Ports, and Multicast
Addresses. The only address that is constant among the lines is the IP Address of the Server P.C.

Adding Buttons to the Design
Once you have created the lines to be used for the P25 system, buttons need to be created on the
console. You can assign buttons to either individual lines or you can use the preconfigured P25-DFSI
Window button.

The P25-DFSI Window button contains all P25 radio/base station functionality in a single popup
window.



C-Soft 8.500 Appendix E - P25-DFSI (Digital Fixed Station Interface) | en 501

Bosch Security Systems, LLC Technical Manual 2025-08 | 16 | F.01U.218.561

i
Notice!
Each DFSI line requires one P25_DFSI button; however, only one window is shown, depending on
the line/button selected.

Figure 53.10: DFSI Design Options

For a P25 DFSI button without a Select Button, an “S” appears on the button for selected. A “U”
appears on the button if unselected.

Figure 53.11: P25 DFSI - Select and Unselect

P25-DFSI Misc Page setup
The P25-DFSI Misc window is used to change the colors of the buttons.
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Figure 53.12: P25-DFSI Misc

To add a P25-DFSI button to the console, do the following:
1. From the Insert menu, select Add UI Button.

A None button appears on the console window.
2. Right-click the None button. 

A shortcut menu appears.
3. From the shortcut menu, select Properties.

The UI Element Setup window appears.
4. From the UI Element drop down menu, select P25-DFSI Window.
5. Click the P25-DFSI Misc tab.
The P25-DFSI Misc Page appears.

Misc group box

Enable P25-DFSI Dispatch Window check box
The Enable P25-DFSI Dispatch Window check box is used to enable the P25-DFSI Dispatch
Window. If unselected, the user cannot open the DFSI Window in Runtime.

The default is selected.

Receive All Talk Groups check box
The Receive All Talk Groups check box, if enabled, allows the console operator to be able to hear all
incoming Talk Groups on that line. When the check box is not enabled, the line mutes all audio not
matching the current Talk Group of that line.

The default is selected.

Receive All Private Calls check box
The Receive All Private Calls check box, if enabled, allows the console operator be able to hear all
Private Calls on that line. When the check box is not enabled, the line mutes private calls not directed
to the console.
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The default is selected.

P25-DFSI Radio List Font Size field
The P25-DFSI Radio List Font Size field indicates the size of the P25-DFSI Radio List Font Size.

The default is 12.

Password Protection group box

Radio Monitor check box
The Radio Monitor check box, if enabled, indicates the Radio Monitor function is password protected.

For more information, refer to “Global Parameter Setup window, page 116”.

Radio Inhibit/Uninhibit check box
The Radio Inhibit/Uninhibit check box, if enabled, indicates the Radio Inhibit/Uninhibit function is
password protected.

For more information, refer to “Global Parameter Setup window, page 116”.

Call Alert check box
The Call Alert check box, if enabled, indicates the Call Alert function is password protected.

For more information, refer to “Global Parameter Setup window, page 116”.

Vote Select/Disable check box
The Vote Select/Disable check box, if enabled, indicates the Vote Select/Disable function is password
protected.

For more information, refer to “Global Parameter Setup window, page 116”.

Dispatch Window Config button
The Dispatch Window Config button is used to change the color of the buttons and background of
the Dispatch Window. Refer to the Figure below.
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Figure 53.13: Dispatch Window

53.12 P25-DFSI window and C-Soft Runtime
The P25-DFSI window is the general control of a DFSI line. Clicking on the P25-DFSI button in the
Figure “DFSI Design Options” in “Setting Up Additional P25-DFSI lines, page 500”, during runtime,
opens the window shown in the Figure below.

Refer to
– Setting Up Additional P25-DFSI lines, page 500

53.12.1 Main Control page
The Main Control page is used to change the settings of the main control.
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Figure 53.14: DFSI 1: Channel 1 - Main Control

Channel drop down menu
The Channel drop down menu is used to select the channel.

Volume Slider
The Volume slider is used to increase or decrease the volume of the P25 audio.

Group Call button
The Group Call button is used to make a group call to the group ID in the ID box.

Talk Group field and drop down menu
The Talk Group drop down menu is used to place group calls to the group selected from the list. The
text above the drop down menu displays the selected value.

Private Call button
The Private Call button is used to initiate a Private Call to the radio ID in the ID box.

Private Call drop down menu
The Private Call drop down menu is used to place private calls to the radio selected form the list.

Mute button
The Mute button is a latching button (press it, it stays muted, press again, it unmutes).

Selected button
The Selected button changes the current line from Selected Audio to Unselected audio.

Digital button
The Digital button is used to toggle the channel between Analog and Digital.
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i
Notice!
The channel must be configured for mixed mode. For more information, refer to “Analog/Digital
Column” on Channel Table window, page 498.

Repeat On/Off button
The Repeat On/Off button is used to turn the base stations Repeater functionality On or Off.

Monitor On/Off button
The Monitor On/Off button is used to enable or disable monitor mode directly over the DFSI

Figure 53.15: DFSI 1: Channel 1- Main Control Keypad

Keypad flyout
The Keypad flyout is used to manually select unit IDs for a private call.

Refer to
– Channel Table window, page 498

53.12.2 Unit Control page
The Unit Control page us used to send unit specific commands.
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Figure 53.16: DFSI 1: Channel 1 - Unit Control

ID List flyout
The ID List flyout contains all the Unit IDs and Group IDs setup for P25-DFSI. The ID List flyout is
used to access the preprogrammed Unit ID and Group ID list.

Date column
The Date column is used to show the historical date commands were sent.

Time column
The Time column is used to show the historical time commands were sent.

Freq column
The Freq column is used to show the frequency that was sent.

Status column
The Status column is used to show any status information about the sent command.

TG-NAC column
The TG-NAC column is used to show the talk group and identifier number for the radio call.

Source ID column
The Source ID column is used to identify the number of the calling subscriber unit.

Target ID column
The Target ID column is used to identify the number the source ID is calling.
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Radio Check button
The Radio Check button is used to verify if the target radio is currently online and functional.

Status Request button
The Status Request button is used to read the Status of a Radio.

Radio Inhibit button
The Radio Inhibit button is used to disable a radio from use. This feature can be used in the case of a
lost or stolen radio.

Call Alert button
The Call Alert button is used to send an alert to the target remote radio.

Radio Monitor button
The Radio Monitor button is used to monitor the selected remote radio.

Radio Uninhibit button
The Radio Uninhibit button is used to enable the radio for use. This feature is used to enable a radio if
it has been disabled with the Radio Inhibit button.

Text Message button
The Text Message button is used to send the selected Text Message from the drop down menu to the
selected radio.

Figure 53.17: DFSI 1: Channel 1 - Unit Control - ID List

53.12.3 Voting page
The Voting page is used to provide a visual representation of voter status.
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Figure 53.18: DFSI 1: Channel 1 - Voting

Receiver column
The Receiver column is used to display the various voting receivers that are being used.

Vote State column
The Vote State column display the status of the various voting receivers.

Report button
The Report button is used to view the current Vote State of the receiver selected in the ID box.

Normal button
The Normal button is used to set the receiver into normal state.

Select button
The Select button is used to select the receiver to use.

Disable button
The Disable button is used to disable the receiver input at voter.

53.12.4 Repeater page
The Repeater page shows the current state of all P25-DFSI lines setup in C-Soft.
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Figure 53.19: DFSI 1: Channel 1 - Repeater

When a line is selected, if the call is a Group Call, the PTT Button turns into a Group Call button. If the
call selected is a Private Call, the PTT Button becomes a Private Call button.

53.12.5 History page
The History page is used to show the historical information for traffic on the line.

Figure 53.20: DFSI: Channel 1 - History

Alert Cancel button
The Alert Cancel button is used to ignore a Call Alert on the P25-DFSI line.
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53.13 System features and requirement for DFSI Interface
Supported DFSI Repeaters
For the most up to date information on repeater support, go to www.telex.com.
– BK/Relm M/8150 with DFSI
– Codan
– EF Johnson Atlas
– ICOM
– RIC-M
– Tait

Supported DFSI repeater functions
For the most up to date information on supported DFSI repeater functions, go to www.telex.com.
– Channel Change
– Repeat mode
– Monitor
– Voting

Supported DFSI radio functions
For the most up to date information on supported DFSI radio functions, go to
www.telexradiodispatch.com.
– Digital\Analog\Mixed Mode
– Radio Check
– Radio Inhibit
– Radio Uninhibit
– Status request
– Call Alert
– Radio Monitor
– Private Call
– Group Call

Required for C-Soft Setup
– C-Soft 6.5000 or higher
– Software-based license key for P25-DFSI lines
– Supported Repeater (refer to Supported DFSI Repeaters, above)
– IP Addresses and Ports of Repeater

53.14 Frequently Asked Questions
– P25-DFSI Line of Server Console won’t connect to Fixed Station:
Check the Control Unicast Address of FS and Control Port of FS in the P25-DFSI Setup.

– P25-DFSI Line of Client Console won’t connect to Fixed Station:
Check the Control Unicast Address of Server and Control Port of Server in the P25-DFSI Setup.

– The wrong channel selected is shown:
Check the P25 Manufacture in the P25-DFSI Setup.

http://www.telex.com
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54 Appendix F - P25 Encryption
Due to C-Soft’s Designer/Runtime separation, C-Soft first requires keys are registered and organized
in the design file. C-Soft uses a specialized architecture to allow for clarity and flexibility in the task of
key management. C-Soft utilizes several constructs and definitions to simplify the management of
encryption keys:

– Registered Key: A registered key’s information consists of a key name and a CKR (Common Key
Reference).

– Encryption Option: Specifies the cryptographic method used to transmit. Available encryption
options are a Registered Key or Clear.

– Encryption Profile: An ordered group of encryption options which represent a list of all encryption
options available on a given P25-DFSI talkgroup.

Each C-Soft design maintains a list of registered encryption keys, which are organized into encryption
profiles. Each P25-DFSI line contains a list of channels that are each linked to an encryption profile,
allowing the dispatcher to select and use any of the encryption options available in the encryption
profile.

Once these organization steps are completed, encryption keys must be loaded into C-Soft Runtime.
Once loaded, C-Soft Runtime uses the key organization as defined in the design file, but uses key data
directly loaded into Runtime. This allows for C-Soft to easily manage key updates, changeovers, and
other cryptographic maintenance tasks.

i
Notice!
The P25-DFSI Encryption functionality is a value added option to your C-Soft license; please contact
your regional Bosch Sales person for details on how to purchase.

Figure 54.1: Encryption Configuration Constructs

In the example shown in the Figure below, there are three channels on both Line 1 and Line 2.
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– P25 DFSI Line 1’s Channel 1 is linked to the encryption profile Clear that contains only one
encryption option, Clear. While using P25 DFSI Line 1’s Channel 1, the dispatcher can only
transmit unencrypted.

– P25 DFSI Line 1’s Channel 2 is linked to Encryption Profile A that contains three encryption
options. While using P25 DFSI Line 1’s Channel 2, the dispatcher can choose whether to
transmit unencrypted, with Key 1 or with Key 2.

– P25 DFSI Line 1’s Channel 3 is linked to the encryption profile B that contains only one
encryption option. While on Channel 3, the dispatcher can only transmit using Key 3.

– P25-DFSI Line 2 contains three channels that are linked to encryption profile B. While on all of
these channels, the dispatcher can only transmit using Key 3.

Figure 54.2: Organization Configuration Example

54.1 Encryption configuration
In order to utilize the P25-DFSI Encryption features, the following configuration steps need to be
completed:
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1. “Registering keys, page 518”.
2. “Group encryption options into encryption profiles, page 521”.
3. “Link P25-DFSI Channels to an encryption profile, page 522”.
4. “Activate Key Fill Device serial port, page 523”.
5. “Add an Encryption Option Select button, page 523”.

The majority of encryption configuration is contained in the Encryption Setup window, shown in
“Encryption Setup window, page 515”.

NAVIGATION: From the Edit menu, select Setup P25 | Encryption.

Refer to
– Registering keys, page 518
– Group encryption options into encryption profiles, page 521
– Link P25-DFSI Channels to an encryption profile, page 522
– Activate Key Fill Device serial port, page 523
– Add an Encryption Option Select button, page 523
– Encryption Setup window, page 515
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54.2 Encryption Setup window

Encryption Keys group box

Name column field
The Name column field is used to enter the name of the key being registered. A maximum of 100 keys
can be registered.

Up to 24 alphanumeric characters can be entered into this field.

CKR column field
The CKR column field is used to enter the common key reference number. A common key reference
number is used to link a key name to an encryption key in a key fill device, commonly used for key
name display purposes. This additional reference value allows changing a key’s name without having
to know its key ID.

The range for this field is 0 through 65535.
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Key Fill Device group box
The Key Fill Device group box is used to import encryption key data (Name and CKR) from a key fill
device to C-Soft.

Serial Port drop down menu
The Serial Port drop down menu is used to specify the serial port that C-Soft Designer opens in order
to communicate with an attached key fill device for key registration purposes.

i
Notice!
This value is also used in C-Soft Runtime to specify the serial port used to communicate with an
attached key fill device for key loading.

Start button
The Start button is used to immediately open the serial port listed in the Serial Port drop down menu,
allowing communication with the key fill device in C-Soft Designer.

The button toggles between a start and stop function.

Encryption Profiles group box
The Encryption Profiles group box is used to create encryption profiles with different encryption keys.
For more information, refer to “Group encryption options into encryption profiles, page 521”. Up to 50
encryption profiles can be created. Each profile can have up to 25 encryption options associated with
it.

i

Notice!
The Encryption Profile list always contains an encryption profile labeled Clear, which contains the
Clear encryption option only. By default, any P25-DFSI Line’s channels are linked to the clear
encryption profile.

Name column field
The Name column is used to enter a profile name, such as All Keys or Clear Only.

Summary column field
The Summary column field summarizes the key options included in the Key Profile (i.e., Clear+2keys).
This column is automatically generated.

Edit button
The Edit button is used to open the Encryption Profile window of the currently selected encryption
profile. Use this window to add and remove different encryption options to the profile as well as set
the default encryption option.

Delete button
The Delete button is used to delete an encryption profile.

1. Select the profile intended for deletion.
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2. Click the Delete button.
A warning message appears verifying the intention to delete the profile.

3. Click OK.
The profile is deleted from the Encryption Profiles list.

54.3 Encryption Profile Edit window
The Encryption Profile Edit window is used to create encryption profiles using the user created
encryption options and Clear.

For more information, refer to “Group encryption options into encryption profiles, page 521”.

Figure 54.3: Encryption Profile Edit Window

Profile Name field
The Profile Name field is used to enter a name for the encryption profile.

All Options list
The All Options list displays a list of all available encryption options for use in the profile.

Add button
The Add button is used to move options from the All Options list to the Selected Options list.

Remove button
The Remove button is used to move options from the Selected Options list to the All Options list.
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Selected Options list
The Select Options list displays a list of the encryption options selected for the profile being created.
The Selected Options list is an ordered list.

i

Notice!
The first option listed is always the default option. For example, in Figure 228, Clear is the default
encryption option. The default option is the first option listed on the Encryption Button Popup List in
C-Soft Runtime.

Use the up and down buttons to move the selected encryption options up or down in the list.

OK button
The OK button is used to accept the modifications made and closes the Encryption Profile window.

Cancel button
The Cancel button is used to close the Encryption Profile window. No modifications made are saved.

Refer to
– Group encryption options into encryption profiles, page 521

54.4 Registering keys
Registering keys requires two pieces of information:
– The Key’s Name
– The Keys CKR (Common Key Reference) value

To transmit encrypted audio using a specific encryption key, the key must be registered into the
system design.

There are two methods to register keys; manually or automatically.

Register manually
To register manually, do the following:
1. From the Edit menu, select P25 | Encryption.

The Encryption Setup screen appears.
2. In the Name column, enter a unique name for the key.
3. In the CKR column field, enter the CKR number for the key.

Register automatically
When using a key fill device to import keys to C-Soft, some radios do not use key names, refer to “Key
Fill Device Group Box”.

To register automatically, do the following:
1. From the Edit menu, select P25 | Encryption.

The Encryption Setup screen appears.
2. From the Serial Port drop down menu, select the COM port to be used to communicate with a

key fill device.
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3. Click the Start button.
The specified serial port for communication with an attached key fill device opens.
NOTE: C-Soft Designer may be unable to acquire the serial port if C-Soft Runtime has reserved
the port.

4. Using the Key Fill Device, load the keys into C-Soft.
The updated Key Names and CKRs appear in the Encryption Keys table.

i
Notice!
When using the automatic register feature, only Key Names and CKRs are loaded.
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54.5 Connecting a key fill device

Depending on the radio you are using, a few differences must be noted.
– If using a Tait Recon KVL, connect the bottom DB-9 serial port to the C-Soft Console PC using a

null serial cable.
– If using either the Motorola KVL-3000+ or KVL-4000, the Tait 9000 Series to KVL adapter is also

necessary. On the Motorola KVL, connect the 10-pin connector to the Tait 9000 Series to KVL
Adapter. And then connect the DB-9 serial port to the C-Soft Console PC using a null serial
cable.

Key Fill Device Features and Limitations
While all tested key fill devices follow the same base P25-defined Key Fill Device Interface Protocol,
there may exist several operational differences and behavior.

Key Names
The Motorola KVL-3000+ and Motorola KVL-4000 do not include Key Names when importing
encryption key data. This results in the following behavior:
– In C-Soft Designer, when using Automatic key registration, only keys’ CKR values are added to

the Key List. Their names must be manually set.
– In C-Soft Runtime, when receiving an audio call encrypted with a key with a non-registered but

loaded key, C-Soft will display “Unregistered Key (#)”, where # is the CKR of the key. This can be
amended by manually registering the key in the Design, which makes the key name appear
properly.

– The Tait Recon KVL key load process includes key names, and in each of these cases, the Key
Name is properly displayed.
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54.6 Group encryption options into encryption profiles
Encryption Profiles are ordered groups of encryption options such as registered keys and Clear.

To group encryption options into encryption profiles, do the following:
1. From the Edit menu, select P25 | Encryption.

The Encryption Setup screen appears.

2. In the Encryption Profile group box, click in the Click to create profile field.
The name column field becomes active.

3. Enter a profile name in the active field.
The profile name appears in the field.
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4. Click the Edit button.
The Encryption Profile window appears.

5. From the All Options list, select the options to add to the profile.
Multiple options can be selected at one time.

6. Click the Add button to move the encryption options to the Selected Options list.
7. Use the up and down buttons to reorder the Selected Options list, if applicable.

NOTE: Reordering the Selected Options list is useful when wanting to the default encryption
option in which the topmost entry becomes the default.

8. Click OK.
The Edit Encryption Profile window closes.

54.7 Link P25-DFSI Channels to an encryption profile
Each P25-DFSI Channel needs to be configured to select which Encryption Profile to use. When the
specific P25-DFSI Channel is selected, only encryption options in the associated encryption profile are
available to use for transmit.

To link the P25-DFSI channels to the encryption profile, do the following:
1. From the Edit Window, select Setup Per Line Parameters.

The Per Line Parameters window appears.
2. Press the Freqs button of the desired P25-DFSI line.

The Channel Table appears.
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3. From the Encryption Profile column drop down menu, select an encryption profile for each
channel.

4. Click OK.
The Channel Table modifications are saved, and the Channel Table window closes.

54.7.1 Activate Key Fill Device serial port
To permit communication between C-Soft and a key fill device, the desired serial port must be
configured.

To configure C-Soft Runtime’s serial port, do the following:
1. From the Edit menu, select P25 | Encryption.

The Encryption Setup screen appears.
2. From the Serial Port drop down menu, select the COM port to be used to communicate with a

key fill device.
3. Click the OK button.

The Encryption Setup window closes.
4. Save the design.

i
Notice!
When C-Soft Runtime is launched with the Design, C-Soft opens the selected serial port for
communication with an attached key fill device.

54.8 Add an Encryption Option Select button
Encryption Profiles containing more than one encryption option need a UI element to control the
encryption option to be used while transmitting. Secondarily, the Encryption Option Select button also
displays encryption key information when receiving encrypted audio.

To add an Encryption Option Select button, do the following
1. From the Insert menu, select Add Button.

OR
Right-click in an empty spot in the Design workplace.
A popup menu appears.

2. Select the Add button.
A button appears in the design workspace.

3. Right-click on the button.
A popup menu appears.
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4. From the popup menu, select Properties.
The UI Properties window appears.

5. From the UI Element Function drop down menu, select Encryption Key Select.
6. From the Line to Associate Function With, select the P25-DFSI Line configured for P25

Encryption.
OR
Select the Global checkbox to have the Encryption key Select button display information based
on the currently selected line.

7. Click OK.
The window closes and the button displays Key Select.

54.9 Loading keys to C-Soft Runtime
At this point, C-Soft Runtime does not have any actual key data. This key data must be loaded from a
key fill device. C-Soft Runtime communicates to a key fill device through the PC’s serial port.

To load keys into C-Soft Runtime, do the following:
1. Launch C-Soft Runtime.
2. Attach a Key Fill Device to the C-Soft Dispatch Console PC via the serial port.

Upon successful connection, C-Soft’s Status Bar displays a “Key Fill Device Attached” message.
NOTE: C-Soft Runtime may be unable to acquire the serial port if C-Soft Designer is using it to
register keys.

3. Using the key fill device, load one or more keys into C-Soft in the same fashion as a radio.
Once finished, C-Soft’s Status Bar displays a “# Key(s) Updated” message, where “#” specifies the
number of keys that were loaded or updated. The keys are now successfully loaded into C-Soft.

Refer to “Connecting a key fill device, page 520” for more information on using a key fill device.

Refer to
– Connecting a key fill device, page 520
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54.10 Receiving encrypted calls
When receiving a call with encrypted audio, C-Soft attempts to find a loaded key in which the
incoming Key ID matches the received Key ID. If a matching key is found, the call is decoded and
played. If C-Soft does not possess a key with a matching Key ID, the incoming call’s audio is muted.

While receiving a call encrypted with an AES key, the line’s Select button displays FIPS to indicate the
call is being decrypted using a FIPS-validated cryptographic library.

In addition, the Encryption Key Select button momentarily displays the incoming call’s key name, or
the Key’s CKR if the name is not known. Since there are potentially two locations in which a key name
is specified, C-Soft uses the following priority list for displaying Key Information:
1. Registered Key Name from Design’s Encryption Key List
2. Key Name obtained from the key fill device.
3. “Unregistered Key <CKR>”

The incoming call flow is summarized as follows:

Figure 54.4: Receiving Call Flow

54.11 Transmitting encrypted calls
The Encryption Key Select button is the essential UI element for encryption operation. The button is
either configured as global meaning the content is changed based on the currently selected line, or
statically configured to a specific line.

The Encryption Key Select button is also linked to the currently selected channel/talkgroups, and
changes its content when the active channel/talkgroups is changed. The Encryption Key Select
button’s selected option is preserved between switching selected lines and switching channel/
talkgroups.
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Figure 54.5: Encryption Key Select Button (with Option List)

The Encryption Key Select button’s drop down menu contains a list of all encryption options contained
in the encryption profile linked by the currently selected frequency of the associated line. In addition, it
contains information relevant to encryption key validity.

The icon/states include:

Icon Meaning Description

Blank Used for “Clear”, indicates
transmissions are not
encrypted.

Key Key data is loaded and available.

No Data Key name/CKR are registered in
the Design file, but C-Soft
Runtime does not possess data
for the key. Any attempt to
transmit using a registered but
not loaded key is blocked. After
using a key fill device to load the
key’s data into C-Soft Runtime,
the no data icon changes to key.

Once an encryption option is selected, pressing a PTT button (e.g. Main PTT, Per-Line PTT, Private
PTT, or Group PTT) button will transmit using the selected key. While receiving a call encrypted with
an AES key, the line’s Select button displays FIPS to indicate the call is being decrypted using a FIPS-
validated cryptographic library. The transmit call flow is as follows:
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Figure 54.6: Transmit Call Flow
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55 Appendix G - CSSI Interface
The P25 CSSI interface is designed to connect directly to P25 Trunking System via an IP Interface
without using a radio gateway or additional hardware. The C-Soft CSSI interface provides flexibility in
deployment and offers advanced radio control features. CSSI interface is an option feature on C-Soft
and available in 2, 6, 12, and 24 talk paths.

i

Notice!
Included with this option is the ability to define a line as either P25 CSSI or P25 DFSI. The total
number of lines available is constrained by the number of lines in the P25 CSSI option license. In
other words, a six line P25 CSSI license could have all six lines set up for P25 CSSI, or all six lines set
up for P25 DFSI, or a combination of 4 lines set up for P25 CSSI and two lines set up for P25 DFSI.

i
Notice!
These steps are only used when the console connects directly with the RFSS. If connecting to the
RFSS using CMS, see the CMS manual.

55.1 Supported features

i
Notice!
While C-Soft supports these features, each radio manufacturers supported CSSI feature set varies,
consult technical support for a list of known features per manufacturer.

The CSSI Trunking Interface supports the following features:
– Console Registration
– Group Call
– Private Call
– Call Alert
– Announcement Call
– System Call
– Short Message Decode
– Status Query/Update
– Radio Unit Monitor
– Radio Check
– Radio Enable
– Radio Disable
– Emergency Alarm
– Emergency Acknowledgement
– Audio Encryption and Keys Loading
– P25 Phase 1
– P25 Phase 2
– P25 DFSI (refer to “Appendix E - P25-DFSI (Digital Fixed Station Interface), page 480”)
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Refer to
– Appendix E - P25-DFSI (Digital Fixed Station Interface), page 480

55.2 Theory of operation
Console
In a P25 CSSI interface, the C-Soft console acts as an RFSS System. When the console starts, it needs
to register its talk groups with the P25 trunking infrastructure via IP connection to gain access to the
system.

i
Notice!
The registration process fails on certain talk groups if those talk groups are not pre-programmed in
the CSSI system.

Call Line
Each CSSI line within a console design can be set up as either Talk Group or Unit Call lines. Talk
Group lines use either a Group PTT or InPTT button for call activation. Using a GroupPTT button
allows the talk group ID to be varied on the line. Using an InPTT button creates a dedicated line with
only one talk group ID. All talk groups needing to receive and transmit on must be registered with the
CSSI system. The console registers all talk groups contained in the consoles System List when the
console first starts. Talk group validation can be viewed in the console’s Global Call History window
(refer to “Global Call History window, page 447”).

A Unit Call line is used to send private calls to an individual radio subscriber. Unit lines use either a
Private PTT button or an InPTT button for call activation. Using a Private PTT button allows the unit ID
to be varied on the line. Using an InPTT button creates a dedicated line to call only one unit ID. Radio
buttons such as Call Alert, Remote Monitor, etc. are typical buttons assigned to this type of line.
Console designers can add a Keypad module to the console design to provide easy access to the Talk
Group or Private Call user list during call operations when using the Private PTT button.

i
Notice!

It is strongly recommended to assign Radio Control Buttons such as Radio Call Alert, Radio Check,
Radio Disable, Radio Enable, and Radio Remote Monitor to a unit call line. This ensures seamless
operation on the console.
Assigning the Radio Control Buttons on group lines that may be restricted can produce unpredictable
results.

The console registers all talk groups contained in the consoles System List when the console first
starts up. The System List can be edited using the System List Window (refer to “Status List window,
page 237”). Talk group validation can be viewed in the console’s Global Call History window (refer to
“Global Call History window, page 447”).
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Refer to
– Global Call History window, page 447
– Status List window, page 237

55.2.1 Distribution of receive audio to the lines
Talk Groups
The CSSI protocol is based on SIP (Session Initiation Protocol); therefore the console implementation
also uses this protocol to structure the operation of the console. The console first scans all lines for a
Group PTT button that is set to the incoming talk group ID. If the receive ID matches the line’s talk
group ID, the line receives the audio.

If no Group PTT button is set to the incoming ID, the console then scans all lines with an Instant PTT
button (a dedicated line) for a group ID assigned to the line (the talk group ID assigned in C-Soft
Designer). If the receive ID matches the lines talk group ID, that line receives the audio.

If no line matches the ID, the receive audio goes to the first available (non-busy) line with a Group
PTT. If all lines are busy, the call is missed.

i

Notice!
If a console system cannot tolerate any missed talk group calls, the console administrator must have
as many Talk Group lines as voice channels available on the CSSI system and all lines must have
Group PTT buttons.
If a dispatcher needs to monitor and talk to a specific talk group, an InPTT button is used to create a
dedicated line.

Unit lines operate exactly the same as group lines, with one exception, if all unit call lines are busy the
console sends back a busy signal to the calling unit.

Operational Notes
– The talk group or unit ID shown on the Group PTT, InPTT, and Private PTT is the line’s current

transmit and receive ID.
– If the keypad module is used on the C-Soft console to change talk group and unit IDs, console

operators must select the desired line by clicking on the Select button first and changing the ID in
the keypad. The ID changes on the selected line’s PTT button and any radio buttons assigned to
it. If a console operator selects another, the previous selected line retains its ID. This operation
holds true for all non-dedicated lines. Dedicated lines are preset to the default designer value; the
keypad has not effect on these lines.

– Up to 24 CSSI lines can be created with any combination of Talk Group or Unit lines.

Group Call line
A Group Call is used to talk to multiple radios within a talk group.

Group lines use Group PTT or an InPTT button for call activation. Using a Group PTT button allows the
Group ID to be varied on the line. Using an InPTT button creates a dedicated line with only one Group
ID. In addition, a Radio Status button can be assigned to a group line to send status messages to a
group.
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i

Notice!
All talk groups must be registered with the CSSI system. Upon initial start up, the console registers all
CSSI groups listed in the Group ID List. Talk group validation can be viewed in the console’s Global
Call History window. The registration process fails on groups not pre-programmed on the CSSI
system. To configure the console’s system list, refer to “File menu - Edit System List, page 195”.

Refer to
– File menu - Edit System List, page 195

55.2.2 Individual Call line
An Individual Call line is used to send private calls to individual units. Individual Call lines use a Private
PTT or an InPTT button for call activation. Using a Private PTT button allows the unit ID to be varied
on the line. Using an InPTT button creates a dedicated line with only one unit ID.

Radio buttons (Call Alert, Remote Monitor, Regroup, Ungroup, etc.) are typically assigned to this type
of line. Console operators can add a Keypad to the console design, providing easy access to the user
list during call operation. All Unit Calls are received by the console when the Individual Call line is in
Scanning Mode. In Dedicated Mode, the Individual Call line becomes a point-to-point call with one
preprogrammed unit.

55.3 CSSI Call types
Each CSSI line within a console design can be set up as either Group or Individual Call lines.

55.3.1 Group Call
Talk Group lines use either a Group PTT or InPTT button for call activation. Using a GroupPTT button
allows the talk group ID to be varied on the line. Using an InPTT button creates a dedicated line with
only one talk group ID.

To create a Group Call, do the following:
1. From the Edit Window, select Setup Per Line Parameters.

The Per Line Parameters window appears.
2. Click the Signal Setup button of the P25 CSSI line to create a group call.

The Signaling Parameters screen appears.
3. Click the CSSI tab.

The CSSI page appears.
4. From the Call Type drop down menu, select Group Call.
5. From the Encryption Profile drop down menu, select the encryption profile to use, if applicable.
6. In the Call Number field, enter the Talk Group Number of the line if using an InPTT button on the

line.
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i

Notice!
If the console designer assigns an InPTT button to the line, this line would only transmit to and
receive from the default ID. This is called a Static Group Line. If the console designer assigns a Group
PTT button to the line, the default ID is overridden at run time by the current Group ID assigned by
the selectable Group PTT button. This is called Manual Group line.
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Figure 55.1: Static Group Line and Manual Line Set Up

55.3.2 Individual Call
An Individual Call line is used to send private calls to individual users. Individual lines use either a
Private PTT button or an InPTT button for call activation. Using a Private PTT button allows the unit ID
to be varied on the line. Using an InPTT button creates a dedicated line with only one unit ID. Radio
buttons such as Call Alert, Remote Monitor, etc. are typical buttons assigned to this type of line.
Console operators can add a Keypad to the console design to provide easy access to the user list
during call operation.

To create an Individual Call, do the following:
1. From the Edit Window, select Setup Per Line Parameters.

The Per Line Parameters window appears.
2. Click the Signal Setup button of the P25 CSSI line to create an individual call.

The Signaling Parameters screen appears.
3. Click the CSSI tab.

The CSSI page appears.
4. From the Call Type drop down menu, select Individual Call.
5. From the Encryption Profile drop down menu, select the encryption profile to use, if applicable.
6. In the Call Number field, enter the Individual Call Number of the line if using an InPTT button on

the line.



534 en | Appendix G - CSSI Interface C-Soft 8.500

2025-08 | 16 | F.01U.218.561 Technical Manual Bosch Security Systems, LLC

i

Notice!
If the console designer assigns an InPTT button to the line, this line would only transmit to and
receive from the default unit ID.
If the console designer assigns a Private PTT button to the line, the Private PTT overrides the default
number and allows different units to be selected.

Figure 55.2: Private Call Configuration

55.4 C-Soft Setup parameters
To program a P25 unit radio or parallel console ID for CSSI operation, do the following:
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1. From the edit menu, select Edit User ID List.
The User ID List window appears.

2. In the Name column, enter the alias for each line.
3. In the User ID column, enter the User ID for each line (the User ID is in decimal format).
4. From the Type drop down menu, select P25-CSSI.
5. Click OK.

i
Notice!
To program an All Call ID that can transmit to all CSSI subscribers on the system, enter 65535 in the
User ID column, and select CSSI from the Type drop down menu. All numbers are in decimal format.

To program a P25 Trunking talkgroup for CSSI operation, do the following:
1. From the Edit menu, select Edit Group ID List.

The Group ID List window appears.
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2. In the Group column, enter the Group alias for each line.
3. In the Group ID column, enter the Group ID for each line (the Group ID is in decimal format).
4. From the Type drop down menu, select CSSI for each line.
5. Click OK.

i
Notice!
During start up, C-Soft registers all of the pre-programmed CSSI Talk Groups. C-Soft can only
communicate to Talk Groups registered to the system.

55.5 Signaling Parameters

Figure 55.3: Signaling Parameters - CSSI Page

Console Call Parameters group box
The Console Call Parameters group box is used to configure a line’s voice call. Configuration options
include the type of call, the encryption profile to use, and the call number.

The Call Type drop down menu is used to select the type of call designated to the line.

Available options are Group Call or Individual Call.

Encryption Profile drop down menu
The Encryption Profile drop down menu is used to select the encryption profile to use for the line, if
any. For more on Encryption profiles, refer to “Appendix F - P25 Encryption, page 512”.
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Call Number field
The Call Number field is used to enter the Talk Group ID or the Individual ID, depending on what is
selected in the Call Type drop down menu. This field is uniquely identified by a number.

The range for this field is 1 to 65535 in decimal.

RFSS Location Parameters group box
The RFSS Location Parameters group box is used to configure the P25 repeater RFSS (Radio
Frequency Sub-System) that connects to the line. The following field values are obtained from the
systems RFSS.

RFSS ID Dec/Hex fields
The RFSS ID Dec/Hex fields are used to enter the ID of the Home RFSS in the connected P25
Trunking system. The unique identifier can be entered in either decimal or hex format.

The range for this field is 1 to 65535 in decimal.

System ID Dec/Hex fields
The System ID Dec/Hex fields is used to enter the ID for the LMR system within a WACN (Wide Area
Communication Network). The unique identifier can be entered in either decimal or hex format.

The range for this field is 1 to 4095 in decimal format.

WACN ID Dec/Hex fields
The WACN ID Dec/Hex fields are used to enter the WACN ID, which is a collection of one or more
LMR systems. The unique identifier for each LMR system can be entered in either decimal or hex
format.

The range for this field is 1 to 1048575.

RFSS IP Address field
The RFSS IP Address field is used to enter the IP Address of the RFSS system. Individual RF sites use
this address to connect with.

RFSS Location ID field
The RFSS Location ID field displays the an ID that is made up of the RFSS ID, System ID, and the
WACN ID. This field cannot be modified. This field is most commonly used for comparison purposes
when setting up a CSSI system.

Global CSSI Setup button
The Global CSSI Setup button opens the Global P25 CSSI Parameters setup window. For more
information, refer to “Global P25 CSSI Parameters, page 539”.

55.6 CSSI System setup
To set up a CSSI Line, do the following:
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1. From the Edit menu, select Setup Per Line Parameters.
The Per Line Parameters window appears.

2. From the Line Type drop down menu, select CSSI.
NOTE: The Multicast address and port number information is used for cross console
communications supporting the following features: Call Queue, Emergency and Cross-patch
updates. These fields should match on each console in a shared system.

3. Click the Signal Setup button.
The Signaling Parameters window appears.

4. From the System Type drop down menu, select P25 CSSI.
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5. Click the CSSI tab.
The CSSI window appears.

6. From the Call Type drop down menu, select the Call Type.
7. In the Talk Group Number field, enter the Talk Group Number.

55.7 Global P25 CSSI Parameters
The Global CSSI Parameters apply to all CSSI console lines and only need to be set once per console.
The Global CSSI Parameters window is assessable from any line, but the values are constant between
lines, and can be found at Edit | Setup CSSI.
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Figure 55.4: Global CSSI Trunking Parameters Window

Console Location group box
The Console Location group box is used to define the console location identifiers.

Console ID Dec/Hex fields
The Console ID Dec/Hex fields are used to enter the ID that is assigned to the console.
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The range for this field is 1 to 16777215 in decimal format.

Console RFSS ID Dec/Hex fields
The Console RFSS ID Dec/Hex fields are used to enter the ID of the RFSS. This ID must match the
external CSSI RFSS ID which was set up on the LMR system.

The range for this field is 1 to 65535 in decimal format.

Console System ID Dec/Hex fields
The Console System ID Dec/Hex fields are used to enter Control System ID. This ID must match the
CSSI System ID which is set up on the LMR system.

The range for this field is 1 to 4095 in decimal format.

Console WACN ID Dec/Hex fields
The Console WACN ID Dec/Hex fields are used to enter the WACN ID. The WACN is a collection of
one or more uniquely identified LMR Systems.

The range for this field is 1 to 101048575 in decimal format.

Console Location ID field
The Console Location ID field displays the location ID of the console. This ID is made up of the
Console RFSS ID, Console System ID and the Console WACN ID. This field is used for comparison
purposes when setting up a CSSI system. This field cannot be edited.

Console SUID field
The Console SUID field displays the SUID (subscriber unit ID). This ID is made up of the Console
WACN ID, Console System ID, and Console ID. This field is used for comparison purposes when
setting up a CSSI system. This field cannot be edited.

Enable Heartbeats check box
The Enable Heartbeats check box determines whether or not heartbeats are sent from the console to
the LMR RFSS.

Heartbeat Rate field
The Heartbeat Rate field is used to enter rate at which heartbeats are sent from the console to the
LMR RFSS.

The range for this field is 10 to 120 seconds.

Missed Heartbeats field
The Missed Heartbeats field is used to enter the number of missed heartbeats allowed before an error
is generated.

The range for this field is 1 to 10.



542 en | Appendix G - CSSI Interface C-Soft 8.500

2025-08 | 16 | F.01U.218.561 Technical Manual Bosch Security Systems, LLC

Receive FNE Supplementary data by SUs registered with group check box
The Receive FNE Supplementary data by SUs registered with group check box determines whether
or not a group registration with both the LMR RFSS and LMR FNE (Fixed Network Equipment) is
allowed. This allows supplementary operations such as Status, Call Alert, Radio Check, etc. to be
handled by FNE. For example, an SU sends a Status update to the FNE. All the consoles registered to
the FNE for that group receives the status update. The SU does not need to send status updates to
each individual console.

Console Tx Priority field
The Console Tx Priority field is used to enter the transmit priority level. Consoles with a higher priority
level transmits over a console that has a lower priority level.

The range for this field is 1 to 255.

i
Notice!
A console always transmits over an SU.

Local Console button
The Local Console button opens the “Local Consoles page, page 131”.
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56 Appendix H - Kenwood NEXEDGE Direct IP interface
The NEXEDGE Direct IP interface is designed to connect directly to NEXEDGE Trunking and
NEXEDGE Conventional Systems via an IP Interface without using a radio gateway or additional
hardware. The C-Soft NEXEDGE IP interface provides flexibility in deployment and offers advanced
radio control features. NEXEDGE IP interface is an option feature on C-Soft and available in 2, 6, 12,
and 24 talk paths.

56.1 Supported features
The NEXEDGE Trunking and Conventional IP Interfaces support the following features:
– Direct IP Interface (no extra hardware or radio gateway needed)
– Supports both Narrow band (12.5Khz) and Very Narrow band (6.25Khz) Channel Spacing
– Group Call/Conference Call
– Unit/Private Call
– Alert Call
– Selectable Talk Group
– Emergency Call Decode with Acknowledgement Capabilities
– Radio Status Request
– Radio Status Decode
– Radio Status Encode
– Radio Remote Grouping
– Over-The-Air-Aliasing
– Supports up to 24 Talk Paths per Console
– Call Queuing Using Incoming Status
– Radio Remote Monitor with Supervisor Password
– Radio Stun
– Radio Revive
– Support the following Conventional interface types:

– No Signaling with RAN
– Signaling without RAN
– Signaling and RAN

– Radio Remote Grouping (Trunking Only)
– GPS Decode with IP Interface
– Text Messaging (Trunking Only)
– Broadcast Call (Trunking Only)

56.2 Theory of operation
Console
In a NEXEDGE system, the console acts as a radio SU (Subscriber). When the console starts, it needs
to register its unit ID with the NEXEDGE infrastructure via IP connection to gain access to the system.
Once it is registered, it then registers all the NEXEDGE talk groups programmed in the Group ID List.
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Private Call
Individual units, or SUs, are calls the console wants to talk to that are not registered by the console. All
unit calls are received by the console if the consoles Unit line is in SCAN mode. Scanning mode allows
a line to overflow to another line, if busy. If the Unit line is in dedicated mode, the line becomes a point
to point call with only one unit. Dedicated mode does not allow an overflow. If a line is busy, the call is
missed.

i
Notice!
The consoles registered Unit ID is set from the Global Parameter Setup window, Console Unit ID
Number (refer to “Global Parameter Setup window, page 116”).

Group Call
All talk groups the console is required to listen and talk on must be registered with the NEXEDGE
system. The console registers all talk groups contained in the consoles System List when the console
first starts up. Talk group validation can be viewed in the console’s Global Call History window (refer
to “Global Call History window, page 447”).

i
Notice!
The registration process fails on certain talk groups if those talk groups are not pre-programmed in
the NEXEDGE system.

Call Line
Each NEXEDGE line within a console design can be set up as either Talk Group or Unit Call lines. Talk
Group lines use either a Group PTT or InPTT button for call activation. Using a GroupPTT button
allows the talk group ID to be varied on the line. Using an InPTT button creates a dedicated line with
only one talk group ID.

A Unit Call line is used to send private calls to individual units or SUs. Unit lines use either a Private
PTT button or an InPTT button for call activation. Using a Private PTT button allows the unit ID to be
varied on the line. Using an InPTT button creates a dedicated line to call only one unit ID. Radio
buttons such as Call Alert, Remote Monitor, etc. are typical buttons assigned to this type of line.
Console designers can add a Keypad to the console design to provide easy access to the Talk Group
or Private Call user list during call operations when using the Private PTT button.

i

Notice!
It is strongly recommended to assign Radio Control Buttons such as Radio Call Alert, Radio Check,
Radio Disable, Radio Enable, and Radio Remote Monitor to a unit call line. This ensures seamless
operation on the console. 
Assigning the Radio Control Buttons on group lines that may be restricted can produce unpredictable
results.
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i
Notice!
In the Conventional interface, when not using talk groups, the RAN (Radio Access Node) configured
is used for the Call Line.

Refer to
– Global Parameter Setup window, page 116
– Global Call History window, page 447

56.2.1 Distribution of receive audio to the lines
Talk Groups
The NEXEDGE protocol is based on SIP (Session Initiation Protocol); therefore the console
implementation also uses this protocol to structure the operation of the console. The console first
scans all lines for a Group PTT button that is set to the incoming talk group ID. If the receive ID
matches the line’s talk group ID, the line receives the audio.

If no Group PTT button are set to the incoming ID, the console then scans all lines with an Instant PTT
button (a dedicated line) for a group ID assigned to the line (the talk group ID assigned in C-Soft
Designer). If the receive ID matches the lines talk group ID, that line receives the audio.

If no line matches the ID, the receive audio goes to the first available (non-busy) line with a Group
PTT. If all lines are busy, the call is missed.

RANs (Conventional Only)
When using talk groups, the console scans all the lines to match the talk group, once it has found a
match it then attempts to match the RAN, as well. If you are not using a talk group the console scans
to find a line matching the RAN. If a match is not found the call is missed.

i

Notice!
If a console system cannot tolerate any missed talk group calls, the console administrator must have
as many Talk Group lines as voice channels available on the CSSI system and all lines must have
Group PTT buttons.
If a dispatcher needs to monitor and talk to a specific talk group, an InPTT button is used to create a
dedicated line.

Unit lines operate exactly the same as group lines, with one exception, if all unit call lines are busy the
console sends back a busy signal to the calling unit.

Operational Notes
– The talk group or unit ID shown on the Group PTT, InPTT, and Private PTT is the line’s current

transmit and receive ID.
– If the keypad module is used on the C-Soft console to change talk group and unit IDs, console

operators must select the desired line by clicking on the Select button first and changing the ID in
the keypad. The ID changes on the selected line’s PTT button and any radio buttons assigned to



546 en | Appendix H - Kenwood NEXEDGE Direct IP interface C-Soft 8.500

2025-08 | 16 | F.01U.218.561 Technical Manual Bosch Security Systems, LLC

it. If a console operator selects another, the previous selected line retains its ID. This operation
holds true for all non-dedicated lines. Dedicated lines are preset to the default designer value; the
keypad has not effect on these lines.

– Up to 24 CSSI lines can be created with any combination of Talk Group or Unit lines.

56.2.2 Group Call line
A Group Call line can be set as a Conference Call:

– Conference Call: A Conference Call is used to talk to multiple radios within a talk group.

Group lines use Group PTT or an InPTT button for call activation. Using a Group PTT button allows the
Group ID to be varied on the line. Using an InPTT button creates a dedicated line with only one Group
ID. In addition, a Radio Status button can be assigned to a group line to send status messages to a
group.

i

Notice!
All talk groups must be registered with the CSSI system. Upon initial start up, the console registers all
CSSI groups listed in the Group ID List. Talk group validation can be viewed in the console’s Global
Call History window. The registration process fails on groups not pre-programmed on the CSSI
system. To configure the console’s system list, refer to “File menu - Edit System List, page 195”.

– UNIT CALL LINE

A Unit Call line is used to send private calls to individual units. Unit Call lines use a Private PTT or an
InPTT button for call activation. Using a Private PTT button allows the unit ID to be varied on the line.
Using an InPTT button creates a dedicated line with only one unit ID.

Radio buttons (Call Alert, Remote Monitor, Regroup, Ungroup, etc.) are typically assigned to this type
of line. Console operators can add a Keypad to the console design, providing easy access to the user
list during call operation. All Unit Calls are received by the console when the Unit Call line is in
Scanning Mode. In Dedicated Mode, the Unit Call line becomes a point-to-point call with one pre-
programmed unit.

56.3 NEXEDGE Call types
Each NEXEDGE line within a console design can be set up as either Conference (Talk Group) or Unit
Call lines.

56.3.1 Conference call
Talk Group lines use either a Group PTT or InPTT button for call activation. Using a GroupPTT button
allows the talk group ID to be varied on the line. Using an InPTT button creates a dedicated line with
only one talk group ID.

To create a conference call or talk group, do the following:
1. From the Call Type drop down menu, select Conference Call.
2. In the Talk Group Number field, enter the Talk Group Number of the line.
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i

Notice!
If the console designer assigns an InPTT button to the line, this line would only transmit to and
receive from the default ID. This is called a Static Group Line. If the console designer assigns a Group
PTT button to the line, the default ID is overridden at run time by the current Group ID assigned by
the selectable Group PTT button. This is called Manual Group line.
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Figure 56.1: Group and Manual Line Set Up

56.3.2 Unit call
A Unit Call line is used to send private calls to individual users. Unit line use either a Private PTT
button or an InPTT button for call activation. Using a Private PTT button allows the unit ID to be varied
on the line. Using an InPTT button creates a dedicated line with only one unit ID. Radio buttons such
as Call Alert, Remote Monitor, etc. are typical buttons assigned to this type of line. Console operators
can add a Keypad to the console design to provide easy access to the user list during call operation.

To create a unit call, do the following:
1. From the Call Type drop down menu, select Unit Call.
2. In the Unit ID Number field, enter the Unit Call Number of the line.

i

Notice!
If the console designer assigns an InPTT button to the line, this line would only transmit to and
receive from the default unit ID.
If the console designer assigns a Private PTT button to the line, the Private PTT overrides the default
number and allows different units to be selected.
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Figure 56.2: Private Call Configuration

56.4 C-Soft Setup parameters
To program a NEXEDGE radio in C-Soft, do the following:
1. From the edit menu, select Edit User ID List.

The User ID List window appears.
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2. In the Name column, enter the alias for each line.
3. In the User ID column, enter the User ID for each line (the User ID is in decimal format).
4. From the Type drop down menu, select NEXEDGE-CONV or NEXEDGE-TRUNK.
5. Click OK.

i
Notice!
To program an All Call ID that can transmit to all NEXEDGE subscribers on the system, enter 65535
in the User ID column, and select NEXEDGE from the Type drop down menu.

To program a Group ID for NEXEDGE in C-Soft, do the following:
1. From the Edit menu, select Edit Group ID List.

The Group ID List window appears.

2. In the Group column, enter the Group alias for each line.
3. In the Group ID column, enter the Group ID for each line (the Group ID is in decimal format).
4. From the Type drop down menu, select NEXEDGE for each line.
5. In the Group ID column, enter the Group ID for each line (the Group ID is in decimal format).
6. Click OK.

During start up, C-Soft will register all of the pre-programmed NEXEDGE Talk Groups. C-Soft can only
communicate to Talk Groups registered to the system.

56.5 NEXEDGE Trunking System setup
To set up a NEXEDGE Line, do the following:
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1. From the Edit menu, select Setup Per Line Parameters.
The Per Line Parameters window appears.

2. From the Line Type drop down menu, select NEXEDGE.
NOTE: The Multicast address and port number information is used for cross console
communications supporting the following features: Call Queue, Emergency and Cross-patch
updates. These fields should match on each console in a shared system.

3. Click the Signal Setup button.
The Signaling Parameters window appears.

4. From the System Type drop down menu, select NEXEDGE Trunking.
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5. Click the NEXEDGE Trunking Parameters tab.
The NEXEDGE Trunking Parameters window appears.

6. From the Call Type drop down menu, select the call type (refer to “NEXEDGE Trunking
Parameters page, page 552”).

7. In the Talk Group Number field, enter the Talk Group Number for the Trunking

Refer to
– NEXEDGE Trunking Parameters page, page 552

56.5.1 NEXEDGE Trunking Parameters page
Console Call Parameters group box
The Console Call Parameters group box is used to configure Call Type and Default ID.

The Call Type drop down menu is used to select the type of call designated to the line.

Available selections for this field are:
– Broadcast Call: A Broadcast Call is a group call. It temporarily disables a remote radio's ability to

respond to the dispatcher in a set amount of time pre-configured in the NEXEDGE system.
Broadcast calls can be used in a special event or in an emergency situation for announcement.

– Conference Call: A Conference Call allows a Talk Group.
– Unit Call Lines: A Unit Call allows the dispatcher to talk to a specific radio unit.
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Talk Group Number field
The Talk Group Number field is used to enter the default talk group ID for the line. The Talk Group
Number is a unique Talk Group ID defined by the system administrator and programmed in the
NEXEDGE system.

i

Notice!
If an InPTT button is assigned to the line, the line only transmits to, and receives from, the default Talk
Group ID. This is known as a Static Group line. However, if a Group PTT button is assigned to the line,
the default talk group ID is overridden by the current Group ID. This is known as a Manual Group line.

Unit Call Number field
The Unit Call Number field is used to enter the default Unit Call number. The Unit Call Number is a
unique NEXEDGE subscriber ID defined by the system administrator and programmed in the
NEXEDGE system.

i
Notice!
An InPTT button on this line allows calls to and from the Default Unit ID. A Private PTT button
overrides the default unit number and allows different units to be selected.

56.6 Console Global Setup
The Global NEXEDGE Trunking parameters apply to all NEXEDGE console lines and only need to be
set once for any line. The Global NEXEDGE Trunking Parameters window is assessable from any line,
but the values are constant between lines, and can be found at Edit | Setup NEXEDGE.
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Figure 56.3: Global NEXEDGE Trunking Parameters Window

Console Unit ID Number field
The Console Unit ID field is used to enter the console’s unique ID registered to the NEXEDGE system.
This number must be programmed in the NEXEDGE system as a console ID.

i
Notice!
The console’s registered Unit ID is set in the global parameters window (Console Unit ID Number).
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Console SIP Rx Port field
The Console SIP Rx Port field displays the console’s receive port number for the SIP connection. This
field cannot be edited.

Console SIP Tx Port field
The Console SIP Tx Port field displays the console’s transmit port number for the SIP connection. This
field cannot be edited.

System Code field
The System Code field is used to enter the number assigned to the NEXEDGE system. The console
System Code must match the NEXEDGE site system code.

The range for this field is 1-131070.

Network Category drop down menu
The Network Category drop down menu is used to select the coverage size. The console Network
Category must match the NEXEDGE site network category.

Available options are:
– Local
– Regional

Channel Spacing drop down menu
The Channel Spacing drop down menu is used to set the frequency separation between two adjacent
channels. The console Channel Spacing must match the NEXEDGE site channel spacing.

Available options are:
– Narrow Band (12.5kHz)
– Very Narrow Band (6.25kHz)

Enable Over the Air Aliasing check box
The Enable Over the Air Aliasing check box is used to enable over the air aliasing. Over the Air Alias
allows the console to display the unique name of the calling transceiver without using User ID list in
C-Soft for aliasing.

i
Notice!
The first 12 characters are used to transmit a console name when operating Direct NXDN with Over
the Air Alias enabled.

i
Notice!
The Over-the-Air Alias option must be enabled and Unit ID Name must be programmed in the
transceiver for the console to receive the name.
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56.6.1 Local Consoles button
The Local Consoles button allows users to setup a parallel console for the dispatch system.

Enable Heartbeat check box
The Enable Heartbeat check box indicates the system is monitoring the site verifying it is still online.
When enabled, the Heartbeat Rate field and Missed Heartbeats Allowed fields become active.

Heartbeat Rate field
The Heartbeat Rate field is used to enter how often the heartbeat occurs, in seconds.

Missed Heartbeats Allowed field
The Missed Heartbeats Allowed field is used to enter the number of missed heartbeats allowed
before disabling the corresponding site. Disabling the site grays out all lines associated with the site.

Transmit Delay check box
The Transmit Delay check box enables transmit delay when delay is necessary for Radio Command
functions.

Initial Transmit Delay Time field
The Initial Transmit Delay Time field is used to ensure receipt of a radio command request when the
called subscriber unit uses scan or battery saver. The Repeater sends an idle signaling command to
the called subscriber at the designated time before sending the Radio Command (Radio Status, Radio
Monitor, etc.). This insures the subscriber is available to receive the request from the repeater.

Initial Transmit Delay Time can range from 0 to 25000msec.

Transmit Delay Time field
The Transmit Delay Time field is used to send a delay time along with the Radio Command request.
Initial Transmit Delay Time and Transmit Delay Time are summed in value to determine for the overall
delay time.

Transmit Delay Time ranges from 0 to 6000msec.

RAN Encode button
The RAN Encode button opens the NEXEDGE Conventional RANs window. For more information,
refer to “NEXEDGE Conventional RANs window, page 562”.

Refer to
– NEXEDGE Conventional RANs window, page 562

56.7 NEXEDGE Conventional IP system configuration

i
Notice!
Samples of a NEXEDGE .veg file and NEXEDGE System List.xml are available for reference design at
www.telex.com/us/dispatch/line.
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Figure 56.4: Signaling Parameters Window - Conventional System Type

When NEXEDGE is selected as the Line Type and the Signal Setup button is clicked, the NEXEDGE
Conventional Parameters Tab appears, refer to the Figure in “NEXEDGE Conventional Parameters
window, page 557”.

Refer to
– NEXEDGE Conventional Parameters window, page 557

56.8 NEXEDGE Conventional Parameters window
The NEXEDGE Conventional Parameters window is used to configure the IP Address of the
NEXEDGE conventional system.
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Figure 56.5: NEXEDGE Conventional Parameters Window

i

Notice!
When using a Group PTT or Private PTT button, the talk group number and Unit Call number are
pulled from the system list. In addition, Talk Group Number, Unit Talk Group Number and RAN
Encode fields cannot be modified. To edit the RAN, see the Global NEXEDGE Conventional Setup
window.

Parameters That Apply to This Line group box
The Parameters That Apply to This Line group box is used to set up the Console Call Parameters,
such as Call Type, RAN number, etc., and the System Site Parameters, such as the Site Number and
Site IP Address.

Console Call Parameters group box
The Console Call Parameters group box is used to select the call type and the default ID for the
selected call type.

The Call Type drop down menu is used to select the type of call to assign the configured parameters.
Select Conference Call to set up a group talk line or select Unit Call to set up a Private Call Line.

Available selections for this field are:
– Conference Call: A Conference Call allows a Talk Group.
– Unit Call Lines: A Unit Call allows the dispatcher to talk to a specific radio unit.
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Encryption Key Field
The Encryption Key field is used to enter the default encryption key for the Line.

Talk Group Number field
The Talk Group Number field is used to enter the Group ID assigned to the group.

RAN Encode Display field
The RAN Encode field displays the RAN (Remote Access Node) for the call type. This field cannot be
modified. Modifications to the RAN are done on the Global NEXEDGE Conv.

System Site Parameters group box
The System Site Parameters group box is used to match the IP Address of the NEXEDGE
Conventional system.

Site Number field
The Site Number field is used to enter the site number of the NEXEDGE conventional system.

Site IP Address field
The Site IP Address field is use to enter the site IP Address the NEXEDGE conventional system is
located.

Parameters That Apply to All Lines group box

Global NEXEDGE Convn. Setup button
The Global NEXEDGE Convn. Setup button, when clicked, opens the Global NEXEDGE Conventional
Setup Window.

Global Encryption Key Data button
The Global Encryption Key Data button opens the NEXEDGE Encryption window.

OK button
The OK button saves any changes made and closes the window.

Cancel button
The Cancel button discards any changes made and closes the window.
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56.9 Global NEXEDGE Conventional Parameters window

Figure 56.6: Global NEXEDGE Conventional Parameters Window

Parameters Apply to All Lines group box

Console Unit ID Number field
The Console Unit ID field is used to enter the console’s unique ID registered to the NEXEDGE system.
This number must be programmed in the NEXEDGE system as a console ID.

Console SIP Rx Port field

The Console SIP Rx Port field displays the console’s receive port number for the SIP connection. This
field cannot be edited.
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The number must match the NEXEDGE site’s Tx SIP port number.
The default port number is 5060.

Console SIP Tx Port field
The Console SIP Tx Port field displays the console’s transmit port number for the SIP connection. This
field cannot be edited.

The number must match the NEXEDGE site’s Rx SIP port number
The default port number is 5060.

Enable Over the Air Aliasing check box
The Enable Over the Air Aliasing check box allows the console to display the unique name of the
calling transceiver without using the User ID list in C-Soft for aliasing.

i
Notice!
The Over-the-Air Alias option must be enabled and Unit ID Name must be programmed in the
transceiver for the console to receive the name.

System Code field
This field is not used for the Conventional Interface.

Network Category field
This field is not used for the Conventional Interface.

Channel Spacing drop down menu
The Channel Spacing drop down menu is used to set the frequency separation between two adjacent
channels. The console Channel Spacing must match the NEXEDGE site channel spacing.

Available options are:
– Narrow Band (12.5kHz)
– Very Narrow Band (6.25kHz)

Local Console button
The Local Console button opens the “Local Consoles page, page 131”.

Enable Heartbeat check box
The Enable Heartbeat check box indicates the system is monitoring the site verifying it is still online.
When enabled, the Heartbeat Rate field and Missed Heartbeats Allowed fields become active.

Heartbeat Rate field
The Heartbeat Rate field is used to enter how often the heartbeat occurs, in seconds.

Missed Heartbeats Allowed field
The Missed Heartbeats Allowed field is used to enter the number of missed heartbeats allowed
before disabling the corresponding site. Disabling the site grays out all lines associated with the site.
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Transmit Delay check box
The Transmit Delay check box enables transmit delay when delay is necessary for Radio Command
functions.

Initial Transmit Delay Time field
The Initial Transmit Delay Time field is used to ensure receipt of a radio command request when the
called subscriber unit uses scan or battery saver. The Repeater sends an idle signaling command to
the called subscriber at the designated time before sending the Radio Command (Radio Status, Radio
Monitor, etc.). This insures the subscriber is available to receive the request from the repeater.

Initial Transmit Delay Time can range from 0 to 25000msec.

Transmit Delay Time field
The Transmit Delay Time field is used to send a delay time along with the Radio Command request.
Initial Transmit Delay Time and Transmit Delay Time are summed in value to determine for the overall
delay time.

Transmit Delay Time ranges from 0 to 6000msec.

RAN Encode button
The RAN Encode button opens the NEXEDGE Conventional RANs window. For more information,
refer to “NEXEDGE Conventional RANs window, page 562”.

OK button
The OK button saves any changes made and closes the window.

Cancel button
The Cancel button discards any changes made and closes the window.

56.10 NEXEDGE Conventional RANs window
The NEXEDGE Conventional RANs window allows you to configure all talk groups and units to their
respective RAN (Remote Access Node). The repeater must have the matching talk group/unit
programmed for this to work. By populating the RANs list, the user has the ability to change the RAN
number for each talk/unit. This can also be changed on the Signaling Parameters Setup and are
reflected in this list.

i
Notice!
The name and ID fields cannot be modified from this window. These changes must be made in the
System List window (refer to “Edit System List window, page 194”).
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Figure 56.7: NEXEDGE Conventional RANs Window

Group/Unit Name field
The Group/Unit Name field displays the name of the group or unit you want to assign the RAN to.

Group/Unit ID field
The Group/Unit ID field displays the ID of the selected group or unit you want to assign the RAN to.

RAN Encode field
The RAN Encode field is used to assign a RAN code used by the associated group or unit.

Type drop down menu
The Type drop down menu is used to select the type of RAN you want to assign, either Groups or
Units.
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i
Notice!
When Group is selected from the drop down menu, Group Name and Group ID are displayed as the
columns; when Unit is selected from the drop down menu, Unit Name and Unit ID are displayed.

OK button
The OK button saves any changes made and closes the window.

Cancel button
The Cancel button discards any changes made and closes the window.

Refer to
– Edit System List window, page 194

56.11 NEXEDGE Conventional IP set up
To set up a NEXEDGE Line, do the following:
1. From the Edit menu, select Setup Per Line Parameters.

The Per Line Parameters window appears.

2. From the Line Type drop down menu, select NEXEDGE.
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3. Click the Signal Setup button.
The Signaling Parameters window appears.

4. From the System Type drop down menu, select NEXEDGE Conventional.
The NEXEDGE Conventional Parameters tab appears.
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5. Click the NEXEDGE Conventional Parameters tab.
The NEXEDGE Conventional Parameters window appears.

6. From the Call Type drop down menu, select either Conference Call or Unit Call.

56.12 C-Soft NEXEDGE Conventional IP interface
IP Console ID List
The KPG-109DN application and system key file are required before gaining access to configuration
settings for the system. The values set in the Console Unit ID, RANs and Channel Spacing must match
the programming parameters in Kenwood Conventional System. The Figure below displays a
Kenwood KPG-109DN conventional repeater programmer.

The Console ID in C-Soft must match one of the IDs on the following list.



C-Soft 8.500 Appendix H - Kenwood NEXEDGE Direct IP interface | en 567

Bosch Security Systems, LLC Technical Manual 2025-08 | 16 | F.01U.218.561

Figure 56.8: Conventional IP Network Window

Channel Edit window
The Channel Edit window is used to enter the channel spacing and RAN settings. Channels can have
a single RAN or use multiple encode/decode tables.

Figure 56.9: Channel Edit Window
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56.13 NEXEDGE System configuration

56.13.1 NEXEDGE System configuration type 1 - No signaling with RAN
Kenwood offers a system configuration that does not use signaling. This means there is no group talk
and the distinguishing element between sites is the RAN (refer to the Figure below).

Figure 56.10: Set Up without Signaling

System configuration features (supported)
– Static Line PTT
– Conference Calls
– Radio Status Request
– Radio Status Decode
– Radio Enable
– Radio Disable
– Emergency Decode
– Emergency Acknowledgement

i

Notice!
In the NEXEDGE Conventional system, Emergency call can be sent out either on a Talk Group or a
Unit ID. However, when the talk group isn’t used in the NEXEDGE system, in order to receive an
emergency call, the radio has to be configured to send out the emergency call to a Unit ID which is a
Console ID.

System configuration
As seen in the Figure above, there are four sites with four different frequencies and four different
RANs. C-Soft must be configured properly in order to interact correctly with the system. The number
of lines must match the number of RANs. Radios should be configured as shown in the Figure below
and lines should be configured as shown in the afterwards Figure.

Radio configuration
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Figure 56.11: No Signaling Radio Configuration

i
Notice!
When setting the NXDN Signal ID to none, the Talk Group Number must be set to zero within C-Soft.

C-Soft configuration
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Figure 56.12: No Signaling C-Soft Configuration

RAN configuration

i
Notice!
Since there are multiple RANs for the Talk Group 0, these do not show up on the Global RANs page.

The No Signal System Type does not support Unit Calls. Send Status and Request Status are the only
radio commands supported in this configuration option.
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Figure 56.13: Repeater Configuration Multiple Encode/Decode Tables

Figure 56.14: Multiple Encode/Decode Table
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56.13.2 NEXEDGE System configuration type 2 - Signaling without RAN
The second system configuration uses only talk groups and no RANs. This configuration uses talk
groups as the distinguishing factor between the different lines (refer to the Figure below).

Figure 56.15: Signaling Set Up

System configuration features (supported)
– Static Line PTT, Group PTT, Private Call PTT
– Conference Calls
– Private Call
– Alert Call
– Selectable Talk Group
– Emergency Call Decode with Acknowledgement Capabilities
– Radio Status Request
– Radio Status Decode
– Radio Status Encode
– Radio Remote Monitor with Supervisor Password
– Radio Stun
– Radio Revive

Radio configuration
Radios in this system configuration are configured similar to the Figure below.
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Figure 56.16: Radio Signaling Configuration

C-Soft configuration
C-Soft in this configuration is configured similar to the Figure below.

Figure 56.17: C-Soft Signaling Configuration
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i
Notice!
The RAN is set to zero, which is the same as None on the repeater.

56.13.3 NEXEDGE System configuration type 3 - Signaling and RAN
This system configuration type allows use of talk groups and RANs. This configuration allows for both
the talk group and the RAN to be distinguishing factors. The lines have to match from the Radio
Configuration and C-Soft to receive the call (refer to the Figure below).

Figure 56.18: Signaling and RANs Setup

System configuration features (supported)
– Static Line PTT, Group PTT, Private Call PTT
– Conference Calls
– Private Call
– Alert Call
– Selectable Talk Group
– Selectable Users
– Emergency Call Decode with Acknowledgement Capabilities
– Radio Status Request
– Radio Status Encode
– Radio Remote Monitor with Supervisor Password
– Radio Stun
– Radio Revive
– Enhanced interference mitigation

Radio configuration
Using the Figure below, configure the Radios.
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Figure 56.19: Signaling with RANs Radio Configuration

In this configuration, the global RANs list populates the talk groups. Talk groups can only have one
RAN associated with them. This configuration requires the repeater to be configured correctly with
each repeater having the corrected decode and encode tables.
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Figure 56.20: Signaling with RANs Configuration

56.14 NEXEDGE System manager parameters
For C-Soft to function properly the values set in the console must match the programming parameters
in the Kenwood Trunking System.

i

Notice!
The KPG-110SM application and system key file are required to access the configuration settings for
the system. The values set in the console, such as Site Number, Unit ID Number, Network Category,
System Code, Network Category, and Channel Spacing, must match the programming parameters in
the Kenwood trunking system.

To configure the Kenwood KPG-110SM radio for use with C-Soft, do the following:
1. Open the KPG-110SM System Manager.
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2. From the Edit menu, select System Configuration.
The System Configuration window appears.

NOTE: For additional support, see KPG-110SM user manual.
Under System Information

3. In the Control Number field, enter Control Number.
4. In Network Category field, enter Network Category.
5. In the System Code field, enter System Code.

IMPORTANT: The values set in the console must match the programming parameters in the
Kenwood System Manager.
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6. From the Edit Menu, select Console Information.
The Console Information window appears.

7. From the Site drop down menu, select a Site to be modified.
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8. Click the Edit button.
The Console Edit window appears.

9. In the UID field, enter Unit ID.
10. Select the Valid check box.
11. Under Talkpath, select the Talkpath check box.
12. Click Close.

56.15 Kenwood radio programming software
To configure Kenwood KPG-109DN software, do the following:
1. Open the Kenwood KPG-109DN radio programming software.
2. From the Edit menu, select Channel Information.

The Channel Information window appears.
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3. Select desired channel and click Edit.
The Channel Edit window appears.

4. From the Channel Spacing (NXDN) drop down menu, select Spacing.

i
Notice!
Channel spacing values must match C-Soft console settings.

The NEXEDGE system allows maximum of 10 console connections per site and 100 console
connections per system.

For additional support, refer to the Kenwood KPG-109DN user manual.

56.16 NEXEDGE Encryption window
The NEXEDGE Encryption window is used to store up to 16 individual encryption keys, as shown in
the second Figure. Each Key Number contains Key Data, Key ID, and Key Name, all of which need to
contain unique data.

To open the NEXEDGE Encryption window from the Edit menu, do the following:
– From the Edit Menu, select Setup NEXEDGE | Global Encryption Key Data.
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To open the NEXEDGE Encryption window from the Per Line Parameters window, do the following:
1. From the menu bar, select Edit | Setup Per Line Parameters. 

The Per Line Parameters window appears.
2. On a line with a NEXEDGE line type, click the Signal Setup button.

The Signalling Parameters Window appears.
3. Click the NEXEDGE Trunking Parameters tab.

The NEXEDGE Trunking Parameters page appears.
4. Click the Global Encryption Key Data button in the bottom right of the page.

The NEXEDGE Encryption window appears.



582 en | Appendix H - Kenwood NEXEDGE Direct IP interface C-Soft 8.500

2025-08 | 16 | F.01U.218.561 Technical Manual Bosch Security Systems, LLC

Figure 56.21: NEXEDGE Encryption Window

Key Number column
The Key Number column is a numerical assignment of the Key Data, Key ID, and Key Name Columns.

Key Data column
The Key Data column is used to enter a unique encryption number used in the encryption algorithm
routine. This field must be entered first when filling out the NEXEDGE Encryption window.

The range for this field is 1 to 32767.

Key ID column
The Key ID column is used to enter an unique numerical alias for the Key Data. the Key ID is the actual
data passed between the console and subscriber units, not the Key Data

The range for this field is 0 to 63.

Key Name column
The Key Name column is used to enter a local alias associated for the console operator to recognize in
the C-Soft Runtime application.

This field can be any combination of letters, numbers, or special characters up to 14 characters.
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Encryption Mute Type drop down menu
The Encryption Mute Type drop down menu is used to select the way encrypted audio is received by
C-Soft when the Scrambler/Encrypt Key Select is set to None.

Available options are:
– Type 1: The console tries to match the encrypted audio received by scanning and matching the

Key ID with the Key IDs created in C-Soft. If no match is found, the scrambled audio is heard.
– Type 2: The console does not scan the list and mutes all encrypted receive audio.

56.17 Scrambler/Encrypt Key Select button
The Scrambler/Encrypt Key Select button, shown in the Figure below, is set up to work with a
specific line or as a global button to work with the selected line. This button includes a drop down
menu that the user to change the current encryption key being used on the line.

The drop down menu includes the Key Names assigned in the NEXEDGE Encryption window.

i
Notice!
The Scrambler/Encrypt Key Select button only works for NEXEDGE type lines, otherwise, it is grayed
out.

Figure 56.22: Scrambler/Encrypt Key Select Button
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57 Appendix I - Telex License Activation tool
C-Soft Runtime requires one or more software-based licenses to operate. The software-based
licenses reside on a Telex License Server. The Telex License Server hosts and manages Telex feature
licenses. C-Soft connects to the Telex Licensing Server to validate licensing requirements. Upon
successful connection, C-Soft checks out the necessary licenses. Once C-Soft closes, the licenses are
released and available for use by other C-Soft instances.

Telex Licensing Server
The Telex Licensing Server is software package running on a PC or dedicated server. The primary
function of the software is to maintain licenses and respond to licensing requests from C-Soft. When
a license is added, the Telex Licensing Server detects the newly added license and makes it available
for C-Soft license checkout/check-in request.

Telex License Server is comprised of two software components:
– Telex License Manager: The Telex License Manager is a background service running on the

hosting computer. The License Manager maintains and responds to licensing requests from C-
Soft. The service automatically starts on boot, and requires no user interaction. The service uses
TCP port 27000 to respond to licensing requests from C-Soft.

– Telex License Activation Tool: The Telex Activation Tool is used to manage hosted Telex licenses.
The Activation Tool has five primary features:
– Viewing current licensing information
– Adding a fulfillment
– Returning a fulfillment
– Repair fulfillments
– Processing a fulfillment response message

57.1 Telex Licensing Server setup
The Telex Licensing Server can be installed in one of two locations:
– On the same PC as each C-Soft position
– On a dedicated server PC, hosting licenses for multiple C-Soft positions

Installed on the same PC as each C-Soft position

Advantages – No single point of failure.
– No configuration necessary in C-Soft. C-

Soft Runtime automatically detects and
check out locally hosted licenses.

Disadvantages – License activation process must be
completed for each PC running C-Soft
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Installed on a dedicated server PC

Advantages – If a single C-Soft position fails, a
replacement C-Soft position can be
configured without an additional license
installation.

– License activation process only needs to
completed once.

Disadvantages – If server PC fails, all C-Soft positions lose
licensing.

57.2 Installation activation

Figure 57.1: Installation Activation Flow Diagram

To activate purchased licenses, do the following:
1. Upon purchase of a feature, an e-mail is sent containing an Entitlement Certificate. The

Entitlement Certificate contains a list of purchased features and an Activation ID.
2. On the target PC, install Telex License Server. Refer to “Telex License Server setup, page 32”.
3. Once installed, launch the Telex License Activation Tool. Refer to the figure on “View current

licensing information, page 586”.
4. From the Telex Activation Tool, click the Add Fulfillment button.
5. In the Add License window, input contact information, as well as one or more Activation IDs

received from the Entitlement Certificate. Refer to “Appendix I - Telex License Activation tool,
page 584”.
A Fulfillment Request Message (Request.xml) is created.

If an Internet connection is available:
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1. Select the Online tab.
The Online Page appears.

2. Enter your System Activation Website Username and Password.
3. Press the Activate Licenses button.

The features granted by the license are now available.

If an Internet connection is not available:
1. Select the Offline tab.

The Offline page appears.
2. Press the Create request button.

A prompt appears to save the Fulfillment Request Message (with default name Request.xml).
3. Visit the System Activation Website and use the Manage License feature.
4. Click the Browse button.
5. Select the newly created Fulfillment Request Message.
6. Click Activate.

A prompt appears to save the Add Fulfillment Response Message (RequestResponse.xml).
7. From the Telex License Activation Tool, select the Process Response Message feature. Refer to

“Process Response Message, page 590”.
8. Select the Add Fulfillment Response Message file.

The features granted by the license are now available.

Refer to
– Telex License Server setup, page 32
– View current licensing information, page 586
– Appendix I - Telex License Activation tool, page 584
– Process Response Message, page 590

57.2.1 View current licensing information
The Telex License Activation Tool displays the computer’s current license information. The left panel
contains a list of Fulfillment IDs added. The right panel contains a table listing all licensed features,
including quantity, order number, activation date, and expiration date of each feature.
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Figure 57.2: Telex Activation Tool

57.2.2 Add Fulfillment
Add Fulfillment is used by the customer or dealer to add a Fulfillment from an Activation ID, which is
contained within an Entitlement Certificate.

The window displays customer information fields (Location name, Customer name, Address, City and
Email) for the user to fill in when adding a Fulfillment. The window also displays a field to enter an
Activation ID, and a list of entered Activation IDs, if the user wishes to enter multiple Activation IDs in
the same transaction.
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Figure 57.3: Telex Activation Tool - Add License Window.

i
Notice!
The Location Name field must be different for each position install at any single location.

To add a fulfillment, do the following:
1. From the Telex License Activation window, select Add Fulfillment.
The Add license window appears.
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Under Customer information

i
Notice!
The Location Name field must be different for each position install at any single location.

1. In the Location name field, enter the location of C-Soft deployment.
2. In the Customer name field, enter the name of the customer.
3. In the Address field, enter the customer’s address.
4. In the City field, enter the customer’s city.
5. In the Country field, select the customer’s country.

Under Activation information

If an Internet connection is available:
1. Select the Online tab.

The Online Page appears.
2. Enter a User Name and Password for the dealer site.
3. Click the Activate Licenses button.
The Telex License Activation Tool attempts to connect to the System Activation Website and execute
the entire License Activation process. When finished, the license is activated and ready for use.

If an Internet connection is not available:
1. Select the Offline tab.

The Offline page appears.
2. Click the Create Request button.
An Activation Request file is generated. The Activation Request file must be processed using the
Dealer Activation website. Refer to the Process Response section for instructions on how to complete
the manual licensing operation.

57.2.3 Return Fulfillment
Return Fulfillment is used by the customer or dealer to remove a Fulfillment currently licensed to the
PC and returns the license to the dealer’s available license pool. A list of available licenses can be
found at the Bosch Dealers Activation website.

To return a fulfillment, do the following:
1. From the Telex License Activation window, select the fulfillment you want to return.
The Return Fulfillment button is enabled.

If an Internet connection is available:
1. Select the Online tab.

The Online Page appears.
2. Enter a User Name and Password for the dealer site.
3. Click the Return Fulfillments button.
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The Telex License Activation Tool attempts to connect to the System Activation Website and execute
the License Return process.

i
Notice!
Once the Return Fulfillment process has been initiated, all licenses associated with the selected
fulfillment are no longer available for license checkout.

If an Internet connection is not available:
1. Select the Offline tab.

The Offline page appears.
2. Click the Create Request button.
A Return Request file is generated. The Return Request file must be processed using the Dealer
Activation website. Refer to the Process Response section for instructions on how to complete the
manual licensing operation.

57.2.4 Repair
Repair is used by the customer or dealer to re-establish the validity of fulfillments licensed to the
server. The Repair License button only appears if the license has been corrupted or tampered with.

To return a fulfillment, do the following:
1. From the Telex License Activation window, select the fulfillment you want to return.
The Return Fulfillment button is enabled.

If an Internet connection is available:
1. Select the Online tab.

The Online Page appears.
2. Enter your Credentials.
3. Click the Return Fulfillments button.
The Telex License Activation Tool attempts to connect to the System Activation Website and execute
the License Repair process.

If an Internet connection is not available:
1. Select the Offline tab.

The Offline page appears.
2. Click the Create Request button.
A Repair Request file is generated. The Repair Request file must be processed using the Dealer
Activation website. Refer to the Process Response section for instructions on how to complete the
manual licensing operation.

57.2.5 Process Response Message
The Process Response Message is used to complete an offline Add Fulfillment, Return Fulfillment, or
Repair Fulfillment operation. Pressing the Process Response Message button opens the Process
Response Message Window.
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Figure 57.4: Offline Response Window

The Process Response Window contains a field used to select an Add Fulfillment Response Message
(RequestResponse.xml), Return Fulfillment Response Message (ReturnResponse.xml), or Repair
Response Message (RepairResponse.xml). After selecting one of these files, pressing the Process
Response Message button completes the transaction.

– Add Fulfillment Response Message: If processing an Add Fulfillment Response Message, a
fulfillment is added to the Fulfillment list, and the newly licensed features appear in the list of
licenses. The newly added features are available for C-Soft license checkout requests.

– Return Fulfillment Response Message: If processing a Return Fulfillment Response Message, the
specified fulfillment is removed from the Fulfillment list and all licenses associated with it are
removed from the list. The removed features are no longer available for C-Soft license checkout
requests.

– Repair Response Message: If processing a Repair Response Message, all fulfillments are
validated and made available for C-Soft license checkout requests.
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58 Appendix J - DMR–AIS
The AIS (Application Specification Interface) protocol was developed by DMR (Digital Mobile Radio)
association to standardize the interface between a third party application such as dispatch console
and DMR radio system. As a DMR member, Bosch implemented the AIS standard in C-Soft dispatch
console application to fully comply with the DMR Tier II Conventional and DMR Tier III Trunking
systems via wireline connection. This implementation provides the flexibility for users to install and
operate DMR radio communication systems. Unlike other console manufactures, the C-Soft AIS
implementation requires no dedicated server nor gateway. Each console on a DMR network will act
like a digital radio subscriber. This advanced architecture provides system reliable and transparency,
enhances operation, and reduces the system cost.

58.1 Supported features
The C-Soft DMR-AIS interface currently supports the following feature set:
– Displays ANI and/or Alias of incoming calls

– Send and Receive Group Calls
– Group Call is sent by selecting corresponding Frequency button and then pressing either

InPTT or Main PTT button.
– The Group Call type (Broadcast Call or Conference Call) can be controlled by using the

Radio Call Type button.

i
Notice!
For Hytera DMR AIS interface, system All Call can be sent by configuring a group with a group ID of
16777215 for Conventional systems.

– Send and Receive Individual Calls
– Individual Call is sent by selecting the corresponding Frequency button and then pressing

either InPTT or Main PTT button.
– Individual calls can be made by selecting or entering a user in the Keypad and then pressing

the Private PTT button.

– Receive Emergency Notifications
– Supports receiving both Emergency Calls and Emergency Alerts.

– Send and Receive Call Alerts
– Call Alert is sent by selecting a user from the Keypad control and then clicking the Radio

Call Alert button.
– Call Alerts can only be sent on lines configured for Individual operation.

– Send and Receive Text Messages
– Text Message is sent by selecting a user from the Keypad control and then entering the

desired text into the Text Message Control. The message is sent when the Send button in
the Text Message Control is clicked.

– Text Message can be sent to a group by selecting the line and group and then entering the
desired text into the Text Message Control. The message is sent when the Send button in
the Text Message Control is clicked.
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– Send Radio Enable /Disable Commands
– Radio Enable/Disable commands is sent by selecting a user from the Keypad control and

then clicking either the Radio Enable or the Radio Disable button.
– Radio Enable/Disable commands can only be sent on lines configured for individual

operation.

– Send Radio Check Command
– Radio Check command is sent by selecting a user from the Keypad control and then clicking

either the Radio Check button.
– Radio Check Command can only be sent on lines configured for Individual operation.

– Send Remote Monitor Command
– Remote Monitor command is sent by selecting a user from the Keypad control and then

clicking either the Radio Check button.
– Remote Monitor command can only be sent on lines configured for Individual operation.

– Console Priority
– The Call Priority button can be created to set transmit priority level for each outbound call.

– Vocoder Support
– C-Soft supports DMR standard AMBE+2 vocoder.

– GPS Support
– GPS currently is not a part of DMR AIS standard. However, Telex has worked with other

repeater manufactures to support their specific GPS data format.
– The following GPS features are available in C-Soft:

GPS Read (Standard Location Immediate Request)
GPS Trigger (Toggle On/Off for Location Reporting)
Incoming GPS Data triggered from Emergency Alarm
Incoming GPS Data triggered from Emergency Call
GPS data during voice calls

i
Notice!
Specific GPS supported functions vary depending on DMR repeater.

– Supports connection to up to 20 AIS compatible repeaters
– Each repeater connection is configured with a name, IP Address, System Type (e.g.

Conventional or Trunking), Vendor, Connection Port, Authentication Password, and
Registration interval.

– Supports up to 24 AIS Interface lines
– Each AIS Interface line connects to a specific repeater. The line configured with a

Connection, Type (Group or Individual), and a list of affiliated Group or Individuals. Lines
connected to a conventional repeater also use a time slot configuration.

– Each line can be configured to accept audio from one to 100 talkgroups.
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– Indication of parallel console transmissions
– Parallel Consoles are configured in C-Soft Designer by going to Edit | Setup Global

Parameters | Local Consoles and entering the Subscriber IDs of the parallel consoles in the
Direct IP Console Subscriber IDs field.

– Calls initiated from parallel dispatch consoles display the ‘T’ icon on the receiving line’s
Select button.

– Crossmuting of parallel consoles
– Calls from parallel consoles can be automatically muted by enabling the Crossmute direct IP

console subscriber IDs field in Edit | Setup Global Parameters | Local Consoles
– When this option is enabled calls initiated from parallel dispatch consoles display the ‘XT’

icon on the receiving line’s Select button.

– Send Annunciations
– Send audio from the .wav file on an AIS line using the Annunciation button.

– Crosspatching
– Crosspatch audio from an AIS line to another line type supported by C-Soft.

i

Notice!
The supported features for DMR AIS interface might vary depending operation modes and DMR
manufacturer’s specifications. Please check the manufacturer’s manual and additional application
notes for more information.
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58.2 AIS Global Setup window

Global Settings group box

Console ID field
The Console ID field is used to enter the identification number assigned to the console.

The range for this field is 1 to 16777215 in decimal format.

Call Inactivity Timeout field
The Call Inactivity Timeout field is used to enter the amount of time in seconds allowed to elapse with
no voice traffic before the console terminates the call. before the console terminates the call. This
value should be set to approximates two seconds greater then the AIS repeater’s call inactivity
timeouts.

The range for this field is 1 to 100 seconds.

Connection List group box

Name column field
The Name column field is used to enter a unique name for the connection.

This field can contain up to 32 characters.

IP column Field
The IP column field is used to enter the IP Address of the connection being used to communicate.
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System column drop down menu
The System column drop down menu is used to select the type of system the connection is running.
There are three service tiers - Tiers I, II, and III. Tiers I and II are considered Conventional systems,
where Tier II is only applicable for commercial radio markets.
Tier III is classified as a trunking system. A trunking system uses a control channel to direct radio
traffic automatically whereas the radio user manually directs a conventional system.
Available options are:
– Conventional
– Trunking

Vendor column drop down menu
The Vendor column drop down menu is used to select the vendor of the system the connection is
running. This setting allows the console to perform any logic or functionality that is unique to a specific
radio system vendor.
The options available for this list are dependent on the currently selected System type.
Available option for a system type of Conventional:
– Generic
Available options for a system type of Trunking:
– Generic
– Leonardo

Connection Port field
The Connection Port field displays the port number used by C-Soft to connect to the AIS repeater.
The connection port need to match the port number used by the DMR-AIS system.
The default value for this field is 5060.

Password column field
The Password column field is used to enter the password configured as the Authentication Password.
When the field is left empty, the system does not require a password to register.

This field can contain up to 32 alpha numeric characters.

Heartbeat (sec) column field
The Heartbeat (sec) column field is used to enter the length of time, in seconds, a console can be
registered to the server without reregistering. This field can be used to monitor the network
connection between C-Soft and the repeater.

The range for this field is 10 to 65535 seconds.

58.3 C-Soft Designer setup
To configure C-Soft Designer, do the following:
1. Open C-Soft Designer v7.300 or later.
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2. From the Edit menu, select Setup AIS.
The AIS Global Setup window appears.

3. In the Console ID field, enter the console ID.
IMPORTANT: Each console must have a unique ID.

4. In the Call Inactivity Timeout field, enter amount of time, in seconds, allowed to elapse with no
voice traffic before the console terminates the call.
NOTE: This value should be set to approximately two seconds greater than the AIS repeater’s
call inactivity timeouts.

5. In the Connection List:
In the Name field, enter a unique name that is easily identifiable.
In the IP field, enter the IP Address of repeater configured earlier.
From the System drop down menu, select Conventional or Trunking.
From the Vendor drop down menu, select Generic unless connecting to a Leonardo Trunking
system.
From the Connection Port drop down menu, select the connection port to use. 5060 is the default
setting; however individual systems may require different orts depending on their configuration.
In Password field, enter the password configured as the Authentication Password, if applicable.
In the Heartbeat field, enter the length of time a console can be registered to the server without
re-registering.

6. Click OK.
7. From the Edit Window, select Setup Per Line Parameters.

The Per Line Parameters window appears.
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8. From the Line Type drop down menu, select AIS for the desired line.
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9. Click the Signal Setup button for that line.
The Per Line AIS Setup window appears.

10. From the Connection drop down menu, select the desired repeater.
11. If the connection is configured as a conventional system, select Slot 1 or Slot 2 from the Slot

drop down menu.
NOTE: A DMR conventional repeater supports two independent time slots, which function as
channels. This field is disabled if the connection is configured as a Trunking system.

12. From the Type drop down menu, select Group or Individual.
IMPORTANT: Group lines can be used to transmit to and receive calls from DMR Talkgroups as
well as receive and send group text messages. Individual lines can be used to transmit and
receive individual calls, and send individual radio command operations. Individual radio command
operations cannot be sent on Group lines.

13. In the Talkgroup List group box, enter one or more group contacts.
OR
Enter one or more individual contacts.
The contacts in the list are mapped to frequency numbers which are selected by the Frequency
controls in C-Soft.

14. Click OK.
The Per Line AIS Setup window closes.
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15. From the Edit menu, select Setup Global Parameters.
The Global Parameter Setup window appears.

16. Click the Local Consoles tab.
The Local Consoles page appears.

17. In the Local Console IP Addresses group box, enter the subscriber IDs of the parallel consoles in
the Direct IP Console Subscriber IDs field.

18. Select the Crossmute direct IP console subscriber IDs check box if parallel console transmit
audio should not be heard on the other parallel consoles.
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19. From the Edit menu, select Edit User ID List.
The User ID List window appears.

20. In the Name field, enter the name of the individual radio in the DMR system.
21. In the User ID field, enter the user ID of the individual radio in the DMR system.
22. From the Type drop down menu, select AIS.

The User ID List is used to alias IDs for incoming calls and to populate the Keypad control.
23. Repeat step 20 through step 22, as necessary.
24. Click OK.

The User ID List window closes.
25. From the Edit menu, select Edit Group ID List.

The Group ID List window appears.

26. In the Group field, enter the name of the talkgroup in the DMR system.
27. In the Group ID field, enter the group ID of the talkgroup in the DMR system.
28. From the Type drop down menu, select AIS.

The Group ID List is used to alias IDs for incoming calls and to populate the Keypad control.
29. Click OK.

The Group ID List window closes.
30. Save the .veg file.

i
Notice!
Verify the Console ID and Group IDs are entered correctly because C-Soft registers its Console ID and
all Talk Groups when it starts up.
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59 Appendix K - C-Soft API Installation notes
API functionality allows third party applications to connect securely to C-Soft. This API allows external
applications to exchange data and provide limited control of C-Soft.

i
Notice!
The API functionality is a value added option to you C-Soft license, please contact your regional
Bosch Sales person for details on how to purchase.

59.1 Supported features
– Secured connection with user authentication
– 256-bit AES data encryption
– Main PTT
– Line PTT
– Private Call
– Group Call
– Line Selection
– Multiple Line Selection
– Channel/Talkgroup Selection (Frequency Control Only)
– Paging Functions (Single, Stack Pages)
– Remote Monitor (Covert Call)
– Crosspatch
– GPS Integration
– Event Notifications
– Private Call Acknowledgement
– Incoming Private Call Notification
– Emergency
– Connection Monitor (Heartbeat)
– Select Call
– Radio Call Status
– Relay/Input support
– SIP support
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59.2 Setup External Systems window

59.2.1 API Setup

Figure 59.1: API Setup Window

Enable API checkbox
The Enable API checkbox is used to enable the API functionality in C-Soft. If this checkbox is not
selected, the functionality of the API is completely disabled.

IP Address field
The IP Address field is used to enter the IP Address of the 3rd party system. This is the IP Address
that communicates with C-Soft. When a 3rd party system connects to C-Soft, C-Soft confirms the
address before connecting to the address.

i
Notice!
This address must match exactly between C-Soft and the 3rd party system.

TCP Port field
The TCP Port field is used to enter the port number that C-Soft attempts to connect and communicate
to the 3rd party system. If this does not match the 3rd party system’s settings, communication cannot
occur.

Username field
The Username field is used to enter the username used by the 3rd party system to log into C-Soft. If
the 3rd party system does not have the correct username, communication fails.



C-Soft 8.500 Appendix K - C-Soft API Installation notes | en 605

Bosch Security Systems, LLC Technical Manual 2025-08 | 16 | F.01U.218.561

Password field
The Password field is used to enter the password used by the 3rd party to log into C-Soft. If the 3rd

party system password does not match, communication fails.

Encryption Key Field
The Encryption Key field is used to enter or generate a 256-bit encryption key that is used to encrypt
communications between C-Soft and the 3rd party system. This key must match exactly in both C-Soft
and the 3rd party system or decryption fails and encryption cannot be used.

Generate Key button
The Generate Key button is used to generate a random encryption key. This key must match exactly in
both C-Soft and the 3rd party system or decryption fails.

OK button
The OK button is used to accept the modifications and close the API Setup window.

Cancel button
The Cancel button closes the API Setup window without saving the modifications.

59.2.2 API Setup window
To set up an API connection, do the following
1. From the Edit menu, select Setup External System.

The Setup External Systems window appears.
2. Navigate to the API Setup page.
3. Select the Enable API check box.
4. In the IP Address field, enter the IP Address of the 3rd party system communicating with C-

Soft.
5. In the TCP Port field, enter the port number C-Soft attempts to connect and communicate with

the 3rd party system.
NOTE: If the port number entered in this field does not match the 3rd party system’s settings,
communication cannot occur.

6. In the User Name field, enter the username the 3rd party system uses to log on to C-Soft.
If the 3rd party user name does not have the correct username, communication cannot occur.

7. In the Password field, enter the password the 3rd party system uses to log into C-Soft.
NOTE: The password can be anything, but the 3rd party system must use the same exact
password for logging in. If the password does not match communication will fail.

8. In the Encryption Key field, enter the encryption key to be used.
OR
Click the Generate Key button.
An encryption code appears in the Encryption Key field.

i

Notice!
The encryption key is an AES 256-bit key. C-Soft can generate the key or a key can be manually
entered. This key must match on the 3rd party system and must be a valid AES 256-bit key. If the
encryption key is not valid, decryption fails and the functionality cannot be used.
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60 Appendix L - Console Sign In
The Console Sign In feature allows individual consoles to connect to the Telex Radio Dispatch
Console Management System and retrieves design files assigned to an individual dispatcher by the
system administrator. If configured, the Console Sign In windows can also be used to view, browse,
and run design files that are stored locally on the PC.

60.1 User Name and Password Window
If the Log In Mode is set to Enter User name and Password, the Sign In window requires the user to
enter a user name and password. The User Name and Password window is intended for use with
dispatch consoles which have access to a keyboard.

Figure 60.1: Console Sign In Window

The icon in the lower left of the window displays the current connection status to the Console
Manager System. A green dot indicates the PC can connect to the Console Management System.
Click the button in the lower right of the window to open the Console Configuration Tool.
Click the Login button to submit the user name and password to the Console Management System for
validation, and to retrieve the list of assigned designs.

60.2 Select User and Enter PIN Window
If the Log In Mode is set to Select user and enter PIN, the Sign In window requires the user to select a
role and user name, and then enter a numeric PIN. The list of available roles and users is created in the
Console Management System. The Select User and Enter PIN log in method is intended to be used on
dispatch consoles that are touchscreen driven or do not have access to a keyboard.
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Figure 60.2: Console Sign In With PIN

The icon in the lower left of the window, displays the current connection status to the Console
Manager System. A green dot indicates the PC can connect to the Console Management System.
Click the button in the lower right of the window to open the Console Configuration Tool.
Click the Login button to submit the user name and password to the Console Management System for
validation and to retrieve the list of assigned designs.
Press the PIN Entry Window button to open the PIN Entry window. The PIN Entry Window can be
used on IP-3XXX series devices and PCs using a touch screen interface to enter a user’s PIN.

i
Notice!
On IP-3XXX series devices, the handset dial pad keys can also be used for PIN entry.
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Figure 60.3: PIN Entry Window

60.3 Design Selection Window
Use the Design Selection window to select a specific design file to open. If the user is assigned
multiple design files, or the Show local designs feature is enabled, the Design Selection window
appears after login.
4 Click the Launch button to open the specific design in C-Soft Runtime.
The Back button located in the lower left window closes the Design Selection window and returns the
user to previous Sign In window.
4 Click the button in the lower right of the window to open the Console Configuration Tool.

Figure 60.4: Select a Design Window

If the Show local designs feature is enabled, the Design Selection window displays a Browse button.
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4 Click the Browse button to open a File Selection dialog, where the user can browse the PC and
select a local design file to open.

Figure 60.5: Select a Design Browse Button
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61 Appendix M - Console Configuration Tool
The Console Configuration Tool displays and modifies position specific settings that apply to design
file access and device level settings. The position settings are stored in an .xml file located at C:
\ProgramData\Telex Communications\C-Soft\Settings\ClientSettings.xml.
To open the Console Configuration Tool, do the following:
4 Double-click the Console Configuration Tool desktop icon.
Or
1. On the keyboard, press the Windows key.

The Start Menu opens.
2. Type Console Configuration Tool.

The Start Menu displays the application.
3. Click on the Console Configuration Tool menu item.

61.1 Console Management System
The Console Management System window displays all the settings related to connecting with the
Telex Radio Dispatch Console Management System.

Figure 61.1: Console Management System Window

Use Console Management System Check Box
The Use Console Management System check box indicates the console is to connect to the Console
Management System using the settings entered in the Connection Settings section.
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i
Notice!
This setting must be selected so the console can use the Contact Management, Design Management,
or CryptoSync feature.

Connection Settings

Console Management System Hostname/IP Address Field
Use the Console Management System Hostname/IP Address field to enter the hostname or IP
Address of the Telex Radio Dispatch Console Management System.

Console Management System Control Port Field
Use the Console Management System Control Port field to enter the port to use to connect to the
Console Management System. The default for this field is 7554.

i
Notice!
This field must match the Control Port field on the CMS webpage located in System | Network
Settings.

61.2 Design Management
Use the Design Management page to configure how the console application starts and which design
field are available for selection by the dispatcher.
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Figure 61.2: Design Management Page

Design Selection Options

Show local designs Check Box
The Show local designs check box indicates whether the Console Design Selection window displays
the last five local designs opened from the PC, in addition to the designs assigned to the user. The
Design Selection window also contains a Browse button that allows the user to browse the local PC
file system to open a design file.

Remote Design Management

Use Remote Design Management Check Box
The Use Remote Design Management check box indicates the console software attempts to retrieve
designs from the Console Management System.

Log in Mode

Enter user name and password Radio Button
The Enter user name and password radio button indicates a user name and password is needed to
log in to the system. This log in window is intended for use on a dispatch consoles that have access to
a keyboard.
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Use default user name and password Radio Button
The Use default user name and password indicates the default user name and password are used to
log in to the system. Console Sign In uses the values entered in the User Name and Password fields to
log in to the Console Management System to retrieve design files assigned to the user. This log in
method is intended to be used in scenarios where the dispatch console always logs in with the same
credentials.

User Name Field
Use the User Name field to enter a user name that the Console Sign In uses to log in to the Console
Management System.

Password Field
Use the Password field to enter the password associated with the user name to log in to the Console
Management System.

Select user and enter PIN Radio Button
The Select user and enter PIN radio button indicates a log in window which requires the user to
select a role and user name, and then enter a numeric PIN displays. This log in method is intended to
be used on dispatch consoles that are touch driven or do not have access to a keyboard.

Backup Log in Mode
The Backup Log in Mode section determines how the console software should behave when a
connection to the Console Management System cannot be established.

Use last launched design Radio Button
The Use last launched design radio button indicates the console software opens the last design that
was successfully ran on the dispatch console.

Show list of local designs Radio Button
The Show list of local designs radio button indicates the console software displays a list of designs
that are stored locally on the PC and are available to be ran.

61.3 Directories
The Directories page displays the folder path for the Storage and Media Directories C-Soft Runtime
uses. You can also set the Crossmute file path from this page.
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Figure 61.3: Directories Page

Storage Directories

Audio Recording Directory Field
The Audio Recoding Directory field shows the directory file path where all audio files recorded by the
C-Soft Runtime IRR recording feature are stored.

GPS Data Directory Field
The GPS Data Directory field shows the file path where the .kml files generated by C-Soft Runtime
are stored.

Media Directories

Images Directory Field
The Images Directory field shows the file path where all image files used in .tda based design files are
stored.

Sounds Directory Field
The Sounds Directory field shows the file path where all sound files used in .tda based design files
are stored.

Crossmuting

Crossmute File
The Crossmute File field shows the file path of the crossmute file used in C-Soft Runtime.
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61.4 Hardware
The Hardware Page allows for configuration of the console name and active network adapter
settings.

Figure 61.4: Hardware Page

Console Name Field
Use the Console Name field to enter the name for the PC that is used to identify it in the Telex Radio
Dispatch system. This name is used in the Telex System Manager application and in the Call Queue
feature in C-Soft Runtime.

i
Notice!
The first 12 characters are used to transmit a console name when operating Direct NXDN with Over
the Air Alias enabled.

i
Notice!
This field replaces the Console Name setting in C-Soft Designer.

Network Adapters Drop Down Menu
Use the Network Adapters drop down menu to select the network adapter that is used by all Telex
Radio Dispatch applications running on this PC. The selected adapter is used if multiple network
adapters are available on the PC.
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i
Notice!
This field replaces the IP Interface setting in C-Soft Designer.

61.5 System Manager
The System Manager Page displays all the settings related to connecting with the Telex System
Manager application.

Figure 61.5: System Manager Page

System Manager Credentials

User Name Field
Use the User Name field to enter the user name that is used to access this console from Telex System
Manager

Password Field
Use the Password field to enter the password used to access this console from Telex System
Manager.

Connection Parameters

Detection Multicast Field
Use the Detection Multicast field to enter the multicast address that is used to listen for Telex System
Manager device queries.
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Detection Port Field
Use the Detection Port field to enter the port used to listen for Telex System Manager device queries.

Response TTL Field
Use the Response TTL field to enter the TTL (Time to Live) value used in the packets sent by the PC in
response to a Telex System Manager device query.

61.6 Saving Changes
After changes are made to one or more settings in the Console Configuration Tool, the Save Changes
button appears in the left navigation bar.

Figure 61.6: Save Changes

4 Click Save Changes to save all modifications to the ClientSettings.xml file.
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